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1 Introduction

mcsMQTT is a Plug-in that understands MQTT and other protocols and conveniently bridges the MQTT
environment with the HS3 environment. It can be installed with HS3 on either Windows or Linux. It
maintains a local SQLite database to remember message setup, history and the basis for graphing. It
also maintains a configuration file for general HS3/user configuration settings. It creates HS3 Devices,
Triggers and Actions. It responds to DeviceValue and DeviceString changes from all HS3 devices. It
publishes MQTT messages with ability to control Quality Of Service and MQTT broker retention
attributes.

The design premise of mcsMQTT is that HS3 is the primary automation node in a typical setup. This
allows mesMQTT to leverage advantages of other protocols such as COAP/RESTful to provide discovery
and transaction-oriented messaging while still retaining the advantages of the Quality Of Service that is
important for devices that may not always be connected or the connection reliability is poor.

This Plug-in is provided as a service to the community. Others have contributed in various ways with
testing, feedback, how-to documentation, encouragement and source code including the SSL
implementation by vasrc.

2 Installation
Installation can be performed using the HS Updater facility from the Plugins or Interfaces page of HS.

Often pre-release updater packages are available and use the Uploader Override process to intall.

To side-load a plugin the following process is used for HS4

1. Download the zip file that is in the HS4 updater format.

(e.g. http://mcsSprinklers.com/HSPI_mcsMQTT_5_12_0_0.zip)

2. Place the download in the HS4 folder.

3. Unzip the file updater_override.json and put it in the same HS4 folder.

4. With browser navigate the the HS4 plugin menu, Add option. Only HS4 plugin available will be
mcsMQTT. Select it. (I do not recall if you need to deselect the current mcsMQTT version before
this or not)

5. Remove updater_override.json to restore normal Updater operation.

For HS3 it is paraphrased from the HS3 SDK

1. Download the zip file that is in the HS3 updater

format. (e.g. http://mcsSprinklers.com/mcsMQTT_5 12 0 0.zip)

2. Place your package installation ZIP file into the \Updates3\Zips folder.

3. Unzip updater_override.txt. | believe it goes in the HS3 folder.

3. Now go to the menu Plugins->Manage and click on the Refresh (Update Listing) button so it finds
your updater_override.txt file and it should list your package

4. Remove updater_override.txt file to restore normal Updater operation.

In addition, incremental builds are available that contain only changed file. These are installed by
unzipping to overwrite the file of the same name. These are typically in \bin\mcsMQTT or
\htmN\mcsMQTT folders.
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3 Environment & Architecture

3.1 MQTT Environment
MQTT is a lightweight protocol that came about as a result of the Internet Of Things (IOT) initiatives.
Communications use TCP over IP with a publish and subscribe model. The environment is widely
supported on both Linux and Windows.

A typical setup has a single MQTT broker who is responsible for keeping track of all subscriptions and
assures that published messages are delivered to those that subscribe to the Topic of those messages.
MOSQUITTO is the standard broker. Normally it is run on something like RPi, Linux or Windows servers.

mcsMQTT will also provide the function of MQTT Broker if desired. This is the default. This
configuration is done on mcsMQTT Page Broker Tab MQTT Broker Name or IP Address text box. When
the text box is left empty then no connection to a MQTT Broker will be attempted. If selection is made
for use of internal Broker, then the IP will show as 127.0.0.1. It is recommended to use an external
MQTT Broker that is running on a network computer with high availability. When the internal MQTT
Broker is used, then it will only be running when mcsMQTT is running and if there are other network
clients that use MQTT these clients will no longer be able to communicate when mcsMQTT is not
running. Any combination of internal and external Brokers can be specified with up to six allowed.
Semicolon is used in the setup to separate the IP of each.

mcsMQTT is a MQTT client. By default, it subscribes to all or a selected subset of messages serviced by
the MQTT broker and it publishes that which is setup by the user in the form of HS Devices and Event
Actions. The mcsMQTT user identifies Topics of interest to HS and places the selected message Payload
in HS Devices or uses the Topic as an Event Trigger.

The MQTT broker being used by mcsMQTT is specified in the setup (/MQTT) browser page of the HS
Plug-in. This can be seen in Figure 40. A variety of options are available to identify the broker. One is to
use the IP address such as “192.168.1.100”. Another is to identify its network name. This is shown in -
Figure 40 example as “MQTT” as a dedicated RPi is being used for this purpose. The third option is an
internet address such as “MyDomainName.com”. Port 1883 is being used for MQTT communications so
the WAN/LAN router will need to be setup to allow port 1883 to be serviced from the WAN wherever
the broker is located. In all cases the firewall protection will need to be setup to allow free
communication between the broker and all clients.

The MQTT broker can be setup to restrict client access with username/password protection. SSL
protocol is typically another broker option. mcsMQTT supports the user of username/password and/or
SSL. If the MQTT broker is not using usernames/passwords then the setup of mcsMQTT will leave these
fields blank. 4-21-2022 12:30

3.2 mcsMQTT Plug-in Architecture
mcsMQTT is a Plug-in that complies with the HS3 and HS4 API for Devices, Event Triggers, Event
Conditions and Event Actions. Multiple browser pages are available from which user options can be
specified. The management associated with items that use MQTT protocol is done from the MQTT
menu selection. Other protocols and specialty functions such as IR, location tacking and others are done
from other browser pages available on the selection menu. The Local page contains setup for
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capabilities that are based on communications on the local network. The Cloud page contains setup for
capabilities that often connect to the internet to external servers to support the desired functionality.

No mater the source (MQTT, Local or Cloud) the information is decoded into individual endpoints and
made available on the MQTT page, Association tab from where the integration with HS can be specified.
This integration normally is initiated with use of the “A”ssociate column checkbox and/or “L”ongTerm
(InfluxDB, MySQL, SQL Server) or “S”hortTerm to SQLite checkbox. Further customization is then done
on the Edit tab or the MQTT Page which can be accessed via hyperlink of the row sequence number or
Ref button.

Devices are created and deleted based upon association with MQTT Topics.

e Created devices select their Location and Name properties based upon MQTT Topic with the
lowest part of the Topic hierarchy used for Name and the next up used for Location.
Alternately, Location properties can be specified on the MQTT Page Client Tab.

o DeviceTypeString is set based upon the receive or transmit nature of the MQTT Topic. Devices
created based upon a received MQTT Topic will be of type “MQTT_Receive”. “MQTT_Transmit”
is used for devices that will publish a MQTT Topic that is not associated with a received Topic.

e The Device MISC properties will be set to SHOW_VALUES and cleared to not perform
AUTO_VOICE_COMMAND. These can be edited from the Edit tab.

e The Device Address property is set to the received MQTT topic.

e DeviceVSP are setup depending upon the nature of the Payload with button-orientation for
those topics that appear to have two or three discrete statuses (e.g. ON/OFF, OPEN/CLOSED)
Payloads and 32-bit integer ranges for numbers and list for enumerated text. These properties
are setup when a subscription Topic is associated and then again when a publish Topic is
selected. A Device remains status-only until a publish Topic is selected.

o DeviceVGP are used for the buttons with the graphics being the standard images used by HS3.

e The CAPI interface supports buttons, numeric and string types of control. The DeviceValue or
DeviceString will store the Numeric and Text Payload, respectively.

o The use of DeviceValue or DeviceString by mcsMQTT will be based upon a combination of the
Edit tab Control/Status Ul and the radio to select between the two. A Control/Status Ul of Text
will use DeviceString. All others will use DeviceValue. The radio can override this default.

Information about Topic/Device relationships is maintained in the mcsMQTT database at
Data\mcsMQTT\mcsMQTT.db. Information about modes and settings is maintained in
Config\mcsMQTT.ini. If scripts are used then they are located in the \scripts subfolder. Backups of the
Data, Config, and scripts subfolders as well as the HS folders related to events and devices are made
daily if a backup location has been specified. If backups are enabled then it is advised that they be made
to a drive different than the one used by HS so if physical damage to main drive occurs the backup will
still be available and so the backup will not eat away at available space on the HS drive.

Startup of the plug-in establishes a connection with HS and makes HS aware of the capabilities provided
by the plugin. The plug-in then performs a connection to the MQTT Broker or spawns its own MQTT
Broker is one has not been specified. It also does its bookkeeping of MQTT topics and HS Devices that
have been previously observed. During this time, it will queue any inbound requests to send MQTT
messages as well as defer rendering of browser pages until it completes initialization.
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mcsMQTT tries to provide a capability that best suits a specific user’s needs. This is configured on the
Client Tab of the mcsMQTT browser page. In its most basic mode, it will allow a user to manually define
a Topic-Device relationship with a set of text boxes and supporting checkboxes or radio buttons for the
relationship’s characteristics. In its most user-friendly configuration, it will discover all Topics and
Devices available and let the relationship be defined by a single checkbox entry. The balance between
modes is driven primarily based upon performance capability of the host computer to support the
features provided by mcsMQTT in a responsive manner.

The HS Device Management page provides the ability to alter some of these settings after device
creation. For example, Location and Name properties can be changed to better suit the user’s intent of
the MQTT Topic, or a displayed Device’s status can be suffixed with “seconds”, “F”, “C” or whatever is
best to put the number in the proper context.

4 Quick Start

This section is intended to show typical MQTT use cases that will get a user going as quickly as possible.
Subsequent Sections 5 and 6 provide a more complete reference for sending and receiving MQTT
messages, respectively. Other reference subjects follow these.

mcsMQTT supports many special functions where most of the setup is automatic and no subsequent
user configuration is needed for integration with HS. For example, messages from WLED, a Shelly
device, Sense Energy, Pentair poolController, and others will automatically create HS devices.

The normal case, however, is that the decoded message is shown on the MQTT Page Association tab and
the user then uses the “A”ssociate checkbox to create the HS Device and then sometimes the Edit tab to
customize it.

There is a middle-ground when HomeAssistant Discovery protocol is used. This protocol consists of
messages delivered by a widget that describe what the widget does. For example, a light with
brightness control. After receiving this description and the widget then communicates its state the plug-
in will create the HS device with on, off and slider controls. Some, but not all, widgets can be configured
to use HomeAssistant Discovery protocol.

41 Q&A
The Q&A is based upon default settings. While other techniques are often available the objective here is
to describe the most common usages. It is assumed that the Association tab filters are setup to not
restrict what is displayed in the Association Table or that they have been setup in a manner that does
not hinder the intended capability.

4.1.1 How do | get started with MQTT

Not much happens with MQTT until a connection to a MQTT broker is established. The broker can be on
the same, different network computer or an internal one built into mcsMQTT. The Broker Tab in the
MQTT Broker Operations Table is used to identify the broker IP or network name. Some brokers are
setup with username/password protection. If yours is, then these two fields also need to be entered.

Assuming the MQTT broker accepts the connection to mcsMQTT, mcsMQTT will subscribe to all Topics
that the broker manages. mcsMQTT will likely receive some messages right away and then receive
others as new Topics are published by other widgets (other MQTT clients).
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The MQTT Page Association Tab with Topic Filter T1 set to MQTT is good to view to confirm that a
broker connection exists. It will also show the last message sent and received as well as statistics about
communications overall. Initially mcsMQTT will send a message to announce that it has established a
connection to the broker. This will be a message on “Topic xxx/mcsMQTT/LWT” with payload content of
“Online”, where xxx is the computer’s name. The LWT topic stands for Last Will and Testament. As part
of the connection to the broker, mcsMQTT tells the broker that its Last Will and Testament is “Offline”.
If at some time in the future mcsMQTT becomes disconnected from the broker then the broker will
deliverer the “Offline” message to all other MQTT clients to let them know that mcsMQTT is no longer
communicating.

The Association Tab can be used to observe all the Topics and Payloads delivered by the broker. Note
that the Association table is not dynamically built as new Topics are received. The “Show Selected
Associations” button needs to be used to build a new table. Payloads in the existing table will be
updated as they change from the broker every ten seconds.

4.1.2 How do | view the MQTT Topic Payload in HS Device

The published topics are available on the Associations Tab and will be shown in green rows. Use the “A”
column checkbox to create a HS Device. When numeric Payloads are received the HS Device Value will
be updated. When non-numeric Payloads are received then either the Device Value will be updated
based upon Value Status Pairs that show relationship between text and a number or will be stored in HS
Device String.

4.1.3 How do I setup a Command/Response Device so HS can control MQTT item and show its
status

The remote item’s status via MQTT will be available on the Association Tab. When “A” is used then the

status will be available in the HS Device. See Section 4.1.2. The Topic column will provide a text box in

which the Topic that HS should publish to control the remote item via MQTT. The specified Topic will be

published with the Value as Payload when the HS Device Value changes.

If the Device has been setup using Value Status Pairs (VSP) then either the Status or the Value will be
placed in the Payload to be sent. By default, it is the DeviceValue, but can be changed to use the Status
or Label by using the substitution variable SSSTATUS: or SSLABEL: in the Payload template that is
available on the Edit tab.

Note that when the Topic is specified then the HS Device Management Ul will create controls to allow
the Topic to be published through its Ul. If no publish Topic is specified then the device will be a status-
only one.

4.1.4 How do | control an existing HS Device with a MQTT Topic

The pink rows in the Association table are the HS Devices that have an interface property that is not
“mcsMQTT”. These are the non-plugin Devices. When the “A” checkbox is used to map the HS Device
to MQTT then two text boxes will appear in the Topic column. One is a command topic. The command
Topic being published by the remote item that desires to control the HS Device is entered here. The
next time the MQTT Setup Page is drawn this row will show in a blue rather than pink or green color to
indicate its hybrid nature. If the remote item is expecting status returned as to the state of the HS
Device then the second status Topic text box is used to enter the Topic that will be used to publish
status.
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4.1.5 | want to subscribe to a Topic, but the Topic has not yet been published through the
MQTT Broker

The Edit tab is used add any subscription topic. Enter the new subscription Topic “MQTT Subscribe

Topic” row in the green table. Other properties of the subscription can be set at the same time in this

table. A common use for this is to subscribe to the special case broker SSYS topics that are otherwise

not visible.

4.1.6 The Device Management Ul is not showing what | want for MQTT Devices, how do |
change it
The Ul is determined at the time a status Topic is entered for an “A”ssociated subscription. It is based
upon the Payloads that have been received prior to association. If only numbers have been received
then the Ul will be a number box. If a set of text Payloads are observed then mcsMQTT will setup a
selector Ul to select among those that have been observed. If it appears that two-state text has been
received (e.g. On/Off, Open/Closed, Online/Offline etc.) then a button control will be provided for each
of the states.

If these defaults are not really what you want then the Edit tab is used to change them. Start by clicking
on the button on the Association tab that has the Ref number or entering the MQTT Subscribe Topic or
Device reference at the top of the Edit tab. The remainder of the table will be populated with the
properties of this subscription topic. Select the desired radio button on row for HS Device
Control/Status Ul.

Control/Status Ul of Button will show buttons on the HS Device Management page. List type will show a
pulldown. Both of these use the VSP associations to manage DeviceValue and Show DeviceStatus.

Control/Status Ul of Number or NumberChange will show a numeric text box for control on the HS
Device Management page. It uses DeviceValue.

Control/Status Ul of Text will show a text entry box for control and the DeviceString.

Control/Status Ul of ColorPicker or ColorXy will show a color picker for control and use DeviceValue that
will publish a value in #RRGGBB hex format.

Control/Status Ul of Slider or HSB will produce a slider control. HSB will also produce a color picker

4.1.7 |see Dim for HS Device Status, how do | remove or change ‘Dim’

The HS3 Device Management Page, Value-Status-Pair tab allows editing of prefix and suffix to be added
to a numeric status display. Dim is the HS default but can be edited to anything desired including totally
removed. A similar capability exists on the HS4 Devices Page, Status/Graphics tab.

4.1.8 Payload numbers contains periods for decimal. | need them to be comma

The Association Tab has a column for Regular Expression processing of incoming Payloads prior to the
Payload use within HS. For this particular case the Regular Expression match pattern is escape period
(i.e. “\.”) and the replace pattern is comma (i.e. “,”).

It also has an Expression text box from which expressions can be entered using functions shown in Table
” n

3 and replacement variables in Table 2. The Expression “Replace(SSPAYLOAD:,”.”,”,”)” will do
substitution of period for a comma.
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4.1.9 How do | know if  am communicating with MQTT broker

The connection status is shown on the MQTT Page, Client Tab. The Association Tab with Topic Filter T1
set to MQTT provides visibility into the connection status, last received and published messages and
timings associated with the subscriptions. Associations can be made to these statistics to facilitate their
use in HS Events.

4.1.10 Where do | look when things go wrong

mcsMQTT maintains a text file in \Data\mcsMQTT\mcsMQTT_Debug.txt that contains some general
startup trace information and other things of interest such as page rendering times. More information
is placed in this file if the General Tab, mcsMQTT Management Section, has the Enable General Debug
checkbox checked. This information is geared for developer and not user, but, in general will be needed
when support is needed. The file can be accessed directly or uploaded in zip format from the button on
the General Tab. For more severe issues, the HS Event Log will contain notifications provided by
mcsMQTT.

4.1.11 How do | know if a client has stopped publishing MQTT messages

Event triggers (MQTT Timeout) can be setup from HS Event page to trigger the event when a specified
period of time has elapsed without a topic being received. A provision of the MQTT protocol is for Last
Will and Testament (LWT) that may or may not be used by the client. If it is, then the LWT Topic for this
client can be “A”ssociated as a HS Device and then trigger an event when this Device shows the LWT
Payload for that client which is often “Offline”. There is also an LWT provision for when a client
connects to the broker.

4.1.12 How do | publish a MQTT message when some event has been triggered in HS

An Event Action can be defined for this event that will publish a specific Topic in response to that event.
Substitution variables (Table 2) can be used in the Action’s Payload that substitute a set of defined items
defined within HS, such as DeviceValue, time, etc.

Another approach is to have previously setup a publish Topic within a HS device (See 4.1.3) and then in
the Event Action to set this Device to the Value desired to command the MQTT topic to be transmitted.

4.1.13 How do | chart the time history of a topic’s payload

Two options exist for collection data in a database for later viewing. One is to store MQTT Topic and
Payload in an SQLite database. The other is to store HS DeviceValue in either InfluxDB, SQLite or MS SQL
Server database. See 4.1.14 for this second approach. The selection of one vs. the other depends if one
is trying to analyzer MQTT message history or history of changes in a specific endpoint’s value.

For the MQTT Topic and Payload the setup is done from the MQTT Page History tab. This allows the
retention to be specified and the types of MQTT messages will be saved.

A chart can be prepared in one of three methods. The easiest is from Association tab by clicking on the
Payload hyperlink. A more customized chart is made from the Chart tab where specific topic and
payload parameters are entered and the chart shown at the bottom of the tab. The third is with a HTTP
request to the HS Server URL where the parameters are part of the request. See Section 9.
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4.1.14 How do | chart the time history of a HS device

When HS DeviceValues are being saved in either SQLite or InfluxDB then the selection of the specific HS
Device Reference is done from the MQTT Page Association tab. The “L”ongTerm column and
“S”hortTerm are used to select the Device and the target database. SQlite is oriented to short-term
data collection while the network databases are oriented to longer term retention. Short-term storage
also has MQTT Page History tab setup to specify the scope of the data collection.

A chart can be prepared in one of three methods. The easiest is from Association tab by clicking on the
LastDate hyperlink that will be available for any row where the S(ortTerm) or L(ongTerm) checkbox is
checked. A more customized chart is made from the Chart tab where specific topic and payload
parameters are entered and the chart shown at the bottom of the tab. The third is with a HTTP request
to the HS Server URL where the parameters are part of the request. See Section 9.

4.1.15 How do | change Payload temperature from Centigrade to Fahrenheit

A transformation can be performed on a payload before it is stored into a HS Device. For textual
transformation regular expressions can be used. For some textual and all numeric transformation then,
numeric expressions can be used that contain functions shown in Table 3 and replacement variables in
Table 2.

In this case it will be a numeric expression “SSPAYLOAD: * 1.8 + 32” that is entered on the Expression
row of the Edit tab.

4.1.16 My MQTT payload is wattage rate, but | want HS to provide daily wattage use

mcsMQTT can integrate or take the derivative of a MQTT payload input. The integral/accumulation
transformation is used if a rate is being provided in the payload. This is done on the Edit tab by checking
the “Create a HS Accum Device” checkbox and also using the checkbox to reset the accumulation at
midnight. HS Device will show the wattage rate and a second one will show the wattage. Had the
sensor been providing the wattage and the desired transformation was to see the wattage rate then the
“Create a HS Rate Device” new radio would be used.

When a integral or rate option is selected a pseudo MQTT topic is created with the Topic that is suffixed
with “-Accum” or “-Rate”. It will show up on the Association Tab from where it can be selected for
history data collection.

4.1.17 How do | easily initialize an 10T device with one-tiime configuration messages

The MQTT Page Pub List tab exists to publish a set of messages on demand. The messages that are
needed to define the |OT device configuration (e.g. LoRa frequency or irrigation schedule) are place in a
text file of type “.pub” located in the \Data\mcsMQTT folder. Each row of the text file will contain a
message of format Topic=Payload. The Execute Publication List button is used to send the set of
messages.

4.1.18 | have been experimenting and have topics that will never be used again. How do |
permanently remove them

The Obsolete function within mcsMQTT is used to remove Topics that have become obsolete. The

function can be done on an endpoint-by-endpoint basis on the Association tab or with a Topic template

on the General Tab. See 4.1.26
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4.1.19 How do | group devices in HS Device Management display

Devices with related information are often desirable to group so always show together in the HS Device
Management page. The user can group by whatever organization a user desires on a device-by-device
basis. In this case the Edit Tab has “Grouping Parent Ref” where the user can specify a parent device
reference and the MQTT device will become the child of this parent.

mcsMQTT will by default group JSON payload items into a parent device of the topic. Since all children
are required to have parents in HS4 it is not possible to leave a child without a parent grouping.

If a parent device does not exist then one can be created by entering a negative number for the
grouping ref. mcsMQTT will then create a parent device rather than using the number as the
identification of the parent.

4.1.20 How do | automatically associate sets of MQTT topics to non-plugin devices

A wildcard capability exists for incoming topics that conform to a pattern and the HS device reference is
contained in the topic. For example, a user has all lighting already setup with HS control and wants to
also provide a method to control via MQTT with minimum setup within mcsMQTT. On the Client tab in
section for Inbound (Subscription) Management is a key “Wildcard Non-Plug-in Control Template” that
will accept the pattern of a control Topic where part of the pattern includes any of the substitution
patterns described in Table 2. An example is shown in Figure 1 where the topic to control an HS device
will start with “test/” and end with “/.cmnd” and the device reference will be in the middle (e.g.
test/123/cmnd). When a topic is received that matches this pattern and the HS device exists then
mcsMQTT will associate the topic and device automatically. Other wildcard patterns such as
“Command/$SSCOMPUTER:/SSFLOOR:/SSNAME:” could be uses as well to uniquely identify each HS
device.

When multiple patterns are desired a comma between each is used. For example, if subscribing to “HS”
or “HS3” topics then the template would be specified as “HS/#,HS3/#".

Normally status feedback when this HS device changes is desired for these devices. The status topic and
the payload templates are setup in the Outbound (Publish) Management section which is also shown in
Figure 1. Again “SSREF:” is used as the wildcard for the HS device reference in the Topic. Other parts of
the Topic can be simple text or other substitution parameters as described in Table 2.

The payload in this status message will normally be either SSLABEL: to indicate to publish the same as
what HS shows for a label of a Value Status Pair. It could also be SSSTATUS: or SSSVSP: to use the VSP
mapping setup on the mcsMQTT Edit tab. This default payload template can be left blank for the default
payload of the DeviceValue.

After the command topic is received it is possible to use the Edit tab for the Topic/Device and change
any of the default behaviors on a Topic/Device by Topic/Device basis.

It is also possible to create associations for all HS non-plug-in devices immediately and not depend upon
receipt of a command topic. In this case both a wildcard subscribe/control topic and a publish default
topic template is needed. The radio button next to the subscribe wildcard is changed to the immediate
option. If new HS devices are created in the future, then they will be automatically associated with
MQTT topics when mecsMQTT is started or when the Enumerate button on the General Tab is used.
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If changes are desired in individual device Topics that vary from the default wildcard or template then
they can be done from the Edit Tab.

Inbound (Subscription) Management

Topic Discovery
Inhibit Topic Discovery

Wildcard Non-Plugin
Control Template

Wildcard Plugin Auto
Associate Template

Echo

150N Decoding

Express Mode

Express Mode Features

Cbsolete Topics

Receive Queue Depth
Receive Queue Interval

® Discover Published MQTT Topics

0 Listen for Only Associated and MQTT Trigger Topics
[ Disable New Topic Recognition

|testl’$$REF:.fl:mnd |

"«@J Associate Topic to HS Device upon receipt of control Topic
) Associate all non-plugin HS Devices immediately

Testi# +/STATUS# |

® Do not process echo of transmitted topics

2 Include transmitted topics in Association tab reception list
® Decode Payload JSON into individual HS Devices

2 Place full Payload into HS Device

) Create both Parent full payload and Child J50M keys

® Default accepted Topics to full support

0 Default accepted Topics to only store in HS device
W Decode JSON into separate HS Devices

# Honor setup of device type and use VSP and Color Picker
™ Process regular and arithmetic expressions
[1 Process Topic event triggers and script callbacks

Remove Topic |
records from database and tables
Process no more than received message at a time

Yield CPU for E milliseconds when queue is above depth limit

Outbound (Publish) Management

Default Topic Template
Default Payload Template
Default QOS5

Default Message Retain
Publish Periodic Status
URI Encode Topic

Topic Prefix

H5 Device Discovery

H5 Device Enumeration

SETOPIC: /command
SESTATUS:

® atMost O AELeast O Exactly

® Do Mot Retzin at Broker

) Retain at Broker

Every D Minutes

® Encode with URI encoding such as %20 for space
2 Send unencoded

[Add STAT/ prefix to Topic on Device change

[ Add INFOQ/ prefix to Topic during periodic reporting
® Enumerate HS Devices during startup

) Enumerate HS Devices only with Button
Enumerate Non-Plugin Devices

Figure 1 Wildcard Topic Setup
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4.1.21 How do | automatically create HS devices based upon MQTT Topics
There are a set of topics that mcsMQTT will recognize and automatically create HS devices. These are:

“shellies/#” for Shelly line of products,
“shellyBlu” for Shelly bluetooth

“wled/#” for WLED light control,

“pool” for poolController.js for Pentair,
“owntracks” for OwnTracks and NextTracks Apps,
“voicemonkey” for Echo TTS,

“Broadlink” for Broadlink IR/RF,

“Daikin” for Daikin AC control,

“Venstar” for Venstar thermostat

“Midea” for Midea thermostat

“AirTouch” for AirTouch thermostat
“EcoNet” for Rheem EcoNet

“Yolink” for Yolink line of products,

“sense” for Sense Energy

“Nanoleaf” for Nanoleaf

Unit serial number for Ecowitt GW1000 family
“PowerView” for Hunter Douglas shades
“Gecko” for Gecko spa

“Kef” for KEF Speakers

“Orbit” for Orbit Irrigation

“Hydrawise” for Hunter Irrigation
“Omnilogic” for Hayward Pool

“ratgdo” for garage door opener

“Govee” for Govee

“Epson” for Epson projector

“Kasa” for TP-Link Kasa and Tapo
“Roborock” for Roborock Vacuum

“NuHeat” for NuHeat thermostat
“Hubspace” for Home Depot lighting
“Switchbot” for Switchbot devices

“Yolink” for YoLink devices

“Abode” for Abode security panel

“Econet” for Rheem Econet equipment
“Solcast” for Solar forecast

“Serial/JACUZZI” for Jacuzzi hot tub

“Nexia” for American Standard, Trane, ION thermostats
“TankUtility” for Tank Utility Propane
“espresense” for Espresense room location
“HS” for HS and Plugins

“MQTT” for statistics collected by mecsMQTT

“URL” for IPs setup on Cloud Page URL tab,
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URL UDP Port 32101 for Coulisse B.V. Motion-Blinds.com Blinds Control
“URL/api.emporiaenergy.com” for Emporia Vue
“URL/api.flumetech.com and URL/api.flumewater.com for Flume

No additional effort is needed by the uses when these topics are present. For some the auto create
capability is enabled from the Client tab, Inbound Management “Enable Auto Device Creation”
checkbox.

mcsMQTT recognizes the HomeAssistant discovery protocol. These are topics starting with
“homeassistant/” and ending with “/config”. This protocol is used by MQTT clients to disclose the
nature of the devices it supports. mcsMQTT will collect this disclosure information and then if any topic
matching it is used it will automatically create HS devices for status and control.

mcsMQTT will also use this discovery protocol to disclose any non-plugin devices that have been setup
for MQTT. The discovery is published with use of the General tab, Outbound Management, “Publish
HomeAssistant Discovery” button. While it will help other clients to understand the nature of what has
been setup in HS, it is hampered by a poor functional model of devices within HS so the disclosure may
not result in the desired devices being created by other clients.

The above approaches provide the most complete automatic device creation as they handle all the
properties such as icons and control Ul type appropriate for the device. A more generic, and less rich,
mechanism is described in the remainder of this section.

mcsMQTT will collect all topics for viewing in the Association tab and the user is able to create HS
devices by using the “A”ssociate checkbox. This opt-in selection can be changed into an opt-out
selection by using plug-inTopic wildcard template for the Topics that will automatically have HS devices
created. This template is found on the Inboud Management section of the Client tab. If every topic is to
create an HS device then the template is “#”. If it is to create HS devices for all topics with “RESULT” in
the second position then the template would be “+/RESULT/#”. The template uses standard MQTT
Topic wildcarding. Anything that does match the wildcard template will obey the opt-in rules. Devices
that were auto-created and are not desired can be removed with “A”ssociate textbox on the Association
tab. Auto-Association only applies to the initial detection of a topic.

When Auto-Association is used then it may be useful to also set the Topic Template in the Outbound
Management section of the Client Tab. When this template is not blank then any HS device that is
created will have a publish Topic setup and either Buttons or Number text boxes setup with the HS
device. For example, Shelly devices suffix the Topic with “/command” to indicate that the topic is
commanding the Shelly device. The Topic template in this case would be “SSTopic:/command”.
Tasmota devices use “/cmnd” placed either as a prefix or before the last segment of the Topic. If the
substitution is “SSTASMOTACMND:” then mcsMQTT will evaluate the Topic and put the “/cmnd” in the
proper position. For example, “Switch/Power” becomes “Switch/cmnd/Power”.

If there are multiple sets of Topics that are whitelisted then each should be separated by semicolon.
This then servers as an OR function to Auto-Associate different sets of Topics, but not all topics.
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Inbound (Subscription) Management

Topic Discovery

Inhibit Topic Discovery

@ Discover All Published MQTT Topics
O Listen for Only Assodiated and MQTT Trigger Topics
O Listen for Only using the Wildcared Template below

1 Disable New Topic Recognition

Enable Auto Device Creation #Enable Auto Creation

Wildcard Non-Plugin Control I
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Associate Template

Default HS Device Location
Default HS Device MISC
Default HS Parent Device
Echo

Express Mode
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(O Associate all non-plugin HS Devices immediately

|l1

® Use Loc2 {Floor) & Loc {Room) based upon MQTT Topic
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[1 Process Topic event triggers and script callbacks

Remove Topic |

records from database and tables

[ Remove Unassociated records from database and tables on shutdown
Reject Topics matching template

| Greenhouse/RESULT |

5 Limit when CPU throttling starts

100 | Limit when messages discarded

Yield CPU for milliseconds when queue is above depth limit

Figure 2 Auto-Association (Opt-out) Setup Example
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4.1.22 How do | publish HS device changes without explicit association to MQTT topics

When the objective is to primarily make HS a source of information and to publish all device changes
that are occurring in HS then it becomes desirable to do this without explicitly associating each device
with a MQTT Topic. The “Publish HS Device Changes” option can be used in conjunction with the default
Topic and Payload templates that are available on the Client Tab.

In the example shown in Figure 3 all changes will be published using the floor, room and name
properties of the device for the topic and the value, status and ref properties as a JSON payload. The
templates can be changed as desired. The option also exists to only publish topics for devices that have
not been created by mcsMQTT.

Outbound (Publish) Management »
Default Topic Template |HS4/$$FLOOR:/$$ROOM:/SSNAME:

Default Payload [{'value"$SVALUE: "status "$§STATUS ", 'rel } |
Template . : -
Default QOS @ At Most OAtLeast O Exactly

® Do Not Retain at Broker

Default M etain -
efauit Message Retain  ~ o oiain at Broker

Publish Periodic Status  Every |0 Minutes
® Send unencoded

URI Encode Topic ) Encode with URI encoding such as %20 for spac
O Replace special characters with underscor

O Disabled
© All non-Plugin Device Changes
'1?) All Device Changes

Publish HS Device
Changes

Figure 3 Publish Without Association
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4.1.23 How do | setup device with different status and control payloads
The desire is to control a door lock where the MQTT payload for status is LOCKED and UNLOCKED and
the HS control buttons show lock=100 and unlock=0.

mcsMQTT has been observing the MQTT status of the lock device and has made a list of LOCKED and
UNLOCKED as known payload content of the device. When the subscribed topic is associated and HS
device created then the Value Status Pairs will be created such that DeviceValues of 0 and 1 are assigned
to UNLOCKED and LOCKED respectively.

If your lock device responds to “lock” and “unlock” payloads then on the Edit Tab leave Payload
template blank. If it responds to a number such as 100 and 0 then use “SSVALUE:” for the Payload
template and edit as necessary the VSP in mcsMQTT to have 0 and 100 for the two states rather than
the default 0 and 1.

To create the “lock” and “unlock” command buttons the HS Device Management page is used. Click on
the name of the mcsMQTT device that now contains the LOCKED and UNLOCKED for its status states.
Select the Status Graphic tab. Click on the Add New Single Value and enter 0 and “unlock” for the value
and status respectively. Select control for the Status-control. Do the same for the “lock” control with a
value of 100. Note that the LOCKED and UNLOCKED states should be status for Status-Control so it they
are different then change them now.

This should result in 2 buttons or pull-down selections on the GUI. You may need to edit the Value
Graphics Pair to get the graphics you want for the two control buttons.

When you click a button the MQTT message will have a payload of 0 or 100 if the payload template is
SSVALUE: or “unlock” or “lock” if the payload template is SSLABEL:. When the node reports its status
change it will return something like UNLOCKED for which mcsMQTT will store a value of 0 in HS3. HS3
will show UNLOCKED in the status for the device on the browser page. Note that SSVSP: will normally
be the equivalent of SSLABEL: and SSSTATUS: will use the Edit Tab status field of the VSP for the
replacement.

Note that when the desire is to only change the status text from what is received in the payload then
the Edit Tab provision for editing VSPs has the advantage of not being later overwritten by mcsMQTT is
the device properties are later changed in the Edit Tab. See Section 17.2.3.

4.1.24 How do | conveniently control a colored light

Colored LED lights or light strips come in various forms with some variance in the control capabilities. In
some cases, it will accept a Red Green Blue (RGB) which is usually represented in hex format. In other
cases, it will accept a JSON payload where the three components are separately encoded. Yet others it
will use a different color model such as XY.

mcsMQTT provides four forms of interface which uses the Color Picker provided by HS for means of
color selection. Received payloads will be converted from RGB, RGBW, XY or HSB color space into an
integer value that will be reflected in the HS color picker device. Publish commands formats will vary
based upon the type selected.

mcsMQTT also provides a method to use sliders in the HSB color space rather than color picker and use
RGB in the MQTT payload. This is RGBtoHSB option.
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RGB type expects #HRRGGBB or RRGGBB as the status input and will publish command in #RRGGBB
format.

RGBW type expects “{"color": {"r":RRR, "g":GGG, "b":BBB}, “brightness”:bbb}” as the status input and
will publish using the same format. mcsMQTT does the conversion from the HS DeviceValue
representing the color picker value.

The ColorXY type is expecting a subscription with a payload containing XY color space and brightness.
"color":{"x":<value>,"y":<value>},"brightness":<value>. mcsMQTT translates this into RRGGBB which is
what the HS device expects for the Color Picker control. Publish command will use

“{"color":{"r":RRR, "g":GGG, "b":BBB}, “brightness”:bbb}” format.

The HSB type is expecting a subscription with a payload containing a comma-separated-values format of
Hue, Saturation, and Brightness “HHH,SSS,BBB”. JSON encoding is not expected for the three
components, but the key such as “HsbColor” can be part of a JSON payload.

HSB can also be used to create both color picker and a set of three sliders. This is done when the
received payload is in RRGGBB format and one desires to be able to individually conrol H, S, and B as
well as have composite color picker control. mcsMQTT will publish as RRGGBB no matter which of the
four controls are used.

The use of the Control/Status Ul or HSB is likely the most flexible for lighting controllers that can accept
HSB commands (e.g. Tasmota). In this case mcsMQTT handles the conversion from the HS RGB Color

Picker Ul and the HSB commands. It also provides the sliders to individually control Hue, Saturation and
Brightness as well as the Color Picker to select specific points in the color space. An example is shown in

& = (C (@ Notsecure | 192.168.0.7/deviceutility
O T + |55 @@
Display Filters: Floor I Room I Device Type I Show All
Status Category Floor Room Name Last Change Control
O MagicHome MagicHome STATUS
O MagicHome MagicHome STATUS:HSBColor Today - AM C6647 r
0O c 80 MagicHome MagicHome STATUS:HSBColor:1 IEF;E'\!'_% At
. ’ A n Today
I us: Color: y
O @ 30 MagicHome MagicHome STATUSHSBColor:2 g o A
. ’ A n a Today
T | - C r ¥
0O @ 40 MagicHome MagicHome STATUS:HSBColor:3 10:36:39 AM

Figure 4 HSB Ul in HS

In the example shown in Figure 5 the bulb information is provided in a JSON payload with state,
brightness, color rgb, color x, and color y parameters. Assuming that one desires to control all
parameters, yet keep the parameters all grouped in HS screens, then the first step is on Client Tab,
Inbound (Subscription) Management and select the third JSON Decoding option to create both parent
and child keys. This will handle the grouping. Remember to come back when done with the new bulb
and change it back to the default first option of decoding into individual devices. If other organization
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means are to be applied then the Client Tab setting for JSON payload can remain in it default selection.

Next step is to use “A”ssociate checkbox for the parameters of interest so they map into HS devices.
After any of the items are associated then after the subsequent reception of the topic then an additional
pseudo-JSON items color:rgb is created. When this item is associated and a publish topic is entered then
the Control/Status Ul type will be set to ColorXY and a HS Color Picker control made available. Figure 5
shows use of state, color rgb and brightness.

Since these will be controlled parameters with a MQTT publish the publish topic is entered into each of
the three text boxes. | n this example it will be the same topic and it will be the same as the base sub
topic with a /set suffix. Sometimes the end point is contained in the Topic and sometimes it is a generic
topic with the specific parameter identified in the payload.

To support the JSON payload encoding needed for ON/OFF and Brightness control the Payload Template
will need to specify the necessary JSON format. Use the Edit tab and change the Publish Payload
Template for JSON formatting for the On/Off device. The easiest way to bring up the Edit tab is to click
on the Ref button of the state device in the Association tab. In this case the contents of the text box will
be {"state":"SSLABEL:"}, {"state":"SSVSP:"}, or {"state":"SSSTATUS:"}. The “{"state":" part is what the
bulb is expecting to identify the parameter. The closing “}” completes the JSON syntax. The “SSLABEL:”,
“SSVSP:” or “SSSTATUS:” is a replacement variable telling mecsMQTT to use the HS VSP, the mesMQTT
VSP Key or mcsMQTT VSP Status which will be either “On” or “Off” as setup in the Value Status Pairs
(VSP) of the device.

The same process is followed for the brightness device. In this case it will be {"brightness":"SSVALUE"}
where SSVALUE: indicates to use the HS Device Value numeric.

The third control is for color selection. Again, use the Edit tab and assure the type to be a ColorXY. This
will give the desired Color Picker Ul for color selection in HS and will tell mcsMQTT that JSON payload
encoding is needed and that XY to RGB translation is needed before storing the color value in HS.

By default, the brightness device will be created with a text box to enter a number in the HS Ul. This
can be changed from HS Device Management for the Brightness device. Status Graphics tab and change
the range to 0 to 255. Also change the type to slider.

Figure 6 shows the result of the above setup with Figure 7 showing various options to make color
selections. Note that use of the color picker will result in a RGB color and the brightness which is implicit
in the RGB value. There is a parent device 1103 which will contain the last received payload for the

bulb. Under it will be the devices to control brightness with a slider, state with on/off buttons, and color
with a color picker. When the slider is used only brightness information is updated, but the status
published by the light will likely modify its RGB and the color picker control status will also be updated.
The same is true with update of brightness device when RGB color is changed.
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Filter Association Table by Mgtt Topic and JSON Payload Key Clear Filters Rebuild Filters

T1 |zigheeWA v| T2 [0xb0ce18140001detb v | T3 | | T4 | v| T5 | v| T6 | v|

J1 | v| J2 | v J3 [ | Ja [ | J5 [ 7| J6 [ v |

Show Selected Associations

Prev D of 6 Next

Association Table for Auto Association of MQTT Topic and HS Device

&l r a ref TOPIC payload h d lastdate

o O O || sub: zigheeWA/OxbOCe18140001de1b/set:brightness 194 O 2018-12-17 14:58:52
Dev: |zigbeeWaA|0xb0ce18140001de1b:brightness
Sub: zigheeWA/0xb0ce18140001delb:brightness

1 0 “ 1104 Pub: the following Topic on Device command 121 U Ll 2018-12-17 14:58:53
zigheaWA/Oxb0ce13140001de1b/set |
Dev: |zigheeWa|0xb0ce18140001da1b:Color:RGE
Sub: zigbeeWA/0xb0ce18140001delb:Color:RGB

z 0o # U Pub: the following Topic on Device command AR o L 2018-12-17 14:58:53
zigheeWA/Dxb0ce 1814000 1de1b/set |

2l O 0O || sub: zigheeWA/0xbOce18140001de1b:color:x 0.433 O 2018-12-17 14:58:53

4 O 0O || sub: zigheeWa/0xbOce18140001de1b:color:y 0.484 O 2018-12-17 14:58:53
Dev: |zigbeeWa|0xb0cel18140001de1b:state
Sub: zigheeWA/0xb0ce18140001delb:state

3 0 “ 1105 Pub: the following Topic on Device command ON U Ll 2018-12-17 14:58:53
zigheaWA/Oxb0ce13140001de1b/set |

Figure 5 Color Bulb Parameter Mapping
Ref Status Floor Room Name Address Last Change Control
{"state":"ON","brightness":230,"color": ] : Today

[1|1103 £%":0,433,"y":0.4841} zigbeeWA | zigbeeWA/0xb0ce18140001delb 2:51:21 PM

[1|1104 |230 zigheeWA | 0xb0ce18140001de1b:brightness ;‘?:f_"io o

[1|1105 oN zigheeWA | 0xb0ce18140001de1b:state ;D;jf‘iu ou ON || oOFF

[1|1108 (16777121 zigbeeWa | 0xb0ce18140001delb:Color:RGB ;‘,’:f_‘io = |FFFFm

Figure 6 HS Device Setup for Color Control
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new

Drag Markers To Pick A Color

Figure 7 HS Color Picker Control

4.1.25 How do | change the subscribe Topic that is associated with a HS Device

There are two ways to change a subscribed Topic to HS Device relationship. One creates a new HS
Device and one preserves the existing HS Device. To illustrate, assume there two Topics visible on the
Association tab. One is Energy/Watts and the other is Energy/Amps with the Energy/Amps Topic
associated with HS Device 123. The objective is to associate Energy/Watts rather than Energy/Amps.

The first approach is point and click. Uncheck the “a” checkbox on the Energy/Amps row of the
Association tab and then check the “a” checkbox on the Energy/Watts row. This will delete Device 123
and HS will assign a new Device such as 124. This is the easiest way when no events or other uses have
been made for Device 123.

The second approach is done from the Edit tab. Enter either 123 or Energy/Amps at the top and this will
populate the remainder of the page with the properties of this relationship and it will also put a change
text box on the second row. In this change row text box enter Energy/Watts. This will preserve Device
123, remove its association with Energy/Amps and assign it to Energy/Watts.

It is not possible to change the reference number of a plug-in Device in this manner because HS assigns
reference numbers and all reference numbers used by the plug-in are assigned to other Topics.

It is possible to change the reference number of non-plug-in device. As an example, assume Device 234
is “Bedroom Light” and Device 456 is “Bedroom Plug” and currently Topic Bedroom/Lamp/cmnd Topic is
associated with Device 234. On the Edit tab first row enter either 234 or Bedroom/Lamp/cmnd. When
the second row appears enter 456. This will change the association of Topic Bedroom/Lamp/cmnd to be
Device 456. Device 234 will no longer be associated with any MQTT Topic.
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4.1.26 How do | remove Topics that have become obsolete
It is not unusual, especially when just starting or experimenting; that Topics are created that will never
be used again. They will appear on the Association tab and just represent clutter.

There are three ways to remove obsolete topics. One is on the Association tab by clicking the
“0O”bsolete checkbox on any row that is to be removed. Visual feedback is provided by the Obsolete
column header changing from “o0” to “Delete Marked”. After all obsolete Topics have been marked then
use this “Delete Marked” button to actually remove them. Note that the “Exclude O & R Columns”

checkbox on the top of the Association tab must not be checked to make the “O”bsolete column visible.

When a parent Topic has been marked as obsolete then all JSON items of this Topic will also be marked
as obsolete and the item’s obsolete checkbox will be disabled. If a parent Topic is not marked as
obsolete then individual JSON items can be marked as obsolete and deleted.

The second is on the MQTT Page General Tab Obsolete Topics row. The obsolete Topic is entered and it
will be removed from the database. The next time the browser page is refreshed the Topic will no
longer be visible.

uxn u
’

It is possible to remove a set of Topics by using Wildcard +” or “#” symbols. The “+” represents
anything in the middle of a Topic. The “#” is used to indicate everything to its right. The “*” is similar to
“#”, but allows partial topic segments to be used. Special care is needed when using wildcard symbols
because they can have far reaching effect.

mcsMQTT makes a backup at midnight, if enabled by user General Tab setting, so it is possible to
manually copy a prior version to mcsMQTT.db in the \Data\mcsMQTT folder, mcsMQTT in the \Config
folder or a script in the \scripts folder and then start mcsMQTT again to get back to that prior version if
necessary. This backup includes all files in these three folders so it is also possible to restore
information maintained by HS or other plugins using this same technique.

Some examples of using the wildcard symbols follow assuming that the following Topics exist

Test/topicl:a
Test/topicl:b
Test2/topic/power
Test2/topic/powerl:a
Test2/topic/powerl:b

“Test/topicl:#” will remove the first two Topics.
“Test2/+/powerl:#” will remove the last two Topics
“+/topic/#” will remove the last three Topics
“Test*” will remove all five Topics

“Test/top*” will remove the first two Topics

A third way is to automatically remove topics that had not yet been associated with HS device or are not
being used for history data retention. It only comes into play at plugin shutdown. The next time the
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plugin starts the topics will no longer be present, but can be relearned if they occur again. This is also on
the General Tab, Obsolete Unassociated checkbox.

4.1.27 How do | update HS Device with minimum resource utilization

There are times when all that is needed is a simple update of HS devices with MQTT payloads and no
need for history, charting and some of the other features available in mcsMQTT. Express mode, which is
enabled on a Topic-by-Topic basis, achieves an 80% reduction in CPU utilization that would occur in
normal mode.

On the Association tab the “e” column checkbox is used to identify if a Topic has full support or if
Express mode support is sufficient.

The Client tab provides a default mode option in the Express mode row. The “E”"xpress column
checkbox on Association tab will be checked/unchecked when a Topic is associated with the “A”ssociate
column checkbox, depending upon the default for Express mode. All unassociated Topics will continue
to have full support provided independent of the default mode selected. Express mode can be very
austere to minimize CPU utilization, but can also support features available in mcsMQTT if enabled on
the Client tab.

Express mode operation is controlled at the Topic level. It is not possible to utilize Express mode for
some, but not all JSON payload items. The Association tab “E”xpress column checkboxes are only
enabled for selection at the Topic level. The JSON payload items are slaved to whatever is selected at
the Topic level.

See Section 16.2 for discussion of Express mode tradeoffs.

4.1.28 How do | associate multiple topics to the same HS Device

It is common that a MQTT node will respond to a command with an acknowledge of the new state as
well as provide the state periodically. Each of these two updates will be done using different topics, but
represent the same state information.

To model this in mcsMQTT the Ref column text box is used. First “A”ssociate a Topic and create the HS
Device. In Figure 8 this was done on row 19 to create the HS Device 1310. 1310 was then entered on
row 1 and row 3. Device 1310 will be updated with ON or OFF payload whenever Topic
“SpaceHeater/POWER”, “SpaceHeater/RESULT:POWER”, or “SpaceHeater/STATE:POWER” is received.
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Association Table for Auto Association of MQTT Topic and HS Device
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ref

1310

1310

1308

1309

1303

1310

TOPIC

Sub: SpaceHeater/LWT

Dev: |SpaceHeater| STATE:POWER

Sub: SpaceHeater/POWER

Pub: the following Topic on Device command
SpaceHeater/Command

SpaceHeater/RESULT

Dev: |SpaceHeater|STATE:POWER

Sub: SpaceHeater/RESULT: POWER

Pub: the following Topic on Device command
SpaceHeater/Command

SpaceHeater/SENSOR

Sub: SpaceHeater/SENSOR:ENERGY:ApparentPower
Sub: SpaceHeater/SENSOR:ENERGY :Current

Sub: SpaceHeater/SENSOR:ENERGY :Factor

Sub: SpaceHeater/SENSOR:ENERGY:Period

Sub: SpaceHeater/SENSOR:ENERGY :Power

Sub: SpaceHeater/SENSOR:ENERGY :ReactivePower
Sub: SpaceHeater/SENSOR:ENERGY  Today

Dev: Unknown
Sub: SpaceHeater/SENSOR:ENERGY: Total
Pub: the following Topic on Device command

Sub: SpaceHeater/SENSOR:ENERGY: TotalStartTime
Sub: SpaceHeater/SENSOR:ENERGY Voltage
Sub: SpaceHeater/SENSOR:ENERGY:Yesterday

Dev: Unknown
Sub: SpaceHeater/SENSCR:Time
Pub: the following Topic on Device command

SpaceHeater/STATE

Sub: SpaceHeater/STATE:LoadAvg

Dev: |SpaceHeater|STATE:POWER

Sub: SpaceHeater/STATE:POWER

Pub: the following Topic on Device command
SpaceHeater/Command

payload

Online

OFF

OFF

1496
13.229
1.00
25
1496

3.861

7.505
2019-03-12T19:31:11
113

1.809

2019-03-21T19:27:15

OFF

Figure 8 Association of multiple Topics to same HS Device

4.1.29 How do | use multiple Topics to change status of single HS Device

4.1.29.1 Case 1 Same Status reported on multiple topics
The scenario being described here is the case for a Xiaomi vacuum that uses individual topics to indicate
the state of the vacuum such as the following:

vacuum/clean_start with payload that indicates the time it started
vacuum/clean_stop with payload that indicates the time it stopped
vacuum/clean_pause with payload that indicates the time it paused
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While these three Topics could be associated with three individual devices it would be more convenient
to have a single HS device that provides the Start/Stop/Pause status and let the LastChanged property
contain the timestamp.

The setup for this is the same as the setup described in Section 4.1.28 to associate one HS Device to the
three topics. In addition, regular expressions on the Edit tab will be used on each of the three
subscribed topics to change the timestamp into status text. The “Payload RegEx Match Pattern” will be
“.+” (without quotes) and the “Payload RegEx Operation” radio will be to “Replace” for each of the
three Topics. This pattern will look for any text so any timestamp will match. The “Payload RegEx
Replace Pattern” text box will contain “Stop”, “Start”, “Pause” or whatever status you want reflected in
HS and is what is expected by the vacuum in its command topic. Each of the three subscribed Topics will
have one of these three.

These same three status items will be itemized in VSP list on the Edit tab for each Topic. This can be
done by entering “Stop,Start,Pause” (without quotes) in the VSP text box.

The Control Ul radio is then selected to be Button. This will create the HS device with three buttons to
control. The HS status will be updated based upon the most recently received of the three Topics from
the vacuum.

The Publish Topic is entered in the Edit tab or Association tab such as “vacuum/command”. Note that
the status values (Start/Stop/Pause) can be different than the command values. If this is the cases then
the edits are made on the HS Device Management page to separate the Status Graphics from “both” to
individual entries for “status” and “control”. What must be maintained are the number relationships
between mcsMQTT VSP and those on Device Management page.

To avoid duplication of effort in the Edit tab for each of the three Topics it would be best to first setup
one of the three Topics and then enter the Ref number of this Topic into the Ref column text box for the
other two. The second and third will then be a clone of the first and all that is needed is to use Edit tab
on these later two to change the regular expression replace text to one of the other states.

4.1.29.2 Case 2 New status to be derived from multiple topics

Consider the case of a roller blind where two relays are used to control the up/down motion of the
blinds. Tasmota firmware is used in this example. The two relay status are reported by Tasmota in
Topic xyz and JSON payload something like {..."Power1":0ON,"Power2":0FF...}

This will be shown on Association tab as rows

xyz:Powerl ON

xyz:Power2 OFF

The desire is to show in HS as a single device that combines the status of the two relays.

Associate, via checkbox in “A” column the second row (the one that comes later in the JSON payload) to
create an associated HS device.

In the Expression field of the Edit Tab combine the two payloads as two catenated strings

"SSPAYLOAD: (xyz:Powerl) :"&"$SPAYLOAD: "

This will result in status values of OFFOFF, OFFON, ONOFF and ONON when all combinations are
received.
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Use the VSP edit to change the HS status to be appropriate. e.g. OFFOFF=0;CLOSED if the status is going
to be displayed. If control buttons are also added as described below then it is likely that the edit will be
in the HS Devices page to remove the ability to control these four values. That is by deleting them in
HS4 and changing their property to Status Only in HS3.

Use the VSP edit to create two additional values that will be used for the control (e.g. ShutterStopClose
ShutterStopClose=4;CLOSE)

Use Button or List for the Control/Status Ul depending upon buttons vs. pull-down selector for the Ul.
In the Publish Topic use cmnd/xyz/SSLABEL:

In HS Devices browser page Status/Graphics tab change the first for Value Status Pairs to be status only
and the last two to be Control only unless independent control of each relay is also desired.

Tasmota will update the relay status when it receives the ShutterStopClose command and this would
then be reflected in the created HS device as one of the four states of the two relays.

4.1.30 How do | create a device that has both slider and On/Off/Last button controls

Consider the case where a MQTT widget provides status and control of a dimmer device where the
On/Off is provided on one Topic and the Brightness is on a second Topic. This could also be a single
topic with JSON keys for state and brightness. One interface approach is a HS Device with two features.
This the the straightforward “A”ssociation of each topic to two HS features that are grouped under the
same parent Device.

Another approach to this is with a single HS Feature with controls from both On/Off Topic and
Brightness Topic. To accomplish this one of the two Topics is “A”ssociated to create the HS Devcie and
Feature. The second topic is linked by using the same Ref number provided by HS for the first
association in the Ref column textbox of the second Topic.

If button and slider controls are to be shown on the HS Feature then enter the publish (control) topic for
each of these two from either the Association tab row or from the Edit tab. See Figure 9 and Figure 10.

From the Edit tab select the Control/Status Ul to be Button and Slider, respectively. mcsMQTT will
recognize that a slider and button control are assigned to a single Ref and will merge the controls for
each of the two into the Feature. It will also force the Off to be 0, the On to be 101 and the slider to be
in the range of 1 to 100. The text for Off and On will attempt to be obtained from previously received
payloads for the button. If the text is not as desired then use the Edit tab to setup text for the 0 and 101
values. mcsMQTT will also add a third button “Last” that can be used to restore the brightness to the
level before the widget was turned off.

If a On/Off topic is received with an Off status then mcsMQTT will set the Feature’s DeviceValue to 0. It
will set the DeviceValue to the Brightness value in range of 1 to 100. An On/Off status of On will result
in DeviceValue being set to 101.

The above assumption is that the bulb being controlled will return to full brightness when ON command
received and the LAST command is to restore it to prior brightness. If the bulb returns to prior
brightness when ON command is given, then an edit can be made on HS Devices Page, Status/Graphics
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to give the ON a value of 100 and the slider max of 99. This will give the desired operation for the bulb
that returns to prior brightness when ON is commanded.

Association Table for Auto Association of MQTT Topic and HS Device

a ref payload

5047 Test/MultiTopic2

Sub: Test/MultiTopicZ:A 14

Sub: Test/MultiTopicZ:B 2050

(%]

o o O O 0O

Sub: Test/MultiTopic2: Discrete

Sub: Test/MultiTopicZ:NUMBER 12345

O O 0O 0O

Dev: TestiMultiTopic2|MultiTopic2:Slider
Sub: Test/MultiTopic2:0nOff

048 Pub: the following Topic on Device command on

O
O
O

Test/ecmnd/OnOff
6 0 0 0 0 Sub: Test/MultiTapic2:POWERT an

7 D D D D Sub: Test/MultiTopicZ:POWER2 ON

Dev: TestIMultiTopic2|MultiTopic2:Slider
Suby: Test/MultiTopic2:Slider

Pub: the following Topic on Device command

5048 60

O
O
O

Test/emnd/Slider

Figure 9 Setup of Multi-Control Feature

Test | MultiTopic2
Test-MultiTopic2 (3749)

LAST
o MultiTopic2:state (3750) 50 Today 10:33:07 AM m m -
®

Figure 10 Slider with Buttons Control

When publishing based upon the HS button controls of event action then it will likely need to be
formatted in the expected manner. This is done in the Publish Payload Template of the Edit tab.
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Assuming that the desired Payload for each of the following actions and the previous brightness was 33
is shown below for each of the four control actions:

1. Off button {“state”:”off"}

2. On button {“state”:”on"}

3. Last button {“state”:”"on”,”brightness”:33}

4. Slider to 50% {“state”:”on”,”brightness”:50}
The Publish Payload Template can be such as:

<<CASE ($$SVALUE:, '0;101"', '{"state":"off"}; {"state":"on"}; {"state":
"on", "brightness":$$VALUE: } ') >>

The << and >> are used to indicate that an inline expression needs to be evaluated

The CASE function provides conditional output based upon the $SVALUE: (HS Command Value). For the
value of 0 the payload willbe {"state" :"off"} . For the value of 101 the payload will be
{"state":"on"}. Forallothers (i.e. slider values), it will be in the range of 1 to 100 for the
slider{"state":"on", "brightness":$$VALUE: }.

mcsMQTT will intercept the Last button value (255) and change it to the previously received brightness
payload.

Note the Publish Payload Template uses both apostrophe and quote. The quote is needed for JSON
syntax. The apostrophe or quote can be used to delimit strings in the expression, but in this case since
guote is part of the text, the apostrophe is used as the string delimiter.

Note also that the CASE function is expecting each of the case input values and results to be delimited
by semicolon and not a comma. This was done to prevent confusion when using numbers that,
depending upon region, have decimal represented by either a period or a comma.

In this example there are two Topis (or JSON endpoints) and each will have a Publish Payload Template
and a Publish Topic. When responding to a Off or On button, the selected Topic and Template will be
the one for which the On and Off buttons are received. The Last button and the slider will use the Topic
and Template where the slider was setup.

4.1.31 How do | setup MQTT Associations for an existing ZWave Dimmer

There may be times when the status of a HS dimmer is desired to be published via MQTT. Dimmer
devices typically contain both a status and a brightness level and for this example the message will be
encoded in JSON with keys for status and brightness so may look something like
{“status”:"on”,”brightness”:75}.

When HS reports a change in the Zwave Dimmer via HSEvent it will provide a DeviceValue that will be in
the range of 0 to 100. The 0 is interpreted as Off and the other values interpreted as On with a
brightness level.
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An “A”ssociation is made for the HS Zwave Device on the Association table or the MQTT Page using the
“A” column checkbox. This will automatically create a Publish Topic. It is likely that this Publish Topic
will be edited to provide a more meaningful name. This can be done on the Association table or on the
Edit tab of the MQTT Page. To have visibility of the Zwave Dimmer on the Association table, the filters
on the Association tab need to have checkbox for “Include Non-Plugin HS Devices” and at some prior
time the “Enumerate Non-Plugin Devices” button at the bottom of the General tab needs to be clicked.

Since the payload of the MQTT message will be JSON there needs to be a Publish Payload Template that
defines the JSON format. This is done with the Association table “Encode Payload per template” textbox
or on the Edit tab. HS is providing only one value and the JSON has two keys so a conditional expression
is needed for the template. The inline expression is indicated as starting with << and ending with >>.

{"status":"<<IF(S$SVALUE:=0, 'Off','On'")>>"<<IF (S$SSVALUE:>0, ', "brightness
":SSVALUE: ', '")>>}

If the desire is to control the Zwave Dimmer with a MQTT message then a Subscribe/Control Topic
needs to be defined at the bottom of the Edit tab. For this example, assume the same status and
brightness keys of a JSON-encoded are used to provide the remote control of the dimmer. Assume the
Topic is “Zwave/Control/Dimmer”. A status “Off” will command the dimmer OFF. A status of “On” will
command the dimmer to the level contained in the brightness key.

After any MQTT JSON message is received on the “Zwave/Control/Dimmer” Topic, the decoded JSON
keys will be available for use. These will be identified as “Zwave/Control/Dimmer:status” and
“Zwave/Control/Dimmer:brightness”.

An Expression on the Edit tab is used to combined the two JSON keys into a single value to command the
HS Device. In this case a conditional IF function is used to look at the status key and if set to “Off” then
use “0” otherwise use the value of the brightness key.

IFEQ ("SSPAYLOAD: (Zwave/Control/Dimmer:status):","Off", 0,
SSPAYLOAD: (Zwave/Control/Dimmer:brightness) :)

The resultant setup is shown in Figure 11.
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Ret: 3752 Sub: Zwawey Control/ Dirnmer

Value Change Event ./
HS Event Trigger Value SetEvent [ |
Leg []

String Change Event  [_]

MQTT Publish Payload

.  (status" <<IF(SSVALUE:=0,0ff /0n)>>"<<IF($SVALUE >0, brightnes:

Send unencoded
Encode with URI encoding such as %20 for space
Replace special characters with underseore

URI Encode Paylnad

coce

MOTT Publish Retain Do not retain .
Retainatbroker (O

§

§

‘ IFEQ("$SPAYLOAD:(Zwave/Control/Dimmer:status):" Off"0, SSPAYL |

Figure 11 Zwave Dimmer Control and Status Setup
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4.1.32 How do | create a device for blinds or shutters with single feature control buttons
Typical blind and shutter control is provided by two relays where each relay reports its status in
individual topics. There will also be a third topic that provides the current position of the blinds or
shutters.

When an association is made with Control/Status types having one or more Toggle and one Slider across
the topics then mesMQTT will treat this a a single feature with control and status based upon the topics.
The Toggles will be the Up/Down or Open/Close ON-state controls. The Slider is the position feedback.
It will never be shown as a control but its numeric value will be shown when the Toggle states are all
0/OFF. See Figure 12. When one relay is active the status will be the direction of motion (Open/Close).
Both relays ON is failure mode.

Dev: Test|MultiTopic2|MultiTopicZ:Button
Suby: Test/MultiTopic2:0nOff
Pub: the following Topic on Device command

Test/cmnd/OnOff

D D D D Sub: Test/MultiTopic2:POWERT OFf

Dev: Test|MultiTopic2|MultiTopicZ:Button
Sub: Test/MultiTopic2:POWER2
Pub: the following Tepic on Device command

Test/cmnd/Power

Dev: Test|MultiTopic2|MultiTopicZ:Button
Sub: Test/MultiTopic2:Slider

Pub: the following Topic on Device command

Test/cmnd/Slider

Figure 12 Topic Association for Shutter - Blinds

The labels for the buttons and the status when a relay is ON will be the VSP status setup on the Edit tab
for the ON relay value. The two end positions will be from the OFF-relay status. 0 and 101 are used for
the VSP values where 101 is significant to support the recognition of the button push from HS. See
Figure 13. 0 and 102 are used for the second button. The order of the buttons is the same as the order
when the button associations to the reference feature is made. The VSP numbers cannot be edited, but
the status values should be edited to get the desired text for the status and the button labels.
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Figure 13 Shades - Blinds VSP Setup

The HS device and feature will be shown as in Figure 14.
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Test | MultiTopic2

O @ Test-MultiTopic2 (5047)

O (@) MuliTopic2:Button (5048) 70 Today 3:44:25 PM ® m ‘

Edit Status/Controls

Start End Status Control Use Row Column Col Span
101 Open _On 0 0 1 @ m
102 Close _On 0 0 1 @ m
Edit Status/Graphics
Start End Label Graphic
0 Closed @ B x
0.01 99.99 Q
100 Open 0
101 -> Open @
102 -> Close @
103 Failure 0

Figure 14 Shutter - Blinds HS Device and Feature

4.1.33 How do | connect to multiple MQTT Brokers

Two techniques are available to use multiple brokers. One is to setup a second broker as a client and
use broker bridging. The other is to specify the second to sixth broker on the MQTT Page Broker Tab. A
semicolon is used the separate the name or IP of each broker as shown in Figure 15. The port, ID and
security will default to the same as the first broker, but each can be individually changed. When editing
the credentials for each broker a semicolon is used to separate the credential for each broker, such as
shown for port and ID in Figure 15.

Date/Time Pri  Type/Error Message/Source

Sep-27 1:01:687 PM mcsMQTT Device 2087(SpaceHeater SENSOR:ENERGY:Total) Changed from 136.198 to 136.288
Sep-27 1:81:84 PM mesMQTT Device 2888 set to @ when SpaceHsater/POWER payload changed from ON to OFF
Sep-27 1:81:84 PM Device Control Device: SpaceHeater POWER to OFF (@) by/from: CAPI Control Handler

Sep-27 1:0@:54 PM mesMQTT Device 2087(SpaceHeater SENSOR:ENERGY:Total) Changed from 136.197 to 136.198
Sep-27 1:8@:54 PM mesMQTT Device 2888 set to 1 when SpaceHeater/POWER payload changed from OFF to ON

Page 56



Broker Mame ¢

127.0.01;192.168.0.16

Broker Port 18831883

COD0O@® OO0O0e

Figure 15 Multiple Broker Setup

All subscriptions will be associated with the broker that delivered the message. If there are multiple
brokers setup then the Association tab topic for each parent row will be suffixed with [#] where # is the
broker that delivered the message. The example in Figure 16 shows broker 2 as the provider of the
message.

Association Table for Auto Association of MQTT Topic and HS Device

N o r e a ref TOPIC payload h d lastdate

e ™ O - test/Broker/JSON [2]

1w w - Sub: test/Broker/JSON:color:x:DS18B20:Humidity 5.0 - 2019-09-14 11:16:20
2wl [w 0O Sub: test/Broker/JSON:color:x:DS18B20: Temperature 5001 [n 2019-09-14 11:16:20
Tl [w O Sub: test/Broker/JSON:color:x:Switch2 ON (n 2019-09-14 11:16:20

Figure 16 Broker Identification for Received Topics

The statistics provided on the Association Tab with Topic Filter T1 set to MQTT shows information for all
brokers except for the broker status which shows each individually. If HS devices are populated with
statistics, then the Online status in DeviceValue is 0/Offline if any broker is offline. By default, the first
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broker will be used to publish messages for HS devices that are associated without a subscription. This
can be edited on the Edit tab with radio button as shown in Figure 17.

The relative position of a broker in the list is very important as this is what is remembered by mcsMQTT.
It will not matter for data that is received from multiple brokers, but when HS is publishing the broker
that will be used is based upon the broker index at the time this broker delivered the subscribed topic.
For example, consider a setup of “192.168.0.100;127.0.0.1” as the list of brokers. Topic “From100” is
received from 192.168.0.100 and associated with a HS Device and has a publish topic “From100/set”
setup. 192.168.0.100 is first broker in the list so mcsMQTT will remember to publish From100/set to the
first broker in the list. If sometime later the broker list is changed to “192.168.0.200;192.168.0.100” and
HS then publishes topic “From100/set”, then it will be sent to broker at 192.168.0.200 because it is the
first one in the list.

This makes it important to keep the broker position static and add new brokers to the end of the list. It
was done this way so that broker IPs can be changed and no change is needed in the prior setup of the
MQTT-based devices.

Start with Either Existing Device Ref or Subscribe Topic
Ref: 1528 Sub:

Edit of Non-Plugin HS Device to Publish (Outbound) on Event Change

Existing HS Device Reference 1528

HS Event Trigger #Value Change Event Log String Change Event
MQTT Publish (status) Topic Test/cmnd/$$LABEL:

MQTT Publish Payload Template

MQTT Publish to Sign * Normal Publish Publish to Messaging Sign

MQTT Publish QOS * At Most At Least Exactly

MQTT Publish Retain * Do not retain Retain at broker

MQTT Publish Broker First Broker '® Second Broker

MQTT Subscribe (control) Topic
Figure 17 Broker Selection for Non-Plug-in Devices

4.1.34 How to record changes to HS Log

When a device is controlled from the HS Ul then a “Device Control” action is put in the HS Log. If a
similar logging is desired when the device is updated based upon MQTT payloads then two setup actions
are needed. First is on the History tab using the Pub-Sub Message History checkbox to Log changes. The
second is on the Association Tab H column to checkbox the specific topics for which logging will be done.
When the log entry is made one of two forms will be used. For express mode the from /to payload will
be shown. For normal mode the from/to HS values will be shown. See Figure 18.
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Date/Time Pri Type/Error Message/Source

Sep-27 1:01:687 PM mcsMQTT Device 2087(SpaceHeater SENSOR:ENERGY:Total) Changed from 136.198 to 136.288
Sep-27 1:81:84 PM mesMQTT Device 2888 set to @ when SpaceHsater/POWER payload changed from ON to OFF
Sep-27 1:81:84 PM Device Control Device: SpaceHeater POWER to OFF (@) by/from: CAPI Control Handler

Sep-27 1:0@:54 PM mesMQTT Device 2087(SpaceHeater SENSOR:ENERGY:Total) Changed from 136.197 to 136.198
Sep-27 1:8@:54 PM mesMQTT Device 2888 set to 1 when SpaceHeater/POWER payload changed from OFF to ON

Figure 18 HS Log of MQTT-based changes

4.1.35 How to view CSV payloads in separate HS Devices
Payloads may contain numeric data as a group or set of values separated by commas. Consider the
following payload:

{"HSBColor":" 120 ,100,46","Channel":[0,46,0,47]}

The HSBColor key contains three CSV values and the Channel key contains four in a group bracket
holder. These two items will be stored in HS devices as strings in DeviceString. The Control/Status Ul
will be of type “text”. To create additional HS devices that contain the individual numbers into
DeviceValue the Edit tab Control/Status Ul type of “CSV” is selected such as shown in Figure 19.
Another option is to select “HSB” which will yield similar results, but also contain the context of
controlling a device that is expecting color control.

Settings for
Plugin Device
HS Device Publish
Topic

HS Device
Control/Status UI

|MagicHomefcmndeSBColnr

) Unspecified () Button (' Number () NumberChange ® Csv () Text () List ) RGB
() Hse O cColorXy ) Sign

Figure 19 CSV type Payload Selection

There will be a HS device created for the key and one for each of the CSV components. The default
name of each will be the same as the subscribed topic and suffixed with the 1-based position of the
number in the CSV list. HS Device Association will be used to keep all the devices remaining together
when displayed.

[ 12327 ([11,12,13,14] MagicHome | STATUS:Channel MagicHome/STATUS | Today 6:49:05 PM ([:?lﬁz)ﬂa,M] Submit
2326 | (U off MagicHome | STATUS MagicHome/STATUS | 12daY
6:46:39 PM
] 12332 |11 MagicHome | STATUS:Channel: 1 MagicHome/STATUS | Today 6:49:09 PM
] 12333 |12 MagicHome |STATUS:Channel:2 MagicHome/STATUS | Today 6:49:09 PM
[ 12334 (13 MagicHome | STATUS:Channel:3 MagicHome/STATUS | Today 6:49:09 PM
|1 12335 14 MagicHome | STATUS:Channel:4 MagicHome/STATUS | Today 6:49:09 PM

Figure 20 CSV Type HS Device Creation

If a CSV device is to be controlled then the publish payload topics need to be set on the Association tab

or Edit tab. For the CSV case the topic is entered as a set of topics which each using a semicolon (“;

“.n

) as

the separator. The controls will be setup as sliders with range between 0 and 100. An example is shown
in Figure 21 and Figure 22. In the HSB case the publish topic will be the topic for the color picker control
and if the sliders are used for control then the values of the three H, S and B sliders will be combined
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and payload will be the same as the color picker payload which is a set of three decimal values
separated by commas.

Dev: |MagicHome|STATUS:HSBColor
Sub: MagicHome/STATUS:HSBColor

4 = . - . | | - - . o
¥ 2354 Pub: the following Topic on Device command 10,104 2019-12-09 16:26:01
MagicHome/cmnd/HsbColor1;MagicHome/cmnd
Figure 21 Setup of CSV Publish CSV topics

[/ 2383 | 6055495 MagicHome | STATUS:HSBColor | MagicHome/STATUS Z?;& o 5c6647 | ]
[1|2396 |80 MagicHome | STATUS:HSBColor:1 | MagicHome/STATUS:HSBColor :”Bd;‘fél o

] . - - . ., Today
[1(2397 |30 MagicHome | STATUS:HSBColor:2 | MagicHome/STATUS:HSBEColor 4:35:31 PM

) _ _ ) . Today

[1|2398 |40 MagicHome |STATUS:HSBColor:3 | MagicHome/STATUS:HSBColor 4:35:31 PM

Figure 22 Devices for CSV Control Type with Publish topic

4.1.36 How do | create unique HS devices when the payload content contains device
identification
A common situation is that a device will publish on a topic using JSON encoding for the payload and one
fo the keys of the payload is the identification of what device characteristic is being reported. Two cases
are supported by mecsMQTT. One is where the JSON contains identification information that applies to
all other keys in the same payload. The second is where identification applies only to the keys in the
JSON group that contains the identification. In the later case the parent of the group is not considered
and only treated as a wildcard position holder.

In the first case, for example, consider the following two message payloads that are sent on the
“Printer/Status” topic.

{“1d”:"ink”,”empty”:false}

2» n

{“Id”:" paper”,”empty”:false}

Normally mecsMQTT will provide two devices when selected since two JSON keys are in the payload.
These are:

Printer/Status:Id
Printer/Status:empty

What is actually desired is to have separate “ink” and “paper” status available so the view presented to
HS would be as follows. This would allow HS device creation of separate ink and paper status devices.

Printer/Status:Id
Printer/Status:ink:empty
Printer/Status:paper:empty

The Edit tab is used for the actual parent Topic (does not have any of the :JSONkey elements) and in the
textbox that is provided for MQTT Subscribe Topic at the top the JSON key “Id” would be entered to
elevate “Id” from the Payload to become a member of the Topic.
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Start with Either Existing Device Ref or Subscribe Topic

Edit Setup Or Edit Of Subscription (Inbound) To a MOTT Topic

C=18B20

JEON key(s) 10 be alevated for unigueness
MGTT Subscribe Topic

Id

Figure 23 Using Payload Key to Achieve Indepenent Devices

In the second, wildcard, case consider the following JSON payload where the actual temperature sensor
identification is the Id part of the message and group name (DS18B20-1/2/3) has no particular
significance. The 1/2/3 is usually part of a JSON array and the order of the array elements has no
particular significance. To indicate that the 1/2/3 should be ignored (i.e. wildcard) then nomenclature
*:1d should be used.

This results in the subscription topic and device name to be shown with “:*:” as shown in Figure 24. The
second step is to now “A”ssociate the temperate key rows. From this point forward the DS18B20-1/2/3
group name is ignored and the HS device reference remains aligned with the Id field of the JSON
payload. Other JSON keys that are not part of the same group as the Id are not affected.

sonoff-1234/STATUS = {"StatusSNS":{"Time":"2022-01-27T01:33:31","DS18B20-
1":{"Id":"000003A280FF", "Temperature":77.2},"DS18B20-

2" : {"Id":"020E92451C31", "Temperature":60.2}, "DS18B20-
3":{"Id":"021892457E2A", "Temperature":58.3}, "BME280-

76" : {"Temperature":113.4, "Humidity":4.1, "DewPoint":23.6, "Pressure":993.1},"BM
E280-

77" :{"Temperature":69.7, "Humidity":25.0, "DewPoint":32.2, "Pressure":993.3},"Pr
essureUnit":"hPa", "TempUnit":"F"}}

Mol v [ee wm Jrome [ [0 ][ mie |

ol O 2590 DS18B20

10 0O 01 [ ] sub:DS18820:*:1d-012025907848: Temperature 34 8 0 2022-01-26 11:08:04

217151 0 Sub: DS18B20:*:1d-01204C350836: Temperature 348 O 2022-01-26 11:08:04

Spell (e O |——— Sub: DS18B20:*:1d-01204C3DFEDA: Temperature  34.8 0 2022-01-26 11:08:04
Dev: DS18B20|DS18820|DS18B20:D518820-1:1d

a0 O o B o o lovte Toric o Device command 012025907848 0 0O [0 20220126 110804
|

50 0O 0o | | sub: DS18820:D518820-2:1d 01204C350836 0 2022-01-26 11:08:04

60 0O O Sub: DS18B20:DS18820-3:1d 01204C3DFEDA O 2022-01-26 11:08:04

70 0O O | Sub: DS18B20:TempUnit F O 2022-01-26 11:08:04

s O [ | Sub: DS18B20:Time 2022-01-24T11:11922 [ 2022-01-26 11:08:04

Page 61



ﬂﬂﬂﬂﬂg-“ﬂﬂ
LR . 590 518820

Dev: DS18B20|DS18820|DS18820:*:1d-
012025907848: Temperature

10 0O o Sub: DS18B20:*:10-012025907848: Temperature 350 0 202220’%;'26
Pub: the following Topic on Device command 11:20:
| |
Dev: DS18820|DS18820|DS18820:*:1d-
01204C350836: Temperature 2022-01-26
Hmil W ™ Sub: DS18B20:*:1d-01204C350836: Temperature 465 0 112 0‘ 019'
Pub: the following Topic on Device command
l |
Dev: DS18820|DS18820|DS18820:*:1d-
01204C3DFEDA: Temperature 2022-01-26
30 0O ™ Sub: DS18B20:*:1d-01204C3DFEDA: Temperature 34.8 ] 112 0‘0 9‘

Pub: the following Topic on Device command
| |
Dev: DS18820|DS18820|DS18820:D518B20-1:1d

Sub: DS18B20:DS18820-1:1d i . . 2022-01-26
Pub: the following Topic on Device command 0120259076848 ane - = 11:20:09

1 |

Figure 24 Elevate JSON key with Wildcard

In summary, when a Payload with a set of JSON keys exists and one of the JSON keys in the JSON group
should be used as part of unique identification then use the Edit Tab with the parent Topic to enter the
JSON key that will be elevated. This is done at the top in the MQTT Subscribe Topic textbox. If the JSON
key is part of a JSON array where the array position has no significance then prefix the JSON key with
“*:” in the MQTT Subscribe Topic textbox. In both cases, from the Association Tabs, “a”ssociate the
items to be mapped into HS. Do not associate the row that has the JSON key that was elevated as that
would be redundant.

4.1.37 How do | store picture contained in MQTT Payload

MQTT payloads typically contain text, but it is also possible to send binary data such as a jpg image as is
done for the Ring doorbell camera as described at GitHub - tsightler/ring-mqgtt: Ring devices to MQTT
Bridge using a Topic such as:

“ring/afa06d00-91a1-49ed-8698-1653ad64c51f/camera/10082c56ad93/snapshot/image"

If this Topic is selected to be “jpg File” as the Control/Status Ul on the Edit Tab as shown in Figure 25
then the received Payload will be stored in file in the subfolder
\htmN\mcsMQTT\File\{floor\{room}\{name}.jpg where {floor}, {room} and {name} are the HS properties
of the “A”ssociated Device. A thumbnail will also be created in the same folder that will show as an icon
for the device via the HS VGP mechanism.

HS Device

Control/Status ! Unspeciied O Button O Toggle O Mumber O NumberChange O Slider O Ramp O
ul csv O Text O List © RGB O RGBW O HSB O ColorXY O Sign ® jpg File

Figure 25 Control/Status Ul selection for a jpg image

The DeviceValue will be incremented for each time the Topic is received. The DeviceString will contain
HTML hyperlink and image tags. The image tag will render a thumbnail of the jpg file and the hyperlink,
when clicked, will render the full-size image. An example of HS4 rendering is shown in Figure 26 where
two jpg File features with the first one showing it has been received 5 times.
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Test | Test
Test
loday 11:23:58 AM

Figure 26 HS4 Device with two jpg File Topics

4.1.38 How do | publish different payload formats depending upon the HS control value

A Publish Template is used to format payload in a message being sent by mcsMQTT. The usual scenario
is that the format of the payload is the same and only a data value will change based upon what is being
requested by a HS commanded value. Take the scenario, however, where the format of the payload
needs to change for each command. For example, HS has three control values UP=0, DOWN=1,
ROTATE=2 and the commands that need to be published are shown below with different formats.

UP - {“U”:true, “D”:false}
DOWN - {“U”:false,“D”:true,”R":"left"}
ROTATE — {“R”:true}

Conditional expressions can be used such as a CASE shown below. Note comma used to separate the
three case parameters and semicolon used to separate the items in the second and third parameters
that are both strings.

<<CASESSVALUE:,”0;1;2”,”{“U”:true, “D”:false}; {“U”:false,“D”:true,”R”:”left”}; {“R”:true})>>

Conceptually this will work, however the content of the two strings contain quotes around the U, D and
R. There is no way to escape or otherwise indicate the literal quote vs. a delimiter quote in the CASE
string parameter. To overcome this the inner quote is changed to a unique character and then part of
the expression is to replace this unique character with the quote. An example below where the
REPLACE function was added to replace ~ with “.

<<REPLACE(CASESSVALUE:,”0;1;2”,”{~U~:true, ~D~:false}; {~U~:false,~D~:true,~R~:~left~};
{~R~:true})'ll~ll'llﬂll)>>
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4.1.39 Data is flooding my system, what can | do
Some MQTT clients send data at a very high rate and this could bring HS down to a crawl and experience
significant delays.

The best way to address the problem is to reduce the rate at which the client is producing data. This will
reduce network traffic to the MQTT Broker and then from the Broker to mcsMQTT/HS. Unfortunately,
some clients will not provide this capability.

If data is being received at a high rate and there is no association with a HS device then there is no need
to subscribe to that Topic. The Topic Discovery row on the Inbound Management Section of MQTT
Page, Client Tab provides a radio control to select between the default listen to everything to selecting
specific topics. The middle radio is usually the easiest, and recommended selection, for any system that
is running without need to discover new widgets. Note that it is the Topic and not just a JSON item
within a Payload that is being selected in this case. If any data in the Payload is associated with a HS
Device Feature, then the Topic will be included and all JSON items in that Payload will be processed.

The MQTT Page, General Tab provides a Reject textbox to specify one or more Topic patterns that
should be ignored upon receipt without further processing. The wildcards of + and # per MQTT
standard syntax can be used to specify groups of topics that should be rejected.

When the data is of interest and associated with HS Device Feature then two techniques can be applied
to reduce the CPU burden. One is to use the Express Mode (“e” column checkbox on Association Table).
This will minimize the times the plugin will use the HS object. The HS Object is the largest CPU user
when Device Features are being updated. MQTT Page, Client Tab, Inbound Management Section has
Express mode tuning options that limit the capabilities that are supported on Topics selected for this
mode of operation.

Another solution is to only process a subset of the data being received. Telemetry type data is typically
only marginally changing on each sample so there will be minimal loss of fidelity when data is
subsampled. For example, data may be received 4 times per second, but any HS event action based
upon this data will only be needed every minute. This means that only 1 of the 240 samples are actually
needed to achieve the objectives of the event action. Subsampling can be defined on a topic-by-topic
basis on the Edit Tab of any parent Topic (e.g. Association Table Sub without a colon). In this example a
value of 60 would result in one sample processed every 60 seconds and the others discarded.

The second method to specify subsampling is on the MQTT Page, Client Tab, Inbound Management
Section with a Subsample Template and Interval. The interval is the sample effect as on the Edit Tab,
but the Template can have wildcard (e.g. Widget/HighRateData/#) to specify a range of one or more
Topics.

4.1.40 Can | use the ZigbeePlus MQTT Broker with mcsMQTT

By default, the HS ZigbeePlus plugin will create a MQTT Broker on interface 127.0.0.1:1883 using the
MQTT 3.1.1 protocol. The default configuration for mcsMQTT is also to create a MQTT Broker on
127.0.0.1:1883. mcsMQTT will first confirm that port 1883 is available for use and if so then not create
the MQTT Broker on 127.0.0.1. If mcsMQTT starts first, then itr is likely that ZigbeePlus will have a
problem creating the MQTT Broker on 127.0.0.1.

Page 64



Both mcsMQTT and ZigbeePlus have options to use other MQTT Brokers. For example, both can be
configured to use Mosquitto running on some computer that is network-visible.

For those that are already using ZigbeePlus and desire to keep using the MQTT Broker that it created,
then mesMQTT MQTT Page, Broker Tab should be configured to not use its Internal MQTT Broker with
the radio setting and the External MQTT Broker should be set to the IP of the HS computer. This will not
be 127.0.0.1, but something like 192.168.0.100.

ZigbeePlus and mcsMQTT both use the same MQTT library so functionality should be very similar. A
MQTT Broker like Mosquitto has a much wider user base so should be a more mature implementation
than those used by the two HS plugins. External Brokers also have the advantage that they continue to
function when HS or the HS Plugin is not running.

The mcsMQTT implementation supports both the version 3 and 5 protocols, contains persistent retain
message support, and provides statistics of the clients that are connected such as shown in Figure 234.
If one has very basic needs for MQTT communications then it should not make much difference which
MQTT Broker is used. For others, the mcsMQTT or Mosquitto MQTT Brokers may be a preferred choice.
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4.2 Default Settings for mcsMQTT
mcsMQTT is setup from Plug-in button — mcsMQTT option. Multiple pages are available. For MQTT
operation the MQTT Page is selected. Multiple tabs are available with Client, Broker and General being
those of interest for the setup. The other tabs are used for later interaction.

The default configuration is a MQTT Broker that is hosted by mesMQTT and mcsMQTT as the client
connecting to this MQTT Broker. These can be altered on the MQTT Page, Broker and Client tabs. A
common configuration is to use an external Broker rather than the internal one. Mosquitto is a popular
MQTT Broker.

4.3 Automatic Setup of Device to Topic Relationship
The default operation of mcsMQTT is to firewall all MQTT Topics and allow the user to selectively
associate each with a HS device. This is the “opt-in” approach. The Association tab shows all the Topics
that have been detected.

This default operation can be changed where the Association tab firewall becomes an “opt-out” or
hybrid of “opt-in” and “opt-out”. The Client tab, Incoming (Subscription) Management section has a line
for “Wildcard Plugin Auto Associate Template”. When this text box is left blank the default “opt-in”
behavior will be used. When one or more Topic templates are entered then the Topics that match the
template with have HS device automatically created. Other topics will be firewalled at the Association
tab for user selection. The Topic template follows MQTT topic wildcard standards where “+” designates
current position in hierarchy and “#” is used to indicate everything at this and positions to the right. To
Auto-Associate everything the template would simply by “#”.

After some Topics have been published by the Broker the next step is the Associations Tab. This tab can
display the universe of information related to received Topics and potential Topics that can be published
by HS. Because the amount of information is large a subset is normally selected for display. Three
tables are used to narrow down information of interest. Initially let us consider only the Topics that
have been forwarded by the Broker. The first table will have one checkbox, “Include MQTT Topics”
checked. The two tables will have no selections made in the pull-downs. If there a limited number of
Topics published the second pull-down table can be left unchanged. If there are many then select one
or two columns of the pull-down to be more specific in the Topic of interest.

The “Show Selected Associations” button at the bottom will then be used to display all the Topics
forwarded by the Broker. If there have been hundreds then it will take many seconds to render the
table. If only a handful then it will be a second or two.

The table rows will be colored green to indicate that this is an inbound Topic and potential mcsMQTT
device in HS. The “A”ssociate column will have no checkboxes and all the Ref column entries will be
blank text boxes. The Topic and Payload of the messages will be shown. If the Payload has been
encoded using JSON then multiple rows will be shown with each JSON item on a row.

Map Topic to mcsMQTT HS Device

If one of these Topics is of interest and the desire is to show the Payload in HS3 Device then the
“A”ssociate checkbox is checked. This will create a status-only device in HS. The device will be updated
each time the Topic is received.
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When “A”ssociate is checked then an additional text box is provided in the Topic column. This text box
is used to Publish a MQTT Topic that will contain the HS Device Value or String each time the Device
changes. The selection of Value or String for the Payload is based upon the receive Topic’s Payload. If it
is a number then DeviceValue will be Published otherwise DeviceString will be Published. The exception
is for a receive Payload of ON, OFF, OPEN, CLOSED, FALSE, TRUE, DISARMED, ARMED, INACTIVE, ACTIVE
0 or 1. In these six cases the HS control presented on the Ul will be a button with DeviceValue of 0 and 1
and Labels that correspond to the text Payload or On/Off for the two numbers. Selection of Label
(Status) or Number (Value) is made in the Publish Payload Template on the Edit tab with SSVALUE: for
Value. SSLABEL:, SSVSP:, or SSSTATUS: will result in the label being published.

When an association is made the update of the HS Device, action triggers on this Topic, History of the
Topic is collected and if the payload is JSON-encoded then mcsMQTT will be decoded it into its
individual components. If the additional features beyond the update of the HS Device are not needed
then the “E”xpress checkbox can be used to identify this Topic being one that will be processed in
Express mode. Express mode CPU consumption is about 20% of full support mode. The default is full
support, but can be toggled on the Client tab Express mode setting. See Section 16.2 for a discussion of
Express mode tradeoffs.

Map Topic to an existing non-Plug-in Device

Assume the Topic of interest is a command that is desired to control an existing HS Device. In this case
rather than using the “A”ssociate to create a new mcsMQTT Device the Ref column text box will be used
to enter the Device Reference of the existing HS Device. The Topic column will show an additional text
box and the “A”ssociate checkbox will be checked. If a Topic is entered into this new text box then this
Topic will be published upon HS Device change.

The same general process can be performed by viewing the non-Plug-in devices and using the
“A”ssociate checkbox to establish a relationship. In this case the “Include non-Plug-in HS Devices”
checkbox would be checked to make available the list of HS devices in the Association table.

Change an existing Topic to HS Device association

If an association between a Topic and HS Device needs to be changed to a different Device or different
Topic then the Edit tab can be used to make this change. Alternately the existing association can be
removed by unchecking the “A”ssociate checkbox on the Association tab to remove the association.
This is followed by using the “A”ssociate checkbox on the desired Topic. This alternate method may be
quicker point and click method but it will result in the original Device being deleted if it is a mcsMQTT
plug-in device. If there were events or other uses of the original Device reference then these will be
broken.

When using the Edit tab to accomplish the change the original Device reference number is maintained.
Start by entering the Ref number or the Topic at the top of the Edit tab. In the second row a change text
box will appear. In the text box enter the Topic that should be associated with the Ref. If the Refis a
non-plug-in Device then it can be changed to another non-plug-in Device to associate the Topic with a
difference Device. It is also possible to change the association of the Topic from a plug-in Device to a
non-plug-in Device by changing the Ref, but the reverse it is not possible because HS assigns reference
numbers and all that have been assigned by HS are already associated with other Topics.
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4.4 Manual Setup of Device to Topic Relationship
If you know the Topic “myHome/myTemperature” will be Published by a temperature sensor then this
Topic can be specified in the Subscription (Inbound) table of the Edit tab. A HS status-only device will be
created and its DeviceValue will be updated when a numeric Payload is Published on this Topic.

If the Topic is “myHome/myLight” then the same process can be followed. In this case the “HS Device
Publish Topic” in the green table can be used to control the light. Let us say the control Topic is
“cmnd/myHome/myLight”. The Button radio selected to generate On/Off controls in the HS Ul. The HS
Device will be controlled by the button on the Ul, or other means; mcsMQTT will Publish Topic
“cmnd/myHome/myLight” with Payload of “On” or “Off”; myLight will respond to the command and
Publish “myHome/myTemperature” with a Payload of “1” or “0” to reflect its state. Note that the
specific values and text are customizable via the HS Device Management Page Value-Status-Pairs.

If you have an existing HS device and you want it to respond to commands from MQTT Topics or want it
to be commanded by MQTT Topics then the pink Publish (Outbound) table is used. Separate text boxes
are provided for each case.

4.5 Leveraging Multiple mcsMQTT Browser Pages
mcsMQTT allows multiple browser windows to be opened and each is maintained independently. One
page can be used to display a large Association table and another page could be used with the Edit Tab
to edit associations. In essence one becomes a reference lookup and the other used to perform the
edits.

Note that each browser page will continue to be updated with new Payloads, statistics etc. as long as
each window is open. When the plug-in is restarted those browsers windows become stale and cannot
be used to interact with a new instance of mcsMQTT. The URL needs to be refreshed to redraw the
page or a new page opened.
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5 Sending MQTT Messages

Sending a MQTT message can be done via Device changes, Event actions, or script. Two paradigms exist
with respect to publishing MQTT Topics. One is to support a HS Topic that reflects the status of an HS
device. This is described in subsequent paragraphs of this section. An example is publishing the HS
Uptime since last restart.

The second is part of bidirectional communication with another publisher where HS publishes a
command to affect the state of an external node. This is described in Section 0. An example is a light
that publishes its ON/OFF status and HS is used to control the ON/OFF state of this light.

Any HS Device that has been “A”ssociated can publish a status or command Topic. The Topics that are
published are entered into the Topic text box on the Association Tab. The published Payload will
depend upon another configuration described below.

In the case where a non-Plug-in Device is “A”ssociated the Payload will default to the DeviceValue and
occur when the DeviceValue changes. See Figure 27. This can be changed on the Edit tab immediately
or later by entering the HS Device Reference number. The trigger can be selected as a change in
DeviceString or DeviceValue (or both). The Payload will be based upon the publish template and can
contain substitution variables. See Figure 27. Substitution variables are described in Section 5.2.

The special symbols +, / and # are reserved per MQTT protocol and cannot be used in Topics. If these
symbols are part of the HS device name, for example, then they should be URI-encoded so as to not
violate the standard. The space character is not recommended and by default it should be URI-encoded
as well.

To specify URI-encoding the substitution variable should be suffixed with “_URI_ENCODE”. A second
option is to use the URI Encoding radio for the message that is available on Edit tab. This will result in
either URI encoding or replacement of all special characters with an underscore character. This will
apply to all characters in the message.

Another option exists for space where substitution variable is suffixed with “_ UNDERSCORE”. For
example, “SSNAME_UNDERSCORE:” as part of the publish Topic will result in any spaces in the HS
Device Name to be replaced with “_".

Association Table for Auto Association of MQTT Topic and HS Device
il r e a ref TOPIC payload h d lastdate

] 118 Dev: Unknown|Unknown |Mew_Device 0001-01-01 00:00:00

Dew: Unknown | Unknown|Mew?
Command HS Device on subscribed Topic:

1 = 119 Publish message on Device change using Topic: 0001-01-01 00:00:00
S3computer/$SroomEEname:

Encode Payload per templake:
From $3name: with value of 33valua:

Figure 27 Non-Plug-in Device Association

Figure 28 shows a non-plug Edit popup. Figure 29 is a popup that appears when the “Configure Sign
Parameters” hyperlink is clicked. It shows that the message going to the sign will appear in Row 1, and
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will show forever (Duration = 65535) or until another Log message is published or the Duration field of
message topic is later set to 0. The text color of the messages will be hex FFFFFF (white).

Start with Either

Ref: 4721 Sub:

ce ta Publish (Outbound) on Event Change

MQTT Subscribe (contral)
Topic

Figure 28 Non-Plug-in Device Manual Setup
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Messaging Sign Text Properties

Cign Display Row 1

Me_asage Duration 1

(rninutss)

Text Color RRGGBB 007F7F [ ]

Default Text C\HomeSeer Data\MyPlugin\Chart jpg

Image Processing for Sign
JPEG Image Scaling % 200

Figure 29 Messaging Sign Properties

If the desire is to control this HS Device from MQTT subscription then the Edit tab or Associations Tab
can be used to enter the subscription Topic in the text box provided. In Figure 27 and Figure 28 these
boxes are currently blank so there will be no means to control Device 10 via MQTT, but Device 10 status
will be reported via MQTT as the DeviceValue changes.

In the case where HS is to control via sending a MQTT Topic to an external entity that has published
status the Association Tab is used to select the published Topic with the “A”ssociate checkbox. This will
bring up a publish Topic text box where the command Topic is specified. See the last row of Figure 30
where Device 212 was created. In this example the status Payload that is on the Subscription (Sub:)
Topic GarageDoor/Door is “CLOSED”. Because this is one of the special case Payloads mcsMQTT will
create a two-state button with labels CLOSED and OPEN and assign DeviceValues of 0 and 1 to these.
The radio under the command Topic shows the label (i.e. CLOSED or OPEN) will be published when the
DeviceValue changes between 0 and 1. Had the radio shown Value rather than Label then the published
Payload would be 0 or 1.

Had the Payload been something like the “Online” shown in the second row of this figure, then the Ul
presented would not be a button, but a text box where text could be entered and this text would then
be the Payload delivered. In this case publishing occurs on a DeviceString change.

The third and last case is where the Payload is numeric such as for Device 248. For this one the Ul will
again be a text box for entry of a number and the Topic will be published on a DeviceValue change with
the DeviceValue in the Payload.
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Association Table for Auto Association of MQTT Topic and HS Device

[+-] ~l (=] (%] e w

w

20

21

22

R

Ref

207

212

Topic

Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:
Sub:

Dev:
Sub:
Pub:

Dev:
Sub:

Pub

Dev:
Sub:
Pub:

GarageDoor/INFO1:Module
GarageDoor/INFO1:Version
GarageDoor/INFO1:FallbackTopic
GarageDoor/INFO1:GroupTopic
GarageDoor/INFO2:WebServerMode
GarageDoor/INFO2:Hostname
GarageDoor/INFO2:IPAddress
GarageDoor/INFO3:RestartReason
GarageDoor/POWER
GarageDoor/RESULT:POWER
GarageDoor/cmnd/Door
GarageDoor/STATE: Time
GarageDoor/STATE: Uptime
GarageDoor/STATE: Ve
GarageDoor/STATE: Wifi:AP
GarageDoor/STATE: Wifi:SSId
GarageDoor/STATE: Wifi:IPAddress

|GarageDoor|LWT
GarageDoor/LWT

the following Topic on Device command

|GarageDoor| STATE:Wifi:RSSI
GarageDoor/STATE: Wifi:RS5L

: the following Tepic on Device command

|GarageDoor|Door
GarageDoor/Door

the following Topic on Device command

GarageDoor/emnd/Door

Payload

Sonoff Basic
5.9.1
GarageDoor
sonoffs
Admin
GarageDoor

192.168.0.70

Software/System restart

Off

On

OPEN
2018-05-20T00:44:24
32 32

3.192

1

U

192.168.0.70

Online

68

CLOSED

Figure 30 Plug-in Device Subscription Association

D

LastDate

2018-04-16 22:56:45
2018-04-16 22:56:45
2018-04-16 22:56:45
2018-04-16 22:56:45
2018-04-16 22:56:45
2018-04-16 22:56:45
2018-04-16 22:56:45
2018-04-16 22:56:45
2018-05-12 15:03:03
2018-05-07 19:00:25
2018-05-12 15:03:02
2018-05-19 16:44:24
2018-05-19 16:44:24
2018-05-19 16:44:24
2018-05-19 16:44:24
2018-05-19 16:44:24
2018-05-19 16:44:24

2018-05-19 20:00:43

2018-05-19 16:44:24

2018-05-19 16:44:24

When a subscribed Topic has been selected with the “A”ssociate checkbox the Edit tab Subscription
table is populated with the same information as the row of the Association Tab table. This allows
further editing if the default behavior is not as desired. It can also be later edited by entering the
“GarageDoor/Door” subscription Topic as shown in Figure 31.

The Client tab has default setting for the publish Topic in the Outbound Management section. When
this text box is not blank then the Pub text box will be automatically completed with this default. Since
all publish topics will be different the default publish Topic is normally defined using substitution
variables. See Section 5.2. A reasonable Topic template for Tasmota devices is “SSTASMOTACMND:”.
For Shelly device it is “SSTOPIC:/command”. If your location has primarily one family of devices that

share a common command topic structure then using the template will be beneficial.
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Edit Setup or Edit of Subscription (Inbound) to a MQTT Topic

MQ-I._I- SHliEE 53 GarageDoor/Door
Topic
Payload RegEx

Match Pattern

Payload RegEx
Replace Pattern

Payload RegEx
v < * Replace Match Pattern with Replace Pattern Extract Match Pattern

Operation
Low Pass Filter Filter sensitivity of 1 (range is 0.00 to 1.00 (most sensitive))
Expression
[ICreate a HS Rate Device with rate sensitivity of |0.75 Range 0.00 to 1.00
Add Rate Device Y (Rang )
Per Second Per Minute '®  Per Hour

[ICreate a HS Accum Device

Add Accum Device ] ) L i o
Mo Reset Accumulation Since Midnight '®'  Delta Since Midnight

Settings for
Plugin Device
HS Device Publish
Topic

HS Device
Control/Status UT

GarageDoorfcmnd/Door

Unspecified Button Number '® Text List ColorPicker Colorxy

0 OPEN

1 INDETERMIMATE
HS Device VSP List 2 cLOSED

Clear existing V5P

HS Device MISC [INO_STATUS_DISPLAY MINO_GRAPHICS_DISPLAY [ |AUTO_VOICE_COMMAND
Properties [ |SET_DOES_NOT_CHANGE_LAST_CHANGE MSHOW_VALUES [ |STATUS_ONLY

Grouping Parent Ref Create New Parent Device

Publish Payload
Template

Publish QOS At Most At Least ® Exactly
Publish Retain Flag  ® Do not retain Retain at broker

Settings for
Non-Plugin
Device

Control non-Plugin
HS Device

Mote additional customization of buttton text, display graphics, button/number relationships etc. is done via HS
Device Management Page by clicking on the Device Mame link and using the Status Graphic and Configuration tabs

Figure 31 Plug-in Device Publish Setup

5.1 Send MQTT via HS Device Change
Any HS Device that has a publish Topic defined can have a MQTT message published whenever the
Device changes Value or String. If the HS Device is owned by mcsMQTT (i.e. created by mcsMQTT by
associating it with a subscription Topic), then the either Value or String change can cause the Topic to be
published. The decision on which is controlled by the HS Device Control Ul as shown in Figure 31. Itis
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also dependent on the publish payload template also shown in Figure 31. Table 2 contains a list of
substitution variables. Those applicable to commands from HS controlling plugin devices are described
Table 1.

For non-plugin devices where the publish action is initiated by the HSEvent callback the same
substitutions are used. If no substitution variable is used then no replacement will occur in this case. In
addition, SSPREVIOUS: and SSPUBLISHED: variables are also available for the previous HS DeviceValue
and last published payload respectively.

Table 1 Plugin Device Control Publish Template Options

Template Text to Send in the Payload

Replacement

Variable

none Use Edit tab VSP key based upon the number provided by HS. The key will be the

subscribed topic payload value. For example the VSP entry of “true=1;0n" will use
“true” if there is no replacement variable or it is SSVSP: in the template.

SSVSP: Same as none. This is the default

SSLABEL: Use the text provided by HS for control. This will be the HS status value that is
normally shown on the button label. It is normally the same as the VSP key, but not
always for the case when the control is a HS selector pulldown.

SSSTATUS: Use Edit tab VSP status based upon the number provided by HS. The status will be the
last text on the VSP line. For example the VSP entry of “true=1;0n” will use “On” is
SSSTATUS: is used in the template.

SSVALUE: Use the number provided by HS for the control

If set to Button or Number then the Value change of the HS Device will result in publishing the Topic
with the new DeviceValue in the Payload. If it is Button then either the numeric Value will be put in the
Payload or the button label as specified by the radio in the same figure.

The Topic will be published with the new DeviceString as the Payload If the selection is Text. The String
change of the HS Device will be the event to publish the Topic.

If no publish Topic is setup such as Device 207 in Figure 30, then any change of this Device will not result
in any MQTT published Topic.

A Ul is provided on the Device Management page to allow manual entry of the Payload that is desired to
be published. The same Ul can exist on custom pages. It is also possible to publish on changes of the
Device Value or String. This can be from another Plug-in, script, or event action. An example is provided
that has Device 138 associated with a MQTT published Topic and running this event will cause the Topic
to be published. See Figure 32.
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Event Name: Type Group Reassign:

£ [matTFirst v [Test AR > R[] x 19|
IF This event is MANUALLY triggered o
Then Execute the command: &hs.setdevicevaluebyref(138,1,true) a (4]

and only allow one instance of the script to run at a time.

Options >

Figure 32 Example of Controlling a mcsMQTT Device

5.2 Send User-Customized Topics and Payloads
The publish behaviors described in Section 5.1 describe the default behaviors of the plug-in with static
user-defined Topics and unformatted and fixed Payloads. Both of these can be customized. Figure 27
actually shows a Topic and Payload that uses the customization via set of defined replacement variables.
These variables have the syntax of $Sxxx: where xxx is the name of the replacement variable. The set of
replacement variables support is shown in Table 2.

Plug-in defaults for both published Topic and Payload follow the plug-in convention of
ComputerName/mcsMQTT/Loc2 /Loc/Name. The payload is the unformatted DeviceValue,
DeviceString, or enumerated Value-Status-Pairs. Use of these defaults is achieved by leaving the
Outbound (Publish) Management section entries for both of these blank. See Figure 40.

The actual Topic used when publishing is specified by the user as described previously. The default will
show up when a HS device has been associated for MQTT publications. This can then be edited to
whatever is needed on a Device-by-Device basis. To minimize the user entry burden, the default Topic
template can be customized with the entry on the Client Tab. What is shown now in Figure 40 is a
customization for “SScomputer:/SSroom:/SSname:”. Every time a HS Device is “A”ssociated this
template will populate the status Topic text box. The published messages will look something
“MyPC/Room1/Try1” for the example shown in Figure 27. Note that “/” are used in the Topic template
as part of standard MQTT Topic formats. Any text in the template that is not a substitution variable will
become part of the Topic.

The $STasmotaCmnd: substitution is a somewhat special case variant of the $$Topic: substitution. It will
take the received Topic and insert “cmnd” to turn it into a publish command. If the topic starts with
tele/ or stat/ then it will replace these with cmnd/, otherwise it will insert “cmnd/” before the last leg of
the topic such as Topic “Light/Power” will turn into “Light/cmnd/Power”.

Table 2 Substitution Variable List

Topic-Oriented Substitution Variables

SSADDRESS: HS Device Address property

SSCODE: HS Device Code property
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SSCOMPUTER:

Network name of the host computer

SSFLOOR:

HS Device Floor which is also the Location2 property

SSINSTANCE:

Instance number of the plug-in Interface property

SSINTERFACE:

HS Device Interface (Plug-in) property

SSNAME: HS Device Feature Name

SSPARENTNAME: HS Device Name

SSREF: HS Device Feature Reference Number
SSPARENTREF: HS Device Reference Number

SSROOM: HS Device Room which is also the Location property
SSTYPE: HS Device Type String property

SSTASMOTACMND: Topic to publish command to Tasmota device

Payload-Oriented Substitution Variables

SSDATE: Current date in short format

SSDEVICETYPE: Device Type (String) property

SSTAG: Free form text field on Edit tab of an associated device
SSDEVICESUBTYPE: DeviceType SubtypeDescription property

SSPAYLOAD: Last received MQTT Payload

SSPAYLOAD:(Topic):

SSPAYLOAD:(JSONKey):

Last received MQTT Payload of any Topic (e.g.
My/Topic:item:subitem)

Last received MQTT Payload of this Topic (e.g.
item:subitem)

SSPAYLOAD_EUROPE:

SSPAYLOAD_EUROPE:(JSONKey)

Same as SSPAYLOAD except humeric results with comma
are converted to numeric results with decimal.

SSSTATUS: Status label as defined for status (3™ parameter) for VSP on
mcsMQTT Edit Tab

SSCONTROL: HS feature control label (2" parameter) from Edit tab VSP

SSLABEL: HS CAPI label (available only when using CAPI for control)

SSVSP: Button label as defined for key (1st parameter) for VSP on

mcsMQTT Edit Tab
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SSSTRING:

HS Device String

SSTIME: Current time in short format
SSYEAR: Local Current Year number
SSMONTH: Local Current Month number
SSDAY: Local Current Day of Month number
SSHOUR: Local Current Hour number
SSMINUTE: Local Current Minute number
SSSECOND: Local Current Second number
SSUTCYEAR: UTC Current Year number
SSUTCMONTH: UTC Current Month number
SSUTCDAY: UTC Current Day of Month number
SSUTCHOUR: UTC Current Hour number

SSUTCMINUTE:

UTC Current Minute number

SSUTCSECOND: UTC Current Second number

SSLASTCHANGE: HS DevicelastChange property using default date/time
display format

SSTOPIC: Last received MQTT Topic

SSVALUE: HS Device Value

SSVALUE_EUROPE:

HS Device Value with comma replaced with period. When
numeric expressions are used the fractional part of a
number needs to be separated by a period.

SSPREVIOUS:

The previous (i.e. current before change) DeviceValue that
exists at the time a DeviceChange event is occurring. Itis
typically used in conjunction with the inline expression
function “IfChange” such as
<<IFCHANGE($S$VALUE:,$$PREVIOUS,”5%")>>

SSPUBLISHED:

The published payload that was last sent. It is typically used
in conjunction with the inline expression function
“IfChange” such as
<<IFCHANGE(SSVALUE:,SSPUBLISHED,”5%”)>>

SSCAPIVALUE:

Last Value change request sent through CAPI interface used
by mcsMQTT SetlOMulti

Page 77




SSCAPISTRING:

Last String change request sent through CAPI interface used
by mcsMQTT SetlOMulti

SSHSEVENT:

Last parameter delivered by HS on HSEvent callback. This
will typically be the new DeviceValue or DeviceString

HS Device-Oriented Substitution Variables

SSDVA:(address):

Use device value. Identify device using address.

SSDVC:(device code):

Use device value. Identify device using device code. (HS3
only)

SSDVR:(reference):

Use device value. Identify device using device reference.

SSDTA:(address):

Use device string. ldentify device using address.

SSDTC:(device code):

Use device string. ldentify device using device code. (HS3
only)

SSDTR:(reference):

Use device string. ldentify device using device reference.

SSDSA:(address):

Use device status. Identify device using address.

SSDSC:(device code):

Use device status. Identify device using device code. (HS3
only)

SSDSR:(reference):

Use device status. Identify device using device reference.

$SGLOBALVAR: (key):

Use the global variable key’s contents.

Date and Time Substitution Variables

SSDATEL: Date in long format (e.g. Tuesday 10 September 2019)
SSTIMEL: Time with seconds (e.g. 2:00:13 PM)

SSDATE: Date in short format (e.g. 9/10/2019)

SSTIME: Time in short format (e.g. 4:52 PM)

SSUNIX: Time in UNIX format (seconds since 1970)

Other Substitution Variables

SSDEG: Degree Symbol (Decimal 176)

SSWANIP: WAN-facing IP address, updated every 10 minutes when
used

SSSECRETKEY: User entry on the URL tab or Cloud page for UDP

communication used for token compuations. Substitution
is in context of the URL Topic for which it was entered
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SSIWT:(key):. JSON Web Token (JWT) contains information that may be
needed in endpoints of the URL endoints. For example, if
“user_id” is needed in the endpoint or the URL (or in the
data payload) then it can be references such as:

URL/https://myServer/user/SSIWT:(user_id):/statu
s

The Payload format can be customized as well. In this case if a template is entered for the payload, then
the DeviceValue, DeviceString or VSP Status that would be published in the no-template case will no
longer be part of the Payload unless SSVALUE: or SSSTRING: or SSSTATUS: is used as part of the
template. As a further example the following could be specified for a JSON-encoded Payload of three
items that reflect the Status of the HS Device that had just changed.

{Name:SSNAME:, State:SSSTATUS:, TimeStamp:SSDATE: SSTIME:}

Topics are always published using URL encoding to assure MQTT reserved characters are not included in
the Topic. URL encoding replaces all character codes except for letters, numbers, and the following
punctuation characters:

. - (minus sign)

_ (underscore)

. (period)

! (exclamation point)

= (asterisk)

. ' (apostrophe)

(and ) (opening and closing parentheses)

Payload is not URL encoded unless explicitly requested in the publish template. This is done by using
substitution variables in the publish template and including “_URI_ENCODE” in the substitution variable
name. Alternately a replacement of spaces with underscores is specified by including “_UNDERSCORE”
in the substitution variable name.

For example, consider the case where a HS Device String has content of “A’B C”.

If the publish template has SSSTRING: then A’B C would be published.
If the publish template has SSSTRING_URI_ENCODE:” then A%27B%20C would be published.

If the publish template has SSSTRING_UNDERSCORE:” then A’B_C would be published.

The “_URI_ENCODE” and “_UNDERSCORE” suffix can be used with any of the substitution variables.
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It is possible to use expressions in the expression text box for inbound messages. They can also be used
in event action payload or device payload template by encasing the expression in “<<” and “>>".
Nesting expressions to two levels is supported.

Examples:
SSDVA:(PI_RELAY-R1): Substitute using DeviceValue from device @ address “PI_RELAY-R1”
SSDTC:(S33): Substitute using DeviceString from device @ code S33
SSDSR:(123): Substitute using DeviceStatus from device @ reference 123

<<$SDVR:(123):*2.55>> Scale DeviceValue of device @ reference 123 by 2.55

5.3 Send MQTT via Event Action
The second mechanism to send an MQTT message is with HS Event Actions. Figure 33 shows both the
setup of an Action (MQTTTrigger2) and how an Action will be shown that has been setup (MQTTTrigger).
The user entry, as shown by MQTTTrigger2, is of the format “Topic=Payload”. The first “=" is used to
separate the two components of the message. The QOS will always be the default setup on the Client
Tab for any MQTT message sent as an Event Action.

Event Name: Type Group Reassign:
E MaTTTrigger v [Test | BvieB8d
IF MQTT Topic "GarageDoor/#" received with Payload "default” Ld |
Then Send Mqtt Message Topic "HS3/Action" with Payload "Sent at $5time with value $$DVR:(138):" > m |

Options >

Event Name: Type Group Reassign:
£ MaTTTrgger2 ] [Test A > [P x ||
IF | Mgtt Topic Received v I |

Matt Topic | Sonoff120/cmnd/+ [optional] and Payload contains
THEN v | Send Mgt Message v v mu

Enter with format Topic=Payload |Shed/Light/cmnd=0N

Figure 33 MQTT Event Action

The MQTT Payload of Event Actions support substitution variables. An example use is show in Figure 34
where the “SStime:” and “SSDVR:(ref):” variables are used. In this example the Payload will include the
current time and the DeviceValue of Device with reference 138. The Value, String and Status of a device
are available for substitution. The reference, address and device code are the available methods to
identify a device. A six-character mnemonic is used to specify each of the nine combinations. These are
shown in Table 2.
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Event Name: Type Group Reassign:

—
£ [MQTTTrigger v | [Tost 1 Bviuad
IF | Mgtt Topic Received v -y U

Mqtt Topic |GarageDoor/# [optional] and Payload contains |default
Then Send Mqtt Message Topic "HS3/Action” with Payload "Sent at $5time with value $$DVR:(138):" Ld a [+ |

Figure 34 Substitution Variables in Event Action

It is also possible to send a set of MQTT messages from the HS Event Action. This is done by sending a
publication list that contains the message list. See Sections 5.7 and 17.8 for description and use of
publication lists. When the action is setup the list of created publication lists will be available from the
selector and if one has been previously selected for this event, it will show as the default. See Figure 35.

Event Name: Type Group Reassign:

£ [Pubiist v| [New Group Y BviwBd
IF The time is sunrise. (04:24:23) 4 &d

THEN v | [Send MQTT Publist v B

Enter MQTT Publication List Name | publist1 v

Figure 35 Send MQTT Publication List Event Action

A similar capability exists for requesting WLED playlist where the playlist name rather than the publist
name is specified.

Voice Monkey is able to do text to speech on Echo devices and images/videos on Echo Show devices.
The event action supports both capabilities with the default being TTS as shown in Figure 36. Other
options with Voice Monkey use JSON to specified the desired set of parameters. These are

e notification —if set to “true” then the Echo device LED ring will be illuminated and “play
notification” command used to hear the announcement and clear the LED

e image — URL of an Echo Show compatible image
e video — URL of a mjpeg file for display on Echo Sho
e websiteurl — URL of text from a web site

An example for picture with notification would be:

kitchen-show={"image”:http://myShapshotServer/last.jpg,” notification”:true}
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http://myshapshotserver/last.jpg

If

This Event 1= Manually Triggered v B a

THEN
Send Mqtt Message, MQTT Publist, WLED Playlist or Voice Monkey Routine v

Options are to publish a single MQTT message specified as Topic=Payload, request a WLED playlist as
Topic=Playlist, publish multiple MQTT messages as specified in a Publication List (Publist), or request a
Voice Monkey routine to be run with payload parameters.

General Tab default QOS And Retain will be used for MQTT messages.

Default Voice Monkey is Routine=Text (e.g. speak-all=Say Anything). QBvmoQ
If non-default Voice Monkey parameters are being used then payload should be in JSON format (e.qg. speak-

all={"announcement":"MyMessage"'notification” "true”," image":"https:/ mySite/myPicture jpg"}
Select between Message, Publist, WLED Playlist, or Voice Monkey Routine
Voice Monkey Routine N

Enter Routine=Payload format
speak-all=Say whatever is in $SDSR:(7047): to all echo devices

ADVANCED OPTIONS

Figure 36 Play Voice Monkey Routine

Note that Voice Monkey can also be commanded via MQTT received messages rather than HS Event
actions. In this case the MQTT Topic format is “voicemonkey/routine” and payload similar to that used
in the event action text box. In this mode of use, mcsMQTT becomes the server to bridge MQTT
messages to Voice Monkey API.

5.4 Send MQTT via Script
The third mechanism to send MQTT message is via scripting. In this case the HS scripting command
“PluginFunction” will be used to get the mcsMQTT object and the mcsMQTT function
“SendMQTTMessage” will be used to send the message.

The prototype for “SendMQTTMessage” is
Public Function SendMgttMessage(ByVal sArray() of String) As Integer

A positive sequential number is returned with success and a -1 on failure. The array contains four
entries:

1. Topic

2. Payload

3.Q0S

4. Retain

5. Optional Broker index (0.. number of brokers — 1)

The QOS parameter has the following enumerated values
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“AT_MOST_ONCE”
“AT_LEAST_ONCE”
“EXACTLY_ONCE”

The Retain parameter contains the following values

“FALSE” — Do not ask broker to retain the message
“TRUE” - Ask broker to retain the message for transmission to new subscribers

An example is below where a positive value return as an incrementing number and a negative value is
returned if there is some form of failure.

Sub Main(parm as object)

Dim iResult as integer

Dim sTopic as string = "Sonoff/Bedroom/Light/cmnd"

Dim sPayload as string= "OFF"

Dim sQOS as string = "EXACTLY_ONCE"

Dim sRetain as string = "FALSE"

Dim sArray() as string = {sTopic,sPayload,sQ0S,sRetain}

iResult = hs.PluginFunction("mcsMQTT","","SendMgttMessage",sArray)

if (iResult < @) then
hs.Writelog("mcsMQTT","MQTT Message Failure for " & sTopic)
end if
end Sub

A second form of the scripting send function is to send to the Messaging Sign. Its prototype and array
parameters are:
Public Function SendSignMessage(ByVal sArray As String()) As Integer
'return -1 on failure
'0-Topic
'1-Text
'2-Row
'3-Duration
'4-Color
'5-Q0S
'6-Retain
Failure is indicated as a -1 returned value. Its use is similar to the basic send function but includes the
details of information going to the sign in additional parameters.

5.5 Send Status on MQTT Request
Any HS device that has a Publish Topic defined can be queried to report its current status from a MQTT
message with the same Topic as the Publish Topic and an empty Payload. The current status that will be
either the DeviceValue or DeviceString depending upon which HS Event Trigger has been defined for the
device on the Edit tab. See Figure 28.

In this example of a non-plugin device where the status is reported on Topic Test/Status and it will
report the DeviceValue. This status will be published every time the DeviceValue changes as well as
when the Topic Test/Status is received with a blank Payload.
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The status query can also be requested by using the Subscribe (control) topic. In this second option non-
plugin devices that are status only will provide no response because no control topic will have been
defined.

When Publish (statues) topic is used then the broker will likely return the same message to the sending
client. There is no guarantee what order the broker returns to the sending client the topic sent by the
sender vs. the topic sent by mcsMQTT. If mcsMQTT is first then the "final" status will have a blank
payload. It could also result in an event in the sending or other clients as the status response transitions
between null and current status.

5.6 Sending Periodic Status
All non-Plug-in HS devices that have been “A”ssociated will have their current DeviceValue or
DeviceString published on the interval setup on the Client Tab. This serves to assure subscribers are
refreshed following unexpected mcsMQTT disconnects when the QOS will not otherwise provide this
capability.

5.7 Sending Configuration / Setup Messages
A set of Topic/Payload messages can be defined that contain the configuration of an 10T device. The list
is a text file located in the folder \Data\mcsMQTT and of file type “.pub”. Each line of the file will have a
message defined as Topic=Payload. The first four lines of the file will contain the substitution variable
definitions.

The Pub List tab is used to start the transmission of the messages. This tab can also be used to create or
edit existing publication list files. The file of interest is selected from a pull-down. If a new file is to be
created then the text box to create a new file is used to specify the file name.

Provisions exist for substitution variables $$1: through $54: to allow a single .pub file to contain a
template which is instantiated based upon the values entered for the substitution variables.
Substitution variables do not need to be used, but their position in the .pub file does need to exist even
if the substitution value is blank.

Edit provisions via browser also exist. This can be used to create of modify a .pub file.

In the Figure 37 example a file of name LoRa.pub exists to define the frequency of three LoRa units. The
frequency is defined as S$1: to be 915. Three messages are setup to transmit this frequency to three
IOT devices. The Execute Publication List is used to initiate the publication.
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Publication List Selections

Select Existing Publication List LOcRa v
Create Mew Publication List

Substitution for $$1: 915

Substitution for $$2:

Substitution for $%3:

Substitution for $$4:

Execute Publication List

cmnd/LeRat/LoRaFrequency=551:
crndiLoRaZ/LoRaFrequency=551:
cmnd/LoRa3/LoRaFrequency=551:

Figure 37 Publication List to Setup a Lora Frequency

5.8 Sending Messages to LED Messaging Sign

The Messaging Sign whose APl is described in Section 20.19 will display text and images on a matrix of
color LEDs. Provisions have been made in mcsMQTT to facilitate use of this sign with HS.

On the Edit tab for plug-in devices a Control/Status Ul of type Sign exists to indicate that published
information will be formatted for this sign. A similar provision exists for non-Plug-in devices to publish
to the sign.

The sign has on-board provisions to store twelve messages for display. The first four are stored in flash
so will persist a power cycle of the sign. The other eight will not persist a restart. Messages are updated
via MQTT topics. The twelve are identified by the topic PTEXT for persistent and TEXT for volatile. Each
is prefixed with /CMND/ and suffixed with index 1 through 4 or 1 through 8. (e.g. LedSign/cmnd/Text8”
to indicate the 8" volatile text message.

When a Sign type selected and the “A”ssociate checkbox used to create to HS device then buttons are
created to correspond to each display row on the sign. See Figure 38. The status will indicate the row a
message is being displayed on the sign. The button will cause a message to be sent to the specified row
of the sign or to remove the message from the sign’s buffer. The color and duration parameters from
the setup of the sign are also sent.

0/07/2019 .
10/07/2019 e [ T e

11328 | Off LedSign TEXTS 14:53:34 —

Figure 38 Control/Status Ul setup in Device Management to Support Sign Type
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The user can use the buttons on the Ul or it can store into DeviceValue the 0, 1 etc. to affect the desired
result. The sign’s feedback will indicate which row the message is showing. If the HS DeviceString is null
then this status will appear on the Device Management page. The row status is also available in the
DeviceValue.

The color and other parameters for the sign are entered from mcsMQTT from the Edit Tab on the
hyperlink “Configure Sign Parameters”. These parameters include the duration in minutes that a
message will be retain for display, the row on which the message will be shown and the color of the
message. The color can also be embedded in the text of the message using “[RRGGBB]” notation to
change the color of the text for the subsequent characters. A default text string that can be used for
text or image path can also be entered and will be used if publish Template and HS DeviceString are null.

MQTT has a limit of 128 characters for a payload. It the message exceeds this then mcsMQTT will split it
into multiple transmissions and the sign will reassemble them so it appears that a long message has
been received. The limits of the sign are 80 characters for non-volatile (PTEXT1 through 4) and 320
characters for the others (TEXT1 through TEXT8). mcsMQTT will enforce this and truncate extra
characters so a user need not be concerned about message length for a successful transmission.

The sign also has provisions for display of images. If the payload of a message going to the sign is a file
path to a jpg image, then mcsMQTT will transmit the binary for the jpg per the API defined in Section
20.20.2. The image can be scaled by a percentage of the capability of the sign’s resolution. By default,
this resolution is 16 x 40 pixels. 10,000 bytes are reserved in the sign to hold the compressed jpg image.
If mcsMQTT recognizes that the image specified with scaling will not fit then it will scale it progressively
smaller in 10% increments until it will fit prior to transmission.

Experience has shown that good results occur when the image is 100% to 200% of the screen size.
There will be sufficient content at any point in time as the image pans to be able to recognize the image.
Lower scaling may result in poor recognition because of the resolution of the screen. Higher scaling will
result in difficulty in recognizing the image content in the viewport provided by the sign.

Provisions have been made to extract information from the HS log to be sent to the screen. This is
described in Section 5.8.1.6 as well as more in the introduction to Section 6. Otherwise, the text of the
message or the file path of the image are generally contained in the DeviceString of the device that has
been assigned the Sign as its Control/Status type. All HS log entries sent to the sign are done on topic
TEXTS.

Provisions also exist to monitor a file name or file folder for an update to a jpg image and then send the
updated image to the sign. This is described in Section 5.8.1.8. All images are sent using the IMAGE
topic.

When using the Sign, a strategy should be developed for how each row is to be used. For example, the
first row is for messages that need user attention and the second row is for messages that are just
informational.

The Sign will automatically scroll through each of its twelve message buffers and show any that have a
non-zero duration. This will be done in a round-robin manner with a three-character space between
each message.
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The Sign Duration parameter should be selected so that stale messages are removed automatically and
set to 65535 for those that need user attention so they can be manually acknowledged. Use of PTEXT
rather than TEXT as the Topic is also appropriate for important messages that need to persist power
cycles or restarts of the Sign.

5.8.1 Messaging Sign Use Cases

The following discussion provides concepts of how mcsMQTT can support use of the Messaging Sign. In
all cases HS devices will exist with the Control/Status Ul having been selected as the type. For plug-in
devices this is the radio on the Edit page. For non-Plug-in devices this is also a radio on the Edit page
label “Publish To Sign” as shown on Figure 28.

5.8.1.1 Send Text to Sign when HS DeviceString Changes

When the DeviceString of any HS device receives a change in its content then the text of the string will
be stripped of any HTML encoding and sent to the sign. The duration that the text will continue to be
displayed, color information and the row on the sign and on the sign are setup from the “Configure Sign
Parameters” hyperlink on the Edit tab. See Figure 28 and Figure 29. The topic used is taken from the
Publish topic that is setup on either the Edit tab or the Association tab.

If the Sign’s corresponding status topic has been associated to a HS device then the Sign will
acknowledge receipt of the text by echoing the row number on which the text was displayed. For
example, if published to topic LEDSign/cmnd/TEXT2 then the Sign will publish acknowledge status on
LEDSign/TEXT2. If the duration countdown expires then the Sign will again publish LEDSign/TEXT2 but in
this case the payload will be 0 to indicate that the text is no longer being displayed on the sign.

5.8.1.2 Send Augmented Text to Sign when HS DeviceString Changes

This scenario is the same as the first scenario but additional text is added to the DeviceString content to
provide context of the text. An example is Caller ID being available from HS and it is to be sent to the
screen when a call is received. The CID will be contained in a non-Plug-in DeviceString.

In this case the Publish Template from the Edit page is used to provide a prefix “CID:” along with
substitution variable SSSTRING:. The Publish Template text box would look like “CID:SSSTRING:”
mcsMQTT would then pull the DeviceString text and append it to the “CID:” prefix before sending the
Sign. The duration parameter on the Sign Parameters popup (Figure 29) in this case would likely be
relatively short such a one minute since the CID info only has immediate use. After one minute the Sign
will remove the CID message.

5.8.1.3 Send Static Text to Sign

Consider a scenario where the text to be sent is predefined such as “Amber Alert” and an HS
DeviceValue changes when the “Amber Alert” is occurring. The HS DeviceString will be null and the
Publish template will be null. The Default Text in the Sign properties popup (Figure 29) is set to “Amber
Alert”.

For discussion let us use the LedSign/cmnd/TEXT2 as the Publish Topic and Sign Duration of 65535 to
indicate that the message will continue to be shown until manually removed. The plug-in device
“A”ssociated with Topic LedSign/TEXT2 will have a “Off” button that can be used to do the removal.
Alternately the DeviceValue of the plug-in device can be set to 0. Either of these actions cause a
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LedSign/cmnd/TEXT2 Topic to be sent with a payload containing a JSON content of Duration being 0 that
supersedes the 65535 minutes originally sent.

5.8.1.4 Send Text to Sign via Script

In this scenario consider an irrigation Plug-in such as mcsSprinklers where the predicted date of the next
irrigation cycle is desired. In this case the mcsSprinklers Plug-in script function needs to be called to get
the predicted date and then from the script one would use the mecsMQTT Plug-in function
SendSignMessage to send a MQTT message per the JSON format expected by the sign. See Section 5.4
for information on the scripting within mcsMQTT.

In this scenario the script formats the text as desired before passing it along with the parameters for
row, duration and color used in the SendSignMessage Plug-in function. There is no dependence on any
other HS device for this operation to function. Status feedback from the Sign does continue to be
provided in the HS device “A”ssociated with the corresponding TEXT or PTEXT topic.

5.8.1.5 Send Augmented Text to Sign when DeviceValue Changes

In this scenario consider a HS DeviceValue that contains the daily energy use that is updated every
minute. The implementation of this scenario is the same the one described in Section 5.8.1.2 except the
substitution variable is SSVALUE: rather than SSSTRING: to indicate that mesMQTT should pull the value
from DeviceValue rather than DeviceString.

Each time the DeviceValue changes an updated message will be sent to the sign to replace the one that
was previously viewed. In this case the Sign Duration parameter could be set to something like 2
minutes so the message will be removed from the sign if it becomes stale.

5.8.1.6 Send all HS Log Entries to Sign Generated by Specific Plug-in

On the Publist/Sign tab Messaging Sign Setup section is a text box where a regular expression can be
entered to specify a filter for HS Log entries. If, for example, the plug-in of interest is mcsSprinklers then
it will place the text “mcsSprinklers” in the Log’s type/error column. This is what would be used in the
regular expression to indicate any occurrence of this text.

At this same location is a radio to enable use of the HS log as source of messages to the Sign.

The TEXTS8 topic will be used for HS Log publications to the Sign. The Publish Topic will be setup to be
something like “LedSign/cmnd/TEXT8”. The Sign Parameters popup ((Figure 29) contains a radio to
select HS Log entries to be sent to Sign.

The other Sign parameters should also be setup as desired. In the HS Log case the Color parameter is
ignored and the color used by the HS Log will also be used by the Sign.

5.8.1.7 Send Jpeg Image to Sign

A Topic similar to “LedSign/cmnd/IMAGE” is used to deliver an image to the Sign. The image will
supersede any text that is currently being displayed. A subsequent text message to screen will remove
the image from the Sign.

The jpg file name can be contained in DeviceString or Sign Properties popup Default Text property.
When a DeviceString changes, mcsMQTT will look at the last four characters for “.jpg” and send the file
content rather than sending the text. If the file does not exist then nothing will be sent.
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All the methods described in the text-oriented scenarios can be used for images but the Publish Topic
should use the IMAGE rather than the TEXT or PTEXT keywords

5.8.1.8 Automatically Send Updated Jpeg Charts to Sign

On the Publist/Sign tab Messaging Sign Setup section is a text box where a file name or a folder name
can be entered. mcsMQTT will monitor this location and every ten seconds when the last change date
changes for a .jpg file then it will scale the image and send it to the Sign. The remaining setup is the
same as used from HS Log monitoring described in Section 5.8.1.6 except file monitor radio is selected
and the only other Sign parameter of interest is the image scaling percentage.

If a folder is being monitored then mcsMQTT will select the most recent file if multiple files change in
the last ten seconds. Charts that have fine detail will perform poorly with this use due to the resolution
of the Sign. Things like Area and Column charts will have more success than Line or Scatter charts.

5.9 Sending MQTT Messages via HTTP/Browser Parameters

5.9.1 Send a Topic with Payload

A request made to the HS HTTP server to the MQTT page with querystring parameters of Topic and
Payload will result in a MQTT message being sent. By default the Broker to be used is the first one, but
can be changed by using the parameter Broker. QOS and Retain parameters are also supported if the
defaults are not to be used. To illustrate the following will send a MQTT message to Topic xyz with JSON
payload {“a”:”b”} using the Broker at 192.168.5.6 and with QOS of 1.

HS4: http://localhost/mcsMQTT/MQTT.html?Topic=xyz?Payload= {“a”:”"b”}?Q0S=1
HS3: http://localhost/ MQTT?Topic=xyz&Payload= {“a”:"b”}&Q0S=1

This capability is typically used in scenarios where a widget is able to communicate via HTTP by sending
at URL and has no capability to use MQTT. mcsMQTT will provide the standardization of communication
so other capabilities such as a HS Event based upon receipt of MQTT message or an associated MQTT
Topic. The Shelly Wall Display is an example of one such device that only has capability to use HTTP in
its Actions.

5.9.2 Send a Voice Monkey request for Alexa

The syntax of Voice Monkey via Browser or other tools capable of making a URL request is similar to the
syntax used for Voice Monkey event actions. An additional parameter “Payload” is used to specify the
text that is to verbalized. See Section 5.3. For example:

http://localhost/mcsMQTT/MQTT.htmI?VoiceMonkey= speak-den?Payload=Voice Monkey Test

5.9.3 Send a WLED Playlist request

The syntax of WLED playlist request via Browser or other tools capable of making a URL request is
similar to the syntax used for WLED event actions. See Section 5.3. The parameter IP is used ot specify a
specific WLED interface. For example:

http://localhost/mcsMQTT/MQTT.htmI?WLED= myFavorites?IP=192.168.1.55
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5.10 Monitoring Ability to Send and Receive via Broker
mcsMQTT monitors the Broker connection on ten second intervals. If a connection is lost it will attempt
reconnection. This will be followed by resubscription. This background activity should be transparent to
the mcsMQTT user except for those who are using the Broker Connection Trigger. Events with this
trigger can be setup for either disconnect or connect transitions as shown in Figure 39.

Event Name: li' Type Group Reassign:
MQTTDisconnect v Test v Li N am
Voice Command:
IF | Maqtt Broker Connection v —
Connects to Broker
Then Speak Disconnected N m

Figure 39 MQTT Broker Connection Event Trigger
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6 Receiving MQTT Topics
Telemetry, sensors and other devices that provide current information via MQTT can be captured in HS

Devices. Triggers can also be raised by either the reception of a Topic or after a Topic has not been
received for a specified time.

The default mode of operation of mcsMQTT is that it is listening to all topics available from the broker.
This is referred to as Discovery and can be deselected from the Client Tab Inbound (Subscription) Section
of Figure 40. This mode is good when initially building the HS/MQTT relationships or when new MQTT
topics are being introduced to the environment. When a stable environment has been achieved the
mode can be changed to only “Listen for only Associated messages and those messages that are used as
MQTT event triggers. This will reduce the volume of traffic being sent between the broker and
mcsMQTT to be only those topics which will result in a change in HS devices. This also means that the
Payload shown in Figure 30 will only be updated for the “A”ssociated devices.

The default is also that published messages are not shown on the Association tab rows. When the echo
feature is enable on the Client Tab Inbound (Subscription) Section of Figure 40 any published message
will be visible on the Association tab as a subscribed topic if Discovery is enabled. If Discovery is not
enabled then the Topic can be made visible from the Manual page by entering the specific subscription.

Topics received that match the subscription template option will be available for management on the
Association tab unless rejected by other settings. They can be hidden from view on the Association tab
by using the “R”eject column checkbox. In this case the messages are still recorded in history, but not
visible on the Association tab. The Client tab provides a Reject Topic Template where a set of
wildcarded topics can be entered to firewall reception of these Topic. In this case they are not recorded
in the history.

When an Association of MQTT Topic is made to create a HS plug-in device the device will be placed in a
Location2 (Floor) and Location (Room) as determined by the MQTT topic or can be at fixed locations if a
default location is setup on the Client tab. This location can be edited from the Edit tab or can be edited
in HS Device Management. Rather than the location being dependent on the MQTT Topic it can also be
specified so that all new mcsMQTT devices go into the same Location2 (Floor) and Location (Room). The
Client tab Inbound section provides the ability to make this choice and select the locations to be used.

The Payload items are stored in HS Features (HS4) or HS Child Devices (HS3). The Feature or Child
Device will be organized under HS Devices (HS4) or HS Parent Devices (HS3). The Device into which the
Features and Child Devices are grouped is normally created using the MQTT Topic hierarchy. Given a
Topic of “Test/Me” there will be a Device Test and a Feature Me created when an Association is made.

Two options exist to modify this Device/Feature relationship within HS. One is on the Client Tab setting
for “Default HS Parent Device”. When this option is used any new association made will use a static
Parent Device. This approach minimizes the number of Parent Devices that are created. Once a Feature
has been created the parent to which is grouped can be changed from the Edit Tab, “Grouping Parent
Ref” text box.
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Express Mode

Express Mode
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Outbound (Publish) Management

Default Topic
Template

Default Payload

Template

AtMost @
Default QOS
s Atteast (O
Exactly O
Nefallt Messaors 2 s
Default Message Do Not Retain at Broker @
Retain
Retain at Broker (O
Publish Periodic 0
Status (Mins)
LRI Encode Send unencoded @
Topic Encode with URI encoding such as %20 forspace (O
Replace special characters withunderscore (O
Disabled @
Publish HS : ~
ublish HS All non-Plugin Feature Changes ()
Feature Changes %
All Feature Changes (O
All Feature ChangeorSet (O

Figure 40 Client Tab Inbound and Outbound Setup Options

6.1 Receive MQTT Payload in HS Device
Figure 27 through Figure 31 are used to setup the mapping between a MQTT Topic and HS Device. The
received Topics will be listed on the Association Tab and a HS device created for each where the
“A”ssociated checkbox is used.

The received list will be formed from all the Topics that were delivered by the MQTT Broker with
subscription to “#”. In addition, special Topics can be specified in the Edit tab. This provision is to
handle the special cases not covered by “#”.

The MQTT Payload can be either raw text or it can be text formatted using JSON. mcsMQTT will parse
the JSON and create a mapping for each JSON element into an HS Device. A “:” is used in the Topic
name to indicate that part of the Topic is based upon the JSON Payload. In Figure 30 all rows were
formed from one MQTT Topic with Payload encoded with JSON keys. The Topic “GarageDoor/Uptime”
is shown as having JSON formatted Payload content for “Time” and for “Uptime”. The “:” is used to
identify that everything to the right of the “:” is part of the JSON Payload.

Take for example the following MQTT message. In this case there are two levels of JSON formatting. As
one example a row will be shown for “Sonoff120/STATE:Wifi:AP” because the “Wifi” value is further
decomposed into multiple components using JSON.
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Topic: Sonoff120/STATE

Payload: {"Time":"2017-12-02T03:38:30", "Uptime":0, "Vcc":3.007, "POWER":"OFF",

"Door":"CLOSED", "Wifi":{"AP":1, "SSId":"default", "RSSI":100, "APMac":"40:16:7E:A2:EE:68"}}
JSON data format consists of an optional group specification starting with “[“ and ending with " ]”.
Inside the group (if it exists) are sets of key-value pairs between a starting “{“ and an ending “}’. The
key-value pair is separated with a “:”. If the value is text, then it is encased in quotes. If it is numeric
then it is not encased in quotes. The key, since it is text, should always be in quote, but mcsMQTT is
tolerant of keys that do not have quotes.

The last Payload for the Topic is shown and if “A”ssociated then it will also be placed in the mapped HS
Device. If numeric it will be put in the DeviceValue otherwise in the DeviceString. Provisions also exist to
setup Value-Status Pairs (VSP) so that DeviceValue rather than DeviceString is updated. This is desirable
because HS has a richer set of features for Values than Strings.

It is common for an 10T device to respond to a command with some form of acknowledge and also for
the device to periodically report its state. There two activities will be published on different topics but
the represent the same information. Section 4.1.28 describes how multiple topics can report status
into a single HS device.

mcsMQTT will observe the Payload history of a Topic and select VSPs, Numbers or Text as the most
appropriate type of Payload mapping to HS Device. The selection can be changed on the Edit tab by
selecting a radio for the HS Device Control/Status Ul. VSPs are used for Button and List. HS Devices
created with Button type will take a snapshot of the received text values to setup the VSP for the HS
Device. They can be manually edited later. Devices of type List will continue to automatically update
the VSPs as new text is received in the payload. These also can be manuallyed edited. Types of
valuesNumber and NumberChange are used for numeric Payload. Type NumberChange will only update
the HS DeviceValue if it has changed. Text is used for random strings. Color Picker is also available for
special case of asking HS to show a color picker control for the Device. Three forms exist for the Color
Picker. The ColorXY is used if the end point is an XY color space. HSBColor for control using Hue,
Saturation and Brightness. The other is used if #RGB is the payload format. Button is used for two state
VSPs and List used for longer ones. Special cases exist for Payloads of ON, OFF, OPEN, CLOSED, OFFLINE,
ONLINE, FALSE, TRUE, DISARMED, ARMED, INACTIVE, ACTIVE where the 0 and 1 values are fixed (e.g.
OFF=0, ON=1). For other cases the values are selected based upon order observed in the Payloads.

6.2 Payload Transformations
In some situations there may be only a part of the payload that is of interest or some textual
transformation is desired on the payload before further process and mapping into HS. Regular
Expressions can be used to achieve this objective. The result of the RegEx will change the visible Payload
in the Association table so this the case where the Payload may not match what is actually received from
the MQTT Broker.

The Regualar Expression parameters are available on the Edit tab.

Regular expressions are for textual transformation such as extracting key date from a long string or
changing a character into another (e.g. comma to decimal or date M/D/Y to Y/M/D). The pattern box is
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used to specify the match pattern. If the pattern is left blank then the Payload will be placed in the
Device and no regular expression activity will be performed on the Payload.

The match radio is to specify the regular expression mode. When unchecked it is set to replacement
mode. When checked it is in extract mode. Replacement mode uses to the pattern to find matches in
the Payload and change those matches to what is contained in the replacement text box. Extract mode
looks for text that matches the pattern and uses it as what is placed in the HS Device. The second text
box in this case is used to identify which of multiple matches are to be used. If blank then the first will
be used. If no matches are found then null is placed in the HS Device. If the number of matches
specified is not found then the last one will be used. A large number in the second text box could be
entered to extract the last instance of the match in the Payload.

The pattern text box is used to for substitution for the match criteria when in replacement mode. The
second text box is used to specify the match instance number when in extract mode. If the pattern is
valid the result of the regular expression applied to the Payload will be placed in the Device. If the
replace box is left blank then the match text will be replaced with null text.

Syntax reference for regular expression supported by mcsMQTT can be found at
https://docs.microsoft.com/en-us/dotnet/standard/base-types/regular-expression-language-
guick-reference. Note that this reference is for the PERL/.NET syntax. Quite often online RegEx
expression analyzers use Java or other conventions. While the concepts are similar there is some
variance in the symbols and their use.
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A few simple examples below.
1. Change period to comma in a number “1.23”

Pattern: \. (look for a “.”, it needs to be escaped with \)
Extract Checkbox: Unchecked
Replace: ,

Result: 1,23

Note: \. is escaped “.” Because “.” is reserved. Every instance of “.”
Will be changed to “,” so could fail if mining large text string

2. Remove suffix “ seconds” suffix from a Payload of “1234 seconds”

Pattern: seconds

Extract Checkbox: Unchecked
Replace:

Result: 1234

Note: replace suffix of “ seconds” with null. Note alternate method using
general rather than specific suffix in next example

3. Extract numeric part of Payload of “1234 seconds”

Pattern: \D+

Extract Checkbox: Unchecked
Replace:

Result: 1234

Note: pattern is consecutive set of non-digits
4. Transform date from YYYYMMDD to MMDDYYYY format in "2018/10/01T00:24:18"

Pattern: (\d+)-(\d+)-(\d+)(T)(.+)
Extract Checkbox: Unchecked
Replace: $2/$3/$1 $5

Result: 01/10/2018 00:24:18

Note: use of “()” provides sequenced substitution groups that are stored in
$1, $2 etc. The first group will capture the year. The second will be the
month. The third will be the day. Between these groups a “-“ is needed.
The “T” is then needed and defined as group $4. $5 will contain the
remainder to string. The replace transforms the order, changes “T” to
and €€ _¢c to ((/)J.

€« «¢c

5. Extract last segment of IP “192.168.1.100”

Pattern: \d+

Extract Checkbox: Checked
Replace: 4

Result: 100

Note: four groups of digits are detected because the period delimits the
digit group. The Replace text indicates that the 4th match is to be
extracted.
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6. Change IP address (192.168.5.127) to a hyperlink (courtesy of bartz, HS board)

Pattern: (.+)

Extract Checkbox: Unchecked

Replace: <a href="http://$1"target="_blank">$1</a>

Result: <a href=http://192.168.5.127 target="_blank”> 192.168.5.127</a>

7. Extract a value for a JSON key such as “Action” in
{“status”:”online”,”Action”:”stop”,”IP”:”192.168.0.1”}. Note JSON decoding is
normally done by mcsMQTT, but for cases where nexted JSON is used then this could
be useful. Assume the JSON key is Action:

Pattern: ((.*)Action:(.*)(,.*))
Extract Checkbox: Unchecked
Replace: $2

Result: “stop”

Note: The first group is everything before the text Action: The second
group is everything after it until group 3. The third group is then the
remainder after the comma. The second group is the Action value of interest
so the $2 is the replacement.
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6.3 Payload Numeric Transformations
Four forms of numeric transformation are available and are invoked for “A”ssociated Topics. If no
transformation is specified on the Edit tab, then the raw Payload will be placed in the HS Device.

A low pass filter can be used to reduce the noise of a Payload input. The filter sensitivity is set near 0.0
to make the make the value very stable thus reflecting only longer-term trends. Sensitivity near 1.0 will
have very little smoothing effect.

An arithmetic expression can be used for simple conversion of units to complex functions. The
expression can be specified using a combination of math operators (e.g. +), functions (e.g. round, sin,
int), and replacement variables (e.g. SSPAYLOAD:). See Table 2 for lists of replacement variables and
Table 3 for available expression functions. As an example, the following will converts Payload in inches
to centimeters with one digit precision: “(round(SSPAYLOAD: * 2.54,1)”

An additional HS Device can be created to capture either the derivate (rate) or integral (accumulation) of
the Payload input. When the Device is created via checkbox selection it is associated with the base
device. This will result in HS always keeping these grouped together such as shown in Figure 41.

(value)

[ (623 |70 HyderonRain |STATE:Wifi:RSSL Today 11:51:35 AM 70 Submi
mit

[1|644 | 210 HyderonRain |STAT RSSI Accum Today 11:51:28 AM

[1|645 |-0.09 HyderonRain |STATE:Wifi:RSSI Rate Today 11:51:27 AM

Figure 41 Base, Rate, and Accumulation Device Associations

A rate device contains a sensitivity factor. A sensitivity of 1.0 will result in the rate determined only by
the last two payload inputs received. As sensitivity approaching 0.0 will result in a very slow changing
rate. The time units can also be selected between per second, per minute or per hour.

An accum device contains a provision to reset the accumulation at midnight. When enabled the
accumulation device value will be set to 0 at midnight. The accumulation device will behave in one of
two ways when reset at midnight. One is to treat the midnight value as the starting point and the accum
device will reflect the change since the midnight value. The other is to set the midnight value to zero
and the accum device will accumulate the values that are received throughout the day.

Status formatting for numeric values is left up to the user using the Status-Graphics edit capability of the
HS3 Device Management or HS4 Devices browser page. Figure 42 is an example of a user edit to change
the Status format displayed to “XX Minutes”.
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Configuration l Advanced Status Graphics

Edit Status Text for device STATE:Uptime

Value Status Row Column (S:olumn Status-Control
pan
Prefix:
Suffix: Minutes
Start: |0 Dec Places: 0
] ] ] both control Delete
End: |3999 M Include Values

["1Has Additional Data
[1Has Scale

Value Offset: 0

Figure 42 Edit of Status for Numeric Devices

6.4 Payload OtherTransformations
Expressions can also be used where the result is text that will be stored in DeviceString. Date and
currency formatting are examples. There are also extensions to math functions that can be used for
numeric transformations that will be stored in DeviceValue. If the result of a transformation is to be
stored in DeviceValue then the type will typically be “Number”, but could also be “Button” or “List”. If it
is stored in DeviceString then it will be “Text”.

An example of a transformation from a Unix/Epoch date/time format into a local time format would be
the expression “Local_DateTime(SSPAYLOAD: ,”d MMMM YYYY h:m:s tt” )” where the payload may be
something like “1554758969”. This would result in “8 April 2019 9:29:29 PM” being stored in the HS
DeviceString.

The prototypes of functions supported are listed in Table 3.

Of special note is “IfChange” as it will inhibit the publish operation if a null string value is returned. It
takes three parameters. The new value, the previous value, and the hysteris threshold. If the value’s
magnitude difference from the previous value is more than the threshold then the function will return
the new value, otherwise it will return a null string. The threshold can be specified as a number or as a
numeric string suffixed with “%”. Its typical use will be in the publish payload template for non plugin
devices where the desire is to inhibit publishing MQTT messages when only a small change occurs in the
HS device value. The following three examples for the publish payload template will inhibit where
device value changes by less than 5% and by less than 20. In the first two cases the delta is from the
prior HS DeviceValue and the third is the case when it is the delta of the Payload from the last time the
Topic was published.

<<IfChange($SVALUE:,$$SPREVIOUS:,”5%")>>
<<IfChange(SSVALUE:SSPREVIOUS:,20)>>

<<IfChange(SSVALUE:SSPUBLISHED:,20)>>
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Table 3 Expression Functions

Math Functions

Public

Function

Sin(ByVal v As Double) As Double

Public

Function

Cos(ByVal v As Double) As Double

Public

Function

Tan(ByVal v As Double) As Double

Public

Function

ArcSin(ByVal v As Double) As Double

Public

Function

ArcCos(ByVal v As Double) As Double

Public

Function

ArcTan(ByVal v As Double) As Double

Public

Function

Sqrt(ByVal v As Double) As Double

Public

Function

Power(ByVal v As Double, ByVal e As Double) As Double

Public

Function

Limit(ByVal v As Double, ByVal eMin As Double, eMax as Double) As Double

Public

Function

Mod(ByVal x As Double, ByVal y As Double) As Double

Public

Function

Min(ByVal vl As Double, ByVal v2 As Double, _

Optional ByVal v3 As Double = Double.MaxValue, _
Optional ByVal v4 As Double = Double.MaxValue, _
Optional ByVal v5 As Double = Double.MaxValue) As Double

Public

Function

Max(ByVal vl As Double, ByVal v2 As Double, _

Optional ByVal v3 As Double = Double.MinValue, _
Optional ByVal v4 As Double = Double.MinValue, _
Optional ByVal v5 As Double = Double.MinValue) As Double

Public

Function

Abs(ByVal val As Double) As Double

Public

Function

Floor(ByVal value As Object) As Integer

Public

Function

Ceiling(ByVal value As Object) As Integer

Public

Function

Int(ByvVal value As Object) As Integer

Public

Function

Trunc(ByVal value As Double, ByVal prec As Integer = @) As Integer

Public

Function

Dec(ByVal value As Object) As Double

Public

Function

FromHex(ByVal value as Object) as Double (e.g. “OA” - 10.0)

Public

Function

Round(ByVal value As Object, ByVal prec As Integer = ©) As Double

Public

Function

Exp(ByVal base As Double, ByVal pexp As Double) As Double

Public

Function

Rnd() As Double
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Conditional Functions

Public Function [If](ByVal cond As Boolean, ByVal TrueValue As Object, ByVal FalseValue As
Object) As Object

Public Function IfEQ(ByVal Parml As String, ByVal Parm2 As String, ByVal TrueValue As
String, ByVal FalseValue As String) As String

Public Function IfGT(ByVal Parml As String, ByVal Parm2 As String, ByVal TrueValue As
String, ByVal FalseValue As String) As String

Public Function IfLT(ByVal Parml As String, ByVal Parm2 As String, ByVal TrueValue As
String, ByVal FalseValue As String) As String

Public Function IfChange(ByVal value as Object, _
ByVal previousValue as String, _
ByVal threshold as String) as String
If value and previousValue are numeric then return null if value from previousValue
is under threshold. Threshold can be number or percent if % is suffix. It not
numeric then compare of two string with equality returning null string.

Public Function IfDelta(ByVal value as Object, _
ByVal previousValue as String, _
ByVal threshold as String) as String
If value and previousValue are numeric then return previousValue if value from
previousValue is under threshold otherwise return value. Threshold can be number or
percent if % suffix is used on threshold.
Example IFDELTA($$PAYLOAD:,$$DVR:(4038):,"10%")
Example IFDELTA($$PAYLOAD:,$$DVR:(4038):,5

Public Function Case(ByVal variable As String, ByVal value As String, ByVal out As String)
As String

Variable is item being evaluated

Value is string of semicolon-separated values

Out is string of semicolon-separated result for each value. If out contains more

items than value then last out will be the else result.
Example CASE($$PAYLOAD:,”10”;20;30”,”0;100;255;-1” will return @, 100,255 or -1
depending upon the payload being 10, 20, 30 or something else
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String Functions

Public Function

Trim(ByVal str As String) As String

Public Function

LeftTrim(ByVal str As String) As String

Public Function

RightTrim(ByVal str As String) As String

Public Function
String = " ") As

PadLeft(ByVal str As String, ByVal wantedlen As Integer, ByVal addedchar As
String

Function Replace
String

(Byval base As String, ByVal search As String, ByVal repl As String) As

Public Function
Integer.MaxValue

Substr(ByVal s As String, ByVal from As Integer, ByVal len As Integer
) As String

Public Function Len(ByVal str As String) As Integer

Public Function Lower(ByVal value As String) As String

Public Function Upper(ByVal value As String) As String

Public Function WCase(ByVal value As String) As String

Public Function Format(ByVal value As Object, ByVal style As String) As String
Public Function Char(ByVal c As Integer) As String

Public Function ChCR() As String

Public Function ChLF() As String

Public Function ChCRLF() As String

Public Function Split(ByVal s As String, Optional ByVal delimiter As String = ",") As
String()

Public Function SRound(ByVal value As Object, ByVal prec As Integer = @) As String
Public Function Hex2(ByVal value As Object) As String (15 -> “OF”)

Public Function Hex4(ByVal value As Object) As String (15 -> “©00F”)

Public Function ToHex(ByVal value As Object) As String (15 -> “F”)

Public Function FromHexString(ByVal value As String) As String (e.g. “41 42” - “AB”)
Public Function RGB(ByVal value As Object) As String (e.g. 255 > “©000OFF”)

Public Function RGBJSON(ByVal value As Object) As String (e.g. FFOOFF ->

{r(r.)):zss)”g»:e’»

b”:255)

Date Functions

Public Function

Now() As DateTime date and time in local format

Public Function

Today() As String date in local format

Public Function

Time() as String time in local format

Public Function
As DateTime

[Date](ByVal year As Integer, ByVal month As Integer, ByVal day As Integer)

Public Function

Year(ByVal d As DateTime) As Integer

Public Function

Month(ByVal d As DateTime) As Integer

Public Function

Day(ByVal d As DateTime) As Integer

Public Function

WeekDay(ByVal d As DateTime) As Integer

Public Function

NameOfDay(ByVal d As DateTime) As String

Public Function
number then loca
https://learn.mi

Format_DateTime(ByVal d As Object, ByVal fmt As String) As String (d is
1 Unix/Epoch time. d is date then local datetime. Otherwise now. See
crosoft.com/en-us/dotnet/standard/base-types/custom-date-and-time-format-

strings for fmt)

Public Function
number then GMT
https://learn.mi

Local DateTime(ByVal d As Object, ByVal fmt As String) As String (d is
Unix/Epoch time. d is date then GMT datetime. Otherwise now. See
crosoft.com/en-us/dotnet/standard/base-types/custom-date-and-time-format-

strings for fmt)

Public Function
Format_DateTime

Unix_time(ByVal n As Object) As String will be obsoleted with use of
and Local DateTime can perform the same function

Public Function
Format_DateTime

Unix_date(ByVal n As Object) As String will be obsoleted with use of
and Local DateTime can perform the same function

Public Function
Format_DateTime

Long_date(ByVal d As DateTime) As String will be obsoleted with use of
and Local DateTime can perform the same function
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Public Function Long_time(ByVal d As DateTime) As String will be obsoleted with use of
Format_DateTime and Local DateTime can perform the same function

Public Function Format_date(ByVal d As DateTime, ByVal fmt As String = Nothing) As String
will be obsoleted with use of Format_DateTime and Local_DateTime can perform the same
function

Public Function DateAdd(ByVal Interval As String, ByVal Delta As Integer, ByVal d As
DateTime ) As DateTime where Interval is
"dayofyear", "weekofyear", "year", "quarter", "month",K "week", "day", "hour" K "minute","second"

Misc Functions

Public Function Money(ByVal d As Object) As String

Public Function [If](ByVal cond As Boolean, ByVal TrueValue As Object, ByVal FalseValue As
Object) As Object

Public Function Entry(ByVal n As Integer, ByVal s As String, ByVal delim As String = ",") As
String

Public Function Index(ByVal s As String, ByVal search As String, ByVal delim As String =

,") As Integer

Public Function Inlist(ByVal search As String, ByVal list As String, ByVal delim As String =

,") As Boolean

Function DbNull() As System.DBNull

Public Function FileExists(ByVal f As String) As Boolean

Public Function Filelnfo(ByVal f As String) As 10.FileInfo

Public Function BasicAuth(ByVal username As String, ByVal password As String) As String

Public Function AES128(ByVal svalue As String, ByVal sKey As String) As String

Public Function MD5Hash(ByVal input As String) As String (e.g. MDSHASH(“username:pw”) )
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Operators

operator_plus +
operator_minus -
operator_mul *
operator_div /
operator_percent %
open_parenthesis (
comma ,
dot .
close_parenthesis )
operator_ne <>
operator_gt <=
operator_ge >=
operator_eq =
operator_le <=
operator_lt <
operator_and and
operator_or or
operator_not not
operator_concat &

any word starting with a letter or value_identifier

value_true true
value_false false

any number starting 0-9 or .
value_number

any string starting ' or "

value_string
open_bracket [
close_bracket ]
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6.5 Payload Storage

6.5.1 Plugin Device Features

The Payload of a MQTT message will usually be stored in the “A”ssociated HS device in either the
DeviceValue or DeviceString property of the device. The selected property will depend upon the setup
of the Control/Status Ul and Store Payload lines on the Edit tab for the Device/Topic as highlighted in
Figure 44.

Anytime Control/Status Ul is selected to be “Text” or “Sign”, or Store Payload is selected to be “Device
String” then the Payload will be stored in the Device String of the HS Device.

If Control/Status Ul is selected to be “jpg File” the Device String will contain HTML for thumbnail image
of the Payload stored in a file at HS subfolder \htmI\mcsMQTT\File\{floor\{room}\{name}.jpg and the
Device Value will increment for each time the Topic is received.

When Control/Status Ul is selected to be List or Button then a VSP relationship will be setup that uses
the text in the Payload to map into a number and then mcsMQTT will update DeviceValue with the
number.

When Control/Status Ul is selected to be Number or NumberChange then the Payload is expected to be
numeric, or has become numeric after using regular expression or expression capability of the Edit tab.
The number will then be stored in DeviceValue.

When Control/Status Ul is selected to be RGB, RGBW or HSB then the Payload is interpreted as a color
space definition and mcsMQTT will convert it into a 24-bit number and stored in DeviceValue

When Control/Status Ul is selected to be Slider then the Payload is expected to represent a percentage
in the range of 0 to 100. It may be necessary to use numeric expressions on the Edit tab to transform
the payload into a number of this range. The result will be stored in DeviceValue.

When Control/Status Ul is selected to be CSV then the Payload is assumed to be a comma-separated set
of numbers. A HS device will exist for each number and the DeviceValue will be updated.

When Control/Status Ul is selected to be Ramp then then a slider control and a rate number box is
presented for this topic. The slider will range from 0 to 100 (percent). The rate will be the number of
seconds for the slider value to go from 0 to 100. The example shown in Figure 43 will send commands at
a rate of (100 seconds / 100% = 1 second rate) with each command being an increase or decrease of 1%
value. The commands will stop when the target level is achieved.

test | test

O @ test (4472) Yesterday 10:24:25 AM

(| . Brightness (4473) 0% Today 11-54:29 AM @

test | String

O e Brightness:TransitionRate (4545) 100 (Seconds from 0 to 100%) Today 12:44:00 PM 100 SUBMIT

Figure 43 Transition Rate Ramp Contorl/Status Ul

Page 106



Start with Either Existing Device Ref or Subscribe Topic

Ref: 3348

Sub: owntracks/mecsSolutionsM1:lat

Delete Sub and Ref

Edit Setup or Edit of Subscription {Inbound) to a MQTT Topic

MQaTT

Subscribe Topic

Payload RegEx
Match Pattern
Payload RegEx
Replace
Pattern
Payload RegEx
Cperation

Low Pass Filter

Expression

Add Rate
Device

Add Accurn

owntracks/mecsSolutionsMA1:lat [ | Check to treat JSON key value as topic

® Replace Match Pattern with Replace Pattern O Extract Match Pattern
Filter sensitivity of| 1 (range is 0.00 to 1.00 {most sensitive])

(Range 0.00 to 1.00)

[ ]Create a HS Rate Device with rate sensitivity of | 0.75

) Per Second O Per Minute ® Per Hour
[1Create a HS Accum Device

Device
Ore Payload

N0 Reset ) Accumulation Since Midnig Belia Since Midnight
® |n HS Device Value ' In HS Device String ' RepomMMgtatus on null Payload

Sewinn= for Plugin Device

HS Device
Publis i

[ |

Device

Control/Status
11

() Unspecified ® Button O Toggle ' Mumber ' NumberChange O Slider ' Ramp
CSV O Text O List O RGE ) RGBW ) HSE O ColorXY O Sign O jpg File

HS Device
Location

ToCZ (FIO0TT [T —v—toe-fRoom-mersmmtore % | Name

|M1:lat
Max number of VSP |12

HS Device vep Favioad 47.5268014=0:47th Parallel VSF

List

HS Device
MISC
Properties
Grouping
Parent Ref
Publish
Payload
Template

URI Encode
Payload

MQTT Publish
to Sign
Publish QOS
Publish Retain
Flag

HS Energy
Databaze

Add/Edit |
Clear existing VSP

[INO_STATUS_DISPLAY [NO_GRAPHICS_DISPLAY [JAUTO_VOICE_COMMAND
[1SET_DOES_NOT_CHANGE_LAST_CHANGE WISHOW_VALUES [ ]STATUS_OMNLY

Create New Parent Device

8847

® Send unencoded
() Encode with URI encoding such as %20 for space
) Replace special characters with underscore

® Mormal Publish ' Publish to Messaging Sign
® AtMost O AtLeast O Exaclly
® Do not refain ' Retain at broker

® Do not save O Save as Watls

Settings for Non-Plugin Device

Control non-
Flugin HS
Device

HS Device Reference Number |:|

Mote additional customization of buitton text, display graphics, bution/number relationships etc. is done via HS
Device Management Fage by clicking on the Device Mame link and using the Status Graphic and Configuration tabs

Figure 44 Override to Store String rather than Value
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6.5.2 Non-Plugin Device Features

MQTT Payloads that are associated with HS Device Features have a more restrictive capability to update
HS DeviceValues and DeviceStrings. The MQTT Page, Edit Tab, Store Payload radio will identify if the
Payload will update the Value vs. String property of the HS Feature.

It is still possible to use Expressions and Regular Expressions to transform the received Payload prior to
updating the HS Feature.

A special case is available where DeviceValue is being updated, but the Payload is text. If the text
matches the Value Status Pairs (VSP) defined in HS for the Feature, then mcsMQTT will do the VSP
lookup to store the matching DeviceValue when the Payload is received.

6.6 Controlling HS Device via MQTT Topic
Lists of MQTT Topics that have been received are available for mapping into HS Devices on the
Associations Tab. The “A”ssociated checkbox or existing Device Reference is used to establish this
relationship. For mcsMQTT devices, Numeric changes in Payload are reflected in the HS DeviceValue.
Non-numeric Payload is reflected in DeviceString. The special case of Payload text of case-insensitive
ON, OFF, TRUE, FALSE, OPEN and CLOSED create a Device-Status pair with DeviceValues of 0 and 1 or
OFF/CLOSED and ON/OPEN, respectively.

The setup described previously in Section for associating Topics and Devices did not include the case
where an existing HS Device is to be controlled by a MQTT Topic. This setup is done in one of two ways.
The first is done on the Association Tab by entering a non-Plug-in Device Reference for a subscribed
Topic rather than using the “A”ssociate checkbox. That will associate the subscription as if it is a
command to control the existing HS Device. It can also be done on the Edit tab in either the Publish or
Subscribe tables. When the Association table is built with this hybrid type setup the row color will be
blue rather than pink or green. Figure 45 provides an example where non-Plug-in Device 72 is being
commanded by “RadarMotion2/SENSOR:Time”Topic and reporting status on “Dell-
PC/mcsMQTT/Unknown/Unknown/New4” Topic. The DeviceValue will be in the Payload as the default
if no substitutions are provided in the Payload template.

Substitutions in the publish template are indicated by use of expressions encased in “<<” and “>>". For
example, if the desire is to publish a 8 bit brightness value and the HS brightness is maintained as a
percentage. Furthermore, a JSON payload rather than just a raw number are to be published. A
template of ‘{“Brightness”:<<SSVALUE:*255/100>>} would be used.

The second method to associate MQTT topic with existing HS device is with use of the Subscription
Wildcard template available on the Client Tab. The HS Device identification will be included in the
received Topic and specified as a set of substitution parameters described in Table 2 and in the
template. This approach has the minimum setup for the user, but the incoming topics must follow a
standard pattern that complies with the wildcard. Note that when the wildcard is used the Outbound
(Publish) Management is usually also setup so changes in the HS device are reported via MQTT. See
Figure 1 and Section 4.1.20 for an example.

Further auto-association can be done such that all existing non-plug-in HS devices are associated with a
publish topic and subscribe topic. This option is selected with the radio selection at the same location as
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the subscribe wildcard on the Client Tab. Note that when the immediate selection is made the
associations are made at time of selection, upon use of the Enumerate button on General Tab or when
the plug-in starts.

Association Table for Auto Association of MQTT Topic and HS Device
i} r e a REF topic payload h d lastdate

Dev: Unknown|Unknown|Mews
Command HS Device on subscribed Topic:
RadarMofion2/5ENS0R: Time
0 e 72 Publish message on Device change using Topic: 0001-01-01 00:00:00
Dell-PC/mesMQTTUnknown/Unknown/News
Encode Payload per template:

Figure 45 mcsMQTT Devices Mapping to Specific MQTT Topics

When MQTT messages of this type are received the CAPI interface is used to control the HS Device. This
is in contrast with mcsMQTT devices that are changed by SetDeviceValueByRef and SetDeviceString
methods. The Plug-in will search through the CAPI interface and try to find a match with the Payload
received and then forward that CAPI control item to HS to have the HS Device controlled. The owning
Plug-in is responsible for updating Device String and Value as appropriate. Normally this update will
result in a HS Event callback indicating that a device status has changed. If a publish topic is setup for
this subscribe topic then the status change will be published unless the publish topic and subscribe topic
are the same.

6.7 MQTT Receive Event Triggers
Three forms of MQTT event triggers are available. One detects a Topic update. This is the “MQTT Topic
Received” event trigger. This is shown as the two lower events in Figure 46. The trigger occurs on
receipt of the Topic. If can optionally be specified further by a specific text somewhere in the Payload.
See Figure 34 where the MQTT event trigger is being setup. This is similar to event triggers that are
from changes in a mapped HS Device where a change in Payload is needed to trigger an event. In this
case the Payload text will be anywhere in the Payload while in the Device change trigger it is setup per
HS trigger specification rules.

The Payload text box has three options: simple text, regular expression, change.

Simple text is a match of the text anywhere in the payload. The conditional operators && and || can be
used to specify multiple conditions such as “id&&45”.

Regular expression is indicated in one of three formats. REGEX(expression), <<REGEX(expression)>>, or
<<expression>>. Match is found when the regular expression indicates one or more matches

Keyword ‘change’ is entered for the Payload field of a MQTT Receive trigger then the trigger will fire
whenever the received Payload for the specified Topic changes. This could be used to trigger on
changing textual Payloads which are not possible with the basic HS Event trigger based upon device
changes.

The receive trigger can be used as an event condition (AND IF / ORIF) .
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Event Name: Type Group Reassign:

—
= MQTTTimeout T Test ' ui o m m
IF MQTT Topic "GarageDoor/STATE:Time/#" not received within 2 minutes Ld u
Then Speak Timeout Ld m |
Options >
Event Name: Type Group Reassign:
El maTTTrigger Y| [Test I > 3PS x [¥5|
IF MQTT Topic "GarageDoor/#" received id |
Then Speak Garage d m u
Options >
Event Name: Type Group Reassign:
= -
£ [MQTTTrigger2 v [Test A > %1% x ¥/
IF MQTT Topic "Sonoff120/cmnd/+" received Ld [+
Then Speak Power Command Ld B |

Figure 46 MQTT Receive Event Triggers

The “MQTT Topic Timeout” trigger is used to determine that an expected periodic update has not been

received. The first event of Figure 46 shows this setup. The timeout duration is in minutes
and only one trigger will be produced after the timeout period. If the Topic is
subsequently received then the timer countdown is reset to enable triggering again.

6.8 Topic Wildcards
The “/”, “+” and “#” symbols have special meaning in MQTT Topics. The hierarchical structure of a
MQTT Topic is indicated with “/”. Generally, the order in the hierarchy is most general to most specific
much like the HS Locaation2/Location/Name hierarchy.

When specifying a receive trigger condition the “+” and “#” can be used as wildcards. The “+” indicates
that anything at the specified level of the hierarchy is acceptable. The “#” is used to indicate a match for
current and all subsequent levels of the hierarchy. Examples of these are used in Figure 46.

6.9 HomeAsistant Discovery
The home automation application Home Assistant has specified a protocol https://www.home-
assistant.io/docs/mgtt/discovery/ by which devices advertise their characterizes to facility including in
the Home Assistant application. Tasmota, among other devices, has support for this definition. In the
Tasmota case the discovery is advertised in the topic “homeseer/x/y/config” where x is the type being
advertised and y is the ID of the device. mcsMQTT will recognize this topic and automatically create HS
devices for the primary status and control aspects of the device. It will also make available other end
points in the Association tab for manual association with HS devices.
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6.1 Tasmota Discovery
Tasmota firmware has defined a discovery protocol specific to Tasmota devices to assist the client in
creating devices for the 10 setup in Tasmota. There are two Tasmota/discovery messages when the
Tasmota SetOption19 0 is used (in Tasmota versions 12 and later). Prior versions of Tasmota also
supported the HomeAssistant Discovery.

The first is tasmota/discovery/+/config where basic 10 devices are defined such as switches, relays and
lights. The second is Tasmota/discovery/+/sensors where sensor reporting is provided as part of the
topic. mecsMQTT will create HS Devices and Features for each sensor automatically if Automatic Device
Creation has been enabled on the MQTT Page, Client Tab. It will also create all simple relay and switch
configurations. When a Shutter has been announced it will create the normal shutter configuration.
When a Light has been announced it will create a dimmer control and a color picker control if Tasmota
also reports a Color capability.

Figure 47 illustrated the Last Will and Testament disclosure in HS Feature 1738. The simple relay in
1740, The color light in 1741 through 1743, the switch input in 1742, the shutter in 1745 through 1748.

Once a Feature has been created it can be removed from HS by using the MQTT Page, Association Tab
row by unchecking the “A”ssociate checkbox. Customizations of automatically created devices can be
done form the HS Devices Page.
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Availability | Availability

[ Availability (1737)
tasmota_E9AD3C | LWT

O o tasmota-E9AD3C-D060:LWT (1738) Online Today 1:43:10 PM

tasmota_ESAQ3C | tasmota_E9AD3C

[] tasmota_E9A03C (1739)
tasmota_E9AD3C | STATE:POWER3

=

O tasmota-E9A03C-0060:POWERS (1740) ON Today 1:43:14 PM

tasmota_E9A03C | STATE:POWER4

= T

O @lasmota—EgADSC—OOED:PDWER4 (1741)  OFF Today 1:43:14 PM

tasmota_E9A03C | STATE:Dimmer

O o tasmota-E9A03C-0060:Dimmer (1742) 19 % Today 1:43:15 PM @
tasmota_E9AD3C | STATE:Color

[l ° tasmota-E9A03C-0060:Color (1743) 663089 Today 1:43:15 PM
tasmota_E9AD3C | SENSOR:Switch1

O Switch1 (1744) ON Today 1:43:15 PM

tasmota_E9AD3C | SENSOR:Shutter1:Position

O @ Shutter1:Position (1745) Partial 37% Today 1:43:15 PM

tasmota_E9A03C | SENSOR:Shutter1:Direction

O o Shutter1:Direction (1746) Down Today 1:43:15 PM

tasmota_E9AD3C | SENSOR:Shutter1:Target

utter1:Target artial 37% oday 1:43:15 PN
sh 1:T: (1747 Partial 37% Tod 43:15 PM L

tasmota_EQAD3C | SENSOR:Shutter1:Tilt

| Shutter1:Tilt (1748) o Today 1:43:15 PM

Figure 47 Tasmota Discovery Device Creation Examples

6.2 Homie Discovery
Provisions exist for discovery per Homie definition https://homieiot.github.io/. While this definition is
more generic and has potential for more wide-spread adoption there are no devices that have been
integrated with mcsMQTT using Homie.

6.3 Scripting Callback
If a user desires to handle the raw MQTT received payload in a script then a callback can be used to
receive MQTT topics with their payload. This is setup with a call to the plug-in to register the script. The
RegisterTopicReceivedScript callback expects an array of three parameters. The first is the filename that
will be located in the HS scripts folder. The second is the name of the procedure in this file. The third is
the Topic that will result in a callback. Multiple Topics can be requested with multiple calls to this
function. MQTT Topic wildcards can also be used.
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hs.PluginFunction("mcsMQTT", "",
"RegisterTopicReceivedScript",{"MyScriptFileName.vb", "MyFunctionName",
"MyMQTTTopic"})

As an example, the following two scripts are used in the file TestCallback.vb. The first (Main) was
invoked by event with script action. The second (TheCallback) was invoked by mcsMQTT when it
received the MQTT Topic “test/topic”.

sub Main (parm as object)
hs.WriteLog ("TestCallback", "Registering Callback for Script")
Dim callbackParameters = New String {"TestCallback", "TheCallback", "test/topic"}

hs.PluginFunction (
"mcsMQTT",
"RegisterTopicReceivedScript",
callbackParameters
)
End Sub

sub TheCallback (parm as object)
hs.Writelog ("TestCallback", "Received Topic " & parm(0) & " with Payload " & parm(l))
End Sub

6.4 Scripting Receive
If a user desires to use capabilities built into mcsMQTT for other devices or data then they can simulate
the publication of a MQTT messages with the scripting function “ReceiveMqttMessage”. The
parameters consist of an array of two strings where the first is the Topic and the Second is the Payload.
A sample usage is below. In a real use the Topic and Payload parameters would be based on user data
rather that the static text in the example.

sub Main (parm as object)
hs.WriteLog ("TestReceive", "Simulating MQTT Message")
Dim sTopic as string = “Test/Topic”
Dim sPayload as string = “TestPayload”
hs.PluginFunction (
"mcsMQTT",
""7
"ReceiveMgttMessage",
{sTopic, sPayload}
)
End Sub
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7 Display Filtering/Sorting and Scripting Automation

7.1 Display Filtering and Sorting
The top of Association Tab contains a set of checkboxes, filter pull-downs and column buttons that can
be used to affect the presentation of rows on the Association Table. Each press of the button will act as
a request to sort the table by this column. Subsequent press toggles ascending vs. descending.

The general approach to showing the Association table is to setup the filters as desired and then click
the “Show Selected Associations” button. This is different than most other interactions with mecsMQTT
where immediate feedback is provided on each mouse click. It is done this way because of the time it
takes to generate the Association table and no desire to wait while intermediate results are shown as
each filter is selected.

In general, the filtering constrains the number of rows that show in the Association table. The exception
is the “Displayed Checkbox Columns” filter affects the columns being shown on the table.

Overriding filters are done with checkbox. The “Show All Associated Only” has precedence over the
Include checkboxes. The subsequent filter pull-down tables are updated to show the subset that match
the checkbox selections when these checkboxes are clicked.

The top filter pull-down is oriented to HS Devices. The lower pull-down and the text textbox filter is
oriented to MQTT Topics and JSON keys within these Topics. A combination of all can be used. The
more filters selected the fewer number of rows will be rendered.

Provisions exist for six levels in each the Topic hierarchy and JSON Payload items. The pull-down for
each of these twelve will show the different names that have been seen at each level of the hierarchy. If
a particular name is selected then only those rows are shown on the display. Multiple levels of filters
can be used.

At any segment level multiple selections can be made. This will behave as an ‘OR’ condition so any of
multiple values of this segment will be included in the filter. Each segment operates and an ‘AND’
condition. Furthermore, a priority exists such that when earlier (left-most) segments have filters, then
the later segments will show only available values after the earlier filters have been applied. For
example, assume Topics x/y, x/z and a/y/b have been received. When selector T1 has elected to include
only x, then T2 will only have a selection for z. Th a/y/b Topic will not be available because the earlier
topic has excluded it. Consider the example in In this case the T1 filter has shown that there is only
interest in Topics “shellies”, “Abode”, and “AirTouch”. From those available Topics only “shellypmmini-
ag032abxyz” is of interest. The JSON payload of these topics will only consider sys/+/stable. This results
in a single Association Table element being shown.

The mechanics of the ‘OR’ condition is that the last selected filter is shown in the pulldown selector.
Earlier selections are shown above it. If any of these to be deselected then reselect it from the pulldown
selector. If all of them are to be deselected the select the blank option available in the selector. If all
segment levels are to be deselected then the option to use the Clear Filters button can also be used.

The Rebuild Filters button is used when new MQTT message have been received and they are desired to
be included in the filter selection process.

Page 114



Filter by Mgtt Topic and JSON Payload Key

Clear Filters Rebuild Filters

Association Table for Auto Association of MQTT Topic and HS Device

P . . of lastdate

N Suby: shellies/shellypramini- 20240408
[ O O O a8032ab2dbaf:sys:available_updates:stableversion O 11:26:16

Figure 48 Association Table Filter Usage

The “Filter By Text” queries the mcsMQTT database (mcsMQTT.db) looking at all the text-oriented fields
as well as the HS Device Ref. This includes things like MQTT Payloads, Topics, VSP entries, Expressions,
Templates and others. The textbox can contain simple text or it can contain a regular expression that
specifies a textual sequence. Simple text is entered as the sequence of characters that must exist in one
of the database fields. Regular expressions are applied to the same fields and are specified in either of
three ways. << regular expression >>, << REGEX(regular expression)>> or REGEX(regular expression).
This is the same syntax used for HS Event triggers that are looking for text in the payload of a MQTT
message.
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Filter Table by Category

Displayed Checkbox Columns

Rejected Selections
Accepted Associations
COutbound Selections

Inbound Selections

Filter by Text

Filter by HS Device Categories

Clear Filters

Loc2 (Floor) Loc (Room)

Filter by Mqtt Topic and JSON Payload Key

Clear Filters

Exclude 0 & R Calumng_|
Exclude H,Dand | Columng_|
Include Rejected Message:lj

Show All Associated Only,
Include Mon-Plugin HS Dm-ice:lj

Include Received MOTT Topics_ |

Rebuild Filters

Type Interface

Rebuild Filters

Show Selected Associations

Association Table for Auto Association of MQTT Topic and HS Device
JAN [s] r e

payload s lastdate

Figure 49 Topic Filter Setup

There may be times where you want the Plug-in to ignore new Topics. It may be a situation where a
new device is being debugged and immature messages are being published. The “Disable New Topic
Recognition” checkbox on General Tab (Figure 40) Inbound (Subscription) table is used for this purpose.

Going even further the “Disconnect from MQTT Broker” checkbox on the Client Tab is used to total
disconnect mcsMQTT from the MQTT environment. In this case no MQTT messages will be sent or

received with mcsMQTT.

Presentation sort order is selected by the association table header buttons as shown in Figure 45.
Ascending vs. descending status is shown in the first column. The column with upper case text is the

sort field.
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7.2 Scripting Automation
Scripting interface consists of sending MQTT messages, setting up callbacks for received MQTT
messages, editing of the MQTT topic properties, process management support, database support, and
other access to mcsMQTT features. The first two of these are described in Section 5.4 and Section 6.3.
The third is described here with the four functions EditPropertyByRef, EditPropertyByTopic, ClearVSP
and AddVSP.

7.2.1 Edit of mcsMQTT Properties

Public Function EditPropertyByRef(ByVal sRef As String, ByVal sProperty As String, ByVal
sValue As String) As String

Public Function EditPropertyByTopic(ByVal sSource As String, ByVal sProperty As String,
ByVal sValue As String) As String

Public Function ClearVSP(ByVal sRef As String) As String

Public Function AddVSP(ByVal sRef As String, ByVal sPayload As String, ByVal sValue As
String, ByVal sStatus As String) As String

The returned value from these functions is normally null. When an error occurs the error message is
returned. All parameters are handled as strings.

A property is updated by providing a handle to either the HS feature reference number or the MQTT
subscribed topic. Two methods are provided for convenience and produce the same result. The
propery being modified is from the following set. While the input parameter is a string its contents will
need to comply with the data type (Boolean, Integer, or String) used by mcsMQTT.

Select Case sProperty
Case "Source"
OMQTT.Source = sValue
Case "Topic"
OMQTT.Topic = sValue
Case "Template"
OMQTT.Template = sValue
Case "Pattern"

OMQTT.Regex (@) = sValue
Case "Replace"

OMQTT.Regex(1) = sValue
Case "Match"

OMQTT.Regex(2) = sValue

Case "Reject"

OMQTT.Reject = CType(sValue, Boolean)
Case "Express"

OMQTT.Express = CType(sValue, Boolean)
Case "Elevate"

OMQTT.Elevate = CType(sValue, Boolean)
Case "ElevateKeys"

OMQTT.ElevateKeys = sValue
Case "URIEncode"

OMQTT.URIEncode = CType(sValue, Integer)
Case "Accept"

OMQTT.Accept = CType(sValue, Boolean)
Case "RetainFlag"

OMQTT.Retain = CType(sValue, Boolean)
Case "PluginDevice"
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OMQTT.PluginDevice = CType(sValue, Integer)
Enum RecordType
NonPlugin = @
Child = 1
Parent = 2
End Enum
Case "Subscribe"
OMQTT.Subscribe = CType(sValue, Boolean)
Case "Chart"
OMQTT.Chart = CType(sValue, Boolean)
Case "History="
OMQTT.History = CType(sValue, Boolean)
Case "StorePayload"
OMQTT.StorePayload = CType(sValue, Integer)
Enum RecordType
InDeviceValue = ©
InDeviceString =1
End Enum

Case "Ref"
OMQTT.Ref = CType(sValue, Integer)
Case "ChangeType"
OMQTT.ChangeType = CType(sValue, Integer)
Enum EventChangeType
IgnoreChange = ©
ValueChange =1
StringChange = 2
AnyChange = 3
LogChange = 4
ValueAndStringChange = 5
ValueAndLogChange = 6
StringAndLogChange = 7
End Enum
Case "Misc"
OMQTT.Misc = CType(sValue, Integer)
per HomeSeerAPI.Enums.dvMISC (HS3)
per HomeSeer.PluginSdk.Devices.EMiscFlag (HS4)
Case "QOS"
OMQTT.QO0S = CType(sValue, Byte)
Enum QOS
AT_MOST_ONCE = ©
AT_LEAST ONCE = 1
EXACTLY_ONCE = 2
End Enum
Case "StatusType"
OMQTT.StatusType = CType(sValue, Integer)
Enum StatusTypes
StatusOnly = @
Button 1
Number 2
Text =
List =
ColorPicker = 5
ColorXY = 6
NumberChange = 7
Sign = 8
CSsv =9
HSB = 10

B woa
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Slider = 11
RGBW = 12
Ramp = 13
Toggle = 14
jpgFile = 15
End Enum
Case "Broker"
OMQTT.Broker = CType(sValue, Integer)
Broker index 0, 1, or 2
Case "Reflist"
OMQTT.RefList = sValue
Case "Energy"
OMQTT.Energy = CType(sValue, Integer)
Case "VgpMax"
OoMQTT.VgpMax = CType(sValue, Integer)
Case “RateDevice”
oTransform.RateDevice = CType(sValue, Integer)
Case “RateSensitivity”
oTransform.RateSensitivity = CType(sValue, Integer)
Case “RatelInterval”
oTransform.RateInterval = CType(sValue, Integer)
Enum RateIntervals
PerSecond = ©
PerMinute = 1
PerHour = 2
End Enum
Case “AccumDevice”
oTransform.AccumDevice = CType(sValue, Integer)
Case “AccumReset”
oTransform.AccumReset = CType(sValue, Integer)
Enum AccumTypes

NoReset = ©

ResetTotal = 1

ResetDelta = 2
End Enum

Case “AccumMidnight”

oTransform.AccumMidnight = CType(sValue, Double)
Case “Expression”

oTransform.Expression = sValue
Case “FilterSensitivity”

This scripting facility provides great power over the configuration of mcsMQTT topics it comes with
corresponding danger to really mess things up. Use with caution and have appropriate backups with
specific focus on the \Data\mcsMQTT\mcsMQTT.db file where the knowledgebase of the properties
exists.

The following test script illustrates the use of these scripting methods.

Sub Main (parm as object)
'update publish Topic property using feature reference number
Dim sRef as string = "5656"
Dim sProperty as string = "Topic"
Dim sResult as string = ""
Dim sValue as string = "Sonoff/Bedroom/Light/cmnd"
Dim sArrayRef () as string = {sRef,sProperty,sValue}
sResult = hs.PluginFunction ("mcsMQTT","", "EditPropertyByRef", sArrayRef)
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if sResult <> "" then
hs.Writelog ("mcsMQTT", "MQTT SetProperty Message Failure " & sResult)
end 1if

'update MISC property using subscription topic

Dim sTopic as string = "pool/state/temps/bodies/1/pool/setPoint:setPoint"
sProperty = "Misc"

sValue = "4096"

Dim sArrayTopic() as string = {sTopic,sProperty,sValue}

sResult = hs.PluginFunction ("mcsMQTT","", "EditPropertyByTopic", sArrayTopic)
if sResult <> "" then

hs.Writelog ("mcsMQTT", "MQTT SetProperty Message Failure " & sResult)
end 1if

'update Expression property using subscription topic
sTopic = "Beacon/DD.0D.30.46.3D.2E"
sProperty = "Expression"
sValue = "{""Key"":""S$SSVALUE:+1""}"
Dim sArrayExp () as string = {sTopic,sProperty,sValue}
sResult = hs.PluginFunction ("mcsMQTT","", "EditPropertyByTopic", sArrayExp)
if sResult <> "" then
hs.Writelog ("mcsMQTT", "MQTT SetProperty Message Failure " & sResult)
end 1if

'define new VSP values and statuses
Dim sArrayClear () as string = {sRef}
sResult = hs.PluginFunction ("mcsMQTT","","ClearVSP", sArrayClear)
if sResult <> "" then
hs.Writelog ("mcsMQTT", "MQTT ClearVSP Message Failure " & sResult)
end 1if

Dim sPayload as String = "CLOSE"

Dim sNumber as String = "0"

Dim sStatus as String = "CLOSED"

Dim sArrayClose() as string = {sRef,sPayload, sNumber,sStatus}

sResult = hs.PluginFunction ("mcsMQTT","", "AddVSP", sArrayClose)

sPayload = "OPEN"

sNumber = "1"

sStatus = "OPENED"

Dim sArrayOpen() as string = {sRef,sPayload, sNumber,sStatus}

sResult = hs.PluginFunction ("mcsMQTT","", "AddVSP", sArrayOpen)

'Error Examples

sTopic = "Beacon/DD.0D.30.46.3D.2E"
sProperty = "BadProperty"
sValue = "dontcare"

Dim sArrayTypol () as string = {sTopic,sProperty,sValue}
sResult = hs.PluginFunction ("mcsMQTT","", "EditPropertyByTopic", sArrayTypol)
if sResult <> "" then

hs.Writelog ("mcsMQTT", "MQTT SetProperty Message Failure " & sResult)
end 1if

sTopic = "Beacon/BadTopic"
sProperty = "dontcare"
sValue = "dontcare"

Dim sArrayTypo2 () as string = {sTopic,sProperty,sValue}
sResult = hs.PluginFunction ("mcsMQTT","", "EditPropertyByTopic", sArrayTypo2)
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if sResult <> "" then

hs.Writelog ("mcsMQTT", "MQTT SetProperty Message Failure " & sResult)

end if
end Sub
Time From Type Message
16/22 /2028 1@:42:48 AM Script mCsMQTT MQTT SetProperty Message Failure Beacon/BadTopic not recognized as a subscribed topic
18/22/2920 108:42:48 AM Script mcsMQTT MQTT SetProperty Message Failure BadProperty is not recognized
18/22/920 10:42:48 AM HomeSeer Event Running script in background (EditProperty): EditProperty.wb
18/22/2920 108:42:48 AM HomeSeer Event Event Trigger "UnNamed EditProperty”
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7.2.2 Process Management Scripting Helpers

Assistance for process management is provided with the two methods “Shutdown” and “Processld” as
parameters to the “PluginFunction” method. The following invocation will result in mcsMQTT going
through an orderly shutdown. This will normally be followed by HS automatically restarting mcsMQTT
since the process has disappeared from HS.

hs.PluginFunction("mcsMQTT", "", "Shutdown", {""})
The immediate script command from an event for HS4 prefixes with &n so

&nhs.PluginFunction("mcsMQTT", "", "Shutdown", {""})

To get the process Id for mcsMQTT the following call is made. This can be useful if a
need exists to monitor or shutdown the mcsMQTT process using shell commands. It will
return the integer value for process Id or © if mcsMQTT process has not yet been
identified.

processId = hs.PluginFunction("mcsMQTT", "", "ProcessId", {""})

The plugin mcsMonitor is included in the Updater package, but not normally installed. If
HSPI_mcsMonitor.exe is copied to the HS folder, and enabled, it will monitor the HS log
for one of the following two conditions by default. These can be changed and others
added from the Config page of mcsMonitor as shown in Figure 50. If either is met then it
will use the above two methods for an orderly shutdown of mcsMQTT which will then be
followed by it’s restart by HS. This work-around is provided for the case where the
bellow conditions have occurred and root cause has not yet been identified.

"Plugin mcsMQTT is not responding but it is still running, not restarting yet."

"Dropping event callbacks due to full queue”

HS Log Monitor Patterns to Restart mecsMQTT

|F’Iugin mesMOTT is not responding but it is still running, not restarting yet.

|Dmpping event callbacks due to full queue

Figure 50 mcsMonitor Config
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A preferred method for monitoring mcsMQTT is to setup an event where there is an expectation of
some periodic event such as the value of a MQTT device being updated. When this trigger occurs then
execute the action of restarting mcsMQTT plugin. This restart capability of mcsMQTT, and all HS plugins,
is available when the Association Table Topics starting with HS/ have been associated with HS Devices.

In lieu of running a plugin to perform monitoring it is also possible to run the same code in a script that
would normally be run as part of the HS startup script. Some modifications are required to put the code
in the scripting context, but central logic does not need to change.

Function InitHW() As String
Dim sResult As String
Try
sResult = InitialInit ()
With PeriodicStatusTimer

.Stop ()
.Interval = 10000
.AutoReset = True
.Start ()

End With

callback.RegisterEventCB (HomeSeerAPI.Enums.HSEvent.LOG, PLUGIN NAME, "")
oHSEventCollection = New System.Collections.Queue

oHSEVentThread = New System.Threading.Thread (AddressOf DoHsEvent)
oHSEVentThread.Start ()

RegisterConfigPage (CONFIG PAGE)

logList = New Generic.Dictionary(Of String, String)
Dim section As String = hs.GetINISection (GENERAL GROUP, INI FILE)
If section <> "" Then
Dim items () As String = Split(section, Chr(0))
gBusy = True
For k As Integer = 0 To items.Length - 1
Dim arrKVP() As String = items (k) .Split("=")
If Not loglList.ContainsKey (arrKVP(0)) Then
logList.Add (arrKVP(0), arrKVP(1l))
End If
Next
gBusy = False
End If

If logList.Count = 0 Then

logList.Add ("RO", "Plugin mcsMQTT is not responding but it is still
running, not restarting yet.")
logList.Add ("R1", "Dropping event callbacks due to full queue")
End If

For Each sLog As String In logList.Values
Console.WritelLine ("Monitoring HS Log for " & sLog)
Next

Return ""
Catch ex As Exception
hs.WriteLog(PLUGIN_NAME, "InitHW " & ex.Message)
Return "InitHW " & ex.Message
End Try
End Function
Private Function InitialInit() As String

Try
If InStr (My.Application.Info.DirectoryPath, "\") = 0 Then
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slash = "/"
glinux = True

Else
slash = "\"
glinux = False
End If

If hs Is Nothing Then
MsgBox ("Unable to access HS interface")

Else
hs.WriteLog (PLUGIN NAME, "Version " &
My.Application.Info.Version.Major & "." & My.Application.Info.Version.Minor & "."
My.Application.Info.Version.Revision & " Registered with Homeseer")
End If
Return ""

Catch ex As Exception
hs.WriteLog (PLUGIN NAME, "InitialInit " & ex.Message)
Return ex.Message
End Try
End Function

Public Sub HSEvent (ByVal EventType As Enums.HSEvent, ByVal parms () As Object)
Implements HomeSeerAPI.IPlugInAPI.HSEvent
Try
SyncLock oHSEventCollection.SyncRoot
oHSEventCollection.Enqueue (parms (3)) 'log message
oEventQueueWaiting.Set ()
End SyncLock

Catch ex As Exception
hs.WriteLog (PLUGIN NAME, "HSEvent " & ex.Message)
End Try
End Sub
Public Sub DoHsEvent ()
Do While Not gShutdown
Try
Dim bRetry As Boolean = True
Dim iQueueSize As Integer
Do While bRetry AndAlso Not gShutdown
Try
SyncLock oHSEventCollection.SyncRoot
iQueueSize = oHSEventCollection.Count
End SyncLock

Do While iQueueSize > 0 AndAlso Not gShutdown
Try
Dim sLog As String = oHSEventCollection.Dequeue ()
For Each sMatch As String In logList.Values
If InStr(sLog, sMatch, vbTextCompare) > 0 Then

RestartIt ()
oHSEventCollection.Clear ()
Exit For
End If
Next
SyncLock oHSEventCollection.SyncRoot
iQueueSize = oHSEventCollection.Count

End SyncLock

Catch ex As Exception
oHSEventCollection.Clear ()
iQueueSize = 0

End Try
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Loop
bRetry = False
Catch ex As InvalidOperationException
Catch ex As Exception
hs.WriteLogEx (PLUGIN NAME, "DoHSEvent Thread", ex.Message)
End Try
Loop
If gShutdown Then
Console.WriteLine ("HSEvent Shutdown™)
End If

Catch ex As Exception
hs.WriteLogEx (PLUGIN NAME, "DoHSEvent", ex.Message)
End Try

If Not gShutdown Then
oEventQueueWaiting.WaitOne ()
End If
Loop

End Sub
Private Sub RestartIt ()

If gProcessId <> 0 Then
hs.WriteLog (PLUGIN NAME, "Stopping mcsMQTT process " &
gProcessId.ToString())

Try
Dim oProcess As Process = Process.GetProcessById(gProcessId)
If oProcess IsNot Nothing Then
'pid = oProcess.Id
Console.Writeline ("Monitor requesting mcsMQTT Shutdown™)
Try
hs.PluginFunction ("mcsMQTT", "", "Shutdown", {""}) 'let plugin
do orderly shutdown. Expect process to disappear at this point
Catch ex As Exception

Console.WriteLine ("mcsMQTT PluginFunction call error " &
ex.Message)
End Try
Try
oProcess = Process.GetProcessById(gProcessId)

If oProcess IsNot Nothing Then 'oProcess.Id = pid Then
Console.WritelLine ("Killing mcsMQTT Process")
Try
oProcess.Kill ()
oProcess.WaitForExit (100000)
Catch ex As Exception
Console.WriteLine ("mcsMQTT Process Kill Error " &
ex.Message)
End Try
'Exit For
End If

Catch ex As Exception
'process has succefully stopped
End Try
'Next
Console.WritelLine ("mcsMQTT Process Abort Completed")
End If

Catch ex As Exception
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Console.WriteLine ("Process
unable to stop.")
End Try
End If
'setup for next monitoring
gProcessId = 0
PeriodicStatusTimer.Start ()

& gProcessId.ToString & is not running,

End Sub

Private Sub PeriodicStatusTimer Elapsed(ByVal Sender As System.Object, ByVal e As
System.Timers.ElapsedEventArgs) Handles PeriodicStatusTimer.Elapsed
Try
gProcessId = hs.PluginFunction ("mcsMQTT", "', "ProcessId", {""})
If gProcessId <> 0 Then
PeriodicStatusTimer.Stop ()
hs.WriteLog (PLUGIN NAME, "mcsMQTT is process " & gProcessId.ToString)
Console.WritelLine ("mcsMQTT is process " & gProcessId.ToString)
End If
Catch ex As Exception
End Try
End Sub
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7.2.3 Custom Database Scripting

7.2.3.1 Expand Database

mcsMQTT integrates the Ul with database functions for message history and device history. A custom
SQLite database table can be created and data store in the database via scripting methods. The scripting
methods of interest to support this are bolded in the sample script below

CreateCustomDatabase, SaveToCustomDatabase and Replacement will normally be used
with the custom database.

CreateCustomDatabase accepts an array of column names (fields) that are to be created in the
MQTT_Custom table of the MQTTHistory.db database. mcsMQTT prepends the fields Sequence and
LastDate. This method can be call once or each time data is being written. It is not possible to alter the
set of columns after they have been created. Options are to manually edit the structure or to delete the
table and let a new one be created.

SaveToCustomDatabase accepts the same size array of values to store. mcsMQTT populates the
Sequence and LastDate fields automatically.

Replacement is a means to get access to data using replacement variables. These variables are defined
in Table 2.

The script below is design to be run on receipt a MQTT topic. The expected payload is CSV. A set of
fields are parsed from the CSV data and the values are stored to the database.

Sub Main (parm as object)

Const ENTER LOCATION as String = "MainGate"

Const EXIT LOCATION as String = "ExitGate"

Const NANNY CODE as String = "1234"

Const URL_TOPIC as String = "192.168.1.248:8992.TCP"
Const KEYPAD GLOBAL as String = "KeypadExitTime"

'parms contains the received message payload which is expected to be
CSV string such as

! 2022-03-25T09:10:39, Confirmation=202, GateExit, Function=99,
Code=1234

Dim payloadOfInterest = "S$SPAYLOAD: (" & URL TOPIC & "):"

Dim payload as string = hs.PluginFunction ("mcsMQTT", "",
"Replacement", {" & payloadOfInterest & "})

'parse and validate the data
Dim arrCSV () as String = payload.Split(",")
if arrCSV.Length < 2 then
exit sub
end if

'setup the database fields and put the parsed data values in the
appropriate fields

Dim arrFields () as string =
{"Confirmation", "Location","Function", "Code", "Button", "Minutes"}
Dim arrvalues() as String = {llll,llll,llll,"","",""}
for ivValue as integer = 1 to arrCSV.Length - 1
Dim arrKeyValue() as string = arrCSV(ivValue) .Split("=")
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'the location field does not have a key, but only a value such as
"MainGate"
if arrKeyValue.Length > 1 then
for iField as integer = 0 to arrFields.Length - 1
if arrKeyValue(0).Trim = arrFields(iField) then

arrValues (iField) = arrKeyValue(l) .Trim
exit for
end if
next
Else
arrValues (l) = arrCSV(ivValue) .Trim
End if

next

'Use global variable to remember when Nanny entered
Dim enterTime as object = hs.GetVar (KEYPAD GLOBAL)
if enterTime is Nothing then
hs.CreateVar (KEYPAD GLOBAL)
enterTime = now
end 1if

if arrValues(l) = ENTER LOCATION then
arrValues (arrValues.Length-1) = 0
enterTime = now
hs.SaveVar (KEYPAD GLOBAL,enterTime)
end if

'Minutes database field is computed. O for all records except Nanny
Exit
arrValues (arrValues.Length-1) = 0
if arrValues(l) = EXIT LOCATION andalso arrValues(3) = NANNY CODE then
if isDate(enterTime) then
arrValues (arrValues.Length-1) = DateDiff (DatelInterval.Minute,
enterTime, Now)
end if
end if

'put the data in the database

hs.PluginFunction ("mcsMQTT", "", "CreateCustomDatabase",arrFields)

hs.PluginFunction ("mcsMQTT", "", "SaveToCustomDatabase",arrValues)
End Sub

7.2.3.2 Retrieve Data

The scripting method ReadDatabase is available to request values for a specified duration from the
Long-Term database. The input parameter is an array with the first element being the Ref number as a
string. The optional second and third parameters provide the date range being retrieved. Data from the
last 30 seconds is retrieved if no range is specified.

InfluxDB contains an implicit date field while the other databases use LastDate as the field name. If data
was recorded with UTC date, then the returned data will also be UTC. InfluxDB data is returned in
ordered pairs of [date,value]. If multiple values are returned then the pairs will be comma-separated.
JSON format is used for others {“LastDate”:”yyyy-mm-dd hh-mm-ss”}, {“LastDate”:"yyyy-mm-dd hh-mm-
ss”} etc.
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Dim arrQuery() as string = {iRef.ToString()} ',optional startDate,
startTime as 2nd and 3rd parameters - default last 30 seconds

Dim sResult as String =
hs.PluginFunction ("mcsMQTT","", "ReadDatabase", arrQuery) 'read value recorded
in last 30 seconds

7.2.3.3 Write Data

The scripting method WriteDatabase is available to store values in the existing database. The parameter
array contains three string entries such as WriteDatabase({“123","first_kitchen_lamp,mytag”,”100"})
where “first_kitchen_lamp” is the Loc2_Locl_Name to be stored in “device” database field, “mytag” is a
tag field, “100” is stored in the “value” field. “123” is the Ref of the device which is used to know what
format is expected in the “device” field.

'(0) = iRef
'(1) = FieldName, Tag ,Tag is optional
'(2) = value

7.2.3.4  Execute SQL Command

The scripting method ExecuteDatabaseCommand is available to deliver SQL commands to the database.
The parameter array contains one item which is the SQL command. For example, the following will
remove all records for the device field that contans the name first_kitchen_lamp.

Function Main (parm as object) as String
Dim arrQuery() as string = {"DELETE FROM mcsmgtt WHERE device=' first kitchen lamp’'"}
Dim sResult as String = hs.PluginFunction ("mcsMQTT","", "ExecuteDatabaseCommand", arrQuery)

End Function
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7.2.4 PluginFunction Reference Methods
The full list of methods that are contained with mcsMQTT PluginFunction scripting call is listed below.
Most are previously described in the context of where they may be used.

Return SendMqttMessage(parms)

Return ReceiveMqttMessage(parms)
Return RegisterTopicReceivedScript(parms)
Return SendVoiceMonkey(parms)

Return CreateCustomDatabase(parms)
Return SaveToCustomDatabase(parms)
Return Replacement(parms)

Return ReadDatabase(parms)

Return WriteDatabase(parms)

Return ExecuteDatabaseCommand(parms)
Return Processld(parms)

Return Shutdown(parms)

Return Name(parms)

Return PagePrelLoad(parms)

Return EditPropertyByRef(parms)

Return EditPropertyByTopic(parms)
Return ClearVSP(parms)

Return AddVSP(parms)

Page 130



8 History
The History feature of mcsMQTT provides a means to record all or a subset of HS DeviceValues and/or
MQTT Topics and Payload that pass through mcsMQTT.

Two types of database repositories are available. Long term or high-volume data can be stored in
InfluxDB, mySQL or MS SQL Server. Shorter term data for use in analysis is stored in SQLite.

The overall data collection parameters are available on the top of the History tab shown in Figure 51.
The Association page “H”istory, “L”ongTerm, and “S”hortTerm columns provide retention selection on
an item-by-item basis.

Assocations Edit/Add Publist/Sign General History Chart

Long Term History (Fxternal Network Database InfluxDB, MySQL or SQL Server)

InfluxDB-1 )
Metwork Database InfluxDB2 O
MysaL @
MS SQL Server (O
IP of External Database 127.0.0.1
Bucket /Database Name MQTT7
Measurement / Table Name mesMQTT
Organization Id (InfluxDE 2 only) /
U root
sername
Authorization Token / Password sees
LocZ_Locl_Name @)
LocZ_Locl_MName_Ref (D
Field Format
ref QO
Name (O
Loc2_ Locl_Parent Name (D
Extra Identification Fields Ref=S5REF:

Figure 51 Hitory Data Collection Setup
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8.1 Long Term Storage in Network Database (InfluxDB, mySQL, SQL Server)
One of the four available long-term network-connected is selected for mcsMQTT to use. This selection
is based primarily on a user’s environment and which database they are most comfortable. mcsMQTT
will create that database (or buckets) it will use. It will also create the schema used in the database.
These database and schema parameters are specified at the top of the History tab.

The long-term data storage is enabled by providing an IP address of the database which is the first row
on the History Tab shown in Figure 51. If an IP (or network name) is not entered then long term storage
will not be enabled.

Different authentication methods are used based upon the database type selected. Influx 1.8, mySQL,
and SQL Sever can be used without entry of username and password if the user has setup their
providers to no require authentication. In the MS Server case authentication is required, but can be
setup as integrated with Windows login credentials. In this case username and password fields are left
blank in mesMQTT. Influx DB2 requires a authentication token and requires an Organization Id. When
using InfluxDB 2.0 the token is generated by the InfluxDB Ul tools. It will be a long string of characters.
When using InfluxDB 1.8 the token is entered as username:password and the username field in
mcsMQTT is left blank.

Data storage will include a timestamp, device identification, and DeviceValue. Device identification can
be one of several formats which are selected by a radio button. The field format radio should be
selected to make the record unique. The Floor, Room and Name options are under user control. The
Ref option uses a number assigned by HS so if a device is deleted and then recreated in the future it will
get a new Ref number and could be more difficult to identify in the database.

If a user desires to have additional data recorded then they specify the additional fields in the additional
identification fields text box. The additional identification fields can be used to help with query of the
data for Graphana or other uses. The data is entered as a set of key-value pairs which each pair
separated by comma. Replacement variables will often be used and expressions are also allowed. An
example of adding three fields (Category, Derived, and Location) to the measurement is shown below.
The value of each being determined by replacement variables.

Category=$$TAG:,Derived=<< (ROUND ($S$DVR: (123) : +$SVALUE:) /2, 1) >>,Location
=SSFLOOR: S$SSROOM: S$SSNAME:

The recording of a record in the database will be performed each time an identified HS Device (Feature)
has been set by user, HS or any plugin action. The recording conditions are specified globally on the
History tab as shown in Figure 52 and individually on the Association tab with use of “L” checkbox
shown in Figure 53.

To reduce the amount of data being stored for cases where only small changes in values are occurring it
is possible to specify a dead band or hysteresis that must be exceeded between writes to the database.
Settings exist for global default on the History Tab and for individual devices on the Edit Tab. A negative
value entered on these fields indicate that no filtering should be done. This is the same as a zero value
in both the global and individual hysteresis settings.

Page 132



All History

Save histary Of only devices marked With L or S column checkbox @)
HE Device History . -
= ’ Save history Of all devices in short term S0Lite O

Save history Of all devices in long term InfluxDB, mySQL or SOL Server

Figure 52 Database Storage Global Settings

The selection of the Devices (Features) to be used is done on the Association Tab using the checkbox in
the “L”ongTerm column. This checkbox will only be available on children Devices (Features) available in
HS. An example is shown in Figure 53.

Association Table for Auto Association of MQTT Topic and HS Device

a ref payload lastdate

D D D 4032 B83264706F6FF973EBO678CC747ACD76D
Dev: GW1000|GW1000|baromabsin
Sub:

83264706F6FF973EB0678CCT47ACDT6D:baromabsin

O O O EUEC FUb: the following Topic on Device command 29.545 0 0

Figure 53 Selection of HS Devices/Features for Recording in Long Term Database

Use of the data recorded in Long Term Database will typically be for use with external charting and
analysis tools, also can be viewed from within mcsMQTT on the History tab and Chart tab of the MQTT
Page. On-demand chart requests are also available. Grafana is a popular graphic package that is
compatible with InfluxDB and mySQL. mcsMQTT has no built-in support of charts using Grafana, but the
data recorded by mcsMQTT can be used with Grafana. mcsMQTT uses .NET tools for charting.

The internet is a good source for site installation of a network database. For those who want to use RPi
for InfluxDB this purpose the following is provided as a good source to walk one through it. It will install
a version 1.8 of InfluxDB on a standard 32 bit RPi image.

https://pimylifeup.com/raspberry-pi-influxdb/

It will contain a sequence of commands that will be entred to accomplish the installation. They are
copied here for ease of reference

sudo apt update

sudo apt upgrade

wget -qO- https://repos.influxdata.com/influxdb.key | sudo apt-key add -
echo "deb https://repos.influxdata.com/debian buster stable" | sudo tee
/etc/apt/sources.list.d/influxdb.list

sudo apt update

sudo apt install influxdb

sudo systemctl unmask influxdb

sudo systemctl enable influxdb

sudo systemctl start influxdb
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influx

CREATE DATABASE pimylifeuptemperature

USE pimylifeuptemperature

INSERT temperature,location=living_room value=20

INSERT temperature,location=living_room value=10

INSERT temperature,location=bedroom value=34

INSERT temperature,location=bedroom value=23

SELECT * FROM temperature

SELECT value FROM temperature WHERE location='bedroom'

CREATE USER admin WITH PASSWORD 'xxx' WITH ALL PRIVILEGES
sudo nano /etc/influxdb/influxdb.conf

auth-enabled = true

pprof-enabled = true

pprof-auth-enabled = true

ping-auth-enabled = true

sudo systemctl restart influxdb

influx -username admin -password xxx

InfluxDB version 2 is emerging with downloads available for 64-bit images at
https://portal.influxdata.com/downloads/ . When version 2 is used there is a requirement that
authentication and organizations be identified. This is setup during the initial run after the install. This
setup will also include the creation of a bucket for the data. This in contrast with version 1.8 where
mcsMQTT is able to create the bucket if not already setup.

Some other differences are that the authentication is optional with 1.8 and if included the
Authentictioan Token is username:password. For version 2 a token needs to be generated within
InfluxDB (https://docs.influxdata.com/influxdb/cloud/security/tokens/create-token/) and then used in
the mcsMQTT setup. Version 2 also requires that an organization id be specified. Like the bucket this is
handled during the initial setup. The org id for version 2 needs to be transcripted into the mcsMQTT
setup. Note this is the org Id and not the org Name. The Id is needed when creating the database
bucket. When using InfluxDB versions before 2, the organization Id needs to be blank so mcsMQTT will
know which database version is being used.

MySQL and MS SQL Server have free community editions that are well documented and included tools
for viewing the schema and data.

8.2 Short Term Storage in SQlite
Data stored in SQLite database is intended for near term analysis. At the start of each day mesMQTT
removes records from the database that are older than the retention period setup by the user. There
are no specific retention limits for the SQLite data, but large datasets will tend to have higher CPU
utilization and greater potential for corruption. The SQLite database is located at
data\mcsMQTT\mcsMQTTHistory.db.

Page 134


https://portal.influxdata.com/downloads/

Use of SQLite for history data is enabled from the History Tab by selecting a non-zero value for the
number of days of history that will be retained. If this field is blank then no short-term data will be
collected.

The selection of data for retention in the SQLite database is the same as for the LongTerm data with
global settings on the History tab and individual device settings on the Association Tab in the
“S”hortTerm column checkbox.

8.1 Viewing History Data

Access to the History data is from the History Tab and Chart Tab. It will present a checkbox and pull-
down selectors as shown in Figure 54 to select from the total History in the database. In this figure’s
example all data between April 1, 2018 and April 2, 2018 that start with Topic GarageDoor is being
selected.
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Filter SQLite History by Category

Diabe Rarige (Slarl,Enc) Or (SingleDay) 1/4/2020,1/5/2021

Culbound Messages riclude Puilished bessges D

sl e rclude Received bescapges

Filter by HS Device Categories
Clear Filters Rebuild Filters

Lo (Raam) Lo (Floor) Typea Interfaca

Filter by HS Device

Shiw Selected S0 ite Dévioe History

Show Selected InfluxDE Device History

Filter by Mett Topic and JSOMN Payload Key

Clear Filters Rebaiild Filters

0 fhzort _roomd_namel 201 2-00T03:45:08 5451201687 50
1 Unknown_Unknown_Control — 2020-12-20T03: 4806 43600642 mull
2 gw000_date_data:humidityin 2020-12-20T04:04:07 5044047747 il
3 gw1000_data_datahumidityin 2020-12-20T04:08:3% 5707560687 null
4 gw1000_data data:humidityin 2020-12-20T04:22:24. 4150455477 null
5 gw1000_date_datethurnidityin 2020-12-20T04: 23006 2HX00EE47 null
& Unknown_Unknown_Control — 2020-12-31 T22:22:28 2645079557 null
7 Unknown_Unknown_Control — 2020-12-31T22:2410. 5087042647 mull
& Unknown_Unknown_Control — 2020-12-31T22:42:05. 6785083237 null

Figure 54 History Filter Selection and Device Display

History data can be viewed from either the ShortTerm or LongTerm database in a tabular format on the
History Tab and graphical format on the Chart Tab. This section describes the tabular format.

ShortTerm is able to collect either MQTT messages and payloads or HS Device Values. LongTerm is able
to only collect data resulting from HS Device Value changes. Three “Show” buttons are provided to view
MQTT Topic history, HS Device History from SQLite and HS Device History from LongTerm database. It
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also provides filters to constrain the amount of data that presented so it will be easier to locate in the
table that is rendered. These are shown in Figure 54.

When the “Show Selected ...” button is clicked the database is queried and the first 20 rows of the
selected history is shown in the table. An example is in Figure 55. At the top of the table are four
buttons that when clicked will sort the data in that column in ascending of descending order. The first
column P/S shows the Subscription Topics and Publish Topics.

Note that the full Topics are displayed vs. the individual JSON items had JSON decoding been selected.

Scrolling buttons are provided to advance through the history data if more than 20 rows are presented
based upon the filters selected. A text box entry is also presented to allow 20 records to be selected
starting at a particular position. In general, it will be more convenient to use the filters to show a limited
set of data rather than using the scrolling/windowing provisions.

Message History

P/5 LastDate Topic Payload

of s |Rnie0e HHlteredWaterﬂNFoz ["WebServerMode":"Admin", "Hostname":"FilteredWater", "IPAddress":"192.168.0.4"}
1) s |00 HFiItered‘.".'ater.-’INFO2 ["WebServerMode":"Admin", "Hostname":"FilteredWater", "TPAddress":"192.168.0.4}
2 s %21590;08 HHIteredWaterﬂNFO2 {"WebServarModa":"Admin", "Hostname":"FilteredWater”, "IPAddress":"192.168.0.4"}
3 S %gijD;SDB HFiItered‘.'\.'ater.-‘INFO2 {"WebServarModa":"Admin", "Hostname":"FilteredWater”, "IPAddress":"192.168.0.4"}
4| s %g:lgg?gaua HHIteredWater,l’INFO2 ["WebServerMode™"Admin”, "Hostname":"FilteradWatar”, "TPAddress™:"192.168.0.4"}
5[ s %gléug‘ous HFilteredm.laterﬂNFoz ["WebServerMode™ " Admin”, "Hostname":"FilteredWatar”, "TPAddress™ 192, 168.0.4"}
6| s o HHIteredWaterfUP‘l‘IME ["Time":"2018-04-08T17:02:00", "Upkime": 1}

2016-04-08 . TTime © 2018-04-08116:22:18", "Uphime 1384 367, 'VcC'-3.105, "Wl :['AP" 12, "SSId" Anther’,
715 |iz2e:0 HF"tered"""ate”ST""TE "RSSI":74, "IPAddress":"102.166.0.4", "APMac"s"EQ:3F:40:2D:B0:68"1)

2016-04-08 TTime'© 2018-04-08116:08:29", "Uptime 1384 267, "VcC'-3.105, "Wl : AP 12, "SSId" Anther,
Bl 5 |izoenm H"_"teredwaterfsmﬁ "RSSI":72, "IPAddress":"102.166.0.4", "APMac"-"EQ: 3F:43:2D:B0:68"1)

s HFiItered‘.".'ater.-’UP‘I‘[ME {"Time":"2018-04-08T16:02:00", "Uptime™:1}

Figure 55 MQTT Topic History Display
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9 Charts

The Chart tab of mcsMQTT provides a means to graphically observe the time history of a particular item
that had been collected in the History database. See Section 8 for setup associated with collection of
history data.

Time history can be collected for MQTT subscribe and publish message and it can be collected to HS
Device Value changes. The MQTT messages are identified by Topic. The HS Devices are identified by
Device Reference. One of the two can be selected for each of up to two vertical axes.

The History tab selects the global conditions for collection of data to be charted. The Association tab
identifies specific items to be available for charting. The Topic selectors on the Chart tab will provide
the list of potentially available items. The selectors can be all topics with numeric data or can be filtered
with the Topic-based selectors at the top of the page and the “Topic Selector” checkbox to include only
associated topics which is located just above the selectors. Text filters can also be used in a similar
manner.

The chart setup is specified by five selections shown in Figure 56. The Date range can be a single day or
span of days. The start time of the earliest date and end time of the latest date can be specified if
partial days are to be used to get finer resolution of the displayed data.

Lines can be selected for either left or right Y axis. Left axis lines are solid and right axis lines are dashed.
Labels and colors are used to identify lines on the chart. If minimum and/or maximum values for the Y
axis is specified then they will be used, otherwise auto scaling will be done that provides about 10% top
and bottom margins.

The selection of the items for the lines is from a pair of pull-downs. If there are a large number of items
saved in the History then it may be beneficial to use the checkbox that includes only associated items
(i.e. mapped to HS Devices) to reduce the length of the pull-down selectors.

Once the chart lines are constructed the set can be saved with a chart name and then can be later
restored with the load selector. The selector will also include “All”. When selected then all defined
charts will be shown in round robin sequence with ten second dwell times.

The Topics available are synchronized with the selections made for Associations and History. If, for
example, the non-Plug-in are not checked for inclusion in the History data, then the Chart Topic Selector
will have no non-Plug-in items.

Page 138



Filter Table by Category and Date
Accepred Assodiations [Show All Associated Only
Outbound Selections WInchudz Non-Plugin HS Devices
Inbound Selections MInclode Received MQTT Topics
Absokste Date Range (Start.End) or (SingleDay) (7271272020,12/132021 )
Absolute Start and End Times Stare: [0:00 | End:[23:00 ]
Relative Start Date-Time (] (format dd hh:mm:ss)
Filter Table by HS Device Calegornies Clear Filters Rebuild Filters
Loc2 (Floor) K2 (Loc (Room) 2 | Type | 2 |Interface A

Filter Association Table by Mqtt Topic and JSON Payload Key Clear Filters Rebuild Filters

Chart Selections
Load Defined Chart L~

Chart Definition Save/Delete | |
| Test'VD/set v |
| v |
Left Axis Topic/Ttem | v
(Select Topic or Device) | Test Control (8§250) W |
| v |
| v |
| d
Right Axis Topic/Item | Control Me (8478) v |
(Select Topic or Device) | v |
I

Left Axis Min & Max LeftMini [ | LeftMaxs [ |
Right Axis Min & Max Right Min: | | RightMax:| | [ISynctoLsft

Show Sedected Chart

Figure 56 Chart Setup

Charting parameters can be setup and given a name. The name can then later be entered to restore the
parameters. These controls are at the top and bottom of Figure 56.

When the “Show Selected Chart” button is used the requested chart will be shown below the button
such as is shown in Figure 58. In this example three lines are drawn. If there is only one line on each Y
axis then the axis and line color (white on left and yellow on right) can be used to identify the item being
charted. If more than one exists on either Y axis then a legend will be shown in the upper right of the
chart as shown in Figure 57. The legend item will start with the axis code of 1 or 2 and then the Device
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Ref of the signal. The end of the legend will be the current value of the item. The Y axis lables will
contains both the name and the ref of the item.

SolarWaterHeater History

— 1:Sunflower Soil-1:Temperature (557) - 64.5
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Figure 57 Chart with Line Legend

When a topic has VSP relationships the VSP legend will be included below the chart such as in Figure 58.
The left axis is from Payloads that contain “OPEN”, “CLOSED” and “INDETERMINATE” text values. If
these have been setup in mcsMQTT as Value-Status-Pairs then the same Status-Value relationship will
be used, otherwise they will be assigned dynamically. The pairs legend is shown below the chart. The
white line (GarageDoor/Door) shows at 9:56 going from CLOSED (0) to INDETERMINATE (1) and then
shortly thereafter going to OPEN (2). About one minute later the door is shown to close while
transitioning through the indeterminate state.

On the right Y axis an RSSI value is shown through four values ranging from 74 to 80 during the selected
time period. The line and the axis labels are in yellow. Since the data is numeric there is no VSP legend
generated below the chart.
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Show Selected Chart

MQTT Payload Time History

=
o
]
=
o
=
(]

Garage

0:40 AM 9:50 AM 10:00 AM 10:10 AM

Time (4 2018 9:32 AM - 42 018 10:12 AM)

GarageDoor/Door
[0 CLOSED |
|1 INDETERMINATE |
|2 OPEN |

Figure 58 Chart Display with VSP Legend

MQTT-sourced charts can also be produced by clicking on the Payload value of a row in the Association
tab. HS Device-sourced charts can be produced by clicking on the LastDate value of a row in the
Association tab if the hyperlink is available. It becomes available when the “S”hortTerm column
checkbox has been selected.

The chart will be shown in a new browser window in the upper left of the screen. In this case the chart
will contain only the left axis and the time span will include all data for the item in the history database.
This can be customized by making a chart definition and saved under the same name as the Topic for
MQTT-sourced or Ref number for Device-sourced. An example is Figure 241. In this case the
parameters will be used to define what is on the chart, the scaling and the time span.

A third method is provided to generate charts through automation rather than interactively. HTTP get
requests are made to the HS server of the form

For HS3: http://<IP>/MQTT?< parameters>

For HS4: http://<IP>/mcsMQTT/MQTT.htmlI?< parameters>
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where <IP> is the computer name or IP address of the HS server. It may include the port if something
other than port 80 is used. <parameters> are from the items below

Identification
Chart=name - name is chart definition file name
Payload=name - name is chart definition file name
Y1l=name -name is topic on left Y axis

Formatting
File=string — location to place created .png file. Either full path of just filename if being placed in
the \htmI\mcsMQTT subfolder of HS
Y1Min=number - optional left Y axis minimum
Y1Max=number - optional left Y axis maximum
Y2=name - optional, topic name on right Y axis
Y2Min=number - optional right Y axis minimum
Y2Max=number - optional right Y axis maximum
StartDate=date - optional start date
EndDate=date - optional end date
Duration=timespan - optional in format of dd hh:mm:ss (end date is set at current date/time)

Duration has priority over StartDate and EndDate
If no date is given then period is current day
If no Y min or max is given then auto scaling is done

Three identification options exist. Either the word “Chart” or “Payload” is required. If it is used with a
name value then that name will be used as the saved chart definition name and all formatting
parameters will default to the named definition values. If it is used without the name value then the Y1
value is required to identify what will be put on the chart.

“Chart” will return the filename of the chart with the file deposited in the HS server htmI\mcsMQTT
folder. “Payload” will return an HTML formatted page that uses an <img> tag to load the graphic file.

Formatting parameters can be used to supersede the definition file or if a definition file is not specified
then they can be set to provide whatever chart customization is desired. If a parameter is not used then
defaults will be selected.

A few examples are shown below for the HS3 plugin.

http://192.168.0.14/MQTT?Chart&Yl=HyderonRain/STATE:Wifi:RSSI&StartDate=1-1-
2018&EndDate=5-1-2018&Y1Min=0&Y1Max=100

http://192.168.0.14/MQTT?Chart&Yl=HyderonRain/STATE:Wifi:RSSI&Y1IMin=0&Y1Max=100&Durati
on= 10 20:30:40

http://192.168.0.14/MQTT?Chart=RSSI-Garage

http://192.168.0.14/MQTT?Payload=RSSI-Garage
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For the HS4 plugin the URL changes to use /mcsMQTT/MQTT.html rather than /MQTT and each
parameter is separated by “?” rather than “&” as shown below.

http://192.168.0.14/
mcsMQTT/MQTT.html?chart?Y1=HyderonRain/STATE:Wifi:RSSI?StartDate=1-1-2018?EndDate=5-
1-2018?Y1Min=0?Y1Max=100

http://192.168.0.14/
mcsMQTT/MQTT.html?chart?Yl=HyderonRain/STATE:Wifi:RSSI?Y1Min=0?Y1Max=100?Duration=10
20:30:40

http://192.168.0.14/ mcsMQTT/MQTT.html2chart=RSSI-Garage

http://192.168.0.14/ mcsMQTT/MQTT.html?Payload=RSSI-Garage

9.1 Charts with HS Touch

HSTouch provides a control that can be used as the container for an image file such as one generated by
mcsMQTT. There may be multiple ways to setup HS Touch. The following discussion illustrates a
specific way as shown below. In this case the image control is placed on the canvas. The
ImageURLNormal propery is set to the HS URL of a png file that will be created by mcsMQTT. The
IsVideo property is set to true to facilitate HSTouch monitoring for a change in the file.

Page 143




[= |3 ) [BucketHeater

wled Histor EH1 |
LA v Actions
lgnorePresses True
~ Appearance
ColarMormal [] Transparent
ImageFormat Stretched
ImageMormal
ImageURLNomal hittp://192_168.0.7/mcsMQT T/bucketHeater png
ImageURLPressed
w  Identification
Name BucketHeater
Visible True
“ Location/Size
0 Left 628
b Top 12
5 Viith 640
= Height 480
5 ZOrder Front
o ZOrderNumber 0
v Misc
ControllD
Control Type
w Settings
Alpha 255
IsVidea True
11:40 AM M IsVideoRefreshRate 0
X Lock ToBackground False
112:19 PM) ~ Status/Device Associations
Status TrackingMommal
RS5UdMomal
R55TableMNameNomal
RS SltemName Normal
RS55RowNumberNomal 0
RS55UsemameNomal
RSSPasswordNomal

Figure 59 HS Touch Setup to Show Chart

An event is setup in HS for periodic execution at the update rate desired for the chart. In this example it
is set to 15 seconds. The event action is an immediate script that uses the hs.GetURL method that
requests mcsMQTT to rebuild the chart from the chart setup called “wled” and to place the png in file
bucketHeater.png. When the event is run the file will be rewritten every 15 seconds and HSTouch will
recognize the update and refresh the image control on the screen. Note the syntax for File parameter in
hs.GetURL uses “?” to separate it from the Chart parameter. For HS3 it would be “&".

o

ZOv@ds3

If
A F.i_ecurnng Trigger Happens A
T‘h;.E\;:e.I_'IT. Will Automatically Trigger Every... v = I+
H Minute o
0 0 15
THEN
Run.w a Script or Script Command v

men Bv i
& hs.GetURL("localhost",'/mesMQTT/MQTT.html?Chart=wled?File=bucketHeater.png",false,80)

Immediate Command D Wait for script to finish Only run one script at a time

Figure 60 Event to Refresh Chart Every 15 Seconds
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When mcsMQTT generates the png file it will actually create two files. One will be “plotXX.png” and the
second will be the name given in the File parameters if this parameter exists. The XX will increment for
each new chart generated. The plotXX.png is appropriate for clients that are looking for a new file

typically embedded in HTML img tags such is produced when using the Payload rather than the Chart
parameter for the chart being generated.
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10 mcsMQTT Self Signed Certificate Support

This section, as well as the SSL implementation within mcsMQTT has been provided by vasrc
from Homeseer Message Board.

There are two parts. The first part is a general overview of the SSL process as it relates to
IOT/MQTT. The second part is an instruction manual on how to create, install and configure SSL
communications using the mcsMQTT plug-in on HS.

10.1 Part I. SSL/TLS Communications
10.1.1 Why encrypt your IOT/MQTT Network

Since the MQTT protocol isn’t currently encrypted natively, all that’s needed is the Broker
username and password to access your IOT network and create havoc. If you don’t use SSL/TLS
encryption, all of the usernames and password may be sent “in the clear” (you can MD5 hash
passwords on some devices).

So overall, it’s just a good thing to do since MQTT is such a basic protocol (invented back in
1999 by IBM, before there were a lot of issues with security) and has no real internal security
provisions.

10.1.2 SSL Communications Overview
In this document, we use SSL to represent both TLS and SSL. SSL certificates are also commonly
called public key, digital or identity certificates.

To understand why we use SSL certificates, it’s helpful to understand how they work. This is a
high-level description of the process as it relates to 10T.

Some of the key elements when communicating with SSL are:

e An SSL certificate is an electronic document used to prove the ownership of a public key.
The certificate includes information about the key, information about the identity of its
owner (called the subject), and the digital signature of an entity that has verified the
certificate's contents (called the issuer). If the signature is valid, and the software examining
the certificate trusts the issuer, then it can use that key to communicate securely with the
certificate's subject. In 10T networks a certificate's subject is typically a computer or other
device. In a typical 10T public-key infrastructure (PKI) scheme, the certificate issuer’s
certificate authority (CA) is usually self-signed vs signed by a company that charges
customers (root certificate).

e Certification authority (CA) is a third party that is trusted by both the SSL client (Device) and
the SSL server (Broker). Its role is to provide the SSL client (Device) and the SSL server
(Broker) a means to authenticate that each of their certificate(s) were issued by a trusted
source. CA certificates can be both Root authorized or Self-Signed.
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e When establishing SSL-based encrypted communication channels, the authentication of the
devices communicating is optional. This means the ownership of the certificates may or may
not be checked to confirm who the users (devices) are, but rather they are used to provide
encryption services to the data being sent and received.

e Due to the diverse number of MQTT capable devices available, the type of SSL
communication will vary. Some of the options are:

o Unidirectional Authentication: only the client (Device) will verify the SSL server's
(Broker) certificate. For end devices this is typically the most common SSL method used
currently.

o Bidirectional Authentication: both the SSL client (Device) and the SSL server (Broker) will
mutually verify each other’s certificates. This is typically done on more “intelligent”
clients such as a Windows or Pl based system that have more resources or an MQTT
utility such as MQTT_Spy.

10.1.3 Root Signed and Self-Signed certificates

e Aroot certificate is a public key certificate that identifies a root certificate authority (CA).
While root certificates are technically self-signed they are not the same as the certificates
we call usually call self-signed. A root certificates primary difference is that their signers
have been universally accepted as being valid. Lists of these valid signers are typically
included in Browsers and applications so they can be used to confirm that SSL certificate
(usually purchased) that’s being used is valid. https://en.wikipedia.org/wiki/Root_certificate

e Aself-signed certificate is very similar to a root certificate with the primary difference being
it is only considered valid by the user/vendor that created it and is not universally accepted
like root certificates are. Therefore, they have to be verified internally. A self-signed
certificate is very common when running an internal DIY |IOT network as an external Root
signed certificate isn’t always easy to validate on smaller IOT devices due to the lack of a
Trusted Root store on the device.

e Both types of certificates are used to sign the SSL certificates that are used to provide the
authentication and encryption functions. The primary difference of these SSL certificates is
whether they are signed internally (self-signed) or externally (Root).

We use SSL communications for two primary reasons:

1. Data Encryption. To provide communication security and prevent session hijacking over
a network by encrypting the data being between the device and Broker.

2. Device Authentication. To ensure both the Devices and Brokers in our network are who
they say they are. This step is called authentication and is not always done in a DIY IOT
network.
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For data encryption it’s necessary to confirm that the SSL certificates and their associated keys
match. This level of authentication is to ensure that the data encryption is secure. This is
hardcoded into the SSL libraries and is always done. If this level of authentication fails, the
network connection will fail.

Device authentication is used to ensure that the SSL certificates represent their owner’s identity
correctly. This is done using HTTPS all the time so you know that the website you think you’re
looking at is really that website. This level of authorization requires a CA that has been signed
by a Root Authority and is confirmed by checking for a Root certificate that is stored on your
computer (usually by the Browser vendor). In a DIY I0T network, this isn’t always feasible as the
Devices can be limited in memory or pre-programmed to operate in a specific manner already.
Therefore, having an SSL certificate that has been signed by a Root Authority won’t always be
helpful as you’ll need to install the Intermediate Certificates

(Certificates that point at the Root Certificates) the same as you would have to install your own
Self-Signed certificate. Therefore, many of the IOT devices run with this level of authentication
disabled and inherently trust the CA certificate it is assigned (the same as it would an
Intermediate/Root certificate).

To provide the minimal (unidirectional) encrypted SSL communications on MQTT devices, two
SSL certificates must be installed on the MQTT broker as well as one on each device. Typically,
in an internal 10T network, this would be a self-signed CA certificate on both the Broker/server
and client/device along with a Broker/server certificate on the Broker, signed by the self-signed
certificate. The CA certificate can be reused on all IOT devices. The Broker/server certificate can
only be used on the Broker. These certificates provide adequate protection from sniffing of the
TCP packets being sent between the devices and the Broker (many times using WiFi). Although
most Brokers and some devices do support client certificates (not currently supported on this
Plug-in) client certificates are not as commonly used, primarily as on most Brokers they force
the user to only use devices that support client authentication. Client authentication currently
is used more for commercial systems than home systems.

Here is a simple overview of how a secure SSL session is accomplished
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(The Client certificate process is not shown in this diagram)

SSL establishes a secure connection between the device and the Broker and the process of
encrypting information and authentication. The technical steps are:

Client Hello:
A Device initially tries to establish connection to the Broker using Client Hello and ask it for identification
details like SSL version number, cipher setting.

Server Hello:

After Client Hello, the Broker responds to the Device with its public key along with a copy of its
SSL certificate including SSL version, cipher settings, session specific information called Server
Hello.

Authentication:

A Device authenticates the details of the Broker certificate (more on Authentication later),
generates a pre-master secret, encrypts it with the Brokers certificate public key and send it
back to the Broker.

Decryption:
The Broker then decrypts the pre-master secret with its private key. Both the Device and the
Broker generate Master secret with agreed ciphers.

Generate Session Keys:
After generating master secret, both the Device and the Broker generate session keys for
encryption and decryption used in information exchange.
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Data Transfer:
Both the Device and the Broker will now exchange encrypted information.

10.1.4 SSL Options that NEED CLOSURE

Not all devices are SSL capable. It’s usually possible to create a second listening port on the
Broker for non-secure devices. If you’re concerned with network security (i.e. your 10T network
isn’t isolated on a VLAN or separate Subnet), you should read up on Access Control lists for the
Broker. Typically, port 1883 is used for non-secure devices and port 8883 is for SSL type devices.
Any port can be selected for either though.

To implement this, both the Broker as well as the Device need to support SSL type
communications. Most newer devices should have this capability. In this example, I'll also
provide an example of how to configure one of the more popular MQTT brokers, Mosquitto.
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10.2 Installing SSL support on the mcsMQTT Plug-in

mcsMQTT provides an automated mechanism to create self-signed certificates, a certificate and key for
the Broker and a certificate and key for the mcsMQTT client. This automated functionality is used when
a Broker security of None is not selected and certificate files are not setup on the MQTT Page, Broker
Tab. In this case a set of certificates and keys are generated in the \data\mcsMQTT subfolder with
naming convention derived from the Broker IP that has been setup on the same Page for the Broker
certificate, the same for the CA certificate with a “ca” prefix, and the computer name where mcsMQTT
is running for the client. The CA certificate, Broker certificate and the Broker key files still need to be
manually copied to the computer where the MQTT Broker is running.

If a user desires to use the same capability manually from a command window, then navigate to the
\Bin\mcsMQTT folder and enter command

CAandClientCert.exe "FilePath, BrokerName/IP,ClientName/IP"

Where BrokerName/IP is replaced by either the computer name (or fully qualified domain name that
can be resolved via DNS) of the MQTT Broker, and ClientName/IP is the same for computer where the
client is running. If ClientName/IP is blank then no client certificate or key wil be produced. The
FilePath is some location on the computer to where the generated certificates will be placed. For
example,

CAandClientCert.exe "C:\Temp, 192.168.0.16, "

CAandClientCert.exe " c:\Program Files (x86)\HomeSeer HS4\Data\mcsMQTT,
MQTTBroker,HSRPi "

The example above is for a Windows use. CAandClientCert.exe is a .NET 5.0 application so should be
able to be used on Linux with a prefix of “mono “. This evaluation on Linux has not beed performed.

What is significant in the names provided is that the same name needs to be used when trying to
connect. For example, if HSRPi resolves to 192.168.1.100 and HSRPi is used in the certificate geneate
name, then connectiong via MQTT needs to be to HSRPi and not 192.168.1.100.

Rather than using the automated process or CAandClientCert.exe tool, other 3™ party tools can be used
to generate the certifiates and keys. The description of using OpenSSL (Windows or Linux) is provided in
the following paragraphs.

10.2.1 SSL/TLS Certificate creation:

The first step in setting up SSL communications between the mcsMQTT plug-in and your Broker
is to create the necessary SSL certificates. You’ll typically need two. A Self signed CA certificate
that you can use to sign your Broker “server” certificate, and the Broker certificate itself. If you
decide to you also want Client certification, you'll need to create another certificate for each
Device/Client as well.

Page 151



10.2.2 Software/Tools:
CAandClientCert.exe utility is described above. A more interactive mechanism using openssl| is shown
below. Openssl can be install on either Windows or Linux.

This example uses openssl to create the certificates. If you’re on a Windows platform you’ll
need to install the Openssl application on your platform:
https://slproweb.com/products/Win320penSSL.html

If you are on some variant of Linux, it will either be installed already or you can use the
associated install app for the flavor of Linux you’re using (apt-get, yum, etc).

There are other automated methods to create certificates as well:
https://qithub.com/owntracks/tools/blob/master/TLS/qgenerate-CA.sh

10.2.3 Certificate Creation
10.2.3.1 Certificate Naming

In the following instructions, you can use any file naming convention you want for the
names of the SSL certificates, but it’s best to name them something that explains
where/what they are used for (i.e. MQTT_Broker.xxx, MQTT_CA.xxx, MQTT_garage.xxx,
etc).

10.2.3.2 Select the directories used to save the certificates
Since SSL certificates can be created on many different devices, they may not always
end up on the device you’re using them on. For this reason, it’s a best practice to create
all your SSL Certificates on one computer both for security as well as for backup rather
than directly on the device (which isn’t always possible for smaller devices). You’ll need
to use some of these Certificates again (particularly the CA certificate) for new devices
and/or reconfigurations so it’s convenient to have them all in one location. This
directory can be located anywhere that’s convenient to you (and hopefully backed up
regularly). Linux typically stores their certificates at /etc/ssl/private for the key and
/etc/ssl/certs for the certificates. On Windows OpenSSL is typically C:\OpenSSL-
Win32\bin\PEM\

Since the SSL Certificates may be on another machine, they will typically need to be
copied to their proper storage location on the device that is using them. This location is
usually device dependent and is almost always located on the device that’s using the
certificates (eg Broker, Device). If the vendor/application doesn’t define a location,
you’ll need to determine where you want to store them. For the Mosquitto Broker, on
Linux there’s usually a directory for the mosquito broker already created for you at
/etc/mosquito. On windows it’s typically located at, C:\Program Files (x86)\mosquitto.

Page 152


https://slproweb.com/products/Win32OpenSSL.html
https://github.com/owntracks/tools/blob/master/TLS/generate-CA.sh

In this example, while I'll use standard directories, it’s perfectly fine to use any file
structure if you understand the openssl process. I'll also assume that the user is creating
their SSL certificates on one machine and has created/confirmed appropriate storage
directories are on that machine. For example, on Linux keyDir/ would be /etc/ssl/private
and certDir/ would be /etc/ssl/certs. On Windows, since openSSL usually stores both the
key and certificate in the same directory both keyDir/ and certDir/ would be the same:
C:\openSSL-Win32\PEM.

10.2.3.3 Create the Key for the CA (Certificate Authority) certificate:

From Windows elevated powershell the following can be done. Otherwise use the openssl process that
follows. In the Powershell example the certificate name is SSL. Change is to the appropriate naming
convention here and in subsequent certificate creation steps if Windows Powershell is being used.

PS C:\WINDOWS\system32> Scerthname = "SSL"

PS C:\WINDOWS\system32> Scert = New-SelfSignedCertificate -Subject "CN=$certname" -
CertStorelLocation "Cert:\CurrentUser\My" -KeyExportPolicy Exportable -KeySpec Signature -KeyLength
2048 -KeyAlgorithm RSA -HashAlgorithm SHA256

PS C:\WINDOWS\system32> Export-Certificate -Cert Scert -FilePath "C:\Cert\SSL.crt"

t New-Se nedCertificate
Exportable 2848
tem Export-Certificate

Directory: C:\Cert

LastWriteTime Length Name

openssl genrsa -des3 -out keyDir/MQTT_CA .key 2048

This creates your IOT networks CA certificate Key which is used to create the final
certificate. The “-des3” requires you to provide a PassPhrase to protect the key and is
optional. Remove it from the command line if you don’t want to have to remember it
(You’ll need to use it when you create the new Broker or Client certificates).
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10.2.3.4 Create the CSR file from the previous CA Key for creating the final CA certificate:
openssl req -new -key keyDir/MQTT_CA.key -sha256 -out certDir/MQTT_CA.csr

-sha512 is acceptable if the latest SSL libraries are installed.

This command requires you to input several variables. Most are informational and/or
not used for a self-signed cert. The Common Name is the only one you need to consider.
Country Name (2 letter Code) [xx]:i.e. US

State or Province Name (full name) [Berkshire]: i.e. Washington

Locality Name (e.g., city) [Newbury]: i.e. Seattle

Organization Name (e.g., company) [My Company Ltd]: i.e. MQTT Ltd

Organizational Unit Name (e.g., section) []: i.e. IT (Optional)

*Common Name (e.g., your name or your server's hostname) []: i.e. IOTnetwork

This should be something like local host, your name or network name. It should not be
the same as what you use on the broker certificate later.

Email Address []: i.e. not required. You can leave blank

Please enter the following 'extra' attributes to be sent with your certificate request

A challenge password []: leave blank

An optional company name []: leave blank

10.2.3.5 Create the final CA certificate:
openssl x509 -req -days 3650 -in certDir/MQTT_CA.csr -signkey keyDir/MQTT _CA.key -
out certDir/MQTT_CA.crt

If you entered a passphrase for your CA key, you’ll need to enter it when requested.
This certificate will be good for 10 yrs (3650). You can select a smaller period if you like.

10.2.3.6 Create Broker certificate Key (NO passphrase)
openssl genrsa -out keyDir/MQTT_Broker.key 2048

10.2.3.7 X509 Create Broker certificate request:
openssl req -new -out certDir/MQTT_Broker.csr -key keyDir/MQTT_Broker.key

Again, you'll be asked the following questions. None of the entries are all that important
EXCEPT the Common Name (CN)

Country Name (2 letter Code) [xx]:i.e. US

State or Province Name (full name) [Berkshire]: i.e. Washington

Locality Name (e.g., city) [Newbury]: i.e. Seattle

Organization Name (e.g., company) [My Company Ltd]: i.e. MQTT Ltd
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Organizational Unit Name (e.g., section) []:i.e. IT

* Common Name (e.g., your name or your server's hostname) []: i.e. IOTmachine

This needs to be the Name of the PC running your Broker. It’s the name that’s attached
to the IP address of the machine, i.e. MyPC, MQTTBroker.local or just the IP address.
Email Address []: i.e. not required. You can leave blank

Please enter the following 'extra' attributes to be sent with your certificate request

A challenge password []: leave blank

An optional company name []: leave blank

10.2.3.8 Create Broker certificate
openssl x509 -req -days 3650 -in certDir/MQTT_Broker.csr -CA certDir/MQTT_CA.crt -
CAkey keyDir/MQTT_CA.key -CAcreateserial -out certDir/MQTT_Broker.crt

If you entered a passphrase for your CA key, you'll need to enter it when requested.

10.2.3.9 Create Client certificate Key (If needed. No passphrase unless client device requires it (MQTTspy, mcsMQTT
plug-in)
openssl genrsa -out keyDir/MQTT_nameOfClient.key 2048

10.2.3.10 X509 Create Client certificate request:
openssl req -new -out certDir/MQTT_nameOfClient.csr -key
keyDir/MQTT_nameOfClient.key

Again, you’ll be asked the following questions. None of the entries are all that important
EXCEPT the Common Name (CN)

Country Name (2 letter Code) [xx]:i.e. US

State or Province Name (full name) [Berkshire]: i.e. Washington

Locality Name (e.g., city) [Newbury]: i.e. Seattle

Organization Name (e.g., company) [My Company Ltd]: i.e. MQTT Ltd

Organizational Unit Name (e.g., section) []:i.e. IT

* Common Name (e.g., your name or your server's hostname) []: i.e. IOTmachine or IP
address

This needs to be the Name of the device or PC the client app is running on. It's the name
that’s attached to the IP address of the machine/device, i.e. MyPC, garageControl, or
just the IP address.

Email Address []: i.e. not required. You can leave blank

Please enter the following 'extra' attributes

to be sent with your certificate request

A challenge password []: leave blank

An optional company name []: leave blank
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10.2.3.11 Create Client certificate:
openssl x509 -req -days 3650 -in certDir/MQTT_ nameOfClient.csr -CA
certDir/MQTT_CA.crt -CAkey keyDir/MQTT_CA.key -CAcreateserial -out certDir/MQTT _
nameOfClient.crt

If you entered a passphrase for your CA key, you’ll need to enter it when requested.

10.2.3.12 Copy the SSL certificates to the correct location (if necessary)
If the SSL certificates were created on a different machine than the Broker, you’ll need
to copy them from that machine to the Broker machine.
Copy the CA (MQTT_CA.crt), Broker Key (MQTT_Broker.key) and SSL certificates
(MQTT_Broker.crt) to the Broker:
For Mosquitto on Linux it’s typically: /etc/mosquito/ssl/private for the Broker Key and
/etc/mosquito/ssl/certs for the CA and Broker certificates.
For Mosquitto on Windows typically they all go to the same directory: C:\Program Files
(x86)\mosquitto\PEM\

10.2.3.13 Create Client composite Certificate
openssl pkcs12 -export -out certDir/MQTT_nameOfClient.pfx -inkey
keyDir/MQTT_nameOfClient.key -in certDir/MQTT_nameOfClient.crt -certfile
certDir/MQTT_CA.crt

10.2.3.14 Copy certificates to Client Devices
For devices/clients you'll need to copy the CA (MQTT_CA.crt) to the individual devices
appropriate location. If you run with Client Authorization and depending on the type of
device, you'll either need to copy the Client (MQTT_name OfClient.crt) and Key
(MQTT_nameOfClient.key) or paragraph 10.2.3.13 MQTT_nameOfClient.pfx to the
devices appropriate location as well. The mcsMQTT plug-in requires the PFX file from
paragraph 10.2.3.13.

10.2.3.15 Summary for ease of copy/past
openssl genrsa -out C:\Cert\MQTT_CA.key 2048

openssl req -new -key C:\Cert\MQTT_CA.key -sha256 -out C:\Cert\MQTT_CA.csr
openssl x509 -req -days 3650 -in C:\Cert\MQTT_CA.csr -signkey C:\Cert\MQTT_CA key -
out C:\Cert\MQTT_CA.crt

openssl genrsa -out C:\Cert\MQTT_Broker.key 2048

openssl req -new -out C:\Cert\MQTT_Broker.csr -key C:\Cert\MQTT_Broker.key
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openssl x509 -req -days 3650 -in C:\Cert\MQTT_Broker.csr -CA C:\Cert\MQTT_CA.crt -
CAkey C:\Cert\MQTT_CA.key -CAcreateserial -out C:\Cert\MQTT_Broker.crt

openssl genrsa -out C:\Cert\MQTT_Client.key 2048

openssl req -new -out C:\Cert\MQTT_Client.csr -key C:\Cert\MQTT_Client.key

openssl x509 -req -days 3650 -in C:\Cert\MQTT_Client.csr -CA C:\Cert\MQTT_CA.crt -
CAkey C:\Cert\MQTT_CA.key -CAcreateserial -out C:\Cert\MQTT_Client.crt

openssl pkcs12 -export -out C:\Cert\MQTT_Client.pfx -inkey C:\Cert\MQTT_Client.key -
in C:\Cert\MQTT_Client.crt -certfile C:\Cert\MQTT_CA.crt
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10.3 Mosquitto Broker configuration for SSL

This is for a Linux based broker. The configuration file is the same for Windows based broker

To add SSL/TLS support to your Mosquitto broker, open the mosquitto.conf file with a text
editor. If you are already running non-secure using port 1883 (or similar), they you’ll need to
decide if you want to add another listening port (so you can listen on both secure and non-
secure ports) or just listen only on the new secure port. I'd recommend you try adding a second
port initially and then remove the non-secure one later if appropriate. Assuming you have your
primary (1883) already running,

1. Search in the moquitto.conf file for “Extra Listeners”. It may not be present depending
upon the install version of Mosquitto. It is possible to have both insecure
communications on port 1883 and secure communications on port 8883. The “listener”
line can be added multiple times to address specific needs.

2. Remove “#” from “#listener” to enable this listener or just add a section starting with
“listener”

3. Scroll down (Be sure you’re below the Extra Listener section (or added listener) as all of
these entries exist for the normal listener at the top of the Configuration file as well)
until you find the line with #cafile. You’ll need to add the location of the MQTT_CA.crt
file. Be sure to remove the Comment (#) marker.

For Linux it would be something like:

cafile /etc/mosquitto/ssl/MQTT_CA.crt (this is completely dependent on
For Windows:

cafile C:\OpenSSL-W32\bin\PEM\MQTT_CA.crt

4. Scroll down to #certfile and add the location of the MQTT_Broker.crt file such as:
certfile /etc/mosquitto/ssl/certs/MQTT_Broker.crt
certfile C:\OpenSSL-W32\bin\PEM\MQTT_Broker.crt
There is no specific path locations. Just be consistent to not confuse yourself.

5. Scroll down to #keyfile and add the location of the MQTT_Broker.key file
keyfile /etc/mosquitto/ssl/private/MQTT_Broker.key
keyfile C:\OpenSSL-W32\bin\PEM\MQTT_Broker.key

6. Restart the mosquitto broker to accept the changes. You should now be able to access
the broker using SSL/TLS communications.

Version 1 and 2 of Mosquitto have different defaults so the transition from 1 to 2 is a breaking
change for most. Another observation is that with version 2, | have only had success with

encrypted communications when both a username/password for Mosquitto and the certificates
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are setup. Inversion 1, | did not have a need to provide username and password. The
mosquito.conf file that has worked for me for insecure communications on 1883 and secure
communications on 8883 is shown below. The mosquitto_passwd utility that comes with

the client tools when using Steve’s guide at How to Install The Mosquitto MQTT Broker- Windows
and Linux (steves-internet-guide.com) is one reference to setup username/password security with

Mosquitto.

The example below uses the auto-generated files for a MQTT Broker IP at 192.168.0.16 that
has been specified as 192.168.0.16 in the mcsMQTT or utility tool and had been copied from
the HS computer to the Linux MQTT Broker on 192.168.0.16. Note that .NET Framework, which
HS uses, does not support TLS1.3 while Mosquitto does.

# Place your local configuration in /etc/mosquitto/conf.d/
#

# A full description of the configuration file is at

# /usr/share/doc/mosquitto/examples/mosquitto.conf.example
per_listener_settings true

pid file /run/mosquitto/mosquitto.pid

persistence true
persistence location /var/lib/mosquitto/

log dest file /var/log/mosquitto/mosquitto.log

listener 1883
allow_anonymous true

listener 8883

require_certificate false

password_file /etc/mosquitto/passwd

certfile /etc/mosquitto/certs/192-168-0-16.crt

keyfile /etc/mosquitto/certs/192-168-0-16.key

cafile /etc/mosquitto/ca_certificates/cal92-168-0-16.crt

tls_version tlsvl.2

include_dir /etc/mosquitto/conf.d

Here are also some links to “prettier” versions of some of the instructions by others:

Mosquitto Broker Configurations:
http://www.steves-internet-guide.com/mossquitto-conf-file/
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SSL/TLS certificate generation:

https://mcuoneclipse.com/2017/04/14/enable-secure-communication-with-tls-and-the-
mosquitto-brokerLocal

Not all IP-interfaced devices use MQTT protocol. A selective, and growing, set of devices have been
interfaced to HS via mcsMQTT that use TCP as the control/status protocol. mecsMQTT handles the
device-level APl and presents to the user a pseudo MQTT presentation.
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11 Local
11.1 IP Relay

The IP Relay tab provides setup for an eight-channel relay and eight channel opto-isolated input
interfaced via TCP connection. The hardware is often referred to as Web-Relay or Relay-Net.

An 8 Channel Relay and Input device which is available from many vendors such as
https://www.ebay.com/itm/173093192868?ul noapp=true has been interfaced. It is shown in Figure
61. The default login is user admin and password 12345678 for IP 192.168.1.166 to configure the
device. From a browser with URL at this IP the System Setttings can be modified to change the IP, if
desired. Another setting exists to bind the input to the relay. This will be changed to not bind unless the
inputs are going to be used to also directly control the relay.

Versions 5.7 and 5.8 of the board are available. 5.7 from the link above and 5.8 from 8 Channel Relay
Network IP Relay Web Relay Dual Control Ethernet RJ45 Relay | eBay (Aug 9 delivery). The V5.7 has
known issue of network connectiveiy through routers and switches that support 1G bandwidth. The
same issue may or may not exit with the V5.8. The version is etched into the edge of the board and the
V5.8 is dated 2019. The input connector block for the V5.8 has 3 pin block for RS-485. The V5.7 in the
same position has labels of COM 5V GND as well as a second COM between the 8 inputs.

My experience with multiple suppliers on Ebay that provide USA stock are not able to assure shipment
of V5.7 or V5.8 boards. It seems both versions are sold under the same product number with the “bin”
having both versions. | find the Dingtian IOT relay described in Section 23 to be a much better
product, at a lower cost ($15 for 8 channels of input and output) and a DIN-rail case available at just a
few dollars more.

Documentation, focused on the V5.8, is available at http://mcsSprinklers.com/I0Zone IP Relay.zip
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Figure 61 8 Channel Relay / 8 Channel Digital Input IP Network Module

Setup for this device is contained on the Local page that is available from the HS Menu for Plug-in
mcsMQTT. From this page a table is presented where the module’s IP address and TCP port are entered
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such as shown in Figure 62. The polling interval entry is used if any of the module’s digital inputs are
being used. If not used then the polling interval text box should be left blank. The input for polling is in
milliseconds, but reasonable values of 10000 vs. unreasonable 100 should be selected when the inputs
are being interfaced.

Two protocols are supported. HTTP is selected for Port 80. Both V5.7 and V5.8 use the same HTTP
protocol. TCP is selected for Port 1234. TCP for V5.7 has been implemented.

Multiple modules are accommodated with a row provided for each module.
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HomeSeer

Devices Events Cameras~ Setup Tools = Plugins -

IP Relay/Yolink Daikin/Imtesis

Relay IP Address Port Polling Interval (milliseconds)

192.168.1.166 1234 30000

Yolink Cloud Server Configuration

mEsMOTT Clignts single mcsMOTT @
Muttiple mestQTT (O
YoLink Server Access Access with mesMOTT Credentials .
Access with Personal Credentials ()

Personal Credentials My A
Yaolink Server Connection Connect to Yolink Server ()
Disconnect from Yolink Server ()

Yolink 32 Character Device QR Code

3743121DABT D42ESBE4AT2060920AABCAF
C5241CAEOFZB482482CAFSC3ACHA3TIE

10047 CRAFOEAAF3334289F4FEETAISZE
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Figure 62 Local Page Setup for 8 Channel Relay/Input and YolLlink Devices

After the module has been identified a set of pseudo-Topics are created and visible on the MQTT Setup
Page, Association Tab. This table is shown in Figure 63. Note the page has been filtered in the T1

pulldown to show only the 192.168.0.166 pseudo-Topic items.

Filter Association Table by Mqtt Topic and JSON Payload Key

T
192,163 0 166

Clear Filters

Rebulid Filters

niE=—

Show Selecled Associations

Assodiation Table for Auto Assodation of MQTT Topic and HS Device

| Sub: 192.168.0.166/INPUT on 2019-12:21 19:27:25
: | Sub: 192.168.0.168/1NPUT2 on 2019-12:21 19:27:25
20 | Sub: 192.168.0.166/INPUT3 off ) 2019-12-21 19:27:25
s | Subs 192.168.0.166/INPUT4 on 0 2019-12-21 19:27:26
. | Sub: 192.168.0.166/INPUTS on . 2019-12-21 19:27:26
5 Sub: 192.168.0.166/INPUT on . 2019-12-21 19:27:26
8 Sub: 192.168.0.166/INPUT7 on ) 2019-12:21 19:27:26
Dev: [192.168.0,166INPUTS
7 BT 5 e e T Davica comnend. | OF 2019-12:21 19:27:26
Dev: [192.168.0.166/RELAY
8 3’ e s nnaad | OO 00 2019221192728
1921680 168/RELAY1
Dev: |192.168.0.166/RELAY2
, e B o WS )
1192.168.0 166RELAY2 |
o 0O Sub: 192.168.0.166/RELAYS on 0 2019-12-21 19:27:24
10 Sub: 192.168.0.166/RELAY4 on 0 2019-12:21 19:27:25
12 | Sub: 192.168.0.166/RELAYS on 2019-12-21 19:27:25
3 | Sub: 192.168.0.166/RELAYS of ) 2019-12:21 19:27:25
1 | Sub: 192.168.0.166/RELAY? of 2019-12:21 19:27:25
15 | Sub: 192.168.0.166/RELAYS on 0 2019-12:21 19:27:25

Figure 63 Local Page Psuedo-Topic for 8 Channel Relay/Input Module

The device is as a Topic by it’s IP address. Its Relay and Input points are identified by RELAY1..8 and
INPUT1..8. When the “A”ssociate column checkbox is checked then HS device is created. In Figure 63
these are 693, 694 and 695 where 694 is the input and the others are relays.

The HS devices contain buttons for relays and status only for the inputs such is shown in Figure 64 for
HS4. Similar functionality is visible in HS3 from the Device Managment page.
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HomeSeer

Devices Events Cameras Setup Tools~ Plugins~

[+ =Q= Q=

FLOOR m carecory M a1« 1921680166 =

HomeSeer Web Control

192.168.0.166
INPUTS

o

Today 7:28:17 PM

192.168.0.166

RELAY1

Today 7:27:24 PM

92.168.0.166

RELAY2

Today 7:28:35 PM

All features of mcsMQTT and HS are available to the created devices and the pseudo-Topics such as

Figure 64 HS4 Devices View for Relay/Input Module

History, Charting, and Events etc.
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11.2 Local HVAC
Venstar, AirTouch, Midea, Daikin or Intesis Gateway provides a means to obtain status of a large number
of parameters and a means to control the primary functionality of the units with a local IP connection.
The IP address of any unit that is to be interfaced can be entered on the HVAC tab of the Local page as
shown in Figure 65.

Most of the thermostat parameters will automatically be associated with HS Device and Features upon
detection of data being received from the thermostat such as shown in Figure 66.

The Association tab will also provide the values of many other parameters. These parameters can be
selected with the “A”ssociate checkbox on the Association tab of the MQTT page (See Figure 67) to have
HS devices created and then the device updated on each polling interval.

The “:Power” device is “A”ssociated by default. It is used for the On/Off control of the unit. The
Homeseer API for a thermostat has the Off control as part of the “:Mode” device and selection of any
mode will result in an implicit On power state. To use the Homeseer Thermostat API the “A”ssociate
checkbox should be unchecked on the Association Tab. This will remove the “:Power” device from HS.
To explicitly control On/Off with a separate device then it should be checked.

Devices Events (Cameras~ Setup Tools - Plugins ~

IP Relay Imtesis; Dxaikin WLED

IP Address Protocol

192.168.0.10 e []

https://192.168.0.11

Daikin 13 digit key WP ]
1231231231231
192.168.0.12 T

Figure 65 Daikin/Intesis/Venstar Unit IP Address Entry
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Display Filters:  Floor v] Room v] Device Type v]
Ref Status Category Floor Room Name Last Change Control

(17| 3038 Daikin| 192.168.0.127 | Daikin-192.168.0.127 ;?{?;"1'0 -

13030 Heat Daikin| 192.168.0.127 | Dakin@192.168.0.127-Mode | 2o o

013040 of Daikin| 192.168.0.127 | Dakin@192.163.0.127-Power |10 | () (2D

12041 Daikin | 192.168.0.127 E:rir*:lglé@etﬁ?ﬁ:as.nﬁzy. ;?{;193;5 o ﬁ‘:'”e) |

013042 Daikin| 192.168.0.127 | p2 K052, 168.0.127- LA, |(;alue) [ suomit

1 |2043 Daikin | 192.168.0.127 | Daikin@192.168.0.127-Fan oA a0 [ F1 [ 2 [ Fa | Fa | s |

N T A ] [ o o

013045 0 Daikin| 192.168.0.127 gﬂi’;‘i‘:ﬁ@éﬁms'wl LA,

013046 0 Daikin| 192.168.0.127 ﬂiiizigf@e:niz'ms'njﬂ' LA,

Figure 66 Default Daikin/Intesis HS Devices
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Clear Filters Rebuild Filters

B EEN BN BT NG
N - I Y - | |

Show Selected Associations

IH-HH--II

3038  Daikin/192.168.0.127

Filter Association Table by Mq‘rl Topic and JSON Payload Key

{8 Daikin____ v
: :

1 D D ! D | sub:Daikin/192.168.0.127: dfd4 0 0 2020-02-27 15:24:55
2 0 0O 'O || sub:Daikin/192.168.0.127:adv 0 2020-02-27 15:24:55
30O | O || sub:Dakin/192.168.0.127:alert 255 O 2020-02-27 15:24:55
4 0 0O 00 || sub:Daikin/192.168.0.127:b_f_dir 0 O 2020-02-27 15:24:55
s OO O || sub:Daikin/192.168.0.127:b_f rate A O 2020-02-27 15:24:55
s OO 0O | | sub:Daikin/192.168.0.127:b_mode 4 O 2020-02-27 15:24:55
70 0O ' 0O || sub:Daikin/192.168.0.127:b_shum 0 0 2020-02-27 15:24:55
8 O O ' 0O || Sub:Daikin/192.168.0.127:b_stemp 12.0 0 2020-02-27 15:24:55
o \olfo 'O || sub:Daikin/192.168.0.127:dfdl 0 O 2020-02-27 15:24:55
100 0O 00 | | sub:Daikin/192.168.0.127:dfd2 0 O 2020-02-27 15:24:55
1" 0O 0 0 | | Sub:Daikin/192.168.0.127:dfd3 0 O 2020-02-27 15:24:55
20 0O 00 | | sub:Daikin/192.168.0.127:dfd5 0 O 2020-02-27 15:24:55
130 O 0 || sub:Daikin/192.168.0.127:dfd6 0 0 2020-02-27 15:24:55
140 O 0 || sSub:Daikin/192.168.0.127:dfd7 0 0 2020-02-27 15:24:55
50 O 01 || Sub:Daikin/192.168.0.127:dfdh 0 O 2020-02-27 15:24:55
%0 0O 0 | | Sub:Daikin/192.168.0.127:dfr 3 5 O 2020-02-27 15:24:55
7o o 0 | | Sub:Daikin/192.168.0.127:dfr1 5 O 2020-02-27 15:24:55
18 0 0O 0 | | sub:Daikin/192.168.0.127:dfr2 5 O 2020-02-27 15:24:55
190 O 0 || sub:paikin/192.168.0.127:dfr4 A 0 2020-02-27 15:24:55
Figure 67 Daikin Additional Parameters
11.2.1 Intesis

The Intesis interface uses WMP protocol. It has the capability to interface Daikin as well as many other
air conditioning units. When selecting Intesis/WMP the IP of the Intesis interface is specified as well as

the WMP checkbox.

The entered IP address will be polled at 15 second intervals to get status updates for units interfaced via

Intesis.

11.2.2 Daikin

Original Daikin models with Wifi are specified with the IP and without the WMP checkbox selected. For
later model Daikin BRP072C42 and likely other most recently introduced units add additional security to
the communications. To specify this later model use “https://” prefix in the IP as shown in example of
Figure 65. This consists of using SSL (https) and including a https header for key “X-Daikin-uuid”. The
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key’s value is generated by mcsMQTT at the time the user enters the Daikin’s 13-digit key from the
sticker on the unit. mcsMQTT will register the header with the unit thus allowing only communications
only with mcsMQTT. The reverse engineering of this security change is described at
https://github.com/ael-code/daikin-control/issues/27.

The entered IP address will be polled at 15 second intervals to get status updates for Daikin and Intesis.
The Venstar polling entry (in milliseconds) allows the user to poll at a desired rate or set to 0 to
disconnect from the thermostats. Upon the initial status update a set of HS devices will be created as
shown in Figure 66.
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11.2.3 Venstar

Venstar integration setup is found on the Local Page, HVAC tab. At startup or upon use of the Discover
button all Venstar thermostats be found and HS Device and Features setup. SSDP is used for the
discovery.

By default, the polling rate is 0 so it needs to be changed before any data will be returned from the
thermostat.

If a thermostat is not found or if the type is not correctly identified then they can be explicitly specified
as shown in Figure 68.

In the Venstar case there are four endpoints available. The /Info, /Sensor, and /Alerts returned data will
result in HS Device & Features being automatically created. The /Runtime endpoint will populate the
Association Table and if desired to be viewed as HS Features then the “a” checkbox on the Association
Table is used.

Venstar control from HS Devices, Events or Script is managed to assure the requested value conforms to
the Venstar constraints. These constraints consist of a minimum delta for setpoints and the relationship
between heat and cool setpoints when in Auto mode.
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Venstar

Discover Vienstar Thermaostats

Polling Rate (milliseconds) 0

Venstar #1 IP Address 192.168.0.7
1A
T IAQ-commercial v
Wenstar #2 IP Address
colortouch-residential v
Wenstar #3 IP Address
colortouch-residential v
Wenstar #4 IP Address
colortouch-residential v
Venstar | BUSBOY
Venstar-192.168.0.1AQ (9485)
s
@ 192.168.0.1AQ:Mode (9486) Cool Today 10217 PM
AUTO
@ 192.168.0.1AQ:State (9487) Cooling Today 1:02:07 PM
©) 192.168.0.1a0:Fan (9488) on Today 10207 PM AUTO “
0 192.168.0.1AQ:Fanstate (9489) off Today 1:02:07 PM
@ 192.168.0.1AQ:Schedule (9490) Disabled Today 1:02:07 PM m
@ 192.168.0.1AQ:SchedulePart (9491) day Today 1:02:07 PM
- Se———— - roy 2 e
@ 192.168.0.1AQ:Heat Temp (9493) Today 1:02:08 PM 40°F :
@ 192.168.0.1AQ:CoolTemp (9494) Today 1:02:09 PM 36°F :
0 192.168.0.1AQ:SpaceTemp (9495) 6°F
° 192.168.0.1AQ:ActiveStage (9496) 2 Today 1:02:09 PM
0192,168.D.IAQ:Humidity (9497) 28% Today 1:02:09 PM
o 192.168.0.1AQ:HumSetpoint (9498) 09 Today 1:02:09 PM 0% :
o 192.168.0.1AQ:DeHumSetpoint (9499) Today 10210 PA 0% 2
0 192.168.0.1AQ:Sensor-Thermostat-Temp (9500) 79k Today 1:02:11 PM
0192,168.0 1AQ:Sensor-Thermostat-Humidity (9501) 28% Today 10211 PA
0 192.168.0.1AQ:Sensor-Space Temp-Temp (9502) 76°F Today 1:02
0 192.168.0.1AQ:Sensor-Sensor 101-Temp (9503) 3'F Today 1:02
01924168.0.:“-. Sensor 101-Humidity (9504) 35% Today 1:02
192.168.0.1AQ:Alert-Air Filter (9505) Inactive Today 1:02:11 PM
192.168.0.1AQ:Alert-indoorHi (9506) Inactive Today 1:02:11 PM

Figure 68 Venstar Integration Setup and HS Devices
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11.2.4 Midea

Midea provides several appliances that have local as well as internet control. mcsMQTT implementation
is based upon local control. It uses the library provided at GitHub - nbogojevic/midea-beautiful-air:
Python client for accessing Midea air conditioners and dehumidifiers (Midea, Comfee, Inventor EVO) via
local network. The link identifies the models of Air Conditioner and Dehumidifer that are known to be
supported using the V2 and V3 protocols.

The plugin has only been tested with the Air Conditioner, but the hooks are in place should somebody
have a Dehumidifier and desires to support the integration. The current implementation is fully
functional, but the library seems to not support fan speed and sound control, but only provides status
for these.

The library needs to be installed per the reference instructions which are:

pip install --upgrade midea-beautiful-air

This assumes pip and Python are available on the computer where the plugin is installed.

The mcsMQTT setup is found on the Local Page, HVAC Tab of the plugin as shown in Figure 69. Required
parameters are the Midea account credentials and the rate at which HS status will be refreshed.

The library is accessed with application midea-beautiful-air-cli.exe. It should be on the search path
following its installation, but the path can be explicitly provided if the login account is different than the
install account.

Discovery of all appliances will be attempted on the LAN where HS is installed. If the appliance ison a
different LAN, then it’s IP can be explicitly specified, otherwise leave the IP textbox blank. Discovery will
be attempted at startup or when the setup parameters are modified. It can also be explicitly attempted
with the Discover button.
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https://github.com/nbogojevic/midea-beautiful-air

Discover Midea Thermostats

Polling Rate (milliseconds) 60000

Aocourt Ennail me@gmail_cnm
Account Password PTTT.
Folder Path of

midea-beautiful-air-cli.exe

Thermostat IP 192.168.33.45

C\Users\mes1\AppDatatLocal\Programs\Python\Python39\Scriptsh,

Midea | Laurie-downstairsAC

Midea-192.168.207.104 (9320)

@ 192.168.207.104:running (9321)
@ 192.168.207.104:mode (9322)

@ 192.168.207.104:target (9323)
O 192.168.207.104:fan (9324)
° 192.168.207.104:sleep (9325)
o 192.168.207.104:eco (9326)

192.168.207.104:purify (9327)

@) 192.168.207.104:indoor (9328)
@ 192.168.207.104:0utdoor (9329)

Running

Cool

74°F
Auto
MNormal
ECO
MNormal

T2°F
82°F

Today 10:07:42 AM

Today 10:07:42 AM

Today 10:07:42 AM
Today 10:07:42 AM
Today 10:07:42 AM
Today 10:07:42 AM

Today 10:07:42 AM

Today 10:07:42 AM
Today 10:07:42 AM

EEIC
=T -
T4°F ¢

T ]

Figure 69 Midea Integration Setup and HS Devices
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11.2.5 Polyaire AirTouch

The AirTouch 2 protocol V1.1 is a local control/status implementation using TCP port 9200 which looks
to be a modernization of a serial interface. It provides the ability to get various statuses and control of
power, mode, setpoint and fan. The interface is to a hub which is likely the serial to ethernet connection
and supports up to for Air Conditioning units per hub.

mcsMQTT provides the interface to one or more hubs. The setup is contained on the Local Page, HVAC
Tab as shown in Figure 70. It has provisions for user entry of the polling rate to refresh data and the IP
where the AirTouch Hub is located on the local network.

AirTouch

Polling Rale fmilliseconds) 0000

AirTouch #1 IP address 192.168.0.34
AunTowch #2 IP Address
AirTowch #3 IP Address
AuTaweh #4 IP Address

Figure 70 AirTouch Setup

Two queries are used. One is to get the names of the units. The other is to get the status. The name
query is used at startup and continues to be used until names delivered. The status query is run at the
polling rate and when data is returned it will create the HS Device and Features. A Device will exist for
each AC Unit and Features will be created for its properties. Figure 71 provides a view of the HS UI.

Controls are buttons for state-type Features and selector for the setpoint. The unit operates using the
Celcius scale and mcsMQTT converts to Farenheit if that is what has been setup in the HS regional
settings. Celcius setpoints are specified to the nearest 0.5 degree. Farenheit ones are to the nearest
degree.

With the serial communication orientation, a CRC is used. mcsMQTT generates the CRC for packets it
sends. Provisions exists to validate the CRC for the data from the AirTouch hub, but have not been
enabled pending integration testing.
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AirTouch | 182.168.0.34
[0 AirTouch-192.168.0.34-UNIT1 (3995)

O @ UNIT1:ACmode (3996) Heat Today 60346 PM
]
0 . UNITA:Power (3997) on Today 60346 PM
5 @ o p— N
O () unimi:Temperature (3999) 73°F Today 60347 PM
O ) unimi:setpoint (4000) TF Today 6:03:47 PM 72F +
O € unimi:Turbo (s001) Turbo Inctive Today 60347 PM
O @ UNIT1:Bypass (4002) Bypass Inactive Today 60347 PM
[ (©) UNITi:spill (4003) Spill Inactive Today 60347 PM
O @ UNIT1:Timer (4004) Timer Not Set Today 6:03:47 PM
O @ unimi:connection (4005) Cannected Today 60347 PM
O (@ unmi:Errorcode (4006) 0 Today 60347 PM
AirTouch | 192.168.0.34
[0 AirTouch-192.168.0.34-UNIT2 (4007)
O (D unmz:acmode (4008) Cool Today 60347 PM

Figure 71 AirTouch HS Device and Features
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11.3 LED
11.3.1 WLED

WLED is firmware typically loaded in ESP8266 and ESP32 that is used to provide a high degree of control
for color LEDs. The project is described at https://github.com/Aircoookie/WLED. The main string(s) of
LED support a MQTT protocol. A string that is divided into segments is controlled by REST/JSON
protocol. JSON is also used for playlist. mcsMQTT uses both protocols to provide full WLED integration.

WLED MQTT Topics all start with “wled”. mcsMQTT recognizes these topics and will create a primary set
of HS device for control and status. Advanced controls are also available with WLED and these can be
enabled by associating the Topic to HS device on the Association tab.

No setup is needed for WLED support for the primary strings. Segments and playlists use HTTP so an IP
address and the size of the segment is needed so mcsMQTT can provide the communication interface
with HS. This setup is on the Local page, LED tab as shown in Figure 72.

In this case two WLED devices have been recognized by mcsMQTT based upon the MQTT traffic with the
topic starting with wled/. One of these two has been identified to have only the primary string and no
segments with an IP at 192.168.0.143.

If any of these are to be controlled as segments then those parameters should be entered. The IP needs
to be set if either segments or playlists are going to be used. If no segments or playlists are used for a
given WLED string then no additional setup for that string is needed.
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IP Relay Dalkin WLED Serial Beacon

WLED Topic Max Segment Index WLED IP

wled/1b8996 0

wled/govee 0 192.168.0.143

Flayist Selections

Select Existing

Playlist FirstPlaylist v

Creale Mew
Playlist

Playlist JSON

Text {"ps": [26, 20, 18, 20], "dur": [30, 20, 10, 50], "transition": 0, "repeat": 10, "end"; 21}

Send Playlist
wlad/1b8996

wled/goves

Figure 72 WLED Segment and Playlist Setup

A playlist has been defined called FirstPlaylist that contains the JSON format expected by the WLED
playlist. If the JSON text is modified then the focused playlist will be updated. If a new playlist is to be
setup then the Create New Playlist text box is used to give it a name.

The playlists are stored as files in the \data\mcsMQTT folder with a file type of “.wled”. If the JSON text
of a playlist is cleared then the playlist file will be removed.

To test the playlist the Send Playlist selector can be used to select the WLED unit to send what is
showing in the Playlist JSON Text textbox.

The playlist can also be requested from the HS Device with the same Send Playlist control. Event actions
to send the WLED playlist are also available.

The Device and Features setup for a WLED device, including the playlist device, is shown in Figure 73.
When the playlist is commanded the HS playlist device is updated based upon the command. There is
no actual acknowledgement from the WLED device.
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wled | govee

[l -'?\ wled-govee (7374) Today 1:37:00 PM

| 0 govee-Status (7375) online Today 1:37:02 PM

D . govee-Brightness (7376) 0% Today 1:37:00 PM ®

T (@) govee-ofion (7377) OFF Today 1:37:00 PM [ or | o]
| o govee-Color (7378) 16752640 Today 1:37:02 PM

| o govee-Effect (7379) Solid Today 1:37:00 PM Solid :
O o govee-EffectSpeed (7380) 50% Today 1:37:02 PM ®

] o govee-Effectintensity (7381) 50% Today 1:37:02 PM ®

O @ govee-Preset (7382) 0 Today 1:37:02 PM QOrange 3
| ° govee-Playlist (7392) FirstPlaylist Today 1:38:11 PM FirstPlaylist 4

Figure 73 WLED Device and Features

The Preset device is created with a control of a Selector with values between 0 and 16. While this will
work to set each of the potential 16 presets in WLED it will be desirable to provide names rather than
numbers in the control. This is done from the Edit tab of the Preset Top using the VSP definitions.
Figure 74 provides an example where the first four have been renamed to Unknown, Orange, Rainbow
and Mood. WLED uses values starting at 1. It is likely the names given to the Preset in WLED will be
transcribed here to avoid name confusion. If there are presets that are not setup in WLED then they can
be removed from the VSP table so they do not show up in the HS Feature control.

Payload 0=0;Unknown VSP
Payload 1=1;0range V5P
Payload 2=2;Rainbow V5P
Payload 3=3;Mood VSP
Payload 4=44 'SP
Payload 5=5;5 VSP
Payload 6=6;6 VSP
Payload 7=7,7 V'SP
: Payload 8=8;8 VSP

1o DOVICS VSP - ioad 9-9°9 VSP
Payload 10=10;10 VSP
Payload 11=11;11 VSP
Payload 12=12;12 V3P
Payload 13=13;13 VSP
Payload 14=14;14 VSP
Payload 15=15;15 V5P
Payload 16=16;16 VSP

| Clear existing vsP

Figure 74 Name WLED Presets
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11.3.2 Nanoleaf

Nanoleaf provides a series of lighting panels that are generally intended for wall mounting. A local APl is
available by which control from HS is possible. The API provides Control/Status, Layout and Rhythm
data. mesMQTT provides all available data using the MQTT Topic Nanoleaf/#. Control/Status and
Rhythm information is automatically associated with HS Device and set of Features. Layout information
represents a static configuration of the panels which is normally setup in the Nanoleaf App. The setup is
visible in the Association Table, but no provisions exist in the plugin to change the Layout.

The setup process consists of the following steps:

1.
2.

Pair the panel’s controller to local WiFi network. This will result in a local IP address.

From the mcsMQTT Local Page, LED Tab, click on the Discover button. This will pick up the IP
and populate the Nanoleaf IP table. It can also be done manually by entering the IP in the
textbox.

The power button is depressed for 5+ seconds until the controller’s button status lights start to
blink. Within 10 seconds click the Get Token button on the Local Page, LED Tab. The plugin will
display in the table the Token that was provided by the controller. The Token will be static until
a new one is requested.

A polling rate for status refresh is entered on the same mcsMQTT Page. 60000 milliseconds is
reasonable.

View Device and Features on the HS Devices Page or other Ul.
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The setup page and the HS Devices page will look something like Figure 75 and Figure 76. The
Device is placed in Floor Nanoleaf and the IP of the controller.

H Gﬁ ESEE r HS4 Web Contro

Devices Events (Cameras~ Setup Tools~ Plugins~

IP Relay HVAC LED Serial Bluetooth IR/RF GW1000 Epson

WLED Topic Max Segment Index WLED IP

wled/100 0

wled/ 186 0

Discover Nanoleaf Units Discover

Mancleaf Polling Rate (milliseconds) 60000

Nanoleaf IP Authorization Token Request Token

192.168.0.243:16021 Sar1tZb0IF TogRbgljoLwhKjdSjpTSg Get Token

Figure 75 Nanoleaf Setup
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The Status Feature is based upon successful communication with the controlled which is
performed at the specified polling rate setup on the Local Page, LED Tab.

Three Rhythm Features are made available if the Nanoleaf panel supports the music sync.

HomeSeer

Devices Events Cameras~ Setup Tools~

Plugins ~

HS4 Web Control & default ~

= Ox o YT
Nanoleaf | 192.168.0.243.16021
Nanoleaf-192.168.0.243.16021-
Sha... (7529)
@ Shapes 3475-Status (7530) Online Today 111145 AM
@Shapes 3475-0n (7531) off Today 120104 PM “ “
o Shapes 3475-brightness (7532) 19% Today 11-12:25 AM °
°Shapes 3475-hue (7533) 271 ° Today 11:12:06 AM ®
o Shapes 3475-sat (7534) 75 % Today 11-12-10 AM ®
°Shapes 3475-ct (7535) 6337 ° Today 11:07:46 AM ®
o Shapes 3475-colorMode (7536) hs Today 12:01:04 PM
e Shapes 3475-effects:select (7537) None Today 12:01:04 PM None E

Figure 76 Nanoleaf Device and Features
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11.4 Serial (IP Serial and COM Serial)
Serial communication is normally provided via a bidirectional set of wires using a Universal Asychronous
Receiver Transmitter (UART) that is contained within the computer or provided by a USB to Serial
adapter. The technology to perform serial communication over Ethernet provides a similar capability
but is not as ubiquitous as the UART. mcsMQTT supports both of these mechanisms.

The setup is done on the Local page, Serial tab as shown in Figure 77. In this example the first row
identifies a serial connection to a Lantronix IP/Serial device. The IP/Serial device baud rate needs to be
setup manually as no provisions exists to communicate meta data over the Ethernet link.

The second row identifies port 1 at 4800 baud. The other serial parameters are set to No Parity, eight
bits, one stop bit (N,8,1). Port 1 will be COM1 for Windows or /dev/ttyUSB1 for Linux. In the Linux case
mcsMQTT will search for other /dev/ttyUSB ports if USB1 is not available. Linux switches ports,
especially when error conditions are detected so mcsMQTT tries to be tolerant of this. If multiple serial
ports are in use, then this could be problematic on Linux.

HomeSeer HS4 Weh Conral

Devices Eventz Cameras~ Setp Tools~  Plugins ~

IP Relay HVAC WLED Semal Blustooth IR/RF CW1000 Epson Resources Shedes Command

- - .
R End Of Line  Min Send Protocol Login .
Byte Interval Layer Credentials
1o 115200 10 0 Raw v None L
192.168.0.54:3001 4800 10 0 Telnet v None L
3 256000 248 0 Raw v LD2410C A
10 0 Raw v None A

Figure 77 Serial Communications Setup

The serial data received is treated as a MQTT payload. The payload is the data that is received between
End Of Line characters. This defaults to the Line Feed (LF)/Chr(10) byte. It can be change in the setup
for each serial port. If this field is left blank then a message end is defined as three second pause in the
reception of serial data.

Provisions have also been made on the transmit side to limit the rate of message transmission. This is
not normally needed, but if a limited link budget exists then it could be useful.

Data is transmitted via the DeviceString of the HS device that was created for each serial port such as
shown in Figure 78. Three controls are provided. The Submit button will send the DeviceString to the
serial port. The Close and Open buttons will close and open the serial port. If strings are going to be
sent through other mechanisms the CAPI is used to interface with mcsMQTT.
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649 Serial Serial Serial MQTT_Receive Yesterday

8:47:14 PM
|©""Mail","P":{"door"0,linl
1 |650[ @ Mall; P Serial | 192.168.0.49:3001 192.168.0.49:3001 Serial/192.168.0.49:3001 | MQTT_Receive | 248 Submit
{"door":0,"link": 10}y : h - :34:
{"door":0,"link": 10} 108045 08045 105.0.95: 1:34:54 PM

Close Open

Figure 78 Serial Port HS Device

Serial messages are managed as MQTT messages with the topic “Serial/xxx” where xxx is the port
address that was setup. Other features of mcsMQTT such as JSON decoding, History retention, Charting,
etc. are available for the serial messages.

In addition, decoding of known byte streams is available. The decoded data will be presented in JSON
format and available in the Association Table for subsequent use.

In the case of the HEX decoder, the received bytes are expanded into an ASCIl hex format (e.g. byte 31 is
converted to bytes with string representation of “1F “). With HEX decoding, the data being sent is also
encoded into bytes from a ASCII hex input. (e.g. “1F 20” is sent as two bytes 31 and 32).

The Jacuzzi decoder will also expand the serial bit pattern into a JSON set of messages. These appear in
the Association Table on the MQTT Page. If Auto-Create is enabled on the MQTT Page, Client Tab then
the HS Device and Features will be automatically created such as shown in Figure 79.

The Jacuzzi interface is somewhat specialized where a connection is made every minute or upon need to
deliver a user command. The connection remains open for five seconds and then closes until the next
polling cycle a minute later. Because of this specialized management of the interface the HS Device that
shows connection/port open/closed status will not reflect the actual state of the port, but will show the
desired state. To stop communication with Jacuzzi, then command the port to be closed.
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Jaouzzi | Jacurzi
Jacuzzi- 192.168.0.64_3629 (6447)

® ; ey
® i it (6449)

o.lmumd.lpdm (6450)

oJmn.i:sumelpda\e:Huul'mg (6451)
eJmuzic&depdalrﬁe:ierp (6452)
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Q) ocurzictightLight2 (6534)
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Q) sacurzictight:Speed (6537)

(1) JacuzaicPrimaryFateration: StartTime (6538)
() Jacurzi-PrimaryFateratior: Duration (653%)
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D) ocuzsicStatustipdate-Ozonator (§724)
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@ e : 7
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@Jmm:m;ummﬂm (6740)

o Jacuzzi:StatusUpdate-DegreeC (6741)
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Figure 79 Jacuzzi Auto Device Creation
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11.5 IR/RF - Broadlink / BestCon RM Pro and Mini
Broadlink produces a family of reasonably priced devices that are capable to transmitting IR and RF,
learning IR and RF codes, and has an online repository of many codes of commercial products. The
device is designed to operate with an App via cloud. It can be taken out of the cloud for local operation.
Much reverse engineering has been done with a leading contribution by with a python implementation
available at https://github.com/mijg59/python-broadlink.

The mcsMQTT integration started with the .NET rewrite of the early python code available at
https://github.com/kemalincekara/Broadlink.NET that includes several models through the RM2. With
a combination of Wireshark and other information gleaned from various sources the capability
expanced to include models through RM4 Pro. The RM4 Pro and RM4C Mini have been tested in this
integration, but nothing has been intentionally done to prevent earlier models’ operation.

The integration with HS provides the ability to connect the broadlink device to the local network,
discover the broadlink devices this has been paired with the network, learn IR and RF codes from a
remote, import IR codes from a Pronto hex format, and transmit IR and RF. The RF capability of the
Broadlink is robust for carrier frequencies locused on 433 MHz and 310 MHz, but falls off rapidly for
other frequencies. Fans are often controlled by 350 MHz or 305 MHz and the Broadlink will not be able
to be used in these applications. Bond is a supplier for a wider RF frequency range.

11.5.1 Putting Broadlink Unit on Local Network

Joining the network is a one-time activity to teach Broadlink what network to use. It is done with
Broadlink device setting up an open Access Point on a SSID it advertises. A computer or smartphone
with WiFi capability connects to the Broadlink AP and then sends the desired network credentials.
Broadlink device then drops its AP and connects to the desired network. It will reconnect to the network
with each power cycle.

A utility is provided for the case where the HS computer does not have WiFi, but some Windows/Linux
computer on the network does. A smartphone can also be used following the standard App for getting
connected to the cloud, but stopping without actually completing the process. The danger is not
stopping and the device is now cloud rather than local control. In this case one needs to start over with
the long press of the reset button.

Each Broadlink device will communicate with one IP. This is normally the cloud server when using the
Broadlink App. To take it out of the cloud it needs to setup to use the IP where mcsMQTT/HS is running.
This is done by putting the device in setup mode where it is producing an AP with SSID “BroadlinkProv”
or “Broadlink_WiFi_Device” and then providing it a packet that identifies the local network credentials.

The device has two setup modes. One is smart and one is AP. The AP is the one that is to be used.
Smart is indicated by a rapid flashing LED. The AP is by an intermittently flashing LED. Hold the
Broadlink setup button with a paperclip until it fashes rapidly. Relase it. Hold again for five seconds, but
not 10 seconds, until it blinks slowly. This setup mode selection may change among Broadlink models so
follow the instructons that came with the unit to put it in AP Setup mode.

The packet with network credentials is provided by mcsMQTT with the “Join Network” button. It can
also be provided by running the utility “BroadlinkJoinNetwork.exe” (described below) or can be done

Page 185


https://github.com/mjg59/python-broadlink
https://github.com/kemalincekara/Broadlink.NET

with smartphone, but one needs to abort the smartphone process before joining the cloud. Only one of
these three options needs to be used.

This is setup from the Local page, IR/RF tab of mcsMQTT. The local network SSID, password and security
mode information are provided followed by the button to join the network. See Figure 80.

Broadlink IR - RF

Network SSID Anthem
Network SSID Password sesssase
Metwork Security Mode WPA1/2 v

Join Network

Figure 80 Take Broadlink Device out of Cloud

Once the Broadlink deivce is in AP mode then use the Join Network button to allow it to join the local
network. It’s IP will be obtained by DCHP so look at DHCP server/router to get it or use other means to
sniff IP addresses. It may take multiple clicks of the Join Network button. Success is indicated by the
BroadlinkProv SSID is no longer present and a DHCP server has given the Broadlink device an IP address.

The WiFi network credentials are not retained, but only used in conjunction with the Join Network
button. This means that they need to be reentered if a second Broadlink device is going to be added.

As an alternate to joining the network a console application is also included in the bin\mcsMQTT that
performs the same function as the Local IR/RF page. This allows the target computer to establish the
network connection with the Broadlink device independent of HomeSeer. Note that when running
“BroadlinkJoinNetwork.exe” the file “broadlink.dll” also needs to be present at the location where
“Broadlink]JoinNetwork.exe” is running. Both of these files are available in the Updater zip orin
\bin\mcsMQTT folder.

It is used with a command line containing parameters of “WiFi SSID, WiFi Password, Security Mode
Number”. From Windows it is run from a console with path currently at \bin\mcsMQTT using the
command like

BroadlinkJoinNetwork “MySSID,MyPassword,4”
A similar Terminal window command is used on Linux

mono BroadlinkJoinNetwork.exe “MySSID,MyPassword,4”

It will provide a feedback direction to get the Broadlink device into mode to allow the WiFi network to
be used. This is 10 seconds hold followed by 5 to 9 second hold of the reset button. From the factory
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the Broadlink device will already be in this mode and have the Broadlink* SSID being advertised. In this
case there is no need to use the reset button.

If there are issues with the command syntax there will be feedback when running the application. It
may not take the first time so repeated execution may be necessary. The “BroadlinkProv” or
“Broadlink_WiFi_Device” SSID will drop off as it connects to the local network. The blue lilght on unit
will stop blinking when the WiFi to the local network has been setup.

11.5.2 Use of Broadlink Unit

11.5.2.1 Find Broadlink IR-RF Device(s) that are on WiFi Network

It may be possible to discover the IP address and this will be done each time mcsMQTT starts, but there
are times that the Broadlink device is silent to this request. The known IP address can/should be
entered in the text box provided. Refresh the page if entering multiple IPs. The status of the discovered
units and the IP entry is shown in Figure 81. If units are not found then the name (e.g. RM4 Pro) will not
be shown.

At startup, entry of an IP or use of the “Scan for Broadlink Device” button a broadcast query will be
made to confirm the Broadlink Unit is online and to get its authorization and encryption credentials. It
will also be done if a HS request to send a code is made and prior attempts have not succeeded.

Find Broadlink IR - RF Device(s) that are on WiFi Network

1) Broadlink Device Type (6498} R4 Pro

2) Broadlink Device Type (6480) Other R4
3) Broadlink Device Type (5208} Other R4

IF of Broadlink device 1 192.168.0.145:80
IP of Broadlink device 2 192.168.0.151:80
IP of Broadlink device 3 192.168.0.198:80

IF of Broadlink device 4

Scan Network for Broadlink Device(s)

Feedback for Broadlink Operation

Figure 81 Broadlink Unit Discovery and IP Address

11.5.2.2 Modes of Operation

The modes of operation affect the auto assignment of code to HS Features when learned and if HS
Feature is represented as an Appliance with VSP entries for each Code or as each Feature having a single
Code. These options are shown in Figure 82.
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Two modes of operation are provided to create Device and Feature for use in HS. One is to
automatically create the Feature when the Code has been learned. It will be assigned to the Broadlink
unit used for learning.

Two Device/Feature models are supported for Broadlink IR/RF. One is a Device for IR and/or RF for a
Broadlink Unit. Features of the Device are the appliances that will be controlled by the specific
Broadlink Unit. The DeviceValues and Status pairs will contain the set of codes for the appliance. This s
a concise representation of the control information

The second is oriented for voice control where each appliance a Broadlink Unit will control will be a
Device. Features will be created for each IR/RF code used to control the appliance.

A user can select which model best suits their need. They can be changed back and forth without losing
the appliance code information, but swapping will result in new HS Device Ref numbers. Examples of
these two representations are shown in Figure 85 and Figure 86.

HE Device/Feature Mode

et kndate HS Faatire A -
-reate/Update H Feature Assign Code Now to HS Feature when Leamed or Imported

for Learned Code

o® 00

Onby Later Azssign all Codes in Appliance to HS Feature Manmually

Figure 82 Broadlink Use Operational Mode Selections

11.5.2.3 Build IR & RF Code Library (Learn or Import)

The library consists of a set of Appliances and a set of Codes for each Appliance. It can be populated by
any combination of import from Pronto format or learning with one of the Broadlink devices. Separate
library entries are made for IR vs. RF.

To start a learning process a Broadlink Unit needs to be selected. It will be the one being controlled
when learning from a remote. If auto-assignment is selected it will also be the one for which a HS
Device will be created. Both the Broadlink Unit selection and auto vs. manual assignment selection are
shown in Figure 86.

Note that the unit used for learning does not need to be the one later used to transmit codes. The
library is just the Appliance and Code and has no relationship to the Broadlink unit. The Appliance/Code
relationship to Broadlink unit relationship is made as HS Features are generated.
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Build IR & RF Code Library (Learn or Import)

Unit to be used for leaming and

opticnal autc-assignment to HS Feature

Appliance name to be leamed and )
Sign

optional autc-assignment to HS Feature

=

Code name to be learned

Leam IR Code

Learn RF Frequency
Learning Operations
Cancel Learning

Play Last Learned Code

Import Codes from Pronto Hex format

Figure 83 Building of Broadlink Appliance/Code Library

Learning also requires that an Appliance and the Code function be identified. These are two text boxes
shown in Figure 83. When the learning function is complete the code function text box will be cleared.
The appliance text box will remain to allow subsequent code learning.

IR learning is usually straightforward where one observes the LED on the front of the Broadlink unit to
know it is in learning mode and then send the code from the remote and the LED will go dark to indicate
the learning is complete. There will also be similar feedback in the Feedback window of the Local Page.

RF learning is a two-step process. The first is to learn the 433 MHz vs. 315 MHz frequency being sent.
The second is to learn the RF code on that frequency. The RF learning starts with the Frequency
detection. When found the LED will no longer be illuminated, mcsMQTT will show in red Feedback that
this phase is complete and the RF Freq button will be replaced by a RF Code button. Click on the
mcsMQTT RF Code button to start learning of the code at the detected frequency. A longer press is
used for the frequency learning. It may need to be repeated until the frequency is determined. Prompt
will be present for short press of the remote for the code to be learned. Usually only one press is
needed and the LED will no longer be illuminated to show the success. mcsMQTT will also provide the
success feedback.

There are times when learning does not go smoothly. The Cancel learning button can be used to stop
the process that looks to not have completed. Another attempt can then be made.

Rather than learning an appliance code function from a remote, a Pronto hex code can be entered.
There are two ways to do this. One is to cut/paste a Pronto code for another source. In this case the
appliance name and code function need to be entered prior to entering the Pronto hex in the text box.
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The second approach is to import a file that contains the Pronto codes for a given appliance. In this
case the filename rather than the individual Pronto code is entered. The contents of the file are
assumed to be alternating lines of the code name and the hex code in Pronto format. Blank lines are
ignored. For example, a file may have the following contents. The code names are imported with
spaces replaced by underscores to avoid syntax and parsing issues.

Toggle power
0000 006C 0022 0002 015B 00AD 0016 0016 0016 0016 0016 0016 0016 0041 0016 0016 ...

Toggle display
0000 006C 0022 0002 015B 00AD 0016 0016 0016 0016 0016 0016 0016 0041 0016 0016 ...

While learning can be done of IR and RF code from an existing remote device, the IR learning can also be
imported from codes available on internet sites such as http:// irdb.tk/find/ that will be available in
pronto hex format. RemoteCentral is another location that a large user-contributed database of pronto
codes, but it is somewhat more dated. An example of the import format for Samsung TV numbers 0 and
1is shown in Figure 84. To use them enter the appliance name and code name into the mecsMQTT
textboxes, copy from the site the hex sequence text and paste into the Import Codes from Pronto Hex
format textbox.

Known IR codes for Samsung TVs

Note that not every Samsung TV necessarily supports all functions on this page
Possibly only the top-of-the-line models have all the functions

What to do with these codes? Program them into your programmable remote control, or build something great using Arduino, or
Protocol information  Pronto Hex ~ UEIHex  Raw  Widget
0000 EO5C 90RO 9922 GPAD GOAD @916 @94l PO16 @941 916 @941 0916 DELlE 9916 G916 0016 PALE 9Pl6 @Ol6 PAl6 @016 @916 GA4l POl @P41 @16 @941 0016 0816 0916 0016
5016 6016 GR16 G816 0016 GO16 @P16 GA41 0016 G016 16 BA16 GO16 BO1E AB16 GB41 0B16 AALE GB1E 0816 0A16 GO16 BA16 0016 BOLS @B41 BA16 G041 G016 8841 G816 BB1E
0016 6041 GB16 G841 GO16 G841 @ALE GGFS

0080 0O6C AROG G322 GRAD GOAD @216 @341 0016 B84l @216 0641 BGA16 PO16 8216 @Al6 0816 @B16 @816 @316 2016 @016 2@lé 24l 2016 P41 8alé @4l @015 8@l6 Valé 8el6
@91c 00le 2216 @916 @9le @016 @Ple ©91lp G016 ©Al6 221t 0e41l 0@16 POle Vele @@le ©0le POle 20l ©9le P91le @016 2ele 2041 00le PB4l 9216 9916 091le 0241 @216 0041
@916 0841 2216 @941 0316 @041 @R16 Q6FB

Figure 84 Sample Pronto IR Code

The IR and RF codes are stored in \Config\BROADLINK.ini. It is possible to manually add entries to this
file if there are other sources from which the codes can be imported. The “Assign IR Appliance to HS”,
“Assign RF Appliance to HS”, and “Remove Appliance from HS buttons” are used to manage the subset
of the Appliances in BROADLINK.ini (i.e. library) that are visible to HS. For example, the “View Learned &
Imported Library” selector can be used to view what appliances are available in the library. The
appliance name then can be put in the “Appliance name to be learned to assigned to HS” textbox. The
“Assign IR Appliance to HS” button then used to create a HS control for this appliance and this control
will include all the IR codes from the library for this appliance.
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For Pronto hex then code can be obtained interactively from the web site and the code pasted into the
pronto hex text box after a name has been entered for the code. mcsMQTT will convert the code to the
Broadlink format and stored just as if it had been learned with the physical remote.

11.5.2.4 Assign Appliance Codes from Library to HS Feature

Broadlink | 192.168.0.145

0

Broadlink-192.168.0.145-IR (8384)

| ° None

Broadlink-192.168.0.145-IR- 0 Today 8:41:24 PM
Pioneer (8385) &

“*

Figure 85 Broadlink VSP Oriented Representation

Broadlink | 192.168.0.145

BN
Broadlink-192.168.0.145-IR-Pione...
(8380)

0@
Broadlink-192.168.0.145-IR-Pioneer-
Volume Up (8381) &

0
Broadlink-192.168.0.145-IR-Pioneer-
Mute (8382) &

0 e
Broadlink-192.168.0.145-IR-Pioneer-
Power (8383) &

Today 8:07:10 PM

Today 8:07:10 PM

Today 8:07:10 PM

Figure 86 Broadlink Feature-Oriented Representation
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Assign Appliance Codes from Library to HS Feature

Appliance name to be used for
Manual Assignment to HS Feature

Create/Update HS Feature{s) for Selected Appliance and IP
hanual Operation

Remove Selected Appliance and IP fram HS

192.168.0.151:B0
From Broadlink Device e

. 192 168.0.145:80
192 168.0.19880

192 168.0.151:B0
To Broadlink Device 102

92168.0.14580

Replace/Reassign Device Assignments

192 168.0.198:80

®
O
@]
@]
®
O

Replace assignments of 'From Broadlink Device' to 'To Broadlink Device'

Duplicate assignments of From Broadlink Device' to 'To Broadlink Device'

Figure 87 Assignment of Appliance & Code to HS Feature

Appliance Codes that already exist in the library can be manually assigned to HS Feature. The Broadlink
Unit and the Appliance need to be selected followed by the button to create the HS Feature. They can
also be removed from HS, but not removed from the library, using the second Manual Operation button.
Removal from the library is described in Section 11.5.2.5.

It is also possible to replace the codes from one Broadlink unit HS Device into another such as may be
desired when replacing the physical unit or moving it to a different location. Rather than replacing a

Broadlink device it is also possible to clone all the Appliances that have been associated into another

Broadlink unit.

11.5.2.5 Appliance Code Library Edit and Management

All learned and imported codes are maintained in the file \Config\BROADLINK.ini. One section is for IR
and one for RF. Each row will contain the Appliance|Code name and the base64 Broadlink format for
playback.

This file is augmented as new codes are learned and imported. The library of codes can be made
available to HS using the manual assignment buttons shown on Figure 87. Prior to manual assignment
the Broadlink Unit selection radio needs to be set and the Appliance name text box needs to be
completed.
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This same assignment operation can be done immediately after a new code is learned. This is the auto-
assignment option shown in Figure 83. If the same Appliance is to be controlled by two Broadlink Units
then the second one will need to selected with the radio and the manual assignment button used.

A dropdown selector is available to view the Appliance|Code names contained in the library. There is
no control action with a selection. However, after this selection the ability to edit the pulse and repeat
properties as well as deleting the item from the library becomes enabled.

The “Delete Code from Library” button the item will be permanently removed from Config\Broadlink.ini
file. The textboxes for pulse and repeat will augment the library code with instructions for modifying
the pulse timing or repeating the code. See Section 11.5.3 for more information on these properties.
The event JSON, when used, will have priority over properties defined here in the library.

11.5.3 Broadlink MQTT and Event Interface

The Broadlink information will also be available via the MQTT Page, Association and Edit tabs. The Topic
structure is “Broadlink/IPxxxx/YY/Appliance/Code” or “Broadlink/IPxxxx/YY/Appliance” depending upon
the HS Device model of Feature vs. VSP, respectively. The IPxxxx will be the IP of the Broadlink device.
YY will be IR or RF. Appliance and Code are the names assigned at time of learning.

The Association Tab will show which topics have been associated with HS devices and will also show a
“/set” suffix added for the publish topic. When HS commands an IR or RF code there will be a MQTT
message sent. If a MQTT message is received that matches the topic then the code will be sent through
the Broadlink Unit.

When used in HS Events the control action will be the Broadlink IR or RF feature. There are no triggers
available for when an IR or RF code has been learned or sent beyond that provided by the DeviceValue
change of the feature.

Generally, when an IR or RF code is requested to be sent the code will be the one that was learned. Itis
also possible to modify the IR code as part of an Event Action. In this case a JSON payload is used to
specify the tweaking that is to be performed. See Figure 88.

The JSON payload consists of any of three keys. If a key is not in the payload, then the code will be used
unchanged from the learned library.

“code” is used when the VSP device model is used to specify which code is being sent. It can also be
used in the Feature model and should be the same as the code using the Topic.

“repeat” is the number of times the code IR should be sent. A value of 0 is zero repeats. 1 is for one
repeat which means the code is sent twice.

“pulse” is the change in the number of pulses that represents each On/Off burst. This can be used to
tweak the timing of the IR signal for sensitive equipment. A value of -1 will reduce the number of pulses
at each transition by one. A value of 3 will increase the number of pulses by 3.
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If

This Event Is Manually Triggered v = +]
THEN
Send Magtt Message, MQTT Publist or WLED Playlist v

Options are to publish a single MQTT message specified as Topic=Payload, request a WLED playlist as
Topic=Playlist, Or to publish multiple MQTT messages as specified in a Publication List (Publist). General
Tab default QOS And Retain will be used.

Select between Message, Publist Or Playlist

Message v

Broadlink/192.168.0.145/IR/VCR={"code":"Power"'repeat":2,"'pulse"- 1}|

Figure 88 Broadlink Control Event Action

11.5.4 Broadlink Sensors

Broadlink makes available a USB power cable (Model HTS2) that contains temperature and humidity
sensors in the cable. The RM4C Mini does not support this cable, but others do. The earlier RM versions
only support temperature. If it is being used then mcsMQTT will create the HS devices as shown in

Broadlink | 192.168.0.145

O @ Broadlink-192.168.0.145 (7037)
] 192.168.0.145-temperature (7038) 78 Today 11:36:05 AM

] 192.168.0.145-humidity (7039) 37 Today 11:36:05 AM
Yy )

Figure 89 HS Devices for Broadlink Sensors

The device delivers temperature in Celcius. If Farenheit is desired then use the Edit tab or popup
Expression text box to do the conversion. For example enter SSPAYLOAD:*1.8+32.
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11.6 IF/IR Link-N-Link RF & Link-N-Link IR (TV)

Link N Link provides a variety of products at an attractive price-point. One is the RF hub
https://kb.linknlink.com/kb/smart-home-devices/eremote/radio-frequency-rf that supports the same
frequency band as the Broadlink RM Pro (310 MHz and 433.91 Hz). It may support others since the
carrier frequency for learning is user-specified. | suspect, however, that the internal circuitry is tuned to
one of these two frequencies so much variation from these will not be supported by the hardware
design.

The Link-N-Link integration provision is focused on use of Home Assistant but the underlaying
communication protocol is MQTT with a layer of Home Assistant Discovery that mcsMQTT is able to
understand. This means that after the Link-N-Link-RF can been connected to the local WiFi network, any
learned RF code to support an appliance function (e.g. TV On) will be automatically result in a HS Device
Feature being created so the control can be done via a HS Device Feature action.

Figure 90 shows two Features being created following learning of two RF buttons. The first is when no
editing is done on the LinkNLink App following learning of the code. The second is after the button was
edited to a more friendly name “Light D button”.

The status being reported is online vs. offline to indicate if the Link N Link RF hub is available to send a
RF command. Each has a button which will always be labeled “CustomizeXX” where XX is the button
number identified. The text of the button can be edited in HS Devices menu where then control button
text is changed from customizeXX to whatever you desire the label to be. Likely it will be something like
“Turn On TV”.

HomeSeer HS4 Web Control & mesSolutions@CenturyTelnet ~

Devices Events Cameras~ Setup Tools~ Plugins~ _ SEARCH >
= 0x o @) B @B @

home | ceac0000

home-ceac0000 (4052)
home | 41005dbeceac000046edf5637c00_customizel

@cusmmizm button (4053) online Today 12:38:13 PM

home | 41005dbeceac000046edf5637c00_customize2

@ Light D button (4054) online Today 12:38:13 PM CUSTOMIZE2

Figure 90 Link N Link RF Feature Creation

| found the Link N Link RF to be finicky when being setup. | think this reflects a lack of maturity and
robustness. It will work for one specific sequence, but not for any other. Uploading firmware that will
provide the HA integration capability was successful, but a power cycle of the device was needed.
Retries were also needed with doing firmware updates and making connection to the WiFi network. |
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also found it to be difficult to initially connect to my WiFi network. It seemed to be product that was
quickly released without appropriate consideration for the technical capability that its sales audience
will have.

An unexpected situation occurred when the UDP port used for Broadlink device discovery was the same
port being used by the Link N Link device. With 65,000+ ports available and the same being used for
both products, | suspect there was some code borrowing between the new Link N Link product and the
mature Broadlink product.

The capability of support of RF frequencies around 433 MHz and 310 MHz are a further clue that the
Link N Link has leveraged the Broadlink product.

From a functional perspective, after getting through the hurdles, the ability of the Link N Link to control
RF is similar to that of Broadlink RM Pro. It has a smaller form factor and can be obtained at a lower
cost.

The downside is that a smartphone App is required to learn codes and in general manage the device.
The integration with HA/HS is just an afterthought. In the Broadlink case, all learning, control, and
device code management can be done within the capability provided by mcsMQTT. The Link N Link
earned codes are not available so it is not possible to tweak the codes to satisfy needs of specific
equipment. This tweaking ability exists with the Broadlink device.

To use the App to setup the RF Hub, start at the My Home screen and click the + icon in the upper right.
Select “eSeries Hubs & Sensors”. Select “RF Hub eHome/eHome HA”. It will find the “Smart Home
Bridge”. Select it and then click “Join the room”. Pick a room that describes where the RF Hub will be
installed. Change the name from “Smart Home Bridge” is desired. Click Save. Next it asks about Sub-
Functions. This does not apply to the RF Hub so click “Skip”.

For adding Appliances that can be controlled with RF codes, select the “Use Device Now” button. “Add
Appliance” button. Pick one of the pre-defined Appliance icons. The App has access to a library of
known IR equipment, but | doubt if there is much available for RF equipment. To learn from an existing
remote/fob select “Cannot find my brand” or for some appliances it will skip this step and go directly to
“Learn Remote Now” button. Navigate screens that narrow down the specific function being learned,
and then select “RF Remote” (i.e. not IR Remote). Pick a room. Enter a name for the function of the
button. Click “Save”. “I know it” for help screen. “Use Device Now” button again. Click on one of the
button icons. Click “Start Learning”. Click “Learn simple RF code”. At this point the LED on the Hub
should be illuminated indicating that it is in learning mode. Enter the RF Frequency such as 433.92. If
you do not know the frequency then click on the link at the bottom “Try auto frequency scan”. When
scanning, hold the remote/fob button continuously until the frequency is displayed on the App. When
learning codes just use a short press like one normally uses to activate the function. After the code has
been learned, its use can be confirmed from the App to control the Appliance function over the network
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11.7 Bluetooth

11.7.1 Sensors and Actuators

There are a multitude of low powered devices that transmit locally via Bluetooth. Most are sensors such
as temperature, humidity, door/window, motion, etc. There are some that can be controlled such as
the Switchbot Bot or Curtains.

Bluetooth is similar to Zigbee with respect to battery usage and range, but generally a hair slower in
responding. This difference will usually not be noticed. Because of the limited range, whole-house
coverage cannot be achieved with a single Bluetooth receiver. Fortunately, the ESP32 has built-in
Bluetooth in most of its models that can act as a bridge between Bluetooth and WiFi or wired ethernet.

Firmware for the ESP32 comes in various varieties such as with ESPHome and Arduino projects.
Openway is the choice made for support with mcsMQTT due to it extensive library of devices that it will
decode and active support to handle new ones as they become available. The firmware is available at
links from OpenMQTTGateway v1.7.0.

mcsMQTT will accept all Bluetooth devices discovered by OpenMQTTGateway and place their properties
in the Association Table that is available on the MQTT Page, Association Tab. For the popular ones such
as Shelly and Switchbot it will auto-create HS Device and Features. The others of interest can be
associated with HS by clicking the “a” column checkbox on the Association Table.

In the case of Shelly Bluetooth devices, it is possible to use the ESP32 contained within the powered
Shelly Gen2 and Gen3 devices to act as gatetways. mcsMQTT will automatically detect the Shelly
Gen2/3 devices and configure them to support the gateway function using the same MQTT message
format that is used for OpenMQTTGateway. It will use the MQTT Topic ShellyBLU/x/BTtoMQTT/y where
x is the Id of the Shelly Gen2/3 device and y is the MAC address of the transmitting Bluetooth device.

mcsMQTT is made aware of OpenMQTTGateway (OMG) from the Local Page, Bluetooth Tab as shown in
Figure 91.
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HomeSeer

Devices Events Cameras~ Setup Tools~ Plugins~

IP Relay HWVAC WLED Serial Bluetooth IR/RF

BLE Sensors and Controls via ESP32 OpenMQTTGateway

OMG MQTT Base Topic(s),

BLE

Discover Mew Devices

Update Associated Devices

C®eo0O

Disable Gateway

Figure 91 Bluetooth Sensor and Actuator Setup

OMG has its own Web Server for configuration and it includes specification of the base Topic that will be
used. It defaults to “home/” but can be changed if desired. Whatever is used is identified to mcsMQTT
by the Base Topic entry shown on Figure 91. If more than two ESP32 devices are being used for OMG
then each can be specified using semicolon to separate each. mcsMQTT does not expect the trailing “/”
in its setup as is used in OMG.

This Topic is used to know that a message may need special handling to look for Shelly, Switchbot and
others for auto-creation. It is also used in conjunction with the three radio button positions under the
Topic. The default is Discover and operates like the same on the MQTT Page Client Tab for MQTT Topic
discovery. This can be chatty as some BLE devices tend to advertise their presence every few seconds.

The plugin also configures OMG to send only messages for things that look like sensor/actuator type
things and excludes the beacon type reports that are normally used for tracking. This significantly lowers
the traffic.

When the radio is in the middle position, mcsMQTT will create a whitelist of BLE devices that OMG
should forward updates. This really quiets it way down. The whitelist is formed by the set of BLE devices
that have been associated with HS. In the Shelly BLU DW case, the message is only received when the
sensor changes.

Page 198



Another message filtering approach to reduce the transmissions from OMG is to use its blacklist. Any
Topic in the Association Table that from OMG can be checked in the “r” column to mark it for rejection.
The set of rejected Topics will be delivered to OMG as the blacklist.

In summary, Association Table “a” is used for whitelist and “r” is used for blacklist of the OMG-delivered
Topics.

The bottom position will disable all updates from OMG.

The received data in the Association Table will look similar to Figure 92. This figure shows where some
of the properties of the Shelly DW have been automatically associated with HS Devices, where some are
not associated, but are available for viewing or association, and other device Emporia, PROV_437034v
was not associated. The HS View of the Shelly DW Device is shown in Figure 93.

I~ B I I =

4957  BLE/OMG_ESP32_BLE/ETtoMQTT
1 BLEfOMG_ESP32_BLE/ETtaMQTT/040D84ER528C
Diew: shellies|shellies| 040084E2528C-batt

; WP Sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040D84ES528C batt o
= & - Pub: the following Topic on Device command BlERel b
3 [ ] sub:BLE/OMG_ESP32_BLE/BTtoMQTT/040D84E8528C:hrand  Shelly 2024-02-13 19:27:54
4 [] sub: BLE/OMG_ESP32_BLE/ETtoMQTT/040D84EB52EC: 04:00:84:E8:52:8C 2024-02-13 19:77:54
Dew: shellies|shellies| 040084E2528C-lux
) Sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040084E8528C: ux o
g = - Pub: the following Topic on Device command 2024-02-13 18:27:54
[ |
8 [] sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040D84E852EC:mac 04:00:84:E8:52:8C 2024-02-13 19:27:55
7 [] sSub: BLE/OMG_ESP32_BLE/BTtoMQTT/040084E8528Cimadsl  ShallyBLU DoorWindow 2024-02-13 19:27:54
8 [] sSub: BLE/OMG_ESP32_BLE/BTtoMQTT/040D84EE528C:imodel_id SEDW-002C 2024-02-13 19:27:54
g [ ] sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040DB4E8528Ciname  SEDW-002C 2024-02-13 15:27:54
Dew: shellies|shellies| 040084E8528C-open
) Sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040D84ER528Ciopen o
9 & Pub: the following Topic on Device command 2024-02-13 18:27:54
|
11 [ ] sSub: BLE/OMG_ESP32_BLE/BTtcMQTT/040DB4ERE2ECipacket 63 2024-02-13 19:27:55
Dew: shellies|shellies| 040084E8528C-rot
) Sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040084E8528C:rot o
12 “ Pub: the following Topic on Device command 2024-02-13 18:27:54
[ |
13 [] sSub: BLE/OMG_ESP32_BLE/ETtoMQTT)/040084E8528 C:rssi -25 2024-02-13 19:77:54
14 [ ] sub: BLE/OMG_ESP32_BLE/BTtoMQTT/040DE4E852EC:type CTMO 2024-02-13 19:27:55
15 BLE/OMG_ESP32_BLE/ETtoMQTT/345650437036
18 [] sub: BLE/OMG_ESP32_BLE/BTtoMQTT/348650437036:id 34:86:50:43:70:36 2024-02-13 19:27:51
17 [ ] sub: BLE/OMG_ESP32_BLE/BTtoMQTT/348650437036iname  PROV_437034v 2024-02-13 19:27:53
12 [ ] sub:BLE/OMG_ESP32_BLE/BTtoMQTT/348550437036: r=si -1 2024-02-13 15:27:51
18 BLE/OMG_ESP32_BLE/BTtoM(TT/BI9122F762BF

Figure 92 Bluetooth Devices in Association Table
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shellies | shellies

SBDW_002C-040D84E8528C (7823)

040DB4E8528C-batt (7824) 100 %
9 040D84E8528C-lux (7825) 0 lux
@ 04084E8528C-rot (7826) 0°
@ 040D84E8528C-open (7827) closed

Today 8:46:54 PM
loday 10:39:57 PM
Today 8:46:54 PM

Today 10:40:27 PM

Figure 93 Shelly Bluetooth Door Window Sensor
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11.7.2 Shelly Bluetooth Trigger and Action

Shelly Gen2 and Gen3 devices have capability to receive Bluetooth transmissions. These transmissions
will automatically be delivered as JSON payloads on the ShellyBLU/# Topic as described in the previous
section.

These payloads can be used in HS Events as triggers for subsequent actions. It is also possible to have
the Shelly device evaluate the received Bluetooth transmission and when a criteria is met to have a
MQTT message sent. This provides a more direct alternative way to control widgets that can be
controlled by MQTT protocol.

The setup of these Bluetooth triggers and actions is shown in Figure 94. Each Bluetooth transmission
contains a 12-character MAC as a unique identifier. The trigger or match criteria is specified as an
expression that starts with the JSON key being matched, the logical operation and the value of the key.
(e.g. temperature>=50). The logical operators supported are "==",">=", "<=","I=" "<>" "=" ">" and
"<". The trigger condition can also be just the JSON key where any JSON value will be considered a

match.

When the match/trigger criteria have been observed, the Shelly device will send MQTT message with
the Topic and Payload setup.

BLE Event Actions via Shelly Gen2/3 non-Battery Devices

Shelly Device Shelly IP BLE MAC ID BLE Match Criteria Publish MQTT Topic Publish MQTT Payload

shellyplusipm-

TR 192.1680.172  38398F8BBBD1 button=1 home/41005dbeceac000046edf5 customizel m
aB032ab2dbal

shellyplusipm-

192.168.0.172
aB032ab2dbaB :

Figure 94 Shelly Bluetooth Trigger and Action Setup

When the Configure button is selected then the criteria defined in the setup shown in Figure 94 will
configure the Shelly device and it will persist a Shelly device reboot. All criteria for any given Shelly
device will be configured upon use of the Configure button.

It is also possible to dynamically add criteria via MQTT message. The criteria added in this manner will
not persist a Shelly device reboot. If the message is sent with the retain flag set then each restart of the
Shelly device will have the message resent so effectively making it a persistent configuration. The
message protocol is:
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Topic: ShellyBLU/<shellyDeviceld>/Config/<Bluetooth MAC>
Payload:

{“Topic”:"<ActionTopic>",
” Payload”:”"<ActionPayload>",
”0p”:"<matchOperator>“,

”.n

"Key”:”<matchKey>",

”.on

"Value”:"<matchValue>"}
For example:

Topic:  "ShellyBLU/shellypluslpm-a8032ab2dba8/Config/38398F8BBBD1"

Payload:
{“Topic”:”home/41005dbeceac000025e7cdcf7fbb/press_command”,”Payload”:”custom
iZEl”,"Op” :Il>ll,” Key” :II button”l”va | uell :II 1//}

The order of items in the JSON payload does not matter.

The use-case that initiated development of this capability is the LinkNLink device that sends RF or IR
codes based upon receipt of MQTT messages that specifies the specific code to be sent. This allowed a
Shelly Bluetooth button to be used to control a machine that is normally controlled by a RF fob.

In this scenario, mcsMQTT serves only a setup role and is not involved in the real time operation. The
same is true of HS. HS can act as a monitor since the same information is available to it, but is otherwise
not involved with normal operation of a Bluetooth transmission resulting in a non-Bluetooth action.

Page 202



11.7.3 Beacon
Beacon monitoring using BLE is available on Windows and Linux platforms. Evaluation on Linux has only
been done with RPi using its built-in Bluetooth capability. Windows 10 is required for the Windows

platform using a USB Bluetooth receiver.

On Windows 10 platform that has a Bluetooth Low Energy interface it is possible to monitor the
presence of BLE beacons with HS4 version of mcsMQTT. The products used for this evaluation include
the following as well as other BLE beacons.

Miilink USBE Bluetooth Adapter, Bluetooth 5.0 + EDR Bluetooth USE Dongle, Mini
- / Bluetooth Adapter for PC, Bluetooth Keyboard, Mouse, Headphone, Speaker Compatible

= with Windows7/8/10 (Gold)
Sold by: miibuy

Return eligible through Jan 31, 2021

$8.599
| Buy it again View your item

FrAsvIoN Feasycom 4000m Mobile USB Long Range eddystone ibeacon Google Android ble
Bluetooth Beacon with SDK

\ Sold by: Shenzhen Feasycom Technology Co., LTD Product question? Ask Seller
Return eligible through Jan 31, 2021
$£31.09
| Buy it again View your item

Figure 95 Bluetooth Beacon and Interface

Beacon discovery is controlled by the setting on the Beacon tab of the HS4 Local page as shown in Figure
96 or on the HS3 BLE page. The top radio disables the beacon scan on the local computer and does not
process any MQTT Beacon/ topics from remote computers. The second radio continues to update the
status of previously discovered beacons. The third radio enables discovery of new beacons. The fourth
radio disables the local computer BLE processing but will update existing beacons from remote
computers. The last radio allows new beacons to be discovered from remote computers.
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Devices Events (Cameras~ Setup Tools > Plugins =

IF Relay Intesis/Daikin WLED Serial Bluetooth

BLE Beacon

Disable All BLE Beacon Processing

Only Update Local and Remiote ELE Beacons
Discover New Local and Remote BLE Beacons
Only Update Remote Beacons

Discover Mew Remoate BELE Beacons

Default of Update HS Device Value with RSS|

C® 0000

Default of Set HS Device Walue to 0 when Beacon in range

Out of Range Timeout Seconds

60

Figure 96 Beacon Tab Settings

Discovered beacons appear in the Association table. They can be easily identified by using the Topic
filter of Beacon in the T1 position. A beacon for which status updates are desired in HS will be
associated by using the “A”ssociate column checkbox. The bottom row of Figure 97 illustrates this and
the HS device appearance is a shown in Figure 98.
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Filter Association Table by Maqtt Topic and JSON Payload Key

Clear Filters Rebuild Filters

Show Selected Assaciations

Association Table for Auto Association of MQTT Topic and HS Device

e a ref payload lastdate
1] 5663 Beacon
] ] ]
Sub: Beacon/3D.8E.84.81.38.DF -66 2020-10-1611:52:53
O O O O . : O
2 Sub: Beacon/52.F1.AD.C4.6E.EF -80 2020-10-16 11:52:53
O O O O e O
4 Sutbx Beacon/7D.F2.15.C0.9E.C8 -84 2020-10-16 11:52:53
] ] ] O . ' ]
4 Sub: Beacon/DC.00.30.47.02.09 -66 2020-10-16 11:56:46
] ] ] O . ' ]
Dev: Beacon|Beacon|400m_DD.00.30.46.30.2E
Sub: Beacon/DD.0D.30.46.3D.2E
Pub: the fallowing Topic on Deviee command ) GE-
5 / -5 2020-10-16 11:56:44
] ] ] m . O ]
Figure 97 BLE Beacon in Association Table
1
Beacon | Beacon
O @ Beacon (5663) Today 11:53:53 AM
[] § ) 400m DD.0D.30.46.3D.2E (5664) 52 Today 11:59:06 AM

Figure 98 Beacon Status in HS

When a beacon advertisement is in range of the Bluetooth interface the HS device will be updated with
the signal strength (negative of RSSI) shown in the DeviceValue and green icon. The signal strength is
smoothed with a low pass filter so its value will not be jumping around due to sampling differences.

When out of range for 60 seconds the icon will change to red and the DeviceValue will be changed to -1.

In a typical situation there will be only a limited number of beacons that are of interest. Once these
have been discovered then the Beacon tab entry changed to the second or fourth position. It can be
changed to allow new discovery later if a different beacon is to be monitored.
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The Association table will contain beacons that not of any interest. To reduce clutter the “O”bsolete
column checkbox can be used to remove them.

Beacons that are associated with HS devices can be customized on the Edit tab to change the location
and name if desired as shown in Figure 100. Edit tab is most easy viewed by clicking the Ref column
button of the device that is being edited from the Association table.

The global beacon timeout and RSSI parameters setup on the Local page, Bluetooth tab shown in Figure
96 can be altered on a beacon-by-beacon basis on the Edit tab. When a beacon is accepted for HS
device association these parameters will default to what has been setup on the Local page, but later an
be changed on the Edit tab or the MQTT page.

Two applications are made available for Linux that can be run on local or remote computers. BLEMQTT
is for HS3 positions identification support. BLEMQTTHSA4 is for HS3 or HS4 to support Home-Away logic.
In the HS3 case the mode of operation of the plugin for BLE is selected on the BLE Page as shown in
Figure 99.

Beacon Application Mode

) Location Identification on XY grid
® Home - Away Device notification

Figure 99 HS3 BLE Application Mode Selection
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Loc? (Flcor) Beacon ¥

HS Device Location Loc (Room) Beacon v

MName DD.0D.30.46.3D.2E

HS Device WSP List

]

NO_STATUS_DISPLAY

[

NO_GRAPHICS_DISPLAY

AUTO_VOICE_COMMAND

[

HS Device MISC Properties
SET_DOES_NOT_CHANGE_LAST_CHANGE

SHOW_VALUES
STATUS ONLY [ ]

9070

Create New Parent Device

Grouping Parent Ref

Publish Payload Template

=]

URI Encode Payload Encode Special Characters ||
AtMost @
Publish Q0S Atteast O
Exactly (O
Publish Retain Flag Do not retain @
Retain atbroker ()
HS Energy Database Donotsave @
Save as Watts ()

Beacon Timeout Seconds 20
Beacon RSSI Range Store RSSIwheninrange @

Store Owheninrange ()

Settings For Non-Plugin Device

Figure 100 Beacon Parameter Edit
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11.7.4 Espresense

Espresense is a application that is installed in an ESP32 that listens for Bluetooth beacon advertisements
and can interrogate them for more detailed information. What it attempts to do is overcome the
randomization of the advertised MAC address that is done on smartphones, but fingerprinting the
reporting device using behavioral and other information that it can ascertain. This means it may be
possible to provide tracking of presence of a smartphone as well as other Bluetooth devices that provide
a periodic advertisement.

The Espresense integration is a middle-ground integration for Bluetooth between what is available with
HS3 where a specific (X,Y) coordindate is determined based upon a beacon’s signal strength relative to a
set of ESP32 or RPI listening stations. The other extreme is the HS4 integration where the objective of
Bluetooth tracking is to determine if a beacon is within or out of range to provide a simple home vs.
away status. The Espresense integration isolates a Bluetooth device to the nearest ESP32 station where
the assumption is that ESP32 stations are located in various rooms so isolation provides the room
location of the Bluetooth device.

The integration provided by mcsMQTT is a variant of the integration of the HomeAssistant integration
described at https://espresense.com/. This link will also be the starting place to understand the
hardware and simple approach to loading the application in an ESP32.

mcsMQTT accepts the MQTT messages delivered on the espresence/devices/+/+ topic where first +
identifies the Bluetooth device (fingerprint) and the second + identifies the ESP32 room identification.
The JSON payload on these topics includes distance between the Bluetooth device and the ESP32 room
as well as other related information.

mcsMQTT will create a HS Device Feature for each user-selected Bluetooth device and report which
room this device is located. A room location is setup by the user as a distance radius from the ESP32. It
is also characterized by a dwell time after which the Bluetooth device is assumed to have exited the
room if no distance update has been received for this time. The radius and dwell parameters are setup
on the Rooms Table shown in Figure 102. This table can also be used to delete rooms that have become
obsolete and are no longer being reported by Espresense. If a Room is still being reported then it
cannot be removed from the table.

There are two special case “virtual” rooms called Home and Away. A Bluetooth device is assigned the
Home room when it is still reporting, but no longer within the radius of any of the ESP32 rooms. Away
room is assigned when no reports from any ESP32 room has been received for 60 seconds. A typical HS
Devices page view for a couple Bluetooth beacons is shown in Figure 101. In this example the first
Bluetooth device “eddy....” Is showing Home status with icon reporting no specific room. The second
“apple...” shows it is in room family. Family is the name setup in the ESP32 configuration of the room
name. The dates shown are the times they entered the room.
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https://espresense.com/

Devices Events Cameras~ Setup Tools~ Plugins ~

es5presense | espresense

espresense (183)
espresense | eddy.0011223344445566778899-aabbecddeeff

9 eddy.0011223344445566778899-aabbeeddeeff (186) o
Home Today 3:08:43 P

espresense | apple.1005.9-12

@apple.mus.g-u{zu?) farmily Today 3:08:41 P

Figure 101 Espresense Status Reporting in HS Device Features

The setup of the room and Bluetooth device parameters is done on the Local Page, Bluetooth tab on
HS4 or on the BLE Page of HS3. Two tables contain configuration parameters. One for each
ESP32/Room and one for each Bluetooth device. See Figure 102.

The first table shows “Away”, “Home” and two ESP32 rooms. The room “family” has a radius of 30 feet
and the room “den” is 5 feet. A Bluetooth device needs to be much closer to the den ESP32 than it
needs to be to the family ESP32 for it to be considered in the den. For both rooms the dwell time is set
at 10 seconds so if the distance is not updated in 10 seconds the room will be assigned elsewhere. The
assighment priority is:

1 Within Radius of nearest room with room still reporting within dwell seconds

2 Within radius of a room with bigger radius and room still reporting it

3 Outside the radius of currently assigned room with transition occurring in dwell seconds
4 Outside the radius of all rooms and some room still reporting it (Home)

5 No room reporting it for 60 seconds (Away)

Selecting a large radius will allow overlap and could eliminate all “Home” assignments. Selecting small
radius will result in being the room when very close to the ESP32 which could result in a large number of
“Home” assignments.

Selecting a large dwell time will delay the reporting of a Bluetooth device leaving a room unless it gets
within the radius of another room. Selecting a small dwell time could result in excessive transitions out
the room due to intermittent reporting from the ESP32.

The Bluetooth devices table allows creating of HS Device Features to track a Bluetooth device. It also
provides the ability to record the changes of room assignment in a database from which charts or
history log can be later viewed. The final parameter is the TxPower gain of the Bluetooth device. This is
not an exact calibration, but does provide a means to account for variation in the Tx Power of different
Bluetooth devices. Typically, battery powered devices transmit at lower power levels than those that
use mains power.
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Delete  Espresense Room Radius (feet) Exit Dwell (seconds)

0 Ay 0 0
] Home 0 0
] den 7 30
] farmily 7 30
Associate HS Ref Espresense Devices Tx Gain ShortTerm LongTerm
= -1 msft.cdp.0902 1 N ]
2165 iBeacon.426c7565-4368-6172-6042-6561636M6e73-3E38-4945 | 4 I:‘ I:l
s cATCAdGCRa43 1 [] [
Z168  appleipads-11 1 |:| D
[ -1 appleipads1 1 ] ]
[ -1 appleipadl4-1 1 ] ]
] 1 eddy.0011223344445566778800-aabbooddeetf 1 ] ]

Figure 102 Espresense Configuration in mcsMQTT

Espresense publishes distance information in MQTT Topics espresense/rooms and espresense/devices
Topics. This information is redundant between the two. mcsMQTT uses that which is published in
espresense/devices. The ESP32 setup should exclude the espresense/rooms. The telemetry topic
contains ESP32 parameters that are not used in room identification, but could be of interest. Figure 104
shows a suggested setup for Preferences and Calibration.

The matrix of distance of each Bluetooth device from each ESP32 room as well the time since that
distance was published in available for analysis as shown in Figure 103. A button is provided to refresh
the matrix of data. Distance and time in black is the assigned room for the device. The distance units
will be either f=feet or m=meters. The time units will be up to three digits with units of s=seconds,
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m=minutes, h=hours, d=days. Devices that have not been associated with HS will be shown with gray
names. Those that are associated will be black.

Two checkbox controls are provided. The first puts the MQTT data received for the rooms and devices
in the Association table of the MQTT Page, Association tab. This raw data can then be used in HS or
used for analysis with charts.

The second checkbox is used to inhibit addition of newly discovered devices. Each time mcsMQTT starts
it will remove the unassociated espresence devices. This checkbox provides this control to remove them
immediately and to prevent new devices from being included in the room assignments.

Show distance data in Association table Remove unassociated devices I:'

Refresh Distance and Time Information

Distances Between Room and Each Bluetooth Device and Seconds Since Update

Bluetooth Device Away Home den family bedroom
35f 90001 36f 43f
1945 24h  4s 45

apple 1005.9-12

Qgoaf 1.6f (9990f (9990 f

apple ipad5-1
apple.ipa 24h |2s Z4h  24h

gagaf|182f 127f 2f
eddy.001122334444556677889%-aabbeeddeeff ) ; 3_

24h

maft.cdp.0902

0s Os Esg
17c8d6cRa43 5.6 227 |BOf
cd7cBdachads _
45 s 65
; e e o e L 8.9 B1f 11.5f
iBeacon 426c7 565-4368-6172-6d42-6561 636f6e73-3838-4940
b5 45 25

1147 |999.91 9999 f

apple.ipadb-17 R .
35 24h  (24h

Q309199991 90999
24h  24h 24 h

iBeacon. fda50693-ade2-41b1 -afcf-ceeb 07647825 10065-26049
. ___________________________________________________________________________________________________________________________________|
Figure 103 Espresense Distance - Time Matrix

All distance information reported by Espresence is available on the MQTT Page Association Tab if the
checkbox is enabled to show it. In general, it will not be of much interest unless doing investigative
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analysis. The downside to using the checkbox is the CPU burden it could incur when raw data is being
received at a high rate. It will be under the espresence/# Topic such as shown Figure 105. An example
of viewing time history of Bluetooth device and distances is shown in Figure 106. This was a case for
ESP32 stations being unpowered and then repowered for testing. To support this chart data was
collected in the internal Sqlite database. Other than the thee MQTT Topic checkboxes the others are at
user discretion.

Preferences

Status LED (default: (@)
Automatically Update (default: &)
|| Arduino OTA Update (default: )

|| Home Assistant Discovery (default: &)

[] Active scanning (uses more battery but more results)
(default: OO0)

] Query devices for characteristics (helps apple fingerprints
uniqueness) (default: O)

| | Send to telemetry topic (default: &)
[_| Send to rooms topic (default: &)

Send to devices topic (default: &)

Calibration

Maximum distance to report (in meters):

|*E|:|: |

Forget beacon if not seen for (in miliiseconds):
125000 |

Update magtt if beacon has moved more than this distance
since last report (in meters):

o5 |

Update magtt if this time has elapsed since last report (in ms):
[10000 |

Rssi expected from a 0dBm transmitter at 1 meter:

P =
-0

Figure 104 Suggested Espresense ESP32 Setup
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Calibration is setup to balance the capability provided by mcsMQTT and Espresense. The top two
settings are for what MQTT traffic is produced as a Bluetooth device is at long distance from the ESP32.
The two lower settings are for MQTT traffic that is published when near the ESP32. Each pair of settings
are for distance threshold and for time threshold.

The maximum distance setting is not critical as the maximum time will typically occur before the
distance threshold has been exceeded for most battery-operated Bluetooth devices.

The maximum time setting works in concert with the time setting for a close device and the 60 second
monitoring interval used by mcsMQTT. When an ESP32 has not published a distance update for 60
seconds then mecsMQTT will move the device out of a previously assigned room. The total time to
recognize a device is no longer present in a room then becomes the max time setup for ESP32 plus 60
seconds.

When a device is close to the ESP32, the ESP32 will unconditionally publish distance at the close time
interval which is shown Figure 104 at suggested 10,000 millisecond rate. When the device has gone out
of range of the ESP32 then it will no longer be published at this rate. mcsMQTT will then detect it 60
seconds later.

This unconditional time interval for in-range devices can be made shorted to reduce latency at the
expense of CPU burden to handle the more frequent raw data reporting.

The final setting is the amount a device needs to move before a MQTT message is produced. This is in
addition to the unconditional periodic reporting. Since the raw data is being used to select the closest
room for a Bluetooth device, the selection of the minimum distance interval should be made in context
of how far apart ESP32 stations are located. If they are far apart then a larger minimum can be used
since it will take some time for the device to move. If they are close then a smaller distance should be
used to the point where the variation in RSSI measurements result in apparent motion when none has
actually occurred.
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Clear Filters Rebuild Filters

Show Selected Associations

t013

Association Table for Auto Association of MQTT Topic and HS Device

N o a ref payload
0 Sub: espresense/devices/apple. 1005.9-12/dendistance 116
L] L] L] [ P sp-AeERARS
1 Sub: espresense/devices/apple.1005.9-12/family distance 16
L] L] L] [
2 | | | O Sub: espresense/devices/c47cBd6cBad3/dendistance 1.37
3 n n n O Sub: espresense/devices/cA7c8d6cBad3/ familydistance 306
4 | | | O Sub: espresense/devices/dc0d30470209/family.distance 1.93
Dev: espresense|devices|den:distance
Sub: espresense/devices/eddy.0011223344445566778899-
aabbeeddeeff/den:distance
° O | | EEZO  Pub: the following Topic on Device command 224

Figure 105 Espresense JSON Data in Association Tab

Show Selected Ch

Device Hist

= |.dendistance (2521) - 291
1 famly distance { )-5.46

=== 2:eddy. 0011223344445

Figure 106 Espresence Room vs. Distance Visualization
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11.8 GW1000 - GW1100
GW1000 is a USB-powered device that converts RF protocol to WiFi for Ecowitt and Ambient sensors.
The integration of this device with mcsMQTT is based upon the work and source code provided by
Homeseer member jim@beersman.com.

These sensors use different RF Frequency depending upon the region where they are being used so
when obtaining the GW1000 or GW1100 assure that the correct frequency for your region. One source
is Amazon at https://www.amazon.com/ECOWITT-Gateway-Temperature-Humidity-
Pressure/dp/BO7JLRFG24/ref=sr 1 2 sspa?crid=26R3CDJOTDDY1&dchild=1&keywords=gw1000+wifi+g
ateway&qid=1630618449&sprefix=gw1000%2Caps%2C646&sr=8-2-
spons&psc=1&splLa=ZW5jcnlwdGVkUXVhbGImaWVyPUEXMVBNMUILITVILWTRXJmVuY3J5cHRIZEIKPUEwW
MDAOQOODAOR1gyUUhJWIFNROpSIMVuY3J5cHRIZEFKSWQIQTA3ZMDEWNTczOVhYT1IESIVRTDNWIndpZGdl
dE5hbWU9c3BfYXRmImFjdGlvbjljbGljalJIZGlyZWNOJMmRvTM90TGInQ2xpY2s9dHJ1ZQ==

Ecowitt WiFi Weather Sensor Smart Sensor Series
(1X GW1000 WiFi Gateway)

Brand: ECOWITT
) ri7 v 749 ratings | 180 answered guestions

LY ErG LRI o “gw 1000 wifi gateway”

Save 33% Lowest price in 30 days

Was: $25:99 Details
Price: $19.99 vPrime g FREE Returns
You Save: $10.00 (33%)

Thank you for being a Prime Member. Get $125 off: Pay $0.00 $19:35 upon approval for

the Amazon Business Prime Card. Terms apply.

./ Color: 1X GW1000 WiFi Weather Station Gateway

Figure 107 GW1000 RF-WiFi Gateway

The GW1000 hardware is setup from the WS View App for Android or Apple. Other than this setup
there is no further need for the App, but it can still be used if desired to view sensor data. Data remain
local and does not depend upon the cloud.

To perform the setup in WS View the following steps are performed

1. Connect to local WiFi network using the WiFi button on the GW1000. See instruction manual
that came with the GW1000/GW1100 if necessary.

2. Click Menu, Click Device List, Click on row that identifies the GW1x00 device, Click More in
upper right. Click Weather Services, Click Next until “Customized” is shown. About four clicks.
See Figure 108 for context. The two fields that need to be edited are the Server IP and Port.
These should match the NIC address and port that have been (or will be) setup on the mcsMQTT
Local Page, GW1000 Tab. It cannot be 127.0.0.1, but needs to be the actual V4 IP address being
used by HS. As an option, the update interval can be changed from the default. The Save
button and the Finish button are then used to program the GW1000/GW1100 to send data

updates.
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Wunderground

192.168.1.50

/data/report/

Figure 108 WS View Setup for GW1000/GW100

The corresponding setup with mcsMQTT is on the Local Page, GW1000 Tab. See Figure 109. The
defaults are 127.0.0.1 to indicate single NIC and port 8080. If those are acceptable then the only setting
needed to the radio to connect to GW1000 or GW1100.
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HomeSeer

HomeSeer Web Control

Devices Events Cameras > Setup Tools = Plugins -

IP Relay Intesks, Daikin WLED Serial

GW1000 Connect Parameters for Unit 1

Network Interfacs 1P

127.0.0.1
Metwork Interfacs Port A080
Gw1 000 Connection Conmect to GW1000 (:j
Dizconnect from GWI000 i
GW1 000 Connection Tirmeout
GW1000 Connect Parameters for Unit 2
Metwork Interface 1P 127.0.0.1
Metwork Interface Part BOAZ
GW1 000 Connectian Cannect to GW1000 @
Digconnect from GW1000 ()

G 000 Connection Timeout

GW1000 Connect Parameters for Unit 3

Metwork Interfacs 1P

Metwork Interface Part

GW1 000 Connection Lonmect to W1 00

Qo
Dizconnect from GWI000 i

GW1 000 Connection Timeout

Figure 109 GW1000 mcsMQTT Setup

When both are setup then the GW1000/GW1100 will be providing updates at the interval that was
setup, mecsMQTT will populate the Association Tab, it will create HS devices and features for each sensor
reading and will update these as new data has been received. An example is shown in Figure 110.
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The connection to GW1000/GW1100 can be enabled and disabled with radio connection. It is also
possible to have mcsMQTT monitor the connection and if no data received for the specified timeout,
then mcsMQTT will establish a new connection.

The Device name being used, and the pseudo-MQTT Topic is the passkey that is contained in the
GW1000 data stream. If other stations are providing data, then it becomes easy to distinguish one from
the other.

GW1000 | GW1000

[] 607FD102894C54001E182E9D734DF202 (355)

U atempinf (356) 76.3 °F Today 1:23:04 PM
] o humidityin (357) 9% Today 1:23:04 PM
] baromrelin (358) 29527 inHg Today 1:23:04 PM
U baromabsin (359) 29527 inHg Today 1:23:04 PM
] o soilmoisture1 (360) 32 level Today 1:23:04 PM
] soilbatt1 (361) 1.5V Today 1:23:04 PM

Figure 110 GW1000 Ecowitt/Ambient Sensors Viewed by HS
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11.9 Epson Projector ESC/VP.net
Epson produces a family of projectors that are network connected and an API
https://files.support.epson.com/pdf/pl600p/pl600pcm.pdf that can be used to provide control
and status. Some detailed integration information is also available at
https://www.epson.eu/en_EU/faq/KA-01...ents?loc=en-us

mcsMQTT provides an integration to the projector with HS3 and HS4. The setup starts with the Local
Page, Epson Tab where the network address of the projector(s) is(are) entered along with the polling
interval that should be used. See Figure 111. Status information from the projector is only provided
upon request. This request is issued by the plugin following a command that changes a parameter and
on the polling interval.

Epson does report events that the projector has been externally commanded such as from a remote.
mcsMQTT imitates a polling cycle when the IMEVENT message is received.

The connection to the projector is monitored. If it is lost for any reason then the plugin will attempt to
reestablish it. Once establish again it will send the required ESP/V21.net message to imitate
communication on the new connection.

H DEES EEr HomaSeer Web Comntrol

Devices Eventz Camneras = Sewp Tools = Plgins~

IP Reley Intesis; Daildn WLED Serial Bluetoath IRSRF GW1000 Epaon

Epson ESC/VP21 . net Projector |P Status Poll Rate (Seconds)  Disconnect from Projector
192.168.1.58 100 Disconnect [ ]
[esconmect D

Figure 111 Epson Projector Setup

When the Epson network address is entered a default HS Device and set of Features will be added such
as shown in Figure 112. User control from the HS Devices page or from HS Events can be used to
command the projector. Status will be updated for each Feature based upon the response received
from the projector.
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HomeSeer

Devices Evenls Cameras~ Selup Tools ~

HomeSeer Web Control

Plugins ~

& default =

@ Epson@127.0.0.1-Power (4220)
o Epson@127.0.0.1-Source (4221)
O Epson@m127.0.0.1-Aspect (4222)
Epsoni@127.0.0.1-CMode (4223)
@ Epson(@127.0.0.1-Mute (4224)
° Epson@127.0.0.1-Vol (4225)

Epson@127.0.0.1-Lamp (4226)

Standby-Abnorma

HDMIZ
Morma
Unrmuted
0

5 hours

Today 1:35:49 PM
Today 1:35:49 PM
Today 1:35:43 P

Today 1:35:50 PM
Today 1:35:50 PM
Today 1:34:52 PM

Today 1:35:50 PM

rion Jf oo J comon X e weve @ BEEE
Epson | 127.0.0.1
Epson-127.0.0.1 (4218)
@Epsan@lZ?.ﬂ.ﬂ.l-Conneﬂian (4219) Disconnected Today 1:36:09 PM w @

HDMIZ *
43 %
Mommal =

0 3

Figure 112 Epson Project Default HS Device and Features

While it is likely that the default set of projector properties will be sufficient for any user, the APl does
provide other information that could be of interest. To include another property from the projector,
then start with the Edit Tab or the MQTT Page and create a Sub Topic that looks like the other Epson
Topics, but ends with the APl parameter that is being added. In Figure 113 is an example of a API
parameter “NEW” which is not a real parameter, but is being used for illustration. A real property

example is “AUTOKEYSTONE".

Once the Epson/127.0.0.1:NEW is entered, mcsMQTT will create a HS Device Feature (4228) and provide
a table where other specifications can be entered. Since NEW is a parameter that can be controlled
from HS, the Publish topic text box needs to be completed as shown in Figure 113. The Control/Status
Ul needs to be completed so the plugin knows the nature of the data that is being communicated.

If is is a hex digit-pair as is most common for the projector, then the type will be List and the subsequent
VSP defined on the Edit Tab. Look at predefined Aspect topic in the Edit tab for an example. If the
property is expecting something like ON/OFF as is used for PWR then it should be a Button. Ifitis an
integer such as is returned for Lamp Hours, then it is a Number.

The Grouping Ref should be reviewed and changed to assure this new Feature is grouped under the

Epson Device.

Page 220




Assocalions EditsAdd Publist/Sign General History Chart
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HE Device Location

Locz
{Floor)
Loc (Room)

Narne 127.0.0.1:NEW

bax number of VSP 2

Payload 00=0;MewDl;Newl0 VSP

H= Device VSP List Payload 10=16New 10:Mewl 0 V5P

Add/Edit

Clear existing VSP

Grouping Device Ref 4718

Figure 113 Augmenting Epson Command/Device List

The result of this is a new Feature such as shown in Figure 114. From this point the user is expected to
rename the Feature and add the appropriate icon. This is done from the HS Devices page in HS4 or
DeviceUtility page is HS3.

Epson | 127.0.0.1

Epson-127.0.0.1 (4218)

@ £rs0n@127.0.0.1-Connection (4219) Disconnected Today 13609 PM m

(@) Epson@127.0.0.1-Power (4220) Standby-Sbnormal Today 13549 PM “ “

Q) Epson@127.0.0.1-Source (4221) HOMIZ Today 1:35:49 PM HDMIZ s

O Epson@127.0.0.1-Aspect (4222) 43 Today 13549 PM 43 s

@ Epsen(@127.0.0.1-CMede (4223) MNormal Teday 1:35:50 PM Mormal %

@ Epson@127.0.0.1-Mute (4224) Unmuted Today 1-3550 BM m m

Q) erson@i27.0.0.1-vol (4225) 0 Today 1:34:52 PM 0 .
Epson@127.0.0.1-Lamp (4226) S hours Today 1:35:50 PM

Epson | 127.0.01

() 127.0.0.1:NEW (4228) New0o Today 1:37:28 PM NewdD s
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11.10 HS and Plugin Monitoring with Enable, Disable and Restart Controls

mcsMQTT accumulates the CPU utilization and other performance measures over each 60 second time
interval and reports it in the pseudo-topic of HS. HS itself, any plugin, and any process name can be
selected for “A”ssociation with a HS Device Feature. Once associated the DeviceValue will show the
resource utilization such as percent CPU use over the prior minute. HS and plugin CPU monitors will
have control available to Enable, Disable, or Restart HS or the plugin. Plugins that are not running will
be shown as “Stopped” in HS with as DeviceValue of -1.

The selection of the desired measures is done from the Local Page, Resources Tab as shown in Figure

115. If other executable processors are to be monitored then the name of the process is also entered
on the same Tab. Use of Windows Task Manager or Linux Top may be helpful to correctly identify the
name of the process.

H C-)‘r—ﬁ'ESEE r HS4 Web Control & default ~

IP Relay Intesis/Daikin WLED Serial Bluetooth IR/RF GW1000 Epson Resources

Computer Resources to Monitor

CPU %

Handle Count
Nenpaged RAM[_
Paged RAM[_|
Virtual RaM[_|
Thread f.“.f_-u.r'.D

Addditional Processes to Monitor

System

ApntEx.exe

Figure 115 Computer Resource Monitor Selection
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Dev: HSHS|HS:HSConsole
Sub: HS:HSConsole

T ) m Pub: the following Topic on Device command a5 20210021 135731
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HS/cmnd/HSConsole
) 2021-09-21
2 |:| |:| l:‘ D Sub: HS:HSTOUCH - |:| 135731
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2] Sub: HSmeskKNX -1
O O O O e O 135731

Dev: HSHSIHS:MCSMOTT
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404 Pub: the following Topic on Device command 1.4

4
O O O O O O
HS/emnd/MCSMQTT
_ U . 2021-09-21
& D D l:l D Sub: HS:MCSSHELLY D oyt
Dev: HS|HS|HS:ZWave
Sub: HSZWave
2 ) m Pub: the following Topic on Device command . T
SO O O | O O 2 3573
HS/emnd/ZWave
; L 20210921
7 D D I:l D Sub: HS:ZWaveGui 9B D 135731

Figure 116 HS Pseudo-Topic for Monitor and Control of HS and Plugins

A sample of the HS pseudo-topics is shown in Figure 116. A sample of the associated Device and
Features is shown in Figure 117. Most plugins have controls for Disable, Enable, Restart. HS and
mcsMQTT do not have the Enable control because they need to be running for these controls to be
used. Controls are only functional if mcsMQTT can access the HS web server over the LAN. Access is
available if HS Setup for Network has “No Password Required for Local (same subnet) Login” enabled or
the username:password has been setup on the MQTT Page, General Tab.

The HS/Plugin control devices will show the CPU use measurement. The other performance measures, if
enabled on the Local Page Resource Tab and “A”ssociated on the MQTT Page Association Tab will not
have any controls presented in HS. They can also be selected for History data collection.
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The Green vs. Yellow graphic reflects the status of the process in which a plugin or HS runs. A plugin
that is not running will show as Yellow. In the case of HS3 plugins that have multiple instances there will
be one process shared by all instances of the plugin. It will be shown in HS with a Device Feature for
each instance so each instance can be individually controlled, but only one process will be running. The
process will remain active as long as at least one of the instances has been enabled.

The percent utilization is also a reflection of the process. One that is not running will be shown in the
status as “Stopped”. For those that are running the DeviceValue will contain the percentage being used
over the last 60 second period.

HS | HS
HS (402)

O HS:HSConsole (403) 35% Today 1:39:31 PM @
o HS:MCSMQTT (404) 0.7% Today 1:39:31 PM m

RESTART

HS:ZWave (405) Stopped Today 1:39:31 PM

Figure 117 HS Device Features to Monitor and Control HS and Plugins

The operation of the Enable and Disable controls is similar to the controls available on the HS Interfaces
or Plugins menu. They actually invoke the same operation as the controls on these pages. For the
Disable it is an orderly shutdown of the plugin.

The Restart control is implemented as a Disable control, monitor for the plugin/HS process to disappear
then invoke the enable action. In the case of mcsMQTT plugin a restart is achieve by internally doing an
orderly shutdown and then killing mcsMQTT process. HS will observe mecsMQTT has disappeared and
restart it. In the case of HS, the shutdown is done through the HS API. The HS restart is performed by a
shutdown, waiting for the HS process to disappear, and then launch HS.

mcsMQTT identifies the plugins by using the HSPI_ filenames in the HS folder. It then attempts to
correlate the filenames with the plugin names which are usually similar. For example, HSPI_SAMPLE.exe
has a plugin name of “Sample Plugin”. The filename is needed for CPU utilization monitoring. The
plugin name is needed for the Controls.

Unlike something like Windows Task Manager or Linux Top that attempt to show instantaneous CPU
utilization, the collection and reporting interval for mcsMQTT is 60 seconds. The intention is not to
capture short term spikes, but to capture steady state utilization.

The DeviceValue from any of these Device Features can be used as Event Triggers. The Controls can be
used in Event Actions. For example, and event can be setup if a plugin is using more than 25% of CPU
then Restart the plugin.

In the Linux case, HS provides tools to shutdown HS or to restart the computer. It does not provide a
tool to restart HS. The Restart control for HS provided by mcsMQTT can fill this gap.
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For those that keep historical trends then these Device Features can be selected for database storage in
mcsMQTT or other providers and then charting for CPU use can be produced.

11.11 Hunter Douglas PowerView Gen2 & Gen3
Hunter Douglas provides a family of approximately twenty shades that are networked interfaced
through a hub. The current hub firmware version is Gen3.

The URL Path for Powerview for access to shades and room information will be either “home” or “api”,
depending upon the equipment generation available. This is a setting on the Local Page, Shades Tab for
PowerView. The local Hub IP address and the update interval to refresh HS status is setup at the same
place as shown in Figure 118.

HomeSeer 541 & defauit ~

Devices Evenls Cameras = Selup Tools ~ Plugins ~ _ SEARCH

IP Relay HYAC WLED Serial Bluatoath IR/RF GW1000 Epsan Resources Shades Carmmand

Hunter Douglas PowerView Gen2 & Gen3

Hub IP Address 192.168.0.111

Stalus Update Interval (ms) - 60000

Equipment Generatian Gena @
Geni2 (]

Figure 118 Hunter Douglas PowerView Setup

mcsMQTT provides the capability to moving shades to a specific position and reporting status of the
position. Some models have a tilt capability which is also controllable. Some models have a secondary
shade that can also be controlled. mcsMQTT will use the model information provided and create the
appropriate set of Features.

A battery status will also be created. If line power rather than battery power is being used then the
battery Feature can be removed by using the “a” column checkbox on the MQTT Page Association Tab
to remove the association with HS. A Device is created for each room setup in the Hunter Dougles
setup.

Figure 119 provides an illustration of the various Features setup within a room Device for the Gen3
equipment. Figure 120 shows the Room and Scene-Group Features for Gen2.
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PowerView | SOUTH BEDROOM -1

[J PowerView-SOUTH BEDROOM -1 (408)

[ (@) ser1-2:Primary_Position (309) 100 % Open Today 25437 PM ® m
[ (@) s8r1-2:5econdary_Position (410) 0% Open Today 25437 PM ® m
O @ serr-zmie@) 0% Tiit Today 2:54:37 PM ° m
O (@) seri-2:Battery (412) Ful Today 25437 PM

O @ SBR2-11:Primary_Position (413) 100 % Open Today 2:54:37 PM ® m
() (@) s8R2-11:Secondary_Position (414) 0% Open Today 25437 PM ® m
O @ SBR2-11:Tilt (415) 0% Tilt Today 2:54:37 PM [ ] m
O (@) ssre-11:Battery (416) Ful Today 25437 PM

[ (@) sBr3-17:Primary_Position (417) 100% Open Today 25437 PM ® m
[ (@ s8R3-17:secondary_Position (418) 0% Open Today 25437 PM ® m
O (@ serz-17:1in (319 0% Tilt Today 25437 PM ® m
[ @E) sBR3-17:Battery (420) Full Today 2:54:37 PM

Figure 119 Hunter Douglas PowerView Gen3 HS Features

PowerView | Room-60507
PowerView-Room-60507 (4598)

(@) cardin 1-30678:Battery (4599) Full Today 12:21:09 PM

Gardin 1-30678:Position (4600) Today 12:21:09 PM m m
@o

@ Gardin 1-30678:Bottom (4601) Closed Today 12:21:09 PM
o
o
@ Gardin 1-30678:Top (4602) Closed Today 12:21:09 PM
LEFTTILT @
(@) cardin 2-11788:Battery (4603) Full Today 12:21:10 PM

(©) cardin 2-11788:Position (4604) Today 122110 PM m m
Do

(@) Gardin 2-11788:80ttom (4605) Open Today 12:21:10 PM
LEFTTILT [ ]
1

@ Gardin 2-11788:Top (4606) Closed Today 12:21:10 PM
LEFTTILT @

PowerView | Scene-Group
PowerView-Scene-Group (4594)

&) scencColiection (4595) Today 12:21:09 PM “
@ scene (a596) Today 12:21:09 PM “
@B GroupPosition-39799 (4597) Today 12:21:09 PM m

Figure 120 Hunter Douglas PowerView Gen2 HS Features

The Local Page, Shades Tab contains the setup for the Hunter Douglas Gen3. The IP is the network IP
address of the hub. The polling rate is the periodic interval when status of shades position is queried.
The status is also queries at plugin startup. HS Devices are created when both the IP and polling setting
are setup.
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11.12 Command Terminal
The Command Tab provides a mechanism to periodically run executable programs that provide a
command line output. mcsMQTT will recognize the format of the output and convert it to JSON from
where a MQTT pseudo-topic is created using the JSON payload.

In general, it is up to the user to selected from the MQTT Page, Association Tab the pieces of
information that they desire to see in HS using the “a” checkbox.

At this time APC battery backup monitor apcaccess.exe is the application that has been implemented.
As interest exists others can be added to the plugin.

The Updater install will include APCMQTT.exe in the bin\mcsMQTT subfolder. This application is
intended to be run remotely such as in a RPi where the APC monitor has been connected. It will publish
MQTT messages on the Topic apcaccess/IP/status where IP is the IP of the host computer.
APCMQTT.exe is a native .NET/Windows application or a Mono/Linux application that should be started
at boot of the host computer. For Linux this is normally systemctl, but other options are available.
Examples of use of systemctl exist in this document. For Windows there are also multiple options to
start an application at boot time.

The apcassess application will output to the console data of a format similar to below. APCMQTT will
format this in JSON and deliver it as a MQTT message. mcsMQTT will run this application every five
minutes.

APC : 001,048,1088

DATE Fri Dec 03 16:49:24 EST 1999
HOSTNAME daughter

RELEASE : 3.7.2

CABLE : APC Cable 940-0024C

MODEL : APC Smart-UPS 600

UPSMODE Stand Alone

UPSNAME SU600

LINEV : 122.1 Volts

MAXLINEV : 123.3 Volts

MINLINEV : 122.1 Volts

LINEFREQ : 60.0 Hz

OUTPUTV 122.1 Volts

LOADPCT : 32.7 Percent Load Capacity
BATTV : 26.6 Volts

BCHARGE 095.0 Percent

MBATTCHG 15 Percent

TIMELEFT 19.0 Minutes

MINTIMEL 3 Minutes

SENSE Medium

DWAKE 000 Seconds

DSHUTD 020 Seconds

LOTRANS 106.0 Volts

HITRANS 129.0 Volts

RETPCT 010.0 Percent

STATFLAG 0x08 Status Flag

STATUS ONLINE

ITEMP 34.6 C Internal

ALARMDEL : Low Battery

LASTXFER : Unacceptable Utility Voltage Change



http://122.0.0.1/
http://123.0.0.3/
http://122.0.0.1/
http://60.0.0.0/
http://122.0.0.1/
http://32.0.0.7/
http://26.0.0.6/
http://19.0.0.0/
http://106.0.0.0/
http://129.0.0.0/
http://8.0.0.0/
http://34.0.0.6/

SELFTEST : NO

STESTI : 336

DLOWBATT : 05 Minutes
DIPSW : 0x00 Dip Switch
REG1 : N/A

REG2 : N/A

REG3 : 0x00 Register 3
MANDATE : 03/30/95

SERIALNO : 13035861
BATTDATE : 05/05/98

NOMOUTV : 115.0
NOMBATTV : 24.0
HUMIDITY : N/A
AMBTEMP : N/A

EXTBATTS : N/A
BADBATTS : N/A
FIRMWARE : N/A
APCMODEL : 6TD
END APC : Fri Dec 03 16:49:25 EST 1999

APCMQTT.exe is expecting command line parameters of path to apcassess that is installed on the
host computer and the IP of the MQTT Broker that it should be using to facilitate the
communications. If the Broker is expecting a username and password then add it as the last
parameter in format username:password. The following are examples of the two cases:

mono /etc/apcupsd/APCMQTT.exe apcaccess 192.168.0.100

mono /etc/apcupsd/APCMQTT.exe apcaccess 192.168.0.100 un:pw

The apcaccess/status Topic will be received and available in mcsMQTT MQTT Page, Association Tab from
where selected items can be associated with HS Device and Features. Note that the raw data includes
formatting so it may be advantageous to remove the formatting so the data can be stored in
DeviceValue rather than DeviceString. Regular Expressions or Expressions on the Edit Tab of MQTT Page
can be defined to remove the formatting. For example, look at Section 6.2 case #2 to remove the suffix.
In these cases, the Control/Status Ul should be selected to be a number rather than text.
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11.13 Speaker
KEF produces a line of smart speakers that accept multiple input sources and allow the speaker to
control transport of the media through the speaker. Models LS50 Wireless Il, LSX Il and LS60 are known
to use the same integration protocol that is implemented in this plugin.

Setup is simply identification of the IP of the speaker and the rate at which status will be updated as
shown in Figure 121.

HomeSeer HS4 Web Control

Devices Events Cameras~ 3Setup Tools v Plugins ~

IP Relay HWVAC LED Serial Bluetooth IR/RF GW1000 Projector

Resources Shades Command Speaker Spa

KEF Speaker IP Status Poll Rate (Seconds)  Disconnect from Speaker

192.168.0.99 60 Disconnectl:l

Figure 121 KEF Speaker Setup

When contacted, HS Device and Features will be setup as shown in Figure 122. About half of the HS
Features will have controls and these include Power, Input Source, Volume, Mute, State, and Like
feedback. The status-only Features show information about the media that is being played.
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Sm HS4 Web Control & defautt ~
omeSeer

Devices Events Cameras~ Setup Tools~ Plugins~ _ searcH
i Kef X
0 = x e Y Y-T--T-

1 Kef | Kef
1| O Kef192.168.0.99 (6227)

) O 192.168.0.99:power (6228) powerOn Today 6:50:50 PM m
| . T
’ O @@ 192.168.0.99:inputsource (6229) wi Today 6:50:50 PM =3
|
=]
0 (@) 192.168.0.99:volume (6230) 30 Today 6:50:50 PM 30 .
O Q) 192.168.0.99:mute (6231) unmute Today 6:50:50 PM [ ]
|
= © 192.168.0.99:state (6232) playing Today 6:50:50 PM m
0 ) 192.168.0.99:rackRolestitle (6233) 0 Today 6:50:50 PM [ we ] s

| O @ 192.168.0.99:trackRoles:icon (6234) Today 6:52:30 PM
O 192.168.0. i (6235) COWBOY CARTER Today 6:52:30 PM
O o 192.168.0 i tist (6236) Beyoncé Today 6:52:30 PM
[m] @ 192.168.0.99:status:duration (6237) 208521 Today 6:52:30 PM
[m] ° 192.168.0 i (6238)  Chill Hits Today 6:52:30 PM
O o 192.168.0 i icelD (6239) spotify Today 6:52:30 PM
O o 192.168.0.99:streamerError (6240) ‘code’123/message"xyz’ Today 6:52:29 PM

Figure 122 KEF HS Device and Features
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11.14 Jacuzzi Spa
Jazuzzi Hot Tubs utilize a serial connection with Prolink/Balboa protocol. The integration within the
plugin is done as part of the Serial integration capability on the Serial Tab of the Local Page as described
in Section 11.4 . An alternate setup is available on this Spa Tab as shown in Figure 123, but the
functionality is the same.

H ﬂﬁ e S eer HS4 Web Control

Devices Events Cameras~ Setup Tools ~ Plugins ~

IP Relay HVAC LED Serial Bluetooth IR/RF GW1000 Projector

Resources Shades Command Speaker Spa

Jacuzzi (ProLink/Balboa)

Metwork Address

Disconnect Connect to Jacuzzi Unit @)

Disconnect from Jacuzzi Unit QO

Figure 123 Jacuzzi Hot Tub (alternate setup)
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11.15 Gecko In-Touch Spa

Gecko In-Touch spas support a network interface. A Python library is available to communicate with it
and this library is being used by the plugin to perform the HS integration. The library is installed from
the command line/terminal using command

pip install geckolib

The library supports auto-discovery of the units as long as they are on the same subnet as HS. If not,
then the IP needs to be explicitly specified in the setup shown in Figure 124.

The plugin needs to know where the Python executable is located. In some installs it is placed on the
PATH environment, but not all so it is an explicit entry in the setup.

There is not data pushed from Gecko so data must be polled periodically. A status request is also sent
after every command sent to the unit.

HS Device and Features are created upon initial connection. The connection can be disabled and
reenabled to control the communications.

H Oﬁ eSeer HS4 Web Contra olutions@CenturyTel.

Devices Events Cameras~ Sewp Tools~ Plugins -

IP Relay HVAC LED Serial Bluetooth IR/RF GW1000 Projector

Resources Shades Command Speaker Spa

Gecko InTouch Parameters

=
(if on different subnet)

Python Path ppData\Local\Programs\Python\Python311\python.exe

Spa Polling Rate

(milliseconds) 30000

Spa Disconnect Connect to Gecko InTouch Unit ()
Disconnect from Gecko InTouch Unit i)

Figure 124 Gecko In-Touch Spa Setup
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Gecko | UdpTestSpa
Gecko-UdpTestSpa (8931)

@ UdpTestSpa/Pump1 (8932) OFF Today 12:23:17 PM
@ UdpTestSpa/Pump2 (8933) OFF Taday 12:23:17 PM
O UdpTestSpa/Blower (8934) OFF Today 12:23:17 PM
@ UdpTestSpa/Lights (8935) OFF Today 122317 PM
O UdpTestSpa/EconomyMode (8936) OFF Today 12:23:18 PM
W ENERGY SAVING
. UdpTestSpa/WaterCare (8937) Standard Today 122323 PM
=

@ UdpTestSpa/Heater:SetPoint (8938) Today 12:23:18 PM 30 E
0 UdpTestSpa/Heater:- Temperature (8939) oc Today 122318 PM
0 UdpTestSpa/Heater:RealSetPoint (8940) o°c Today 12:23:18 PM
m UdpTestSpa/Heater:Operation (8941) Idle Today 122318 PM

UdpTestSpa/SmartWinterMode:Risk (8942) NO Today 12:23:18 PM

UdpTestSpa/SmartWinterMode:Active (8943) NO Today 122318 PM
0 UdpTestSpa/CirculatingPump (8944) ON Today 12:23:19 PM
0 UdpTestSpa/PumpRun (8945) False Today 122318 PM

UdpTestSpa/Ozone (8946) OFF Today 12:23:18 PM
o UdpTestSpa/FilterStatus:Clean (8947) False Today 12:2318 PM
o UdpTestSpa/FilterStatus:Purge (8948) False Today 12:23:18 PM
@ UdpTestSpa/Time (8949) ] Today 122318 PM
@ UdpTestSpa/RinseFilter (8950) 13 Today 122323 PM
e UdpTestSpa/CleanFilter (8951) 1] Today 12:23:18 PM
o UdpTestSpa/ChangeWater (8952) 47 Today 122323 PM
e UdpTestSpa/CheckSpa (8953) 687 Today 12:23:23 PM
e UdpTestSpa/Connection:Address (8954) 192.168.0.35 Today 12:23:19 PM
0 UdpTestSpa/Connection:Connected (8955) False Today 12:24:14 PM
o UdpTestSpa/ErrorSensor (8956) Nane Today 12:23:19 PM
e UdpTestSpa/Info (8957) Udp Test Spa$ Taday 12:24:14 PM

Figure 125 Gecko In-Touch HS Device and Features
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11.16 Roborock Vacuum
Roborock vacuums support a WiFi interface that is used to configure the device using the Xiaomi
smartphone App. A Python library has been developed https://python-
miio.readthedocs.io/en/latest/index.html that implements a local control of the robot vacuum.
mcsMQTT uses this library to perform the integration.

Tthe Python library that can be installed from the command line with
pip install python-miio

The install includes a step where the Python is compiled into an executable that is placed in the \Scripts
subfolder under python.exe. On my first install on my newer computer there was a failure due to lack of
Visual Studio C++ Version 13+ Build Tools which can be downloaded

from https://visualstudio.microsoft.com/v...p-build-tools/ After the download the installer option for
desktop tools need to be selected to actually install them.

When python-miio completes successfully there are two programs of interest that will be in Python's
\Script subfolder. As an example

C:\Users\mcsSo\AppData\Local\Programs\Python\Python313\Scripts\mirobo.exe
C:\Users\mcsSo\AppData\Local\Programs\Python\Python313\Scripts\miiocli.exe

From a command prompt run the second one (miiocli.exe) with parameter cloud. It will prompt for
username and password for your Xiaomi account and return the IP and the Access Token for each
Roborock vacuum. This will be the only time that the Could server is used. Everything is local in the
actual integration.

cd C:\Users\mcsSo\AppData\Local\Programs\Python\Python313\Scripts
miiocli cloud list

Username: xxx

Password: xxx

== Anthem (Fully charged) ==
Model: roborock.vacuum.s5
Token: 6f48...546a

DID: 117...116
Locale: us

== North Bend (Fully charged) ==
Model: roborock.vacuum.s5
Token: 445a...4773
IP: 192.168.0.75 (mac: 50...20)
DID: 262...111
Locale: us
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The IP and Access Token is entered on the Local Page, Roborock Tab as shown in Figure 126. Other
entries are path to mirobo.exe, polling rate and radio to enable the integration. The polling rate is for
general status. There are also consumables, timers, and history that are down at longer intervals that
are a multiple of the base polling rate.

HomeSeer : 2 default -

Devices Events Cameras~ Setup Tools * Plugins ~ _ SEARCH

IP Relay HVAC LED Serial Bluetooth IR/RF GW1000 Epson Resources Shades Command Speaker Spa Roborock

Roborock Parameters and Control

Vacuum IP Access Token
Vacuum 1 192.168.0.75 445a..4773
Vacuurn 2 192.168.0.176 6f48...546a

Vacuum 3 l | I

Path to Python executable mirobo.exe  C:\Users\mcsSo\AppData\Local\Programs\Python\Python313\Scripts\mirobo.exe

S eouor
(milliseconds)

Vacuum Disconnect Connect To All Roborock Vacuums @

Disconnect From All Roberock Vacuums (O

Figure 126 Roborock Setup

When the "Connect to ..." radio enables the integration, the HS Device and Features will be created for
each vacuum as shown in Figure 127.

Roborock | 192.168.0.75
Roborock-192.168.0.75 (8007)

Q) 192:168.0.75/5tate (2008) Charging Today 0302 PM m sTaRT
G 192.168.0.75/Fanspeed (8009) 102% Today 9:03:06 PM 0 B
(B) 192.168.0.75/Battery (8010) 100,00 % Today 9:03:06 PM

Q) 192:168.0.75/Main Brush (8011) 73.68 Hours left Today 90312 PM
() 192.168.0.75/Side Brush (8012) 60,69 Hours left Taday 30312 PM
@ 192:168.0.75/Fiter (3013) -115.69 Hours left Today 90312 PM
() 192.168.0.75/Sensor Dirty (8014) 30.00 Hours left Today 90312 PM

@ 192.168.0.75/Cleaning Since (8015) 0.01 Hours Today 9:03:06 PM
o 192.168.0.75/Cleaned Area (B016) 0.00 ft2 Today 9:03:02 PM
0 192.168.0.75/Water Box Attached (8017) False Today 9:03:02 PM
192.168.0.75/Total Cleaned Count (B018) 145 Times Today 9:03:19 PM
192.168.0.75/Total Cleaned Time (8019) 21600 Hours Today 3:03:19 PM
192.168.0.75/Total Cleaned Area (B020) 0.00ft2 Today 9:03:02 PM
g 192.168.0.75/Clean History0 (8021) M/A Today 9:03:03 PM
Q 192.168.0.75/Clean History1 (8022) N/A Today 9:03:03 PM

Figure 127 Roborock HS Device and Features
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Scheduling is setup with timers. Timers can be defined from the Roborock Tab as shown in Figure 128.
The example below is a 8 AM schedule 4 days of the week. When testing with my vacuum | discovered
that the cron parameter is not correctly parsed and this prevents the ability to define a timer from HS. |
did not attempt to define a schedule with the smartphone App.

When | searched for cron usage | found a problem report on Github with author not interested

Roborock Timer Definition

Srhes _—
el Ul Include Timer Funetionalit ]

Minute(s) of Day

Hour(s) of Day 8
Day(s) of Month
Month(s) of Year
IR Sun mon[_] Tue wed[] Thr Fri[] Sat

IP for Time 192.168.0.75 v
Apply ta Timer Nurmber v

Delete Timer Murmber v

Figure 128 Roborock Timer Specification

There is a checkbox to "Include Timer Functionality". When checked it will create HS Features for nine
timers and will include the polling of timer status. The docs show example of timer info as below. | do
not get this on mine, but | have no scheduling setup.

Timer #0, id 1488667794112 (ts: 2017-03-04 23:49:54.111999)
4922 **6

At 14:49 every Saturday

Timer #1, id 1488667777661 (ts: 2017-03-04 23:49:37.661000)
4921 **3,4,5,6

At 13:49 every Wednesday, Thursday, Friday and Saturday
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The created Features have controls to enable and disable created timers. Status such as "At 14:49 every
Saturday" will be shown for the timer when enabled.

@ 192.168.0.176/Total Cleaned Area (8119)
() 192:168.0.176/Clean Historyd (8120)
@) 192:168.0.176/Clean History1 (8121)

@ 192.168.0.176/Timer1 (8122)
(©) 192.168.0.176/Timer2 (8123)
@ 192.168.0.176/Timer3 (8124)
(©) 192.168.0.176/Timerd (8125)
(©) 192.168.0.176/TimerS (8126)
@ 192.168.0.176/Timer6 (8127)
@ 192.168.0.176/Timer7 (8128)
@ 192.168.0.176/Timer8 (8129)

(©) 192.168.0.176/Timers (8130)

0o0f
A
NiA

Disabled

Disabled

Disabled

Disabled

Disabled

Disabled

Disabled

Disabled

Disabled

Figure 129 Roborock Timer HS Features
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11.17 TP-Link Kasa/Tapo Plugs, Lights, Switches etc.

TP-Link provides a variety of smart products that are intended for control from their smartphone App.
They can, however, be controlled locally using a reverse-engineered API. It appears the effort at
https://github.com/python-kasa/python-kasa is the most complete and supported. This functionality

has been integrated into mcsMQTT.

The documented list of supported devices as of the start of 2025 is

Supported Kasa devices

Plugs: EP10, EP251, HS1002, HS103, HS105, HS110, KP100, KP105, KP115, KP125, KP125M1,
KP401

Power Strips: EP40, EP40M1, HS107, HS300, KP200, KP303, KP400

Wall Switches: ES20M, HS2002, HS210, HS2202, KP405, KS200, KS200M, KS2051, KS220,
KS220M, KS2251, KS230, KS2401

Bulbs: KL110, KL120, KL125, KL130, KL135, KL50, KL60, LB110
Light Strips: KL40OL5, KL420L5, KL430
Hubs: KH1001

Hub-Connected Devices3: KE1001

Supported Tapol devices

Plugs: P100, P110, P110M, P115, P125M, P135, TP15

Power Strips: P210M, P300, P304M, P306, TP25

Wall Switches: 5210, 5220, S500D, S505, S505D

Bulbs: L5108, L510E, L530E, L630

Light Strips: L900-10, L900-5, L920-5, L930-5

Cameras: C100, C210, C220, C225, C325WB, C520WS, €720, D230, TC65, TC70
Hubs: H100, H200

Hub-Connected Devices3: S200B, S200D, 7100, T110, 7300, 7310, T315

Vacuums: RV20 Max Plus

There are two categories of products. The original (legacy) products use network port 9999 and the
current products use port 80 with a higher security consideration. While the cloud is not needed for
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https://github.com/python-kasa/python-kasa#user-content-fn-3-80ab73f655f8d24461a284cfcbda199f

control, it is needed to obtain the decryption information that is encoded in each device. Once
discovered cloud access is no longer needed.

Three encryption methods are used for current products. The method is not available using discovery,
but is likely KLAP. AES and XOR are the other two that appear to be used. The method mcsMQTT is
using is shown on the Local Page, KP-Link Tab. In the future this can be made a user option if necessary.

Current products appear to disclose their type information which is needed when accessing the device
to avoid the need to use discovery with each access. Legacy products do not. The plugin guesses the
legacy product types based upon textual information in the discovery. If necessary, this can also be
made a user option.

The first step in the installation is to install the Python library referenced above. This is from the
command/terminal line with:

pip install python-kasa

The install will put the executable kasa.exe in the Python script path. mcsMQTT needs to know where
this located and provides a text box for entry. A typical entry will be like:

C:\Users\mcs1\AppData\Local\Programs\Python\Python311\Scripts\kasa.exe

The network subnet, Kasa cloud account email and password, status polling interval, and connection
controls are also provided in the setup as shown in Figure 130.

The network subnet is only needed if multiple NIC are installed and the TP-Link devices are not on the
same subnet as HS. If needed it will be in the format 192.168.0.255 where 255 is used as the wildcard.

Polling for status update is done, but does not need to be very frequent since each commanded changed
has a status response to indicate the new status. Perhaps every 5 or 10 minutes would be appropriate
unless there is a situation when other control outside of HS is being used.

Discovery is done at startup. It can also be done with button click if a new device has been added and
not yet known by HS.

The disconnect radio breaks/makes use of the Python library. It should only be needed when doing
diagnostics.
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IP Relay HWAC LED Serial Bluetooth IR/RF GW1000 Epson Resources Shades

Speaker Spa Roborock TP-Link

TP-Link (Kasa) Parameters and Control

Network |P
Kasa Account Email xxx@gmail.com
Kasa Account Password sesssnan

Path to Python executable kasa.exe  C:\Users\mcs1\AppData\Local\Programs\Python\Python3

Status Polling Rate

o 60000 Discover Devices
(millizeconds)

TP-Link Disconnect Connect To TP-Link Devices O
Disconnect From all TP-Link Devices @

P Port Deviceld Cloud Type Encrypt
192.168.0.242 |80  803B2BCEB2E6C65CSB1E22EFCAADS0ADZIAF3E2] | True | SMARTKASASWITCH KLAP
192.168.0.240| 9999 frue  bulb KLAP

Figure 130 TP-Link Setup

For each discovered TP-Link device, a HS Device and its Features will be created such as in shown in
Figure 131.

One bulb and one switch were used in the integration testing. While the structure to create HS Device
and Features is generalized based upon the discovery information, there may need to be future updates
to the plugin to handle other products.

TP-Link appears to use HSV model for color. The plugin does the conversion to represent the color in
RGB format that is used in the HS color selector control. It is possible to include individual slider controls
for hue and saturation if desired.

Presets were disclosed in the device being used for testing, but control of preset is not functional due to
a lack of syntax knowledge or a deficiency in the Python library. This may change in the future.
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Kasa | 192.168.0.240:
Kasa Light - KL135-192.168.0.240... (1515)

192.168.0.240:State (1516)

9 192.168.0.240:Brightness (1517)
192.168.0.240:ColorTemperature (1518)

@ 192.168.0.240:LightPreset (1519)

. 192.168.0.240:Color (1520)

o 192.168.0.240:Wattage (1521)

o 192.168.0.240:TodaysConsumption (1522)
o 192.168.0.240:MonthsConsumption (1523)
o 192.168.0.240:TotalConsumption (1524)

on

24 %
5048 °K

Not set

3997953

320W

0.04 kWh
0.44 kwh
0.00 kwh

Today 1:15:59 PM

Today 1:16:22 PM
Today 1:16:13 PM

Today 1:15:51 PM

Today 1:16:22 PM

Today 1:16:59 PM
Today 1:15:59 PM
Today 1:15:59 PM
Today 1:15:51 PM

G
[ ]
®

NOT SET LIGHT PRESET 1
LIGHT PRESET 2
LIGHT PRESET 3 LIGHT PRESET 4

Kasa | 192.168.0.242:
Kasa Smart Switch - HS200-192.16... (1525)

@ 192.168.0.242:State (1526)

@ 192.168.0.242:Overheated (1527)

off

False

Today 1:16:55 PM

Today 1:15:52 PM

Figure 131 TP-Link HS Device and Features
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11.18 Shelly Wall Display

The Shelly Wall Display is a hybrid Shelly product that implements a 3.5” display with Android features
and a small amperage relay for use as a switch or thermostat output under its Gen2 rpc protocol.

As of the start of 2025 the firmware is still in the beta cycle and has no official publication. The
integration is based upon a trial/error and Shelly question/response cycle and it is likely that future
firmware will provide additional functionality and could break some existing integration.

What is available with the Wall Display is a small screen that can be scrolled left-right to view a media
player, a thermostat, limited virtual devices, and some sensor measurements. See Figure 135

shellies | shellies-Online

[] shellies-shellies-Online (3190)

shellies | ShellyWallDisplay-00082296CC85

U
shellies-ShellyWallDisplay-00082... (3193)
O

ShellyWallDisplay-00082296CC85-temperature.0:tF (3194) 88.90°F

QO
ShellyWallDisplay-00082296CC85-humidity.0:rh (3195)
1O

ShellywallDisplay-00082296CCB85-illuminance.0:lux (3196) 60.00 lux

28.00 %

U@
ShellyWallDisplay-00082296CC85- wilight
illuminance.0:illumination (3197)

0O
sShellyWallDisplay-00082296CCB85-input.0:state (3198)

O
sShellyWallDisplay-00082296CC85-
devicepower.0:external:present (3199)

Inactive

0@

ShellyWallDisplay-00082296CC85-switch.0:output (3207)

Figure 132 Wall Display Online status and Sensors HS Features
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Figure 133 Shelly Wall Display Thermostat HS Features
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Figure 134 Shelly Wall Display Media HS Features
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Current Tempe

Figure 135 Shelly Wall Display Panels Display

The mcsMQTT integration provides control of the media player for radio stations and uploaded media.
Video and photos looks to be future capabilities that are not yet supported by the beta firmware.

A thermostat panel can be added and the integration fully supports all aspects of the thermostat other
than control of the C vs. F temperature scale for which the beta firmware only supports the C display.
The HS Feature will show either C or F depending upon the HS setup for F or C.
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When a virtual button is defined on the Wall Display, it can be associated with an action using a browser
pointed to the IP of the Wall Display. The action is a URL that will be requested using HTTP GET. A
querystring can be added. See Figure 136.

For integration with HS two options are available. One is the JSON API defined by HS at
https://docs.homeseer.com/hspi/json-api. This reference assumes a remote cloud interface, but the
URL can be the local IP. Another choice it to use the same HS server, but
/mcsMQTT/MQTT?Topic=xxx?Payload=yyy to send a MQTT message in response to the virtual button
push. For example

http:/192.168.0.7/mcsMQTT/MQTT.html?Topic=ShellyWallDisplay-00082296CC85/rpc?Payload={"name":B1","count":2}

A Notsecure  192,168.0.201/#/button/200/create-action/

WallDisplay

Create Action

[ Media Library

) Diagnostics *| Enable action

Button double push

http:/192.168.0.7/mcsMQTT/MOT T? Topic=ShellyWal IDisplay-00082296CC85/ rpc?Payload={"name™:B1", "count™:2}

Add url

Add local action

Figure 136 Wall Display Action Setup
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The media panel provides a set of transport controls that include both Radio and Media targets. In
general the two “Favorites” buttons apply to the Radio, but in many case the Radio will respond to other
buttons such as Stop.

Two selector controls are provided. One for media and one for radio. Selection of one or the other will
determine if radio or media is being played. The radio selector status will show the radio station being
played or N/A. The title and artist status will show the media that is being played.

Some of the controls are interlocked within the Wall Display so control of one could affect another.
Statuses will be updated in this situation.
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12 Cloud

12.1 URL

12.1.1 Overview

The URL tab provides access to internet sites and local widgets using HTTP/REST GET, HTTP/REST POST,
UDP, WebSocket/Webhook and TCP protocols. The returned data will be analyzed for XML or HTTP
Querystring formats and automatically converted to JSON. JSON is further decoded and others are
handled as text on the MQTT Page Association Tab. The setup options available are the URL to the site
being accessed, the protocol to use, polling rate, and if appropriate any changes to the protocol
headers. An example is shown in Figure 137.

The GET, POST and URL protocols support periodic polling of the site to obtain data updates. They can
also be used to send data from HS Device page, HS Event Actions or scripting. The UDP, WebSocket and
TCPIn setup a persistent socket connection so that event data can be reported through mcsMQTT to HS.

Received data is analyzed to assess if it is XML and if so, is converted to JSON for subsequent use. Ifitis
POST data using HTTP QueryString format (i.e., key value pairs separated with “&”) it is also converted
to JSON. Non-JSON data that does not fit these categories is treated as raw text.

If HTML data is retuned from the URL it will not be visible on the HS browser pages because the HTML
changes the rendering of an existing HTML page, but it does exist so extraction or other operations are
possible.
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Figure 137 Sites for polling JSON data via HTTP

GET protocol uses REST where the data being sent from mcsMQTT is placed in the URL as the
QueryString. POST protocol also uses REST with data being sent placed in the message body. UDP
places data being sent from HS in Datagrams. WS negotiates a persistent communication socket with
the URL setup. This is a listen-only protocol. TCPin is similar to WS, but the URL in this case is the NIC IP
and socket port that will be opened for listening. The external widget would need to be setup to use the
same if it desires to send data. The TCPIn URL can be defined as some port on 127.0.0.1 and in this case
mcsMQTT will pick the NIC being used. This implies that a single NIC exists on the computer to assure
know communication.

When the GET, POST or URL protocol is used then HS device is created through which the polling can be
stopped or started and text can be commanded to be sent. See Figure 138. When sending data through
a device the text box and Submit button are used. When sending data via Event Action the Send MQTT
Message Event Action is selected and the user entry for the action will be Topic=Text. The Topic will
start with URL/ and is visible in the Association tab as rows 12 through 16 of Figure 139 Pub text box. It
is of the format URL/URL:Control/Send. For example

URL/mcsSprinklers.com-8080:Control/Send=Text to Send
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In this example the port is separated from the address with dash rather than a colon so that confusion
does not exist with JSON key (colon delimit)

The GET and POST headers use default of the following. KeepAlive and Timeout are not actual headers
being transmit, but can be used to affect the connection persistence. Additional headers can be entered
in the last column of Figure 137 or the default headers can be changed by entering the header key and
value in the format key:value.

Content-Type:application/x-www-form-urlencoded,
Accept:*/*,

User-Agent:mcsMQTT,
Accept-Encoding:identity;q=1.0,*;9=0
KeepAlive:True,

Timeout:5000

Various authentication methods are employed across the web. mcsMQTT supports the most common
ones. The Authorization column provides a radio for selection of the method employed by the server at
the URL. mecsMQTT will either negotiate the authentication or it will include in the header the
authorization information for the Token and Bearer techniques.

REST GET and POST protocols usually have the URL prefixed with case-insensitive HTTP:// or HTTPS://.
UDP and TCPIn protocol does not have a prefix. Websocket/Webhook uses WS:// or WWS”// prefix. A
site that is expecting direct TCP commands can be setup with the GET protocol using “TCP://” prefix.

Data that is returned is expected to be in JSON format and decoded into individual keys such as shown
in Figure 139 . If XML it is converted to JSON. If not JSON then the entire message is treated as text or
number. The “A”ssociate checkbox on the Association tab can be used to map the returned data into HS
devices in the same manner that is used for associating MQTT data. If a transformation is needed such
as KPH to MPH values then the Edit tab Expression textbox can be used.
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Figure 138 REST and UDP HS Device Interface
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Figure 139 JSON Topics in Association Tab

12.1.2 URL Base and Endpoints

A server may have multiple endpoints that all share the same authentication methods. In this scenario
there should be one URL IP setup on the URL tab and that will be the IP of the base URL. For example, if
a server supports commands and status where the command URL is http://myServer/command and the
status URL is http://myServer/status then http://myServer would be the base IP used to establish the
link between the server and a HS device.

The HS Device will show a text box for parameters to be entered to route to this server. If the
parameter starts with “/” or with “?” then they will be appended to the IP to form the full URL that will
be sent to the server. For other cases, except the publist, the parameters will be considered to be the
data send as part of a POST request. GET requests have all their parameters on the querystring that will
start with “?”.

The publist needs to be used for the case where both the endpoint of the URL and the posted data need
to be sent. The publist is a text file located in the \data\mcsMQTT subfolder that contains both the full
URL and the data to be posted. It can be generated from the MQTT Page, Publist Tab or it can be done

“u_n

with any text editor. Each line of the publist file is a text list that uses “=" to separate two parts of the
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line. The first part can be a local replacement variable name, a MQTT Topic, or a URL. The replacement
variable is a convenience so often used text can be defined once in the file and then applied multiple
times. A line that defines a replacement variable has the syntax of $SSxxxx:=yyy where xxxx and yyy can
be any text strings. The Publist Tab editor of the MQTT Page has provisions of xxxx being 1, 2, 3 or 4; but
any text can be used for xxxx when making the file with a text editior. The definition of a local
replacement variable is an option that is not required.

In this context of defining multiple URL endpoints, the left side of the “=” will be the URL if not a
replacement variable definition. Using the same example of http://myServer as above a publist to send
a command to turn device 123 on and 456 off could be:

URL/http://mcsServer/command={“device”:”"123"”,”state”:”on”
URL/http://mcsServer/command={“device”:”456",”state”:” off”}

The use of the publist is designated with the parameter in the HS Device control text box ending with
“.pub” such as “myServer.pub” where the file will reside at subfolder \data\mcsMQTT\myServer.pub.

The publist is also available as an event action. A publist can send using HTTP or MQTT protocols. The
user of HTTP is indicated with the line starting with “URL/”, “GET/”, ”POST/”, “PUT”. Other starting text
will result in a MQTT publish. “URL/” will use the method setup on the URL tab of the Cloud Page.
“GET/”, PUT” and "POST/” will use the GET, PUT and POST methods respectively. For these HTTP
methods the specified URL must have the base URL defined on the Cloud Page, URL Tab. Using the same
example as above, if the POST method was to be explicitly requested rather than using the method
setup on the URL tab then the following would be used:

POST/http://mcsServer/command={“device”:”123”,”state”:”on"}
POST/http://mcsServer/command={“device”:”456",”state”:” off"}

“u_n

If the data in the publist contains a “=", other than the one used to separate the Topic from the Paylaod,
then it should be escapted with a backslash such as “\=". It will be sent without the backslash.

A third method to use the publist is for the case where periodic polling has been enabled on the Cloud
Page, URL tab for the server. If the endpoint entered ends with “.pub” then mcsMQTT will get the URL
information from the specified publist file.

In addition to the publist, a single endpoint can be controlled from a HS Device Feature that has been
associated with data received from the URL. For example, data received from xyz.com using the GET
method will show up in the Association table as URL/xyz.com.GET:xxx where xxx is JSON key. When
URL/xyz.com.GET:xxx is associated to HS then the Publish Topic can be defined to send data to that
endpoint in a manner similar that is done with publist. For this example, “PUT/http://xyz.com?id=1234"
could be entered for the Publish Topic and Payload Template setup with JSON format such as
{“move”:SSVALUE:}. This will send a PUT message to http://xyz.com with query parameter of id=1234
and body with JSON move key and value received from HS.

To send to a URL from a non-plugin device that has been associated the pub topic will contain the URL
that is setup on the URL Tab of the Cloud Page which will be typically a POST method. The publish
payload template will contain the post data and can contain replacement variables. For example, if URL
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https://someserver.com was setup as the URL and message to be sent is JSON with ref number of HS
Device and its value, the following would be used

Publish Topic — URL/https://someserver.com or URL/someserver.com

Publish Payload Template — {“ref”:SSREF:,”value”:SSVALUE:}

12.1.3 oAuth2 Authentication

When the authentication method being used by the server is oAuth2 then a second URL is involved in
the authentication process. This URL as well as the data payload being sent for authentication is
entered on the two text boxes provided on the row where oAuth2 authentication is selected.

Typically, the authentication URL will contain /oauth such as https://api.flumewater.com/oauth/token.
The data payload is JSON and will contain the grant type, client and secret tokens and other information
required by the server. An example is:

{"grant_type": "password","client_id": "ABC","client_secret": "DEF","username":

"myEmail@emailserver.com","password": "xxx"}

A successful authentication will result in a token that can be used in subsequent access and information
about expiration and method to renew the token. This information will be stored in mcsMQTT.ini in an
encrypted format for use when later needed to access the base URL.

The user does not need to be concerned by the token except in cases where a failure is reported and
visible on the MQTT Page, Association Tab related to the ability to access the server. If access failure
then the authentication credentials need to be reviewed.

The token is typically formatted in a standard manner called JSON Web Token (JWT) and will contain
information that may be needed in subsequent endpoints of the URL. The API for the server will
document the endpoint requirements and the key that can be obtained from the JWT token to satisfy
those. They are retrieved by mcsMQTT using replacement variable SSJWT:(key):. For example, if
“user_id” is needed in the endpoint or the URL (or in the data payload) then can be references such as:

URL/https://myServer/user/SSIWT:(user_id):/status

While it should not be needed it is also possible to get access to the JWT token itself using SSJWT:. The
SSJWT replacement variable is only valid in the context of Cloud Page URLs that have been setup for
0Auth2 authentication method. If used elsewhere then an empty string will be returned. If the key is
not in the JWT token then an empty string will also be returned during the replacement.

mcsMQTT will monitor the expiration date of the authentication token on a daily basis and send a
request that the token be refreshed on the day before it expires. If for some reason mcsMQTT is not
able to refresh it then a new token can be requested when needed.

WebSocket and Webhook (TCP Listener)
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Websocket and Webhook protocols open socket listeners on the HS computer at a specified port. When
a packet is received, it is converted to a MQTT pseudo-topic and payload that can be viewed on the
Association table and associated with HS Device Feature.

If there is special processing that is to be done or if a response to the received message is needed on the
same socket on which it was received then a script can be specified to provide the response text as
shown in Figure 140. If this processing is not needed then the script name does not need to be entered.

"_. GET Response Script
URL - POST | TCPResponse vb |
1921650 712345 || = Ubk Certificate File for 551
L WebSocket | |
@ TCP In Webhook
"_' GET Response Script
URL OPosT | |
192.165.0.7:6739 || ubP Cartificate File for 55L

CWiebSocket
— choefimesd.crl
® TCP In Webhook | |

Figure 140 Listening Sockets Script Option

The script will be a Function with procedure name “Main”. It should expect two parameters. The first is
the URL that provided the packet of data and the second is the data in UTF8 string format that was
received.

The script will return the text that should be returned on the socket or a null string if no response is
desired.

As an example the following script will return the URL and received message if the message is “ECHO”
otherwise it will return a null string. mcsMQTT will return the text from the function in the first case on
the socket. It will return nothing in the second.

Function Main (parm as object)
Dim URL as String = parm(0)
Dim Data as String = parm(l)
if Data = "ECHO" then
Return URL & "=" & Data
else
Return ""
end if
End Function

If the TCP Listener needs to support a secure SSL connection then a certificate needs to specified as

shown in Figure 140. If an unencrypted communication is being used then the SSL textbox should be left
blank. Generation of certificates is described in Section 10.2.3.
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12.2 Voice Monkey
Voice Monkey provides a means to communicate with Echo devices from HS. There is a setup to be
performed that involves:

1. registering with Voice Monkey,
2. enabling Voice Monkey skill in Alexa App, and
3. entering the skill’s access token and secret token on the mcsMQTT Cloud Page.
After setup then HS event actions are used to speak the Text, show Video or show HTML page.

Voice Monkey setup of access tokens is done on the same Tab as the Serial setup as shown in Figure
143. The tokens become available on the dashboard when a free Voice Monkey account is requested
via Voice Monkey - Sign In (https:// app.voicemonkey.io).

This account provides ability to link the Echo Voice Monkey skill with a user’s Amazon account. This skill
provides the ability to do Text-To-Speech to Echo devices as well as pictures, videos and HTML pages to
Echo Show devices.

The theory of operation is that a mapping is performed using Echo Routines between an Echo Device
and a corresponding Voice Monkey Routine. When the Voice Monkey Routine is run the Text-To-
Speech, video, image, or HTML page is delivered to the mapped Echo Device. The Voice Monkey
Routine is run when the Routine Id is used in mcsMQTT event action or MQTT message.

The Voice Monkey Routine to Echo Device mapping is done using the Alexa App run on IOS or Android.
Prior to this the Voice Monkey account, via a browser, is used to define the Routine names. The Routine
names can be defined all at once or can be done at anytime before the Routine name is used in the
mapping operation in the Alexa App.

Routines have a name and have an Id. The name is entered by the user in the format “Speak
EchoDevice” in both Voice Monkey and Alexa App. The Id is the same as the lower-case name, but with
a hyphen rather than a space (e.g., speak-kitchen). The Id is used in the mcsMQTT event action and
MQTT topic.

The process using Voice Monkey and browser will result in a set of Monkeys which are the same as the
Routine names as show in Figure 141.

Then naming convention is the same as is being used by Jon00 in his Voice Monkey integration with HS.
What is important is that whatever convention is used there must be a relationship setup between
name being used, the Echo Device, and the Routine name. Using the outlined naming convention
assures the relationships will exist.

The Voice Monkey name is referred to as a Monkey. In the APl Version 2 format it is “device”. It is used
to form the Routine Id that is used by mcsMQTT in Event Actions and MQTT Topics and becomes the
trigger to cause Voice Monkey to route a payload to the Echo Device. One Name/Monkey/Device
defined in Voice Monkey can be used multiple times in Alexa App Routines so that multiple Echo Devices
can receive the same payload with a single Event Action or MQTT Topic.
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Figure 141 Voice Monkey Routines Seteup
In the Alexa App a mapping is done for each Echo Device with the result shown in Figure 142.
1. Start with Routines (from more menu in lower right)
2. Use +iconin upper right to add a new Routine

3. Enterinto “Enter Routine Name” textbox “Speak <EchoDevice>" where <EchoDevice> is the
name given in Alexa to the Echo Device. When done use the “Next” prompt in upper right.

4. Click “When this happens”, on new screen select “Smart Home”. On next page there will be a
listing of the Routines that were setup previously in Voice Monkey browser. Select the Routine
name that is the same as the EchoDevice being mapped. The screen will echo “When ‘Speak
<EchoDevice> is pressed’”. Select Save.

Page 259



5. Click “Add Action”. Select Skills. From Your Skills select “Voice Monkey — Routine Triggers &
Text To Speech”. Screen will update with “Alexa will open Voice Monkey Voice Monkey —
Routine Triggers & Text To Speech. Select Next in upper right.

6. On bottom of screen “From “ click on “Choose Device”. Select the <EchoDevice> that is being
mapped. Click Save in upper right.

Routine Name

Speak (Den)

When

Voice Monkey Skill

Add Action

Open Voice Monkey — Routine Triggers & Text To Speech

From

Echo Device Name (Den)

Figure 142 Alexa App Edit Routine for Voice Monkey

There is a special case Routine name “Speak All” that is used as the “When” part of the Routine
definition. There can be multiple Routine names that use “Speak All”. This has the effect of sending the
same text, video, image or HTML to multiple Echo Devices with a single Event Action or MQTT Topic.

There are two benefits. One is to reduce the size and labor of defining HS Event Actions where the
announcement is to be sent to all Echo Devices. The second is that there is a limit of 30 requests to
Voice Monkey per minute. If one has 30 Echo Devices, for example, then only one message can be sent
per minute. For 15 then it would be two, etc.

mcsMQTT maintains a queue of Voice Monkey requests that run in a separate thread. It manages the
gueue so that no more than 25 requests to Voice Monkey are made in a rolling 55 second window. If
there is heavy request rate then it is possible that there will be a delay. If the throttling was not done
then Voice Monkey would enforce a 15-minute lockout if the 30 per minute was exceeded.
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Figure 143 Voice Money Token Setup

The Voice Monkey event action defaults to Text. To show Video of HTML pages then JSON is used to
specify the details. Section 5.3 contains more details on the use of the event action.

When using Voice Monkey via MQTT message, the full capability of the Voice Monkey V2
Announcement APl is exposed in the MQTT Payload. Refer to https://voicemonkey.io/docs for a
complete description of the announcement optioins. The MQTT Topic is “voicemonkey”. The options
consist of image", video", "video_repeat", "voice", "no_bg","media_width,
"media_height", "media_scaling", "media_align", and "media_radius with mandadory
keys device and text Inthe JSON payload.
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12.3 Yolink

12.3.1 Cloud Integration

YoLink has make available an integration API to interact with its cloud server much like their smartphone
apps is able to provide the Ul for their devices. This integration works with the original/standard hub
and with the Speaker Hub. It is also possible with the Local Hub (YS-1606UC) to have control and status
without an internet connection. Note that the YS-1606UC also is able to talk Matter. These local
benefits come at a hefty price over a standard hub.

Yolink provides the API to support partner product integration or individual user integration.
mcsSolutions (mcsMQTT) was submitted and approved to have a partner account capability. This is the
mechanism by which mcsMQTT integrates with HS. As a partner, mcsMQTT has visibility of the state of
any device identified for mcsMQTT management. It does not have visibility into a user’s account by
default, but if the user desires to simplify the setup with HS then access to a user’s account can be
granted (via Oauth2) to allow mcsSolutions to get the list of devices that have already been setup on the
user’s Yolink account. This is typical of Internet-based servers where data is available, but the data is
not associated with any individual, but only an account number. If access is not granted, or not
attempted, then the setup uses the QR codes of each YoLink product in the setup. The QR code comes
with each product when delivered and often are imprinted on the device. Sometimes they are only on
the packaging or an insert. Access to a user’s account is a convenience and not a requirement for
integration with mcsMQTT.

The user has two options to identify the YoLink devices that mcsMQTT will integrate. One is to use the
list of devices that were setup on their account. This is done with the “Get All Devices ...” button. The
other is to identify a YoLink device with its 32-character QR code. A smartphone QR scanner can provide
this. It is entered on the YoLink QR code table. mecsMQTT will inform the YoLink cloud server of this
device being integrated via mcsMQTT. The Yolink cloud server will acknowledge and, in the future, will
provide notification of any state changes for the device. See Figure 144. In this figure it shows the first
four where the QR code was entered manually by the user. The last row shows a device unique id which
is signified by encasing it in “[“ and “]”. This indicates a device where the QR info was obtained from
authorized access to the user’s Yolink account. A third option is with the data encased in “{* and “}".
This indicates that the device is coupled to a Local Hub (YS-1606UC) and control and status will be
obtained locally. The YS-1606UC will still send actions to the Cloud server for use by the user’s YoLink
smartphone App. The designation of a YoLink device to be local or cloud-based is one in the YoLink
smartphone App and it only applies to the YS-1606UC hub.

When a Local Hub is setup it will show it’s index and the device that are managed through it will show a
QR code that starts with “{x-“, where x is the index of the Local Hub. This index will normally be 0 unless
multiple Local Hubs are being used. The corresponding Local Hub index will show at the end of Device
Name column in the table of QR codes.

he Yolink hub devices are sometimes not returned in the list of devices in the YoLink account. If
HS/mcsMQTT (online/offline) monitoring of the hub is desired then it may be necessary to manually
enter the QR code. Manual entry of QR codes do not start with “{“ or “[“.

Note a scenario where one HS instance can monitor YolLink devices at two residences or otherwise
widely separated locations. In this scenario the radio for multiple mcsMQTT should be selected on both
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mcsMQTT instances and the same QR devices or account list set of devices should also be setup on both.
The effect of this setup selection is that MQTT communications from the YoLink server will be delivered
to all locations where mcsMQTT is running so each location can remain in sync.

Note also in the QR table shown in Figure 144 has two entries for the YoLink Relay. One is via Cloud
based upon info from the user’s account (“[“ prefix) and the other is local control from Local Hub index
0. At this time mcsMQTT will give precedence to the Local Hub. In the future it is possible to implement
a backup mechanism by which the Cloud access is used if the Local Hub is no longer available. This
implies that a standard or speakerHub is available for alternate routing.
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HomeSeer

Devices Events Cameras = Dashboards Selup Tools - Plugins -

UIRL GeoFence Energy

Yalink Voice Monkey

YoLink Cloud Server Configuration

rCSMOTT Clienls Single mesMaTT @
Mulliple meshaTT (O

YolLink Local Hub

Yodink Local Hub IP{s) 192.168.0.230

Yolink Local Hub Client 1d 489ef13c-0544-413b-95e3-0ecad 7ibl ce?

YoLink Local Hub Clienl S8crel | sssssssssissssssssssssssssssss

YolLink Integration

vioLink Connections Connect o Yolink Server and Local Hub{s) )
Disconnect from YoLink Server and Local Hubis) (O

YolLink 32 Character Device QR Code Device Id Device Type Device Name

Get All Devices That Have Been Setup in Your YoLink Account

[b4Z2c1 Bed1fe14817abeabd2b2476953€] d88bAcOZ0000(7dY | LeakSensor | Leak Sensor
[33d935aeee3adbbadTebe2645ab65570)] dE8bAc02000055dd DoorSensor  Door Sensor
[4167640124c049b5922f631 49865a749] d28hAeT604009293 SpeakerHub  Speaker Hub
[60390ac701de4021a0c4358f7048f9de] dBBbAC16020032d8 Hub YoLink Huby
[b7c221c50eed452809fd8881213356e1b] dBBbAC1606000025 Hub YoLink Loezl Hub
[4350d039432141c5ad0430b351e5787¢] dB8EAc010002fede | Oullel YaLink Plug
[adcbec033e67402496a54e18a818cded] d&8b4c01000896b Swilch YaLink Relay
{0-81454D8BEAAST15B96EC2167157C611CE} dBBbAC010008%a6b Swilch Yalink Relay

Figure 144 Yolink Device QR Code Entry
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When getting YoLink devices from a user’s account an oAuth2 process is invoked where the user logs
into the YolLink site and grants access to the devices in their account to the plugin. This screen is
presented when the “Get all Devices...” button is clicked and shown in Figure 145. Since this browser
page is being served by the YoLink server, mcsMQTT has no visibility into the user’s account other than
the listing of devices that are on the account that are subsequently delivered by the server once access
approval is granted. This is the same as when the QR codes for the devices are individually added. The
account that these devices were setup is not visible to mcsMQTT.

The oAuth2 process directs the browser to the YoLink server and then once approval has been granted
the Yolink server redirects the browser to an externally-visible internet site. The assumption being
made in the plugin implementation is that the redirection will be back to the same IP as where it started.
This means that use of the “Get all Devices...” button can only be done from a browser that is running on
the same computer as HS.

The Yolink server does not provide the identification of the YolLink Hub when the list of user devices is
delivered. If monitoring of its status from HS is desired, then the QR code of the Hub needs to be
explicitly specified in the QR table.

Data in the table is a 32-character code. When manually entered from the QR code from the YoLink
device then it shows exactly as entered. Codes that are obtained from access grant to the user account
are shown encased in [ and ]. These are not the QR codes, but the unique ID’s of the device which has a
one to one relationship with the QR code.

< c 23 apiyosmart.com/oauth/v2/authorization.htm?response_type=code8redirect_uri=http://... &= TAT a @ Relaunch to updats §
o Error when pairedd.. @ 1 @ Advanced Search -... [3 Al Bookmarks
YoSmart YoSmart Auth
Dear user:

You will grant mcsSolutions :

Access to Devices

Device Remote Control

Please make sure you have YoSmart Account,and had add your devices by Yolink App already. You can get YoLink App from App Store or Google Play.

In the process of using YoSmart products, we will protect your personal information in strict accordance with the requirements of the YoSmart Privacy Policy.

I Confirmed

Login YoSmart

Figure 145 YoLink oAuth2 Authoriztion Screen

The information that is received from the YoLink cloud server is available on the mcsMQTT MQTT Page,
Association tab such as is shown in Figure 147. mcsMQTT will automatically associate the likely features
of interest such as the state or battery level if the MQTT Page, Client Tab setting has been enabled for
auto-creation of known integrations. Figure 146 provides a typical example. The user can manually
associate any of the items shown in the Association table if additional visibility in HS Device Features is
desired. Thisis done using the “A”ssociate column checkbox. This will be on the /report topic.
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Manual association also applies to new widgets that YoLink sells and have not yet been recognized by
mcsMQTT. In this case the user can manually associate the widget for HS monitor and control and not
need to wait for a future plugin update.

L]
YolLink-DoorSensor-

d88b4c02000055... (7986)

[] ‘D report:state (7987) closed Today 8:45:16 PM
] report:battery (7988) 100 % Today 74645 PM

YolLink | YoLink

(]
YolLink-LeakSensor-

d88b4c020000f7... (7989)

[] 0 report:state (7990) normal Today 7:42:36 PM
] report:battery (7991) 75 % Today 817:47 PM

YolLink | YoLink

(]
YoLink-Outlet-

d88b4c010002fcdc (7984)

] report:state (7985) on Today 7:47:23 PM OFF “

Figure 146 Auto-created YoLink Device and Features
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Association Table for Auto Association of MQTT Topic and HS Device

0 N N I TR I N KN TN

9601  Yolink/d88b4c010002fcdc/report

100 0 0 00 [ | sub: Younk/dssb4co10002fcdc/report:dataidelay:ch 1 O el
20 0 1 0 [ ] Sub: Yolink/dssbaco10002fcdc/report:data:delay:off 0 O o
30 0O 0 [0 [ ] sub: Yolink/de8b4c010002fcdc/report:data:delay:on 0 O ig?j;.’;;”
Sub: 2021-07-25
40 0 a a l: YolLink/d88b4c010002fcdc/report:data:loralnfo:gatewayld d88b4c16030032d5 a 13:17:06
- Sub: 2021-07-25
S0 0 a . [:] YoLink/d88b4c010002fcdc/report:data:loralnfo:gateways 1 o 13:17:06
6 O 0O O O l:’ Sub: Yolink/d88b4c010002fcdc/report:data:loralnfo:signal -48 O 21’22117‘0;25
700 0 0 [0 [ ] sub: YoLink/d88b4c010002fcdc/report:data:power 0 0 fg.qua-?;-zs
Dev: Yolink|d88b4c010002fcdc|report:data:state
~ Sub: Yolink/d88b4c010002fcdc/report:data:state 2021-07-25
A0 O e Pub: the following Topic on Device command open O 0O D Y4636
YoLink/d88b4c010002fcdc/Outlet

014 07 AAne a3 ac

Figure 147 Yolink Report Data
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12.3.2 Local Integration

Local integration is possible with the model YS1606-UC hub. This hub allows both cloud and local
integration and includes a cellular and Matter interface as well. The cellular interface, if activated,
comes with a monthly subscription fee.

The YS1606-UC is a new product as of Q1°2025 and a smartphone YoLink App update is needed to start
using the additional capabilities of this hub. The smartphone App is needed to obtain the authorization
credentials to directly access the local hub.

Once the updated App is installed then an option becomes available for a local network subnet and this
option should be exercised. This will allow each device on the YoLink Cloud account to be selected for
local status and control via the local hub that is supporting its subnet. The implication is that different
local hubs can be deployed with different YoLink devices on each. Once the Local link has been
exercised then the Local network screen becomes available as shown below. Integrations tab is selected
from which the Local API client id and client secret can be copied and transferred to the mcsMQTT
Yolink tab setup.

<  Local Network

General Devices Automations Integrations

Matter
<

Commissioned
I
Local API
I
7o

From the App, the Client Id, Client Secret and the Net Id are transferred to the mcsMQTT Local Page
setup. To complete the Local Hub setup, the IP of the Local Hub needs to be specified. It will
automatically populate on the mcsMQTT Yolink tab after the QR becomes available and mcsMQTT polls
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each QR code to get info about it. It can also be manually entered in the text box. The YolLink Tab setup
related to the Local Hub is shown in Figure 148.

HomeSeer

Devices Events Cameras~ Dashboards Setup Tools - Plugins -

LIRL GeoFence Enengy

‘Yolink Vioice Maonkey

YoLink Cloud Server Configuration

mosMOTT Clients Single mesMOTT @)
Multiple mcsMOTT ()

YoLink Local Hub

Yolink Local Hub IP{s) 192 168.0.206
Yolink Local Hub Met Id COo0D005
Yolink Local Hub Client Id 489ef13c-0544-413b-95e3-0ecad 7fb1celd

Yolink Local Hub Cliernt S2CT8t | sssesrsrresssssnssrsssnssnrsnnns

YoLink Integration

Vol ink Connechions Connect to Yolink Server and Local Hub(s) ()
Disconnect from Yolink Server and Local Hub(s) ()

Figure 148 Yolink Setup including Local Hub

The Cloud Page, Yolink setup includes a configuration table such as Figure 149showing information
about each Yolink device that has been integrated with mcsMQTT. Table entries starting with “[“ are
those that were obtained from the user’s Cloud YoLink account. Access authorization) (0Auth2) is
granted by user when the “Get All Device...” button is used.

“" [II

Rows starting with “[“ indicate the information came from the user account. Rows starting with “{“
indicate the information came from the Local Hub that had been configured to place the subject device
on it local network. Other rows are those where the user entered the QR code to identify its devices for
HS integration via mcsMQTT.
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Note that is it possible for the same Device Id to exist on both the Cloud account and the Local Hub
network. In this case, the status of state and state change event notification come from two sources
(internet cloud and local hub). At this time mcsMQTT only attempts to control via the local hub when
the device is on the local hub’s network.

An interesting observation during development integration is that control via Cloud is faster than control
from Local hub. This was confirmed by YoLink engineers as they have setup multiple powerful servers to
handle the Cloud communications while the Local Hub has limited resources to support its local
network. This may even be exasperated when Matter support is functional.

Since Cloud control is more responsive, the mcsMQTT design in the future may default to Cloud control
and only use the local control when the Cloud interface is down.

Yolink 32 Character Device QR Code Device Id Device Type Device Name

Get All Devices That Have Been Setup in Your Yolink Account

[b42c1 6ed1fe14817abeabd2b2476953¢] dABh4c0P0000f7d7 | LeakSensor  Leak Sensor
[33d935aeee3adbbad7e5e2645abs5570] de8b4c02000055dd DoorSensor | Door Sensor
[41676401a4c049b5922f63149865a749] di8b4c1604009293 SpeakerHub  Speaker Hub
[60390ac701dc4021a0c4358f7048f0de] da38h4c16030032d8  Hub Yolink Hub
[b?czz'] cSleed45280fd2881213356a] b] d88b4c1606000025 Hub Yolink Local Hub
[4350d039432141c5ad0430b351e5787¢] di8n4cO10002fcde | Outlet Yolink Plug
[adchec033e67402496a54e1 Ba818cded] dE8h4c010008%a6b Switch Yolink Relay
{0-B1454DBEAAS715B96EC2167157C61 1CE} di8b4c0100089a60 Switch Yolink Relay
{0-DZF3EDBB05216758544438FC49697759) d8804c010002fcde | Outlet Yolink Plug

Figure 149 YolLink Managed Devices

Page 270



12.4 Geofence

The Geofence settings are used in conjunction with the smartphone tracking that is provided by the
OwnTracks or NextTracks App. The setup and use of Owntracks for purpose of setting up a geofence is
described in Section 14.

The location setup in HS Settings is always available as the center of a geofence. As many other
locations can be setup as desired. For example, multiple work locations, a friend’s location, etc. can be
defined such as shown in Figure 150.

URL | Yolink | Voice Monkey | Geofence | Sense ‘

Geofence Location Name Latitude Longitude Boundary (ft)

|HS \ |4? 49323 \ |-121,7831 | \500 |
|Shop '|[47.49325 |[-121.7837 | [200 |
| Property [47.49323 |[-121.7831 | 1000 |

|

Figure 150 Geofence Locations Setup

When position updates from Owntracks is received mcsMQTT will calculate the distance from each
geofence location and determine if the position is inside or outside the geofence.

The geofence boundary that is setup will determine the parameters for the here-away logic. A phone
moving toward a location that is identified as a geofence location will show here status if within 80% of
boundary distance. A phone that is moving away will show away status when it exceeds 120% of the
boundary distance. The hysteresis minimizes status toggling as the boundary is being traversed.

The geofence distance and the distance displayed with the Owntracks MQTT topics will be based upon
the HS setting for use of English vs. Metric units. It will be either feet or meters.
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12.5 Energy

12.5.1 Sense Energy

Sense Energy provides a device that measures electricity utilization and then based upon patterns it tries
to determine specific appliances that are using the energy at any given point in time. The data that is
collected is sent to the Sense cloud server for collection and analysis. There is not local access to the
data that has been published.

When a Sense device is obtained there is a process to setup an account that consists of an email and
password. To access the data via their App or via mcsMQTT the login credentials are needed. The API
for accessing the Sense cloud server account is not published but has been reversed engineered and
implementation provided for powershell, nodejs and Python. mcsMQTT is a .NET implementation based
upon information that is on the internet from other implementations.

There are three main capabilities provided. The primary is to make available the real time energy
consumption of each device identified by Sense. This can be seen on the Association Table of Figure 153
and HS Devices of Figure 152. The second is to provide a graphical display of the energy consumed by
each device over day, week, month and year timespans. Clicking on the MQTT Page, Association Tab,
Payload column value for the sense/realtime/... topic of interest will produce the popup chart, but only
if the additional download has been requested on the Sense setup of Figure 151. The third is to provide
access for HS visibility to other data related to status of the Sense algorithm to identify devices, a
timeline of events for specific devices turning off and on with chart display shown in Figure 154, and the
accounting of device properties maintained by Sense Energy.

mcsMQTT will setup a websocket to receive realtime data. Fast polling places greater burden on the
Sense server and HS/mcsMQTT. Default polling rate is every minute (60000 milliseconds). The polling is
for realtime data. If the user selects Devices, Status or Timeline then it will be polled at the rate
specified by user on the Cloud Page Sense tab as shown in Figure 151, but no faster than every minute

The realtime data feed provides energy utilization of each Sense-identified device and the total. For
each of these a HS Device Feature will be created and updated as shown in Figure 152.
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Devices Events Cameras~ Seip Tools~ Plugins~

LIRL Yolink ‘oice Mankey GeoFence Senee Hubspace Switchiot Tank

Sense Energy Connect Parameters

Apcount Emai | me@gmail.com| |

Aocount Password

Server Polling Rate (milbseconds) | g0DOO0

De=play Precision 4
Server Disconnect Connect To Senze Server ()
Diszonnect from Sense Server i
Dewces] |
Additional Downlosd ‘:&'.atu:lj
Timeline[_]
Figure 151 Sense Energy Setup
Sense | Sense
[] w0 sense-realtime-42569 (470) Today 12:54:26 PM
O o Total Watts (471) 4768.5127 W Today 3:08:10 PM
O o Solar Watts (472) 298.6376 W Today 3:08:10 PM
O o Other Watts (473) 27331567 W Today 3:08:10 PM
| o Rig1 Watts (474) 1143.2482 W Today 3:08:10 PM
O o Always On Watts (475) 524.9009 W Today 3:08:10 PM
O o Office Watts (476) 304.1045W Today 3:08:10 PM
| o Fridge 3 Watts (477) 84.7928 W Today 2:08:42 PM
O o Fridge 1 Watts (478) 63.1027 W Today 3:08:10 PM
| o Living Room TV System Watts (479) 10.901 W Today 3:08:10 PM

]

Figure 152 Sense Energy HS Devices and Features
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Pub: the following Topic on Device command

m —/ 1 1 Sub: sense/realtime/42569 payload device_data_checksury

i — — — Sub: sense/realtime/42569 payload features
O O o

i ] r [ ] Sub: sense/realtime/42569:payload:monitor_ '_checksum

Sub: sense/realtime/42569:payload-online

partner_checksum

D - U L Sub: sense/realtime/42569:paylo

M ] [ Sub: sense/realtime/42569:payload:pending_events:goal:quid

Figure 153 Sense Energy Topic Endpoints

[MONTH] Always On History

m 1:Always On

= 1:Total

Always On-Total

September 5 September 12 September 19 September 26
Time (8/31/2021 9:00 PM - 9/30/2021 9:00 PM)

Figure 154 Sense Energy Trend Chart
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12.5.2 Emporia Energy Vue

Emporia Energy provides a cloud server from which real time energy usage can be obtained for each
circuit that has been installed for monitoring. Their site is at https://www.emporiaenergy.com/.

"
%
L)
2
R
L)
.
.

Figure 155 Emporia Hub and Circuit Clamps

Integration of their server with HS via mcsMQTT can be done in one of two manners. The easiest is from
the Cloud Page, Energy Tab. The integration was originally developed using the Cloud Page, URL Tab.
When using the (generic) URL tab, there is more user input required. When using the Energy Tab, the
plugin provides the front-end for what would have been done manually using the URL tab setup. Setup
from the Energy Tab will automatically populate the URL tab entries.

12.5.2.1 Setup from Cloud Page Energy Tab

For the Energy Tab setup, the user provides login credentials, the path to the Python executable, the
report scale, polling interval, and controls for connect/disconnect. See Figure 156. The python path in
this case is shown truncated. The full path, for this install of python is:
C:\Users\mcsSo\AppData\Local\Programs\Python\Python312\python.exe, but it will likely be different
for each user.
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In addition to the user-specific setup, it is also necessary to install the library for PyEmVue. This is from
command line with “pip install pyemvue” in command/terminal window. This assumes Python 3 has
previously been installed and pip is available with that install.

H Dﬁ eSeer HE4 Web Control

Devices  Events Cameras ™ Dashboands FEI:LFI Tooks ~ Ph_g'“gv

URL GeoFence Enengy Wiater Propane Irmigation Thermostats Solar Pl

Ecohet Aboda Goves WoLink \ioice Monkey

Emparia Energy Connect Parameters

Account Emel mcssolutions@centurytel. net

Account Pasaword e

Server Polling Rate (Seconds} g0

Python Path ChUsersymcsSo\AppData\Local\Programs'\Python\Python

Srale TMIN v

o " - i T, e
Lerver thsoonnect Connect To Empona Server

Dizconnect from Empona Server

oe

Figure 156 Emporia Energy Setup

12.5.2.2 Setup from Cloud Page URL Tab

If done on the URL tab, then the following paragraphs provide the guidance. Note that the URL tab
setup is based upon the original Emporia integration for which much investigation and learning was
associated. Itis captured below for reference and contains information that could be useful when
diagnosing unexpected opteration.

For the URL setup, the user edits mcsMQTT.ini to provide the Python executable path and edits
\data\keys.json to provide the login credentials. The user also provides the URL to the Emporia server.
In both cases the user provides the desired polling rate and device ids of the devices that are being
monitored. In the URL integration the device ids are specified in the Endpoint of the URL setup. In the
Energy integration they are provided explicitly on the tab. If polling rate is zero or null on the URL tab
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then it disables the integration. The Energy tab provides an explicit enable/disable control. The original
integration used a Python module AWSLogin.py that needed to be copied by the user to a specific
location dependent upon where the Python libraries were located. The updated integration used
EmporiaRequest.py and no explicit user action is need to relocate it.

The details of the original URL integration are contained below.

The URL Tab setup is started on the Cloud Page, URL Tab by entering the Emporia cloud server URL
https://api.emporiaenergy.com, the endpoint query
“/AppAPI?apiMethod=getDeviceListUsages&deviceGids={123456}&instant=SSUTCYEAR:-
SSUTCMONTH:-
SSUTCDAY:TSSUTCHOUR::SSUTCMINUTE::SSUTCSECOND:.0Z&scale=1MIN&energyUnit=KilowattHours”
and a polling rate as shown in Figure 157. The protocol is GET and the authorization is oAuth2. The red
text for deviceGids parameter is unique for each user. Getting this value will be discussed later in this
section.

The API for Emporia Vue has been reversed engineered and the company has indicated that an official
one will be published in 2022. Emporia uses the AWS servers. The login to these servers is with AWS’s
flavor of oAuth2. mcsMQTT utilizes an existing Python implementation of the cognito login to
accomplish the authentication. This is expected to change to a native .NET implementation when the
official APl is published. There is no need to enter anything in the Cloud Page, URL Tab “oAuth2 URL and
Data Payload” textboxes as this is currently handled with the Python glue.

The Python implementation is available at https://pypi.org/project/pyemvue/. Itis installed from a
command line with “pip install pyemvue”. In addition, a Python module was developed as glue logic
between mcsMQTT and pyemvue login. The AWSlogin folder and __main__.py file in this folder is
installed in the same location as pyemvue. The location will depend upon the computer. For a clean
install on Windows the path is “C:\Python37-32\Lib\site-packages”. AWSLogin that contains both the
folder and file is available at http://mcsSprinklers.com/AWSLogin.zip. Unzip while maintaining the
folder structure as shown in example below.

This PC » Local Disk (C:) # Python37-32 » Lib » site-packages » AWSlogin

Mame Date mu:u:lifil;:l Type Size

& __main_.py 3/1/2022 10:21 AM Python File | KB

Also available at http://mcsSprinklers.com/AWSKeys.zip is template file for the Emporia account login
email and password. This file is placed in the \data\mcsMQTT folder and edited to provide the account
login information. This file will be updated by AWSLogin with a set of tokens after a successful login has
been accomplished. It will continue to be updated as tokens expire and new tokens need to be
obtained. This will occur typically on an hourly basis. No user action is need after then initial edit of the
template.

mcsMQTT will execute AWSlogin.py when it receives a 401 unauthorized result. The expected path of
Python is C:\Python37-32\python.exe. If this not the path on your computer then add a line
under the [General] section of \config\mcsMQTT.ini that looks like below with the red text
containing the path on your computer.
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https://pypi.org/project/pyemvue/
http://mcssprinklers.com/AWSLogin.zip
http://mcssprinklers.com/AWSKeys.zip

PythonPath= C:\Python37-32\python.exe

On a later RPi/Linux install additional steps were needed as the required cryptography libraries had to
be locally built from source because of Linux hardware variations. The following steps were used. Note
the third line below captures the interactive inputs for rust configuration.

sudo apt-get install python3-pip python-dev

curl --proto '=https' --tlsvl.2 -sSf https://sh.rustup.rs | sh

2, arm-unknown-linux-gnueabihf , nightly, complete, Y, 1

sudo apt-get install libssl-dev

pip install pyemvue

The second issue on the Linux install is that during pyemvue install the python path environment was
not updated to include the path to this and dependent modules. To overcome this a bash script was

used that first set the environment variable and then executed the AWSlogin module. The script is
shown below. | called the script AWSlogin.sh and placed it in the /Data/mcsMQTT folder.

#!/bin/bash
export PYTHONPATH=/home/mcs/.local/lib/python3.9/site-packages

/usr/bin/python3 $1 $2 $3

This script can be put anywhere and does need to be made executable (chmod AWSlogin.sh 755).
Something like /Data/mcsMQTT or /scripts seems like a reasonable place.

It needs to be edited to put the path where AWSlogin module was placed in the PYTHONPATH line. Note
that the PYTHONPATH environment is being explicitly stated here for whatever user is associated with
the shell execution. In my case it was not the logged-in user that was running HomeSeer. It would be
safer to add to existing PYTHONPATH rather than replacing, but | did not evaluate this approach. | found
Google reference to do this with "export PYTHONPATH=/home/mcs/.local/lib/python3.9/site-
packages:SPYTHONPATH.

It needs to be edited to put the path to python if not /usr/local/python3.
/Config/mcsMQTT.ini needs the PythonPath= xxx where xxx is the path to where this script was placed.

For example
Code:

PythonPath="/usr/local/HomeSeer/Data/mcsMQTT/AWSlogin.sh"
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URL

) ) content-type:application/json
https://api.emporiaenergy.com Norie

Poll {mnilliseconds

10000 LDP

Polling Endpoint

/AppAPI?apiMethod=getDevicelistUsages&deviceGids={1(

Figure 157 Emporia Vue mcsMQTT Setup

The polling endpoint setup has a scale parameter which can any of the following [1S, 1IMIN, 1H, 1D,
1W, 1MON, 1Y]. 1MIN is areasonable value. It means that Emporia will provide the KwH
measurement for data collected over the past one minute. In the setup of Figure 157 the polling rate is
shown as every 10 seconds. This means the data will be refreshed every 10 seconds for the amount of
energy used over the past 60 seconds.

mcsMQTT converts the KwH data received into Watts in the HS Device Features. It does this by using
the Expression text box of the Edit tab to use the appropriate conversion based upon the scale
parameter being used. This is all done automatically by mcsMQTT with no user action needed. If the
user changes the scale parameter, then mecsMQTT will change the conversion expression. For example,
a KwH reading that was taken with scale=1S will have an expression 3600*1000 to handle the
conversion from hours to seconds and from kilowatts to watts. For scale=1MIN the conversion is
60*1000, etc.

mcsMQTT automatically creates HS Device Features for the “:usage” JSON keys of the data from the
Emporia server. It gives the Feature the value of the “:name” JSON key. This is shown in Figure 158.

Emporia JSON payload is provided as arrays. This results in multiple rows on the mcsMQTT Association
table of the MQTT Page with similar data. It is possible to “A”ssociate other rows into HS Device
Features, such as “:percentage”. If this is done then take care to associate only one of the multiple rows
that could provide the same data.
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URL | api.emporiaenergy.com

[J URL-api.emporiaenergy.com (3028)

URL | api.emporiaenergy.com:Control

O @ api.emporiaenergy.com:Control (3029) 0 242442022 9:16:49 AM
STOP POLLING START POLLING

URL | api.emporiaenergy.com.GET
[J URL-api.emporiaenergy.com.GET (3610)

o Main usage (3611)
o First Fl South Plugs usage (3612) 0724W
o Third Floor Air Handler usage (3613)
o Dryer usage (3614)

o DishWasher usage (3615)

o Towel Warmer usage (3616)

o Coffee Maker usage (3617)

o Living Rm Lites & Spiral usage (3618)

o Master Bed Lights usage (3619)

o Master Bed Bath Lights usage (3620)

o Steph Bed Bath Lites usage (3621)

o Anna Bed Bath Lites usage (3622)

o Master Closet and Hall usage (3623) 1.349 W Today 9:50:56 AM

o Hall Lites usage (3624)

o Disposal and HotWater usage (3625)

Ooooooooooooooooao

o Balance usage (3626)

Figure 158 Emporia Usage as HS Device Features

At the top of in Figure 158 is the polling control buttons and interactive endpoint text box. The buttons
are used to start and stop the polling. These will not normally be used. The text box is used to send
one-time requests to the Emporia server.

The specific need for this text box is to obtain the deviceGids value that is needed to poll the energy
data that was setup on the Cloud Page, URL Tab. Enter (without quotes) “/customers/devices”.
This should result in a request being sent. If accepted then the MQTT Page, Association Tab will show
many rows of data about the Emporia devices. The payload column will show the deviceGid for each
device such as:

Sub: URL/api.emporiaenergy.com.GET:channels:02:deviceGid 123456
This number will be used in endpoint text box of the Cloud Page, URL tab for the Emporia row.

There is no longer any need for the data in the Association Table that was just populated to get the
deviceGid. To clean this up go the MQTT Page, General Tab, Obsolete row text box and enter (without
quotes) “URL/api.emporiaenergy.com.GET:#”

The step-by-step setup of the pieces described above is itemized below.
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10.

Install PyEmVue from command line with “pip install pyemvue” in command/terminal window.
Note possible variation between Windows and Linux described above to have success with the
install.

Download AWSlogin and place in Python packages folder
Download AWSKeys, unzip into \data\mcsMQTT folder and edit for login credentials

Edit \config\mcsMQTT.ini if the path to python.exe is not C:\Python37-32\python.exe. Note
again a variation in Windows vs. Linux where Linux may require use of an additional bash script
and change to how PythonPath is specified.

On Cloud Page, URL tab enter URL https://api.emporiaenergy.com, GET radio for protocol,
0Auth2 as authorization

On HS Devices page select URL for Room and locate the Feature
api.emporiaenergy.com:Control. In the text box enter /customers/devices

On MQTT Page, Association Tab, look for the deviceGid in Payload column and write it down.
Using the J3 filter for deviceGid on the Topic filter may make it easier to find the six-digit
deviceGid in the Payload column.

Optionally, on MQTT Page, General Tab, Obsolete Row textbox enter
URL/api.emporiaenergy.com.GET:# to remove the data that was just obtained for the
deviceGid

On Cloud Page, URL tab enter the following after updating the deviceGids number and scale if
desired /AppAPI?apiMethod=getDeviceListUsages&deviceGids={123456}&instant=SSUTCYEAR:-
SSUTCMONTH:-
SSUTCDAY:TSSUTCHOUR::SSUTCMINUTE::SSUTCSECOND:.0Z&scale=1MIN&energyUnit=Kilowat
tHours

On Cloud Page, URL tab enter polling rate that should be consistent with the scale parameter.
For example, if scale=1D then no need to poll every second, but perhaps 1 hour would be
appropriate.

If an Emporia outlet is being used and the desire is to also control this outlet from HS then an
“A”ssociation will need to be made on the Topic that reports the outlet state and some changes
made on the Edit tab.

The Topic is provided in the same URL endpoint that is used to determine the Gid and will end with
“outletOn” such as row 1 in Figure 159. Once “A”ssociated with the “A” checkbox then the HS Ref
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https://api.emporiaenergy.com/

will be assigned and the Edit tab accessed by clicking on it. There needs to be a publish topic
defined so the HS buttons will be created and the VSP modified for case sensitivity and to change
True/False from Emporia to On/Off in HS. These edits are shown in Figure 161.

Association Table for Auto Association of MQTT Topic and HS Device

N o] . a REF

32656 URL/api emporiaenergy.com.GET
O n O pempy gy

Dew:
URLapi.emporiaenengy.com. GET|api.emporiaenergy.com. GE T-devices:0outletoutletOn
Subr URL/api.empaoriaenergy.com.GET:devices:00:outlet:outietOn

! ] ] ] m Pub: the fallowing Topie on Deviee command R
/devices/outlet

Dev: URL|api. emponaenergy.com GET|126621-Main usage

Sub:
URL/api.emporiaenergy.com.GET.devicelisiUsagesdevices0tchannelUsages:Mainusage
2 | O O EXTl  Fub: the following Topic on Device command o
— — — — Sub: URLYani emporizenerav.com GET-devices:00:manufacturerDeviceld BODD0B0Z04c45bbefads

Figure 159 Emporia Outlet Topic

The URL endpoint on the Cloud Page URL tab also needs to be changed from polling the single endpoint
to get usages to also poll the devices endpoint to get the outlet status. This is done by using the name
of the publist file for the endpoint rather than the explicit single endpoint. See Figure 160.

URL
Header
https://api.emporiaenergy.com Mone (D)
GET @ Basic ()
ol seconds) AeT Token
el LE e T POS O O oauth? URL and Data Payload
LDP O Bearer O
10000 ')
WebSocker ()
TCP In OAuthZ2 .
Paolling Endpoint Webhook O

Emporia.pub

Figure 160 Emporia Outlet Publist Endpoint
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An example \data\mcsMQTT\Emoria.pub file contents is shown below where Gid shown in red will be
user dependent. Note multiple Gids are entered with “+” separator such as 123456+654321. Note that
the Emporia querystring contains “=" so it needs to be escaped with “\=" because mcsMQTT uses the
“=" to separate the URL querystring from the data that is sent with POST and PUT methods.

$$1:=URL/https://api.emporiaenergy.com

$52:

$$3:

$54:
$$1:/AppAPI?apiMethod\=getDevicelListUsages&deviceGids\={/AppAPI?apiMet
hod\=getDevicelListUsages&deviceGids\={126621}&instant\=$SUTCYEAR: -
$SUTCMONTH: -

$SSUTCDAY : TSSUTCHOUR: : $SUTCMINUTE: : SSUTCSECOND: . 0Z&scale\=1MIN&energyUn
it\=KilowattHours}é&instant\=$SUTCYEAR:-$SUTCMONTH: -

SSUTCDAY : TSSUTCHOUR: : SSUTCMINUTE: : $SSUTCSECOND: .0Z&scale\=1MIN&energyUn
it\=KilowattHours=

$$1:/customers/devices=
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Settings for Flugin Device

HS Device Publish Topic  devices/foutlet

Unspecified ()
Button i
Mumber ()
MurmberChange (O
Slider O
cay O
Text ()
HS Device List {:}
Control/Status Ul Ree O
RoBW O
HSB O
Coloryy ()
sign O
Ramp O
Toggle O
jpaFile O
Generic ¥
HS Device APl Type
and SubType
Eattery v
HS Device Location
Loc2 (Floor) URL v
Loc (Room) api.empo..y.com.GET E

Marme api.emporiaenergy.com.GET:devices:03:outlet:outletOn

Max number of VSP 12

Payload false=0,0ff,0ff V3P
HS Device VSP List Payload true=1;0n0n VSP

Add/Edit

Clear existing VSP

Figure 161 Emporia Outlet Edits
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12.6 Hubspace

Hubspace is a brand that shares a common smartphone App for outlets, locks, lights, fans and other
products distributed through Home Depot. A snapshot from the HD marketing page is shown in Figure
162.

Exclusive Hubspace Smart Products

&5 Ve ¥

Smart Lighting Smart Ceiling Fans Smart Lightbulbs Smart Outlets Smart Door Locks Smart Outdoor Lighting

Compatible Hubspace Brands

i HOME
- Eﬂ'&ﬂg{g'ﬂl IS Zecosmart. HAMPTON BAY DECORATORS

Figure 162 Hubspace Products

The products are setup by first creating a Hubspace account and using the QR codes provided with each
instance of the product that is being installed. Bluetooth is used for initial setup of the product to gain
access to the WiFi network and then WiFi is used to communicate with the Hubspace cloud server.

A Python library is available with instructions and repository at https://github.com/jan-leila/hubspace-
py and https://pypi.org/project/paho-mqtt/#installation It is most easily installed from the command
line / terminal window using PIP with the command

pip install hubspace
pip install paho-mqgtt

If Python3 and PIP are not yet installed on the Homeseer computer they first need to be installed. Use
Google for guidance on installing them on the OS that is hosting Homeseer. After installation, the folder
where python.exe needs to be identified as it varies. There will also be a \Scripts subfolder that
normally a subfolder of where python.exe is located. HubspaceRequest.py will be copied to the \Scripts
subfolder.

During installation of Python, the PATH environment variable is normally updated with path to python
and the scripts subfolder. It will likely be necessary to have these definitions in PATH.

The integration of this library with Homeseer is done with the Python script HubspaceRequest.py that is
available in the mcsMQTT download package and originally installed at subfolder \bin\mcsMQTT. It will
not be run from this location, but is moved to the \Scripts subfolder of python install.
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The mcsMQTT setup for Hubspace integration is on the Cloud Page, Hubspace Tab as in Figure 163

Note the full path to python.exe and the Scripts folder in the setup. Also needed are the email and
password to the account that was setup with Hubspace. Data is polled for status updates to handle the
local control being synced with HS. Provision is also provided to disconnect the connection with the
cloud server. This disconnection will also result in the Python script HubspaceRequest.py being
terminated. HubspacaceRequest.py is managed by mcsMQTT and run when the setup is complete and
not disconnected.

HomeSeer

Devices Events Cameras ™ Sebp Tools~ Plugins~

Hubzpace Energy Connect Parameters

Account Ema myEmail.com
coount Pa
Pythan Path C:\Pythond7-32\python.exe
Python Script Path C:\Pythond7-324Scripts\HubspaceRequest. py
Server Polling Rate (millizeconds &0000
Erve nect nn . eserver i
izconnect from Hubspace Server ()

Figure 163 Hubspace Integration Setup

After everything is put in place it would be good to run HubspaceRequest.py from console/terminal
window such as below after navigating to the Python \Scripts folder. In this example, 192.168.0.5 is the
MQTT Broker address. If no MQTT Broker has been setup then use 127.0.0.1 here and on the mcsMQTT
MQTT Page, Broker Tab. myEmail.com will be your Hubspace account email. myPW can be anything as
this test will not have success with connection to the cloud server. The test is to assure all the Python
components are installed correctly. If no error message on the console/terminal then likely the install is
good.

python hubspaceRequest.py myEmail.com myPW 192.168.0.5

At this time the integration supports the outlet and lightbulb. Others can be added in the future with
assistance from users of the other equipment. The mcsMQTT integration structure is setup to add
additional products with minimum difficulty.
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mcsMQTT will use two endpoints with the Hubspace server. One provides Meta data that describes the
characteristics of the product that exist on the account/server. The other provides the Attributes of the
products which includes the current state.

The data of interest is visible on the MQTT Page, Association Tab. This includes the Hubspace product
attributes and message feedback in communications between mcsMQTT and HubspaceRequest.py. The
Meta data is not shown in this table. A slice of this is shown in Figure 164. Beyond the setup of HS
Device Features other features of mcsMQTT, such as History data and charting, can be selected from
this page.

o U

O | O O | O

o O O o O O
Hubspace/HStest_toggle outlet-1

O Ol O O Ol O

T

Hubspace/A19 Color CCT Light_¢

Figure 164 Hubspace Product Data as MQTT pseudo-Topics

The outlet is presented by the Hubspace server as two independent plugs. There is no single command
to control both simultaneously, but the HS linking capability can be used if the desire is to have both
plugs controlled together.

A feature is provided by mcsMQTT to allow an outlet to be always ON. At each polling interval
mcsMQTT will confirm it is ON and if not, it will command it to the ON state. The On/Off controls will
still be visible on the HS Devices page, but can be removed if desired using the Status/Graphics Tab of
the HS Devices Page.

To indicate that an outlet plug is be always ON, the PubTopic on the Association Tab will be changed so
that is indicates it is “on” rather than the actionld that is normally at the end. Using the example of HS
Feature 7823 shown in Figure 164, the Pub textbox will be changed

From: Hubspace/HStest_toggle outlet-2_3 872d485519a9fcde/3

To: Hubspace/HStest_toggle outlet-2_3 872d485519a9fcde/on
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HS Device and Features will be automatically created based upon the Meta data with example of outlet
and light in Figure 165. The Feature names are taken from the Meta data. They can be changed by the
user from the default names if desired. Renaming will not affect operation. Similarly, Floor, Room and
Device/Feature grouping can all be changed using the Devices page tools provided by HS.

HomeSeer HS4 Web Control & default -

Devices Events Cameras~ Setup Tools~ Plugins~ _ SEARCH

FLOOR m CATEGORY X Hubspace % Name Asc v ° E m

Hubspace | Hubspace
Hubspace (7813)

A19 Color CCT Light power (7814) on Taday 7-08:01 PM “
0 A19 Color CCT Light brightness (7815) 100 Today 7:08:01 PM ®
@ A19 Color CCT Light color-temperature (7816) Today 7:08:01 PM 2200°K s
° A19 Color CCT Light color-rgb (7817) 15794947 Today 7:08:01 PM
e A19 Color CCT Light color-mode (7818) sequence Today 7:08:01 PM m w
A19 Color CCT Light color-sequence preset (7819) custom Today )1 PM custom s
@ A19 Color CCT Light speed color-sequence (7820) -6 Today 7:08:01 PM -6 4
. A19 Color CCT Light restore-values (7821) 2 Today 7-:08:01 PM — —
° A19 Color CCT Light color-sequence custom (7822)  july-Ath Today 7:08:01 PM July-4th s
@ HStest toggle outlet-1 (7823) off Today 7:09:38 PM “

HStest toggle outlet-2 (7824) Oon Today 7-:08:01 PM “

Figure 165 Hubspace Auto-Created HS Device and Features
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12.7 Switchbot

12.7.1 Introduction

Switchbot provides a line of interfaces that are managed via their Cloud server or locally via Bluetooth.
This includes Bot, Curtain, Meter, Lock, Keypad, Keypad Touch, Motion Sensor, Contact Sensor, Ceiling
Light Pro, Plug Mini (US), Plug Mini (JP), Plug, Strip Light, Color Bulb, Indoor Cam, Pan/Tilt Cam, Robot
Vacuum Cleaner S1, Robot Vacuum Cleaner S1 Plus, Blind Tilt and more.

For those who want to use the Switchbot smart plugs and lights locally via WiFi without dependence on
a Cloud server, a mechanism exists with Over-The-Air change of the firmware. Section 20.13.2 describes
this process. Once changed, the integration described in this section via the Cloud server will no longer
be used.

12.7.2 Setup

To get started with Switchbot, one first needs to install the Switchbot App on their mobile device to get
access to the token and secret keys. This process is described in GitHub -
OpenWonderLabs/SwitchBotAPI: SwitchBot Open APl Documents for the Version 1.1 integration
performed by mcsMQTT. These keys are obtained from the App using the steps:

Go to Profile > Preference b) Tap App Version 10 times. Developer Options will show up
¢) Tap Developer Options d) Tap Get Token

The tokens are then entered on the mesMQTT Cloud Page, Switchbot Tab as shown in Figure 166. Two
access methods to the cloud are available. mcsMQTT will poll status updates at the rate specified by the
user in the setup. If the user has a means to accept data pushed by the Switchbot Cloud server then the
WAN-visible URL is entered in the setup. This URL will be used by mcsMQTT to setup a webhook listener
and inform the Switchbot server of its presence.

A setup provision also exists to disconnect from the Switchbot server and reconnect while still maintain
all previous setup.
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HdlﬁESEE[‘ HS4 Web Control

Devices Events Cameras~ Setp Tools~ FPlugins -

URL Yolink oice Monkey GeoFence Senze Hubspace Switchbot Ecobet

Switchbot Connect Parameters

Token 4ea72bcd48475e0ch1418b19161212d21affac4deBb79fed

Secret Key B T T TP

Server Poliing Rate (millizeconds) . 100000

WAN-Visible Webhook URL http://myWebhookURL:1234

Autocreate Verbosity Minimum Operational Set
All Available Properties

Server Disconnect
0 requests today

Connect To Switchbot Server

ce Oe

Disconnect from Switchbat Server

Figure 166 Switchbot Setup

mcsMQTT will ask the Switchbox server for the list of devices that have been setup on the user account.
It will then create HS Device and Features such as shown in Figure 168. The number of Features per
Device will depend upon the Auto-create Verbosity setting in Figure 166. This setting can be toggled
and will apply to all Switchbot Devices.

For those that want to use local Bluetooth control and status then the Bluetooth setup is needed on the
Local Page, Bluetooth Tab for the Open MQTT Gateway. See Section 11.7.1. Bluetooth status updates
will occur automatically. Bluetooth control vs. Cloud control is a user selection on the Cloud Page,
Switchbot Tab as shown in Figure 167.

Use Bluetooth then Cloud Server

Server Disconnect Disconnect from Switchbot Cloud Server

1 requests toda
/ Do not use OMG EBlustooth Gateways for Control

Mo Cloud Contact and no Bluetooth Control

oNONON

Figure 167 Switchbot Local vs. Cloud Control

Page 291



The control algorithm implemented is to first try with the Bluetooth gateway that shows the strongest
Bluetooth signal (rssi). Seven seconds are allocated to a response to the command with the expected
new status. Next attempt will be with the Bluetooth gateway that had the last contact to the Switchbot
device. If after seven seconds the expected status update is not received then the command will be
delivered to the Switchbot cloud server for execution through the local Switchbot hub.

12.7.3 Switchbot Devices

When a Switchbot item is controlled from HS via Devices, Event, or Script/CAPI, mcsMQTT will deliver
the request with a retry if necessary. The Switchbot response will include and updated status and HS
Feature will be updated based upon this status. mcsMQTT will then poll to get status from Switchbot
server to confirm. The HS Feature status will be updated again. No update occurs unless the response
status indicates a success status (100). If the Webhook has been setup the state change will also be
reported via the Webhook and Feature status updated.

The APl does not document the status response content for each Switchbot device. The only device
available for initial development that can be controlled is the Bot. Other devices that users may have
will need the debug output to include status reporting for that device. As a note, the US Smart plug was
converted to Tasmota, but still shows in the Switchbot account. It, however, could not connect to the
Hub so could not be controlled by the Cloud integration (or smartphone App).

Status updates are polled and optionally delivered via Webhook. Polling limit of the Switchbot server is
1000 requests per day. mcsMQTT enforces a limit of around 900 with the polling interval minimum of
100000. The status of the number of requests and if the daily limit has been exceeded is shown in the
Server Disconnect label such as is shown in Figure 166. While the user enters a desired polling rate that
would cover the interval for a single device, mcsMQTT will increase the interval by the number of non-
Hub devices that the user has their account. This means that if a user has 10 non-Hub devices the
polling interval will be increased by a factor of 10 so the daily limit is not exceeded.
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Switchbot | DBOECE117722/5trip Light
[1 Switchbot-DBOEC8117722-Strip Lig... (5749)

S A—— o Tty 14 I T

] .su-ip Light:brightness (5751) Today 10:11:48 AM L]
O .smp Light:celor (5752) 0 Today 1011:48 AM

Switchbot | DBOECE117723/Color Bulb
[ Switchbot-DBOEC8117723-Color Bul... (5753)

0 @ oo benm 730 . Tty 0140 I

=] .cm Bulb:brightness (5755) Today 10:11:49 AM L]
O .Cnh( Bulb:colorTemperature (5756) Today 10:11:49 AM [ ]
0O .cm Bulb:color (5757) 0 Today 10:11:49 AM

Switchbot | DBOEC8117724/Robot Vacuum Cleaner S1
[0 Switchbot-DBOEC8117724-Robot Vac... (5758)

[ (@) Robot Vacuum Cleaner S1:workingStatus (5759) Sandsy Today 10:11:49 AM StandBy :
O Qnobet\"acuum Cleaner S1:onlineStatus (5760) offine Today 10:11:49 AM
O ennbonrawnmchmausuum(mn 0 Today 10:11:49 AM

Switchbot | DBOECE117725/Robot Vacuum Cleaner 51 Plus
[J Switchbot-DBOEC8117725-Robot Vac... (5762)

O (@) Robot Vacuum Cleaner S1 Plus:workingStatus (5763) StandBy Today 10:11:49 AW StandBy s
O (@) Robot Vacuum Cleaner S1 Plus:onlineStatus (5764) offine Today 10:11:49 &M
[0 () Robot Vacuum Cleaner S1 Plus:battery (5765) 0 Today 10:11:49 AM

Switchbot | DBOEC8117726/Blind Tilt

[0 Switchbot-DBOEC8117726-Blind Til... (5766)

O .a\imnmﬂmm (5767) Today 10:11:49 AM [ ]
O eB\ind‘ﬁll:bmm (5768) 0 Today 10:11:49 AM

O .B\ild'ﬁlbgrum (5769) False Today 10:11:49 AM

O .B\ind‘ﬁll:munr (5770) False Today 10:11:49 AM

O @B\ind‘l’ll!:dluclion (5771) down Today 10:11:49 AM

O @B\ind‘l’llbcalibram (5772) False Today 10:11:49 AM

Figure 168 Sample Switchbot Devices and Features

User tweaking of the setup is available on the MQTT Page, Association Tab and Edit Tab such as shown
in Figure 169. This will allow HS-properties edit via Edit tab and show the mechanism by which the
devices can be accessed via MQTT Topic/Payload orientation.
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Filter by Mgtt Topic and JSON Payload Key

Clear Filters Rebuild Filters

a ref TOPIC payload 5 lastdate

0 5008 Switchbot/DEOECE117710/Bot
O O O

Dexv: Switchbat|DBOECS117710/Bot|Botpower
Sub: Switchbot/DBOECE117710/Bot:power
3 ) Pubs: the fallowing Topic on Device cornmand 2023031
O ] O & - O O O 11:53:28

Switchbot/DBOECS117710/Bot:power/set

D 5910 Switchbol/DBOECS117711/Curlain
O O O

Dev: Switchbat|DBOECS117711/CurtainCurtaincbattery
Sub: Switchbot/DBOECE117711/Curtainbattery
Pub: the fallowing Topic on Deviee command 20230321
- O O O 11:53:28

Dev: Switchbat|DBOECS117711/Curtain|Curtainccalibrate
Subr Switchbot/DBOECE117711/Curtaincalibrate
Pub: the fallowing Tapic on Device cormmand 2023-03-21

‘O O O e >4 O O O 11:53:28

Figure 169 Switchbot Pseudo-Topics

12.7.4 Switchbot Infra-Red

Switchbot hub supports learning of IR code for custom devices and from a library of standard devices
such as TV, DVR, Fan, etc. Each appliance that has been learned will be reflected in HS as a Device and
Feature with a dropdown selector control. Control is also possible through standard event action and
scripting methods. See Figure 170.

Switchbot | 02-202303162107-92595706/IR
[1 Switchbot-02-202303162107-925957... (6531)

OPEN TILT

| 9 IR:Blinds (6532) off Yesterday 9:20:44 AM

Switchbot | 02-202303162124-12190314/IR
[J Switchbot-02-202303162124-121903... (6541)

O e IRTV (6542) Today 50729 AM volumeSub .

O €2) Rsetchannel (6543) Today 91431 AM 1 B

Figure 170 Switchbot IR Appliance Devices
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For the standard IR appliances known by Switchbot, mcsMQTT will populate the selector control with
the available IR-code names. These are the only ones that the Switchbot hub will recognize and respond
by blasting an IR pulse sequence.

For the custom IR appliances, the user needs to define the IR-code names that were setup on their
account via the Switchbot App. The names are maintained as Value Status Pairs (VSP). They can be
entered from the HS Devices Page, click on the IR Feature, Status/Graphics Tab, New Single Value, Edit
icon, enter Label column Status such as “Close” in Figure 171.

Feature  Status/Graphics

Switchbot 02-202303162107-92595706/IR Switchbot-02-202303162107-92595706-IR (IR:Blinds)

Advanced settings, changes could cause devices to not work as expected

Edit Controls
Start End Label Control Use Row Column Col
Span
0 NotSpecified 0 0 1
Value Slalus Cantral Use Row Column Span
1 Close NotSpecified "0 0 0 X
Edit Status/Graphics
Start End Status Graphic

: o @0
1 ) @ ®

Figure 171 Switchbot Custom IR Code Definition

This can also be done on the MQTT Page, Edit Tab/Popup for the selected IR Topic as shown in Figure
172. The syntax in the Add/Edit textbox is Name=number;Name for a single entry or to put all entries in
at once use comma between each name such as “-,0n,0ff,Close,Open,Tilt” to define six IR Codes.
Before doing this make certain the Max Number of VSP textbox will account for all codes being entered.
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Max number of V5P 3

Payload =0 ; WSP
HS Device Payload Cloge=1;Clase:Cloge VSP
VP List Payload Open=2,0pen;Open VP

Add/Edit

Clear existing VSP

Figure 172 Switchbot Custom IR Codes Setup on Edit Tab

For both custom and standard IR Appliances it is possible to change between using Buttons or a Selector
for the HS Devices control. The default is Selector. The Selector is identified on the Edit Tab with a HS
Device Control/Status Ul of List. To change the list to a set of Buttons on the HS Devices Page for control
then select the Button radio option.

Unzpecified
Button

Murnber
MNurmberChange
Slider

Csv

HS Device Text

Control/Status List
] RGEB

RGEW
HSE
Colorxy
Sign
Rarmp
Toggle
jpa File

0000000000000 e0

Switchbot | 02-202303162107-92595706/IR
O
Switchbot-02-202303162107-925957... (6531)

Ca e e

| e IR:Blinds (6532) off Today 9:20-44 AM

Figure 173 Switchbot IR Control via Buttons
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In the case of the TV, IPTV, and Set Top Box the IR control contains two Features. One for discrete
control and one for channel number selection. By default, the channel number selection is shown to the
user as a number text box into which the desire channel is entered.

This default can be changed to a list selector where the list of favorite channels is available. It could also
be done with individual button for each channel favorite. This change is done on the Edit Tab with the
Control/Status Ul for Button vs. List and the VSP text box where the list of channels is entered such as
“4,5,11,13,121,118” without quotes. This process is similar to what is shown in Figure 172 and Figure
173. Note that this needs to be done via Edit Tab and cannot be done directly in HS Devices
Status/Graphics. The icons, however, will be done on the Status/Graphics page if desired.
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12.8 Rheem EcoNet
Rheem EcoNet is a cloud integration of Rheem user equipment. Access to the cloud serverisvia a
username and password. This provides ability to login and obtain credentials for subsequent access to
the EcoNet server. This is not a public API, but one that has been reverse engineered so it is possible
that it could change in the future without notice. The mcsMQTT integration is based upon the work
contained in GitHub https://github.com/w1lllam23/pyeconet/find/master) .

The mcsMQTT Cloud Page, EcoNet tab provides the ability to enter username and password as well as
disconnect when desired. This is shown in Figure 174. This login provides the ability to obtain a user
token and an account id that are used in subsequent communications. These secret credentials are not
made visible by mcsMQTT except when the option for the additional download is selected via checkbox.
For normal updates from the EcoNet server the additional downloads are not needed. The additional
data may be useful to get specific identification information if trying to later publish setpoints, modes,
or other control from HS to the equipment.

HomeSeer HS4 Web Control

Devices Events Cameras~ Setup Tools~ Plugins ~

LIRL Yalink Viice Maonkey GeoFence Sense Ecohet Thermostat

Rheem EcoMet Connect Parameters

Account Email myAccount@gmail.com

Account Password ernsrman

Status Polling Milliseconds.

Server Disconnect Connect To Ecobet Server i)
Disconnect from EcoNet Server ()

Additional Download Download Equipment and Status

Figure 174 Rheem EcoNet Setup

The observation is that reports from EcoNet server for normal status are infrequent with an update rate
of perhaps every couple of hours. It was also observed that after the @ CONNECTED message was
delivered with a “false” status that no subsequent messages were received. The assumption in this case
is the local equipment has gone offline and not visible to the EcoNet server.

EcoNet server provides data from two sources. Pulled data includes the list equipment, it’'s properties
and status. This pull request is done on startup and when a setup change is made. Pushed data is sent
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encrypted as status changes. mcsMQTT consolidates the two sources into a single set of messages used
to create and then update HS Device Features. A manual pull of data can be done with the button
shown in Figure 174. While it should not be necessary, it is also possible to schedule periodic pulling of
the data as shown on the same figure where a 0 value is now visible. Perhaps every hour (3600000
milliseconds) or longer would be reasonable intervals if desired.

During development there were cases where connection was lost with the push/MQTT communication
channel and graceful reconnection was not always possible. To overcome the difficulty the EcoNet
communication with the EcoNet Cloud Server was moved to a separate process (EcoNet.exe) and the
MQTT on the LAN used to exchange information with this EcoNet process. The Topic used is
EcoNet/message with JSON payload. The data from EcoNet server is communicated on the LAN using
the EcoNet/Location Topic. Commands to change the equipment use the topic /user/+/device/desired
where + is the location identifier obtained via the login process.

Association Table for Auto Association of MQTT Topic and HS Device

e a ref payload lastdate

0 0 0 ] EcoNet
1 0 0 O 4364 EcoNet/Location

Dev: EcoNet|Location|Location:1017:ElectricWaterHeater ACTIVE
Sub: EcoNet/Location:1017:ElectricWaterHeater:ACTIVE
m Pub: the following Topic on Device command

Dev: EcoNet|Location|Location:1017:ElectricWaterHeater AWAY
Sub: EcoNet/Location:1017:ElectricWaterHeater AWAY
m Pub: the following Topic on Device command g -

C
ol
O

Dev: EcoNet|Location|Location:101 7:ElectricWaterHeater.CONNECTED
Sub: EcoNet/Location:1017:ElectricWaterHeater:CONNECTED 2023-02-
Pub: the following Topic on Device command

] O O e 4 true O 0O O )

Dev:
EcoNet|Location|Location:1017:ElectricWaterHeater-DRACTIVE value
Sub: EcoNet/Location:1017:ElectricWaterHeater:DRACTIVEvalue
O B W EELLl  Pub: the following Topic on Device command

O
O

Dev:
EcoNet|Location|Location:1017:ElectricWaterHeater:-ENABLED:value
Sub: EcoNet/Location:1017:ElectricWaterHeater-ENABLED:value 2023-02-

A | O O m Pub: the following Topic on Device command O O | 14

user/30612480086952676/device/desired

Figure 175 EcoNet MQTT Report Snapshot on Association Tab

HS Device and Features are created based upon the Location Equipuipment information provided by
EcoNet Server. The only equipment available during test was Water Heater so that is all that is auto-
created. Updates to mcsMQTT can be made if access to other equipment is made possible.

For the Water Heater the HA user interface is shown in Figure 176.

During evaluation the WiFi SIGNAL update occurred as the signal strength changed by 1 unit at a rate of
once or twice per hour. This will be dependent upon local WiFi characteristics. As a control is issued,
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such as change of Setpoint, the status is immediately updated and will usually include multiple
properties such as ScheduleResume being shown with “Resume” to reflect that the schedule has been
superseded and Resume control is now active to restore operation to the schedule.

Devices Events Camer Setup Tools~ Plugins ~

FLOOR w CATEGORY x EcoNet X Name Asc v ° E

EcoNet | Location
& EcoNet-Location (4364) Vesterday 1022:32 AM
° Location:1017:ElectricWaterHeater:ACTIVE (4365) Active Yesterday 10:22:32 AM
o Location:1017:ElectricWaterHeater: AWAY (4366) Home Yesterday 10:22:32 AM
o Location:1017:ElectricWaterHeater:CONNECTED (4367) Connected Yesterday 10:22:33 AM
@ Location:1017:ElectricWaterHeater:DRACTIVE:value (4368) null Yesterday 10:22:33 AM
. Location:1017:ElectricWaterHeater:ENABLED:value (4369) Enabled Yesterday 10:22:34 AM
o Location:1017:ElectricWaterHeater:MODE:value (4370) Energy Saver Yesterday 10:22:34 AM ENERGY SAVER
o Location:1017:ElectricWaterHeater:RESUME (4371) Yesterday 8:17:08 PM
0 Location:1017:ElectricWaterHeater:RUNNING (4372) Idle Today 1:40:56 AM
@ Location:1017:ElectricWaterHeater:SCHEDULE (4373) Schedule Yesterday 8:15:30 PM
@ Location:1017:ElectricWaterHeater:SCHEDULERESUME (4374) Yesterday 8:17:08 PM “
@ Location:1017:ElectricWaterHeater:SCHEDULESTATUS (4375)  Following Schedule Yesterday 8:17:08 PM
@ Location:1017:ElectricWaterHeater:SETPOINT:value (4376) Unknown Yesterday 10:30:26 PM 110 ¢
. Location:1017:ElectricWaterHeater:STATUS (4377) Enabled Yesterday 10:22:36 AM
Location:1017:ElectricWaterHeater:VACATION (4378) AtHome Yesterday 10:22:36 AM
o Location:1017:ElectricWaterHeater:SIGNAL (4379) -64 Today 9:54:21 AM

Figure 176 EcoNet Water Heater Device and Features
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12.9 Flume Water
There are multiple providers of instrumentation that monitor water utilization. Many local monitoring
solutions with meters installed locally and monitored via xAP, MQTT, and HTTP protocols. The Cloud-
based integration provided by mcsMQTT uses the Flume equipment.

Flume provides a Personal API that is well documented at Flume Personal API | Flume Help Center
(flumewater.com) . This enables a user to interact with the Flume Cloud server to get information
similar to that available via their smartphone App. Interaction with the API can be setup from the
mcsMQTT Cloud Page, Water Tab or more detailed on the URL Tab. Use of the Water Tab will be easier
for most users. The same result will occur either way. The Water Tab is a wrapper around the user-
defined parameters while the URL tab requires the same parameters to be inserted in the specification
or the communication protocol.

To start a user needs to have an account with Flume. This is authenticated with email address and
password. After logging into the account at
https://api.flumewater.com/account/login?client_id=customer-
portal&redirect_uri=https%3A%2F%2Fportal.flumewater.com&state=8eff28d0d602804948d7ac4b9938
1903f84de012 an option exists to "Generate API Client”. When activated the Client Id and Client Secret
credentials will be displayed.

Two options are available in mcsMQTT to integrate with the Flume equipment. The original one
imposes greater user burden to specify the integration parameters as the user builds the raw HTTP
requests. This integration was developed as the generic capability to integrate with any API using the
URL tab or the Cloud page of MQTT. In essence it was a proof of concept that the generic capability
presented on the URL tab was sufficient to fully integrate a specific site.

This capability remains, but has been augmented to allow mcsMQTT generate the necessary syntax for
the API queries. In this second case, the integration is specified on the Water rather than the URL tab of
mcsMQTT. It includes user entry of those user-specific parameters that are needed to support the
Flume API. This second case continues to use the URL tab features, but the entries are auto-generated
based upon the user data specified on the Water tab for Flume. This approach was taken to maintain
existing setup of early users, while providing new users with a more simplified setup.

12.9.1 Flume Water Tab Setup

Five user-defined parameters are used to specify the integration as shown in Figure 177 . These are the
account email and password and the client id and secret, as well as the polling rate of the cloud server
and radio control to disable vs. enable the integration.
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HDT'HESEEF HE4 Web Control

Devices Events Cameras ~ Dashboards Setup Tools~  Plugins =

URL GeoFence Enengy Wiater Propane Irrigaticn Thermostats Solar

Ecofet Abode Goves WoLink \ioice Monkey

Flurme

Usemame meg@agmail.com
Password LL

Cliarit 10 123456789
Cliant Secret e

Server Polling Rate (Seconds} | &0

Flurme Sarver Connechion Connect to Flume Server

oe

Dizconnect from Flume Server
Figure 177 Flume Setup

The URL tab integration creates a HS Device and Feature to allow specific data to be delivered to the
Flume server and to enable/disable the integration. This capability continues to be supported with the
new integration and is synchronized with the Flume Server Connection radio selection.

What will be noticed upon completion of the first four entries on the Water tab, the URL tab will be
populated to specified more detailed integration shown on Figure 178.

If the setup is done on the Water tab, then no additional setup is needed such as is described in the
subsequent paragraphs of this section.

12.9.2 Flume URL Tab Setup

There are two Servers provided by Flume. One for general information. The other for water usage
queries. Two IP’s are setup on the URL tab to handle both servers. oAuth2 authentication is used. The
oAuth2 server for Flume is https://api.flumewater.com/oauth/token. The oAuth2 payload looks like:

{"grant_type": "password","client_id": "XXXXX","client_secret": "YYYYY","username":

nn

"myemail@gmail.com","password": "mypassword"}

Email and password are the ones used for the Flume account and App. The XXXXX and YYYYY are
obtained from the Get Tokens link at https://flumetech.readme.io/reference/introduction#introduction.
User login to this site is needed.
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HomeSeer

Devices Events Cameras~ Setup Tools~ Plugins~

URL YoLink Voice Monkey GeoFence Sense EcoNet Thermostat

Protocaol Authorization  Additional Parameters

Header

URL content-typezapplication/json
https:/fapi.flumewater.com/me a S
Eedap i Nane (O accept:application/json
T @ Basic ()
Poll {milliseconds) posT O Token (O
UDE O Bearer O
60000 T (@
WebSocket O - oAuth2 URL and Data Payload
TCPIn o cauthz @
Polling Endpaint Webhook https://api.flumewater.com/oauth/token
FlumeWater.pub
Header
URL content-type:application/json
https:/fapi.flumetech.com/me Mone O accept:application/json
GET O Basic O
Pall {milliseconds) POST . Taoken O
UDE o Bearer O
60000 Digest ()
websocket O o oAuth? URL and Data Payload
TCPIn o osuthz @
Palling Endpoint Webhaok https://api.flumewater.com/oauth/token

New JWT

FlumeTech.pub

Figure 178 Flume Integration via URL Tab

Note that endpoints that will be used for water usage are using POST while those for general
information are using GET.

Polling was setup at one minute and five-minute intervals with the endpoints contained in the
\data\mcsMQTT\FlumeTech.pub and \data\mcsMQTT\FlumeWater.pub. If different endpoints should
be polled at different rates, then additional .pub files should be used and HS Events setup to Send MQTT
Publish message. If only one endpoint is to be sent then it can be put directly in the MQTT Send
Message action text box rather than creating a .pub file.

12.9.3 Water Use Queries

Once the tokens have been obtained and the oAuth2 authentication has been setup then one needs to
get the identification of the installed equipment. This is done with Fetch User’s Devices from the same
page where the token was obtained. Alternately device identification it can be obtained by entering
“/devices?user=false&location=false” in the Submit text box on the HS Devices page for the device
created for the flumewater URL.

The returned payload is JSON and the key of interest is “id” such as “id": "2ZzZZ". If done from the HS
Device page then it will be shown on the Association tab.
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The device identification (ZZZZZ value) is used in the water utilization queries. These queries are most
easily setup and managed using a publist which is a structured file located in the HS subfolder
\data\mcsMQTT with a filename ending in “.pub”. See Section 12.1.2 for more information on the
publist use in this context.

It is possible to make a single request with multiple queries or multiple requests of a single query each.
The former is preferred to reduce overhead. The example below are three queries. The first gets the
water usage for the past minute. Th second for the current day and the third gets the usage for the
current month. Flume provide the options available for queries at Querying Samples (readme.io). Note
that the URL contains a replacement variable

$SPAYLOAD: (URL/api.flumewater.com/me.GET:data:*:type-1l:device id):

which could be changed to manually enter the device_id rather than picking it up from the payload from
an earlier /devices query from flumewater.

An example query is shown below where the start of the period being requested is at the first second of
the bucket’s interval.

URL/https://api.flumetech.com/me/devices/$SPAYLOAD: (URL/api.flumewater
.com/me.GET:data:*:type-

l:device id):/query={"queries":[{"request id":"Now", "bucket":"MIN", "op
eration":"MAX","since datetime":"SSYEAR:-$SMONTH:-SSDAY:

$SHOUR: : $SMINUTE:: 00"}, {"request id":"Today", "bucket":"DAY", "operation
":"MAX","since datetime":"S$SYEAR:-SSMONTH:-SSDAY:

00:00:00"}, {"request id":"ThisMonth", "bucket":"MON", "operation":"MAX",
"since datetime":"S$SYEAR:-SSMONTH:-01 00:00:00"}1}

Another approach is to query from the start of the desired interval such as for the “Now” query where
the start is 60 seconds in the past. In this case inline expressions are used to compute 60 seconds in the
past and to format the date in the desired format.

{"request id":"Now", "bucket":"MIN", "operation":"MAX","since
datetime":"<<Format DateTime ("<<DateAdd ("second",-60,Now)>>","yyyy-MM-
dd HH:mm:ss")>>"}

The returned data will be in the Association table. Note the use of “request_id” parameters in the
above queries. They will be part of the structure in the Association table to identify the utilization of
interest. This was done for Devices 126 and 128 in the example below.
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Filter Association Table by Mgt Topic and JSON Payload Key Clear Filters Rebuild Filters

™

URL  ~lap ﬂumeiech com

_—__
[ Frov | CH of 34] nex |

lﬂ-ﬂﬂ-ﬂﬂﬂ

19 URL/ api.flumetech.com/me
The remote server refurned an error:

I R ) : . 2022-02-09
lw| w | w | w l:l Sub: URL/api.fAlumetech.com/me.GET ::142‘;} Unautho L 15:10:47
200 0 125 URL/api.flumetech.com{me.POST
e . . . > 2022-02-10
300 - l:l ‘Sub: URL/api.flumetech.com/me.POST:code 602 13:00:37
o = . 5 g = 2022-02-10
4 00 0O l:l Sub: URL/api.flumetech.com/me.POST:count ] O 13:00:37
e - Sub: - - 2022-02-10
500 o l:l URL/api.flumetech.com/me.POST:data:01: ThisMonth:datetime SPEATE 6y . 13:00:37
Dev: URL|api.flumetech.com|me.POST:data:01:ThisMonth:value
Sub: URL/api.flumetech.com/me.POST:data:01:ThisMonth:value . - — 20220210
6 o 123 Pub: the following Topic on Device command 8478.82961472 - - = 13:00:37
- - i . N PO s 2022-02-10
70 O 00 [ ] sub: URL/api.Aumetech.com/me POST:data:01:Today:01:datetime  2022-02-10 00:00:00 e
g0 0O 1 [ ] sub: URL/api.flumetech.com/me,POST:data:01:Today:0Livalue 1254 38205204 ig,zén",]g;m
I - . ) ) e L 2022-02-10
a0 O 00 [ ] sub: URL/api.Aumetech.com/me POST:data:01:Today: datetime  2022-02-10 00.00.00 e

Dev: URL|api.flumetech.com|me.POST:data:01:Today:value

Sub: URL/api.flumetech.com/me.POST:data:01:Today: value 2=
RL/ap |/ ay PR AT -~ M 202202410

Pub: the following Topic on Device command - = = 1300:37

w0 O 4 126

12.9.4 Notifications

Notifications are obtained with the GET query to the /notifications endpoint. Flume returns a list of
notifications with the most recent first and older ones later. What is of interest is only the most recent
so the query is setup to return only one notification. The JSON returned payload contains a “type”
parameter that can be USAGE_ALERT, BUDGET, GENERAL, HEARTBEAT or BATTERY. The remainder of
the keys in the JSON payload then apply to this notification type. To provide unique HS devices for each
notification type this “type” key can be elevated for uniqueness after selecting type as an Associated
topic. This is done on the Edit tab as shown in Figure 179 below. Flume provides the notifications in a
JSON array. It does not matter which position in the array the notification is delivered so the elevated
key can be prefixed with “*:” to make the position a don’t-care.

Edit Setup Or Edit Of Subscription (Inbound) To a MQTT Topic

URL/api flumetech com/me POST

JSON key(s) to be elevated for uniqueness
MQTT Subscribe Topic

*type

Figure 179 Elevate Flume JSON Key 'type' to Provide Uniqueness of Notifications
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For usage alerts there is a message and the time the message was created and when last seen. Itis
possible to create a HS device for each of the keys or as shown below the payloads can be combined
using the Expression textbox on the Edit tab for the Associated topic. For example the expression below
concatenates three strings to be stored in the HS DeviceString. Note the use of quotes in the expression
to assure each element that is being combined with “&” is a string.

"SSPAYLOAD:"&" created at "&"$SSPAYLOAD: (
URL/api.flumewater.com/me.GET:data:*:type-l:created datetime):"

Aol r]efalw Jromne  Jopawa [0 ]d]i] e |

Dev: URL|api.flumewater.com|me.GET:-data: 01:type

. Sub: URL/api.flumewater. com/me.GET: data: 01:type . . . 2022.02-10
120 0O o m Pub: the following Topic on Device command L : - “' 11:06:58
| = . Rk . — 2022-02-10
130 0O O l:l Sub: URL/api.flumewater. com/me.GET: data: 01:type-1:address 3029 Gulf of Mexico Dr 11:06:56
N . . ) AP - 2022-02-10
140 0O 0O l:l Sub: URL/api.flumewater.com/me. GET:data: 01:type-1:address_2 [ 11:06:56
R — r Sub: URL/api.flumewater. com/me.GET: data:01:type- - 2022-02-10
150 0 0 [ 1 1wy mode EE2 ' 11:06:56
Dev: URL|api.flumewater.com|me.GET:data:01:type-
1:battery_level
I Sub: URL/api.flumewater. com/me.GET: data: 01:type- X . . ., 2022-02-10
60 O ¥ BN battery jevel igh S Y 110639
Pub: the following Topic on Device command
| = o i . . 2022-02-10
70 0O 00 [ | sub: URL/api.Aumewater.com/me.GET: data:01:type-1:bridge_id  6303870226312230084 Gaaan
R — r Sub: URL/api.flumewater. com/me.GET: data:01:type- - 2022-02-10
B0 o ol 1] 1:building_type e T k 11:06:56
— I — — . ; 2022-02-10
19 l:l Sub: URL/api.flumewater. com/me.GET: data: 01:type-1:city Longboat Key 11:06:56
20 0O O :l Sub: URL/api.flumewater. com/me.GET: data:01:type-1:connected  frue ﬂzﬂz\;ﬂggll]
. . . ! R : - 2022-02-10
210 0O 0O :l Sub: URL/api.flumewatsr. com/me. GET: data:01:type-1:country Unifed States [ 11:06:56
— - Sub: URL/api.flumewater. com/me.GET: data:01:type- e r 2022-02-10
»0 0 o[ ] Lscresed_datoime 2022-02-10T07-15:00.000Z I G
T . . ) e - 2022-02-10
230 O 01 [ sub: URL/api.fumewater.com/me. GET:data:0L:type-1idevice_id  6886483410961583712 | P
— I — — . . 2022-02-10
24 [ | sub: URL/api.Aumewater.com/me.GET: data:01:type-1:id 5694328 e
25 O I:l Sub: URL/api.flumewater. com/me. GET: data:01:type-1:installation DONE ﬂzﬂz\;ﬂ:ﬁlﬂ
. . i e ) . 2022-02-10
26 O l:l Sub: URL/api.flumewatsr. com/me.GET: data:01:type-1:insurer_id 2 [ 11:06:56
- ) e 2022-02-10
7 0O [ ] sub: URL/api.fumewater.com/me.GET: data:01:type-1:last seen  2022-02-107T18:58.09.0002 Soan
. . ) e 2022-02-10
28 O l:l Sub: URL/api.flumewater. com/me. GET: data:01:type-1:location_id 72613 11:06:38
Dev: Unknown High Flow Alert triggered at LEK. Water haz
Sub: URL/api.Aumewater. GET:data:0L:type-1: EEu -02-
20 0O # m u e Bl s R DT HESREE unning for 15 minutes averaging 9.92 0 O | AEEIL

Pub: the following Topic on Device command T ey ' : T 11:06:38
minute.

This figure also shows the Association of the battery where the status shows “high”. By default, this is
considered text by mcsMQTT so will have the text stored in DeviceString. To be able to trigger on the
status VSP can be used to map the text into a number to be stored in DeviceValue. The radio for
Control/Status Ul is changed to Button (or List). “high” is the only state currently reported. When other
states are reported they will be added to the VSP and unique values assigned.
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Settings for Plugin Device

HS Device | |
Publish Topic
HS Device ) Unspecified @ Bufion ' Toggle () Mumber (' MumberChange O Slider 0 Ramp O
GProlSIales - Gey O Text O List O RGB O RGEW O HSB O ColorxY O Sign O jpg File
HE Deyi Lec? (Floor) | URL v |
cE -
w
Loation Loc (Room) | api.flumewaler. com |

Mame |rne.G ET-data:0n :Iype-|

Max number of VSP

HE Device Wsp Pavioad high=0;high;high WSP

List Add/Edit |

The above selections resulted in the following HS Devices page. It contains a submit control to manually
request data from an endpoint from each the flumetech and flumewater servers. These same controls
contain two buttons to manually control polling of the endpoints that are contained in the
FlumeWater.pub and FlumeTech.pub publication list files.

URL | api.flumetech.com
URL-api.flumetech.com-me (142)

SUBMIT
STOP POLLING START POLLING

@ me:Control (143) 0 Today 9:31:47 AM

URL | api.flumetech.com
URL-api.flumetech.com-me.POST (153)

me.POST:data:01:Now:01:value (154) 1.8245178 Today 11:07:31 AM
me.POST:data:01:Today:02:value (155) 113846435448 Today 11:08:35 AM
me.POST:data:01:ThisMonth:03:value (156) 9646.95541572 Today 11:08:45 AM

URL | api.flumewater.com

URL-api.flumewater.com-me (146)

SUBMIT
STOP POLLING START POLLING

@ me:Control (147) 0 Today 9:31:56 AM

URL | api.flumewater.com

URL-api.flumewater.com-me.GET (149)

me.GET:data:01:type (150) 2 Today 10:07:36 AM

@me.GEr:data:O‘I:type-Z:hattery_Ievel (151) high Today 10:03:28 AM
High Flow Alert triggered at LBK.
Water has been running for 15

@ me.GET:data:01:type-1:message (152) minutes averaging 10.27 gallons Today 10:07:36 AM
every minute. created at 2022-02
11T07:16:00.000Z
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12.10 Coulisse B.V. Motion-Blinds.com Blinds Control
WiFi controlled motion blinds can be obtained from https://motionblinds.com/ with a WiFi hub as
described at https:/d.otto.de/files/65ff764c-b2c7-538f-b555-4751394351b5.pdf.

Several other brands are known to work as well including the llist below from a HomeAssistant
integration. Other information included herein was also derived from the integration described at
Motion Blinds - Home Assistant (home-assistant.io).

AMP Motorization, Bliss Automation - Alta Window Fashions, Bloc Blinds,
Brel Home, 3 Day Blinds, Dooya, Gaviota, Havana Shade, Hurrican,
Shutters Wholesale, Inspired Shades, iSmartWindow, Martec, Motion
Blinds, Raven Rock MFG, Smart Blinds, Smart Home, Uprise Smart,
Shades

An API reference is avaialbe on post #10 at Possible to controll blinds from "motion-blinds.com" /
Coulisse B.V. ? - HomeSeer Message Board. Communications are on UDP port 32101 from the WiFi hub
and on 32100 back to the hub. Multicast IP 238.0.0.18 is used by the WiFi hub.

Integration with HS is setup from the mcsMQTT Cloud Page, URL Tab by entering the IP of the WiFi hub
using port 32101 such as shown in Figure 180.

192.168.0.7:32101

Figure 180 Setup for Coulisse B.V. Blinds

The WiFi hub will be sending a “heartbeat” message on 238.0.0.18:32101 every 30 or 60 seconds.
mcsMQTT will be listening for this message. If a heartbeat is not heard for a minute, then mecsMQTT will

simulate the heartbeat. This is to deal with the installations that do not reaceive the multicast UDP
messages.

When received, the plugin will send a request on the URL IP that was setup to ask for the list of devices

being supported by the WiFi hub. From this list mcsMQTT will create a HS Device and set of Features for
each such as shown in Figure 181.

There are three types of blinds supported by the WiFi bridge. Standard, Top-Down/Bottup Up, and
Double Roller. While the structure is in place to support all types, at this time the Standard blinds are
the only of the three that are implemented. Users with other types are needed to complete the
integration testing.
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URL | 192.168.0.17-32101

[] URL-192.168.0.17-32101 (1809)
URL | 192.168.0.17-32101:Control

=
D 192.168.0.17-32101:Control (1810) Open 5/7/2022 8:03:59 AM

URL | 162.168.0.17-32107 UDP:mac-500291b691fd005f
[J URL-192.168.0.17-32101.UDP:mac-5... (2803)
O @ 192.168.0.17-32101.UDP:mac-500291b6911d005f-type (2804) Today 6:37.02 PM

] CLOSE/DOWN OPEN/UP m
Closed/Down Tod 02 PM

192.168.0.17-32101.UDP:mac-500291b691fd005f-operation (2805) “

O @ No-Limits Today 6:37.02 PM

192.168.0.17-32101.UDP:mac-500291b691fd005f-currentState (2806)

0e e S— e

192.168.0.17-32101.UDP:mac-500291b691fd005f-currentPosition (2807)

L]
O o 0° Today 6:37.02 PM

192.168.0.17-32101.UDP:mac-500291b691fd005f-currentAngle (2808)

0@

192.168.0.17-32101.UDP:mac-500291b691fd005f-batteryLevel (2809)

URL | 192.168.0.17-32101.UDP:mac-500291b691d0060
[] URL-192.168.0.17-32101.UDP:mac-5... (2810)

] @ 192.168.0.17-32101.UDP:mac-500291b691fd0060-type (2811) Today 6:37.02 PM
o
Clesed/Down Today 6:37.02 PM
192.168.0.17-32101.UDP:mac-500291b691fd0060-operation (2812) “
O @ No-Limits Today 6:37:02 PM
192.168.0.17-32101.UDP:mac-500291b691fd0060-currentState (2813)
®
a e 0% Today 6:37.02 PM
192.168.0.17-32101.UDP:mac-500291b691fd0060-currentPosition (2814)
L]
o 0 o* Today 6:37:02 PM
192.168.0.17-32101.UDP:mac-500291b691fd0060-currentAngle (2815)
e

192.168.0.17-32101.UDP:mac-500291b691fd0060-batteryLevel (2816)

Figure 181 Coulisse B.V. Blinds HS Device and Features

To be able to interact with the WiFi hub an access token is needed. The token is a 16-bit AES-128
encryption of the token provided in the heartbeat message using an encryption key that can be obtained
from the smartphone App for the blinds. Obtaining this key is described below.

The Motion Blinds API uses a 16 character key that can be retrieved from the official “Motion
Blinds” app for IOS or Android.

Open the app, click the 3 dots in the top right corner, go to “settings”, go to “Motion APP
About”, Please quickly tap this “Motion APP About” page 5 times, a popup will appear that gives
you the key.

Please note that “-” characters need to be included in the key when providing it to Home
Assistant. The key needs to be similar to 12ab345c-d67e-8f

The secrey encryption key is entered on the mcsMQTT Cloud Page, URL Tab as shown in Figure 180.

The payloads used to communicate use JSON format. The decoded data received can be see on the
MQTT Page, Association Tab. There is more information available than is automatically used by
mcsMQTT to create the HS Device and Features. This data can also be “A”ssociated with HS from the
“A” column checkbox of the Association Tab. Similarly, the “A” checkbox can be unchecked for Features
that are not of interest within HS. See Figure 182
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https://apps.apple.com/us/app/motion-blinds/id1437234324
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Association Table for Auto Association of MQTT Topic and HS Device

N o @ a raf payload £ lastdata

2143 URL/192.168.0.17-32101.UDP

O O O
1 Sub: URL/192.168.0.17-32101.UDP-datacurrentState EIZS DL
O O O O [l 19:43:40
2022-04-30
D |:| D |:| Sub: URLA192.168.0.17-32101. UDPdatanumberOiDevices 3 |:| ) 9_4:_43
2022-04-30
O 0 O 0 Sub: URL/192.168.0.17-32101.UDP.dataRSS 7 0 - 9':’%‘43
4 Sub: URLA192.168.0.17-32101.UDPdeviceType 02000001 ?322—3‘}-%'
O O O O ’ O 9.43.40
- 2022-04-30
Sub: URL/192.168.0.17-32101.UDP:mac
O O O O : ’ o ' O 104313
Dev: URL|192.168.0.17-32101. UDP:mac-
500291b691fd|192.168.0.17-32101 UDPmac-5002971b691 fd-
batteryl evel
Sub: URL/192.168.0.17-32101.UDP-mac- o
] J ] m 500291b691 fdbatteryl evel J ] J 19:
Puty: the following Topic on Devics command
Dev: URL[192.168.0.17-32101 UDP:mac-
500291b6911d|192.168.0.17-32101. UDP-mac-500291b691 fd-
currentAngle
Sub: URL/192.168.0.17-32101.UDPmac- 20
] O ] m 500291b691 fdeurrentAngle ] ] J 1o

Pub: the following Topic on Device command

192.168.0.17:32100

Figure 182 Coulisse B.V. Association Table

mcsMQTT send data to the WiFi hub using port 32100. This is the Publish Topic on the Association Tab.
It uses the Payload Template to format the JSON such as below:

{"msgType":

"WriteDevice", "mac":"500291b691fd", "deviceType" :"$SSPAYLOAD: (URL/192.16
8.0.17-32101.UDP:mac-500291b691fd:deviceType) :", "AccessToken":
"<<AES128 ("$SPAYLOAD: (URL/192.168.0.17-

32101 .UDP:mac:token) : ", "$SSECRETKEY: ") >>", "msgID": "<<$SUNIX:>>", "data"
:{"targetPosition":$SSCAPIVALUE: }}

Replacement variables are used to dynamically complete the payload. deviceType is obtained from the
rececieved JSON of the deviceType JSON key.

"deviceType":"$SPAYLOAD: (URL/192.168.0.17-32101.UDP:mac-
500291b691fd:deviceType) : ",

AccessToken gets the token received in heartbeat message, the SecretKey entered on the URL tab, and
the AES128 encryption function.

"AccessToken": "<<AES128 ("SSPAYLOAD: (URL/192.168.0.17-
32101.UDP:mac:token) :", "SSSECRETKEY: ") >>",

msgID needs to change with each transmission so the Epoch time which changes every second is used to
get a changing value.
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"msgID":"<<S$SSUNIX:>>",

Data contains the command to be executed which is from the HS CAPI Control that was the event to
send the message.

"data":{"targetPosition":$SCAPIVALUE: }}

mcsMQTT makes a request back to the WiFi hub each time it receives a heartbeat (or simulated
heartbeat) message. It will make a request for one device supported by the hub and after all device
statuses have been requested it will ask again for the list of devices. This methodology will allow new
devices to be added to the hub and for status to be refreshed periodically without any user action
necessary.

The WiFi hub used “mac” as the key to uniquely identify each device it is supporting. The “mac” key has
been setup as an Elevated JSON key so it looks like part of the Topic thus allowing the data to be
separately viewed for each device reported by the WiFi hub.

The battery status is reported as a voltage. mcsMQTT assumes a two-cell battery pack is being used
which has a full change reading of 8.4V. Three cells have 12.6V. Four cells have 16.8V. If two-cell is not
being used then the mcsMQTT Edit Tab, expression text box should be edited to correctly capture the
range of the battery.
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12.11 Thermostats
12.11.1 NuHeat Thermostat

NuHeat provides a WiFi-enabled thermostat used to control floor heating. The device is managed via a
Cloud connection and this connection is used to integrate with HomeSeer.

Nuheat

11:15 AM
Mon. Apr 27

Energy Use Settings

Figure 183 NuHeat Thermostat

The setup of each NuHeat thermostat is done from the Cloud Page, NuHeat tab as shown in Figure 184.
If multiple thermostats are used then a semicolon is used to separate the Id of each. This Id is available
from the NuHeat site account login.

Polling can be setup to keep HS in sync with the NuHeat server and the thermostat. If not setup then a
status update in HS will only occur 20 seconds after a HS control action is taken such setting a temporary
setpoint.

Normal operation of the thermostat is to run off of its internal schedule. This schedule can be
interrupted by selecting a SetPoint Temperature. This will be the new temperature for heating control
for the next hour. The ScheduleMode will reflect TempHold status.

The Schedule Mode can be changed to indefinite hold of the SetPoint Temperature with the Hold
button. The Run button on Schedule Mode is used to restore the normal internal schedule of the
thermostat.
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Status is shown for the equipment being in heating vs. quiescent operation. Status is also shown for the
temperature sensed by the thermostat.

H dT_ﬁ ES eenr H54 Web Control

Devices Events Cameras - Setup Tools~ Plugins =

LIRL Yiolink Voice Monkey GeoFence Sense Hubspace

Tank Liility EcoMet Ahode Irrigation ‘Salar Themaostats

MuHeat Thermostat Connect Parameters

Aceount Email me(@yahoo.com

Accourt Password cerssraran
House(s) Id isemicolon-separated) | 1684160

Server Polling Rate (milliseconds) 60000

Server Disconnect Connect to MuHeat Server

o)

Disconnect from NuHeat Senver

Authorize V1 APl (Group Access)

Authazize APl V1 Access for Groups

Figure 184 NuHeat Thermostat Setup

The following information is provided by the NuHeat cloud server. Each item is visible in the Association

table of the MQTT Page. Those in blue are automatically mapped into HS Device and Features as shown
in Figure 185.

The Groups Device is created when the Authorize API V1 Access for Groups is clicked, authorizatoin (via
oAuth2) is granted, and one or more Groups has been defined in the account.

SerialNumber:1234567 MaxTemp : 7000

Room: NUHEAT MinTemp:500

GroupName: ErrorCode:0

Groupld:-1 Confirmed:true
GroupAwayMode: false Email :myemail@yahoo.com
Temperature:2050 TZOffset:-06:00
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SetPointTemp:2000 Assigned:true
ScheduleMode:1 FloorArea:75
OperatingMode:1 KwCharge:0
HoldSetPointDateTime:2022-06-13T02:00:00+00:00 WPerSquareUnit:12
Online:true SWVersion:201
Heating:false HasBeenAssigned:true

DistributorId:1

MuHeat | NuHeat

NuHeat 1684160 nuheat (1530)

9 SetPointTemp (1531) 620 Today 12:37-11 PM 62 m
@ VacationSetPoint (1532) Yesterday 10:51°54 AM 0 m
@ VacationDays (1533) 0.0 Yesterday 10:51:54 AM 0 m
@ ScheduleMode (1534) Run Vesterday 10:51°54 AM m
9 Temperature (1535) 60.8 Today 12:34:51 PM

Heating (1536) Quiescient Today 12:30:31 PM
MuHeat | NuHeat
NuHeat Groups (1537)
@ string0-awayMode (1538) Away Today 12:37-11 PM m
@ string0-awaySetPointTemp (1539) B8 Today 12:37-11 PM 68 m
@5tring1-awayMode (1540) Home Today 12:37-11 PM m
@ string1-awaySetPointTemp (1541) 86 Today 12:37-11 PM 86 m

Figure 185 NuHeat Thermostat Device(s) and Features
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12.11.2 Nexia / Trane / American Standard Thermostat

Figure 186 Trane Thermostat

Nexia thermostats are branded as Nexia, Trane, or American Standard. They are integrated via a cloud
server. Two servers are available. One used to support a desktop/browser access and one to support a
mobile App. There is overlapping information. mcsMQTT toggles between each server to get the full set
of data of interest. The integration is done by emulating the operation of the desktop and App.

The cloud server login requirements are username and password, the house id of the thermostat(s) and
the brand. The house id can be obtained by logging into your Nexia/Trane/AS account, selecting the
Climate option, and then observing the URL being used by the browser. It will contain the numeric
house id. Polling rate is also specified in the setup as shown in Figure 187.
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Mexia/ASAir/ Trane Thermostat Connect Parameters

Account Email somebody@yahoo.com

Account Password remsmrnen

House(s) |d (semicolon-separated) . 1234567

nexia ()
Brand . O
trane i
Server Polling Rate (millizeconds) 60000
Server Disconnect Connect to trane Server

o)

Disconnect from trane Server

Figure 187 Nexia / Trane / American Standard Thermostat Setup

There is much information available from the servers. A subset is selected for mapping into HS Devices
and Features. A thermostat device is created and one or more zone devices are created. In the case of
a single zone, some zone information is contained in the thermostat device based upon how the cloud
server reports. A combination of controllable and status only features are created for each device as
shown in Figure 188.

Nexia | 3934928-Olmos Upstairs_84300098-Master_Bath
Nexia-3934928-0lmos Upstairs_843... (2841)

[ur) Imos Upstairs_ ; (2842) None Today 10:21:17 AM
a0 cooL HEAT
(4] Imos Upstairs_ (2843) AUTO Today 10:21:17 AM
oFF
Oasunzs-olmns Upstairs_ Mast int (2844)  6O°F Today 10:21:17 AM 89°F
) Imos Upstairs_ ISetpoint (2845)  78°F Today 102118 AM 78°F
@ Imos Upstairs_ (2846)  78°F Today 10:21:18 AM
@ Imos Upstairs_ (2847) dle Today 10:2118 AM
e Imos Upstairs Bath:Operati (2848) None Today 10:21:18 AM

Nexia | 3034928-Olmos_Upstairs
Nexia-3934928-0lmos_Upstairs (2820)

(©) 3934926-Olmos_upstairs:Scheduling (2821) OFF Today 102115 AM
S ———

oaquezs-olmns,uPstai.s:Cnnlingnehumiditysetpoim (2823) 50% Today 10:21:15 AM 50% B
) 2934928-Olmos_Upstairs:FanMode (2824) Auto Today 102115 AM [ o ]
D) 2934928-Olmos_Upstairs:FanSpeed (2625) 50% Today 10:21:16 AM 50% B
[4) Imos_Upstairs:FanCirculationTime (2826) 20 minutes Today 102116 AM 30 minutes

() 2034928-Olmos_upstairs Blower (2827) OFF Today 10:21:16 AM

(1) Imos_Upstairs:0 (2828) osF Today 10:21:16 AM

Q) 3934928-Olmos_Upstairs:indoorHumidity (2829) a7% Today 10:21:16 AM

o I ;_Upstairs:C (2830) 1] Today 10:21:16 AM

[C) Imos_Upstai (2831) 0 Today 102116 AM

Figure 188 Nexia HS Devices
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The are two cloud logins that are used. One intended for mobile applications (first URL) and one for the
desktop applications (second URL). The mobile application includes configuration information so is used
for most of the setup of HS Devices and Features. In the case where login does not give access to the
mobile site, the standard site is used, but controls created will not be functional. The second site just
contains data of current state. Some information is available on only one of the two sources. Some is
available on both. The first URL is polled at 20% of the polling rate and the second at 80%. This means
mode, scheduling, etc. is only updated every fifth polling interval and the others are update on four of
five polling intervals. The specific features and source are shown below.

Blower - Only desktop URL ZoneMode

CompressorSpeed - Only desktop URL Scheduling
RequestedCompressorSpeed - Only desktop URL | OperatingState - Only mobile URL
Emergency Heat SystemStatus - Only mobile URL
Aircleaner HeatingSetpoint
DehumiditySetPoint CoolingSetpoint

FanMode Temperature (if available)
FanSpeed Humidity (if available)
FanCirculationTime Preset (if available)
OutdoorTemperature

IndoorHumidity

12.11.3 Carrier Infinity / Bryant Evolution / lon

P U

s
—_—

- IrEhaTY SYITIN

—

The Carrier family of advanced HVAC equipment provides a System Access Module (SAM) that provides
a bridge between the Carrier Internet server and the RS-485 serial communications used between the
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thermostat and the HVAC equipment. mcsMQTT has implemented a means to use the cloud server to
get status and control the thermostat. There was also a reverse-engineering of of the RS-485 called
Infinitude that is not supported by the plugin.

The cloud API provided by Carrier has been encapsulated using Python as is available as a library module
under the name carrier-api. A Python, version 3, install on the same computer as mcsMQTT is needed
to run this library. The Pyton install varies based upon the OS.

A Python library is available with instructions and repository at https://pypi.org/project/carrier-api/ .
The Python MQTT and HTTP library is also needed. They are most easily installed from the command
line / terminal window using PIP with the command

pip install carrier-api
pip install paho-mqtt
pip install aiohttp
When both Python2 and Python3 are in the environment then
python3 -m pip install carrier-api
python3 -m pip install paho-mqtt

python3 -m pip install aiohttp

If Python3 and PIP are not yet installed on the Homeseer computer they first need to be installed.
Version 3.10 and 3.11 are known to work with the Carrier-API library. Use Google for guidance on
installing them on the OS that is hosting Homeseer. After installation, the folder where python.exe
needs to be identified as it varies. There will also be a \Scripts subfolder that normally is a subfolder of
where python.exe is located on Windows.

The integration of this library with Homeseer is done with the Python script CarrierRequest.py that is
available in the mcsMQTT download package and originally installed at subfolder \bin\mcsMQTT. It will
not be run from this location, but is moved to the \Scripts subfolder of the python install or an alternate
location on Linux.

During installation of Python, the PYTHONPATH environment variable is normally updated with path to
where the Python libraries are installed. PYTHONPATH will be discussed later.

The mcsMQTT setup for Carrier integration is on the Cloud Page, Thermostats Tab. See Figure 189.

Note the full path to python.exe and the Scripts folder in the setup. Also needed are the email and
password to the account that was setup with Carrier.

Data is polled for status updates to handle the local control being synced with HS. Provision is also
provided to disconnect the connection with the cloud server. This disconnection will also result in the
Python script CarrierRequest.py being terminated. CarrierRequest.py is managed by mcsMQTT and run
when the setup is complete and not disconnected.
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Carrier/Bryant/lon Thermostat Connect Parameters

Account Email mcssolutions@centurytel.net

Account Password

Python Path C:\Python311\python.exe

Python Script Path C:\Python311\Scripts\CarrierRequest.py

Server Polling Rate (milliseconds) | 60000

. . ™ ey . y ar Bt e Chamrype
Sarver Disconnect Connect to Carrier/Bryant/lon Server .

Y
)

Disconnect from Carrier/Bryant/lon Server

P
*,

Figure 189 Carrier Thermostat Setup

mcsMQTT will launch CarrierPython.py using the default shell account. If the Python libraries were
installed with a different account, which is the normal Linux situation, then Python cannot be executed
directly because PYTHONPATH has not been defined for the shell account. In this situation then it needs
to be launched via a script that also contains the definition of the PYTHONPATH.

A sample script for Linux will contain something like below when the path to the site-packages Python
version being used and the path to where the CarrierRequest.py was placed. It also requires that
mcsMQTT be told to run the script rather than Python. The setup is the same as shown for Omnilogic
below with the name Omnilogic changed to Carrier.

#!/bin/bash
export PYTHONPATH=/home/mcs/.local/lib/python3.11/site-packages

/usr/bin/python3 /home/mcs/Scripts/CarrierRequest.py $1 $2 $3 $4 $5 $6
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Hayward Omnilogic Connect Parameters

Account Email somebody@complace.com

Account Password eecccsccoee

Python Path /usr/bin/bash

Python Script Path /home/mcs/Scripts/OmnilogicRequest.sh

Server Polling Rate (milliseconds) 60000

Server Disconnect Connect to Omnilogic Server

®O0

Disconnect from Omnilogic Server

Figure 190 Launching Python via a Bash Script

In summary, the setup consists of installing Python and two libraries and then filling in the setup info on
the MQTT Cloud Page, Thermostats Tab. A successful install will result in HS Device and set of Features
being created such as shown in Figure 191.

A failed install has multiple places to look for clues. mcsMQTT Debug.txt is enabled from the MQTT
Page, General Tab. The Python \Scripts folder will have CarrierDebug.txt. MQTT messages on Topic
Carrier/Response will also exist that may contain Python execution traceback information.
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—
HomeSeer

Devices Events Cameras~ Setup Tools~ Plugins~

Carrier X meskKNE X

& default

_ SEARCH

£ e QEDECE
Carrier | North_Bend
Carrier-North_Bend (7019)
@ Morth_Bend:mode (7020) off Today 10:34:37 AM
° North_Bend:indoor_unit_operational_status (7021)  off Today 10:34:37 AM
North_Bend:outd i jonal_status (7022
@ rorn. B -statue (7022) Today 12:47:24 PM
0 North_Bend:outdoor_temperature (7023) 44°F Today 1:38:04 PM
(® rorth_Bend:airflow_cfm (7024) ocim Today 12:47:24 PM
(@ north_Bend:static_pressure (7025) 1.190000 Today 10:34:37 AM
Morth_Bend:filter_used (7026) 10 Today 10:34:37 AM
0 North_Bend:is_disconnected (7027) False T
=2
. North_Bend:ZONE_1:current_activity (7028) manual Today 10:34:37 AM
=2
@ North_Bend:ZONE_1:hold (7029) Holding Today 103437 AM m m
@ North_Bend:ZONE_1:hold_until (7030) Indefinite Today 10:34:38 AM Indefinite
[ ov | e |
o North_Bend:ZONE_1:fan (7031) off Today 103438 AM
o North_Bend:ZONE_1:heat_set_point (7032) B4°F Today 12:54:57 PM 54°F ]
@ North_Bend::ZOMNE_1:cool_set_point (7033) BO0°F Today 10:34:38 AM 80°F :
@ North_Bend:ZONE_1:temperature (7034) 54°F Today 1:30:58 PM
0 North_Bend:ZONE_1:humidity (7035) 49% Today 1:21:50 PM
North_Bend:ZONE_1:conditioning (7036) idle Today 12:47:25 PM
o North_Bend:ZONE_1:occupancy (7037) off Today 10:34:39 AM
e North_Bend:ZONE_1:cool_set_point (7038) 80°F Today 12:54:58 PM 80°F ®

Figure 191 Carrier Thermostat HS Device and Features
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12.12 Propane
The propane tank fuel monitoring available through mcsMQTT is via Tank Utility that is a service
provided by some providers.

Tank Utility is instrumentation to monitor Liquid Propane (LP) tanks. The commercial product consists of
the sensor and a smartphone app. It can be purchased on Amazon at
https://www.amazon.com/Generac-7009-Tank-Monitor-White/dp/BOSWZGKAFL . There is a published
APl at http://apidocs.tankutility.com/ which is what the integration with mcsMQTT is based. The
integration is based upon periodically polling the data available from the Tank Utility server and making
the data available in a convenient presentation within HS. The data is uploaded from the sensor to
Cloud server once per day. mcsMQTT synchronizes to this time and then polls at 10-minute intervals 24
hours later to get the next reading.

Multiple tanks can be integrated. For each tank the following JSON payload is available. Those items in
yellow highlight are used for the HS integration. If other items are desired then an update can be done.

device_1d:002700373232373103473035

short device id:ABCDEFGH

name:Tank 1

address:123 MyStreet,My Town, My State, My Country

account id:

fuel type:propane

fuel dealer id:

connection type:wifi

product id:WIFI-G

product name:Generac Tank Monitor

supplier id:-supplieril23

status:deployed

capacit :25

orientation:horizontal

consumption types:cooking,fireplace

consumption_type{11}

backup heating:false

bulk storage:false

commercial industrial:false

cooking:true

fireplace:true

generator:false

heating:false

hot water:false

laundry dryer:false

pool:false

retail fill up:false

battery warn:false

battery crit:false
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battery level:good

average consumptio:0.10714285714285714

estimated fill da:2024-03-23721:08:01.6007

fixed transmission time:-1

reading interval:21600

transmission interval : 86400

threshold 1:-1

threshold 2:-1

change :-

lastReading{12}

tan :56.47379

temperature:58.782

time:1680590098000

time is0:2023-04-04T06:34:58.0007

Sw rev:12.005

event code:0

fixed transmission time:-1

reading interval:21600

transmission interval :86400

threshold 1:-1

threshold 2:-1

change of value:-1

telemetry[5]

0{13}
attempt no:0
chn:1
cipher:229
ecn:3

http status code:200

modem ram:51032

module temp:0

module voltage:0

rssi:-87

ssid:MySSID

time to conn:17.395

tlm_time:1680590120

type:wifi

The setup includes account username/email and password. This is available on the Cloud
Page, Tank Utility Tab such as Figure 192. An option also exists to disconnect/reconnect to the Tank
Utility server.
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HﬂﬁESEEr‘ HomeSeer Waeb Control

Devices Evenls Cameras >~ Selup Tools = Plugins ~

URL Yolink Voice Maonkay GaoFanoe Sensa Hubspace Swilchbol Tank Utility

TankUtility Connect Parameters
Aceaunl Email _ pgmail.com

Aocounl Password EEERb R AR ER S

n n a2 ankULility Server
Server Discannec Canmect To TankULility Sery

o)

Discannect from TankUlility Server

Figure 192 Tank Utility Setup

One HS Device is created for each tank with the properties of interest shown as Features. See Figure
195. This information is also available on the MQTT Page, Association Tab. Customizations can be done
from this location such as selecting a measurement for historical recording and subsequent charting.
The example in Figure 193 shows where the tank level measurement has been selected for “s”hort term
storage. The History Tab of the MQTT is used to define the when the data is removed from short term
storage. Perhaps a month or a year. It can also be stored in external database for “I”ong term storage.

Association Table for Auto Association of MQTT Topic and HS Device

e ] ref payload 8 lastdate

Dev: TankUtility| TankUtility|lastReading-tank
Sub: TankUtility,/( IR )3 5:lastReading-

(EaeLe 2023-04-07

0 O O O v Pub: the following Topic on Device command 56.354948 O V4 O 2265

Figure 193 Tank Utility Association Table Entry

Selecting a chart is done from the MQTT Page, Chart Tab where the measurements to appear on the
same chart are selected and the period of time of the data being drawn. An example is shown in Figure
194.
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Shaw Salected Chart

Figure 194 Tank Utility Measurement Chart

HomeSeer HomeSeer Web Control

Devices Events Cameras~ Setup Tools~ Pluging~™

TankUtility | TankUtility
Tankutility [ EKNG | 177)
short_device_id (478) Today 11:26:02 AM
[2=) name (479) Today 11:26:02 AM
Q. address (480) Today 11:26:02 AM
A fuel_type (481) propane Today 11:26:03 AM
O capacity (482) 250 gal Today 11:26:03 AM
o orientation (483) Harizontal Today 11:26:00 AM
hattery,warn (484) Good Today 11:26:01 AM
average_consumption (485) 01242857143 Today 11:26:03 AM
estimated_fill_date (486) 2024-03-25T17:25:44.320Z Today 11:26:03 AM
e lastReading-tank (487) 56.35495 gal Today 11:26:03 AM
O lastReading-tank-percent (488) 23% Today 11:26:03 AM
lastReading-temperature (489) 65.67 °F Today 11:26:03 AM
@ lastReading-time_iso (490) 2023-04-07T06:36:28.0002 Today 11:26:03 AM
@ telemetry-rssi (491) -85db Today 11:26:03 AM
o telemetry-ssid (492) _ Today 11:26:03 AM
telemetry-time_to_conn (493) 15.391 Today 11:26:03 AM

Figure 195 Tank Utility HS Device and Features
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12.13 Abode Security

Smart security systems to keep your family ¢

Shop Abode >
abode

Abode provides a security panel at a reasonable price that utilizes modern technologies such as WiFi and
Zigbee for sensors and actuators and a wired or wireless connection to the internet. All activity is
managed through their cloud server with primary Ul being a smartphone. They provide a monitoring
service, but is not required for normal operation.

Abode does not provide a public API. Data availalble has been reversed engineered. Much of the
mcsMQTT development has levereged the Hubitat Groovy https://github.com/jorhett/hubitat-
abode/wiki and Home Assistant Python https://github.com/MisterWil/abodepy implementations. Both
of these developments are stale with Abode having added new devices and are not contained in these
references. What is included in mcsMQTT is based upon devices in possision or with cooperation of
other HS users. In general all status information is available in HS Device and Features. Most controls
are also available, but not all due to the lack of information on the expected control parameters.

The integration to HS has a minimal setup of email and password as shown in Figure 196. The email and
password are the same as used when installing the security system via smartphone.
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HomeSeer HS4 Web Control & default ~

Devices Events Cameras v Setup Tools~ Plugins ~

URL Yolink Voice Monkey GeoFence Sense Hubspace Switchbot

Tank Utility EcolNet Abode Thermostats

Abode Connect Parameters

Account Email | xxxxi@gmail_com I

Account Password = seesesss

Video Storage Path - C:\Users\Public\Documents

Refresh Devices Find & Refresh Panel Devices

Server Disconnect Connect To Abode Server @

Disconnect from Abode Server (O

Figure 196 Abode Setup Parameters

On startup mcsMQTT will request information about the panel and devices that have been configurerd
on the account. HS Devcies and Features will be created such as shown in Figure 197.

The plugin will establish a WebSocket with the Abode server. This conduit is the primary mechanism to
receive status update of the panel and devices. In some cases the event reported will contain new
status information. In other cases the event report will include only the identification of the device that
has had some type of status change (e.g. color change in light bulb). In these cases mcsMQTT will
request a status update of the device from with the HS Feature status is updated.

The primary interface with the panel is the mode information. The panel supports two areas that are
independently managed. Devices will be setup to be in one of the two areas via the smartphone App.
When mcsMQTT, fob, or smartphone app commands a mode change, the event will be reported, but the
event report will not provide which area has had a mode change. The change is available immediately
when requested for devcie changes, but panel changes are not immediately availalble. mcsMQTT waits
60 seconds to request the panel status update which will include the mode status of both areas.

Two timers that countdown every second during arming and prior to alarm that mimics the timers
contained in the Abode panel. They are only infomational.

The plugin includes a Connection Featue that has three states. Normal, Inactive, and Failure. Itis
managed as part of the Pong response from Abode server on the WebSocket which occurs every 25
seconds. If it has not been received for 120 seconds then the Normal state will transition to the Inactive
state and an attempt made to restart the connection. If the conection is not restored in 20 seconds
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then the status will migrate to the Failed state. This monitoring is in addition to monitoring that is done
behind the scenes with auto recovery attempts done automatically.

Panel mode management is focused on the Area 1 Mode. Abode does not provide event notification
that can be used to distinguish Area 1 from Area 2. The HS Area 1 Mode Feature is updated based upon
event reporting for the panel or event reporting for the Fob. Fob status will show the last event state
reported for the fob which could be different than the last event reported for the panel. Variance will
typically occur if the Fob is not used to change the mode.

Abode | Abode
[] Abode Panel (7887)

(] @Are;ﬂ Mode (7888) Disarmed - Standby Today 5:26:35 PM m
O @Area2 Mode (7889) Disarmed - Standby Today 5:26:35 PM m
O @ Exit Timer (7890) 0sec Today 5:26:35 PM
[ @) entry Timer (7891) Dsec Today 5:26:35 PM
O (@ hasFauits (7892) Battery Today 5:26:35 PM
O °Alarm (7893) Off Today 5:26:35 PM
(| 0 Connection (7894) Normal Today 5:28:53 PM

Abode | Abode Area 1
[] Abode RF:026cc200 Fob (7872)

[] @ Fob (7873) Disarmed - Standby Today 2:25:32 PM
[ @ FobhasFaults (7874) No Faults Today 22530 PM

Abode | Abode Area 1
[1 Abode RF:0aeaf510 Contact Sensor (7869)

| @ Contact Sensor (7870) Closed Today 2-:39:43 PM
[l ° Contact Sensor hasFaults (7871) Mo Faults Today 2:39:43 PM

Abode | Abode Area 1
[[] Abode XF:bOc5ca394390 Light NB (7875)

[ (@) vioht na switch (7676) off Today 2:25:32 PM “ “
(] o Light NB brightness (7877) 50.00 % Today 2-25:32 PM ®

| o Light NB hue (7878) 0 Today 2:25:32 PM [ ]

O o Light NB saturation (7879) 0% Today 2-25:32 PM L

] Light NB color_temp (7880) 5000 °K Today 2:25:32 PM [ ]

[l Light NB color_mode (7881) temp Today 22530 PM

| ° Light NB hasFaults (7882) No Faults Today 2:25:30 PM

Abode | Abode Area 1
[ Abode XF:bOcSca3d22aa Cam NB (7883)

| ° Cam NB snapshot (7884)

[l Cam NB privacy (7885) Wigwing Today 2:25:32 PM m

O @ Cam NB hasFaults (7886) No Faults Today 5:29:00 PM

Today 5:29:02 PM

Figure 197 Abode HS Devices and Features

Camera support consists of two controls. One to turn the camera on or off for privacy. The other is to
capture the current image being seen by the camera. Images will also be captured when the alarm
panel snaps a picture when the alarm triggers. Each image will be saved in a HS subfolder
\htmN\mcsMQTT\xxx.jpg where xxx is the ID of the camera that took the snapshot. A second copy if
made in same folder with fixed filename of Abode.jpg. mcsMQTT will also create a thumbnail of the
image and place it in the DeviceString of the camera’s snapshot Feature. The DeviceValue of this
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Feature will increment with each image download. Clicking on this image will bring up the full-size
image. In addition, an archive of the image will be copied to the user-specified video folder with a
subfolder created for each camera if that location is specified on the Cloud Page, Abode Tab setup.

Note that a snapshot will still take the image even when in privacy mode.

The color light device has multiple controls. All are functional except the switch and brightness controls.
The Abode returns code 600 — Panel Error when trying to control these from the plugin.
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12.14 Irrigation

12.14.1 Orbit B-Hyve Irrigation

Orbit provides consumer-grade smart irrigation controllers with their B-Hyve line. It operates using WiFi
to provide setup and operation via smartphone. Once setup it will operate locally, but if dependent
upon weather data when setup for smart or ET-based irrigation the control will become stale.

mcsMQTT integrates the run-time information from the controller and provides common user controls
such as selecting among the programs that have been setup or running a station asychronously. Plugin
setup is on the Cloud Page, Orbit Tab as shown in Figure 198. Setup uses the login to the user’s Orbit
account and provides a mechanism to disconnect and reconnect to the cloud server as well as
asychronously request all data from the Orbit Server.

Two communication channels are used. One is HTTPS that is used at startup and polled every five
minutes. Primary use is to get the equipment definitions that are used to setup the HS Devices and
Features. The polling will update status, but the primary status update is with the WebSocket channel
that reports real time events from the controller and is used to deliver asynchronous commands to it.

The implementation is based upon data gathered by others through a reverse engineeing process. The
control flow for the plugin is based upon the Hubitat Groovy code GitHub - dcmeglio/hubitat-
orbitbhyve: Provides integration with a Orbit™ Bhyve Timer and SmartThings. The control endpoints
were primarily gathered from Python implementaiton that looks to also be used by Home Assistant
GitHub - sebr/pybhyve: Python library for interacting with the Orbit BHyve API. Inthe end the
integration was completed using a man-in-the-middle exploit to decode the traffic from the Orbit BHyve
App and using this to reverse-engineer the functionality provided in the plugin.
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The plugin gathers information from multiple URL endpoints that include Devices, Timelines, and
Landscapes. A History endpoint is also available that is not used. Devices describe the Stations.
Timelines relate to the Programs. Landscapes related to smart irrigation.

HomeSeer HS4 Web Control

Devices Events Cameras~ Setup Tools ~ Plugins ~

URL Yolink Voice Monkey GeoFence Sense Hubspace Switchbot

Tank Utility EcoMet Abode Orbit Solar Thermostats

Orbit Connect Parameters

Account Email my@email

Account Password sessssen

Refresh from Server Refresh from Orbit Cloud Server

Server Disconnect Connect To Orbit Server

Disconnect from Orbit Server

o
@)

Figure 198 Orbit B-Hyve Account Setup

A HS Device is create for the Panel and one for each Station. From the Panel Device it is possible to
select amoung the programs that were setup on the smartphone, to change the operation between Off
and Auto and to pause or delay the program. Status is also provided for the next start time, the battery
status, panel connection status and rain delay that may be active. Date-Time information is presented
in the Status and DeviceValue is populated with the Unix local time.

Each station has a control to run the station for a specified amount of time and to set the soil moistue
level when smart watering is active. Status information for the Station is watering status, last start and
end times, rain sensor status and the timed vs. smart control. Orbit only provides the current water
level in response to a request to change the level. It does provide any other polling or event-based
reporting to reflect the current moisture level so the HS status will not change from the level at which it
was manually set.
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Status updates from Orbit server are obtained on an event basis via a WebSocket connection. This
connection is actively monitored and attempts wil be made every 25 seconds if the connection is lost.
Polling will occur every hour as a precaution and as a means to monitor the connection in a closed-loop
manner.

A Monitor HS Feature is provided that shows the number of minutes since the last data from Orbit
Server has been received. During quiescent times this value is expected to reach 60 minutes. A control
on this Feature is provided to restart the plugin’s support of the Orbit integration.

Orbit | Panel
Orbit/0/ Panel (4812)

Tuesday, May 23, 2023 9:00
PM

mPanel:Rain Delay (4814) 0 Hr Today 811:27 AM 0

() panct:Run Mode (4815) manual Today 8:28:37 AM
@ panci:sun-wed (4816) Enabled Today 8:11:27 AM

(D panciNext start Time (4813) Today 8:11:27 AM

0 Panel:Battery (4817) unknown Today 8:11:27 AM

@PaneI:Connected (4818) True Today 8:11:27 AM

) panct:Monitor (4819) 0 Min Today 8:29:12 AM

Orbit | Drip

Orbit/0/Drip (4820)

o Drip:Zone1:Zone Status (4821) watering_in_progress Today 8:28:37 AM

@ Drip:Zone1:Program (4822) manual Today 8:28:37 AM
Tuesday, May 23, 2023 828

@) oriv:zoner:start Time (4823) A:js ay. May 23, Today 8:28:37 AM

0 Drip:Zone1-End Time (4824) N/A Today 8:28:37 AM

@ Drip:Zone1:Rain Sensor (4825) False Today 8:11:27 AM

Drip:Zone1:Manual (4826) 1 Min Today 8:28:37 AM 1
@ Drip:Zone1:Smart Watering (4827) False Today 8:11:27 AM TRUE

° Drip:Zone1:Moisture (4828) 50% Today 8:11:27 AM ®

Figure 199 Orbit B-Hyve HS Devices and Features
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12.14.2 Hunter Hydrawise Irrigation

The integration with the Hunter Hydrawise unit is performed with the second generation (V2)
methodology of oAuth2 for authentication and GraphQL for query of the Hunter Hydrawise server. This
APl provides access to the controller, sensors, and zone relays. Much information is available from the
Hunter Hydrawise server, of which a subset is selected for automatic creation of HS Devices and
Features. A Device is created for each controller and Features are created for status information for the
controller, sensors and zones.

The controller Summary Feature can be used to control all the zones per the schedule that has been
setup. No provisions exist in mcsMQTT to manage schedules. This is done with the Hydrawise
App/Account.

Controller overall control provisions apply to the current schedule with ability to Start, Stop, Suspend,
and Resume the schedule. See Figure 200. When suspending the schedule, the HS Feature
Suspend.Hours is used to specify the number of hours that the suspension will be enforced by the
controller. By default, this is one hour, but can be change by HS Event or HS Devices Page user entry.
The entry can contain fraction hours such as 1.25 to provice a pause of 75 minutes. Setting
Suspend.Hours has no immediate effect. Suspend operation is performed by the “Suspend All” or
“Suspend Buttons”.

The status is reported in Device Value and Device String. The Device String is what will be visible on the
HS Devices Page as the status. The controller Device Value will be zero when no zone is running. It will
be one when any zone is running. The Devices Page status icon will also provide a visual indication of
the stopped vs. running status.

Similar controls and status exist for each zone. A run time text box is also included for the zones. The
number entered via HS Device Page or Event action is the number of minutes to manually run the zone,
independent of what is programmed in the schedule. Again, fractional values can be used such as 10.5
to run the zone for 10 minutes and 30 seconds. The submit textbox will show the time entered and will
be updated each minute to show the time remaining. It wil be 0 when not running.

The status reporting is from the Hunter Hydrawise server and stored in the HS Device String. With
standard HS Events the Device String cannot be used as Event triggers, but the EasyTrigger plugin has
such capability if needed.

All Features will be updated based upon the current information on the Hunter Hydrawise server every
60 seconds when no zone is active and 20 seconds when at least one is active. The water flow
information is updated based upon the raw water flow sensor to show real-time water use. Upon
completion of a zone the water use is synchronized with the Hydrawise server using the completion
event data from the server.

Zone status is shown in the Zone Feature’s Device String and will be visible on the HS Devices Page. This
will be the current status summary from the Hunter Server and will include the “suspend until”
information if is is available from the server.
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HomeSeer HS4 Web Control Lcear

Devices Events Cameras~ Setup Tools~ Plugins - _ SEARCH

Hydrawise X
e - - = X wemerx e - OBDEOE
Hydrawise | Stilson Ranch Rd
[] Hydrawise-Stilson Ranch Rd (6618)
] (@) stilson Ranch Rd:Suspend.Hours (6619) 1.00 Hrs 1/7/2023 3:52:39 PM 1
s
O ostilson Ranch Rd:status:summary (6620) All good! Today 12:51:19 PM
D 95{"50“ Ranch Rd:status:online (6621) true 1/7/2023 3:52:40 PM
D @Stﬂson Ranch Rd:status:lastContact:value (6622) Fri, 10 Nov 23 12:50:46 -0700 Today 12:51:19 PM
1 @Stﬂsan Ranch Rd:status:actualWaterTime:value (6623) 37 Min Today 12:51:19 PM
1 @snlsnn Ranch Rd:status:normalWaterTime:value (6624) 0Min 1/7/2023 3:52:40 PM
ilson Ranch Rd:sensor.Flow al oday 12:
[ Stil Ranch Rd. Fl 6625) 2800 gal Today 12:51:19 PM
71 € stison Ranch Rsensor viruaFiow 6626) 18050 fosay 125175 P
O ° Stilson Ranch Rd:sensor.Rain and Freeze (6627) falze Today 11:45:03 AM
D ostllsun Ranch Rd:zone.MP—SW Native (Zone 1 Mins) (6628) Not scheduled to run Today 12:51:19 PM START
"
O @Stilson Ranch Rd:zone.MP—SW Native (Zone 1 Flow) (6629) 100.00 gal Today 12:51:19 PM
00
chedule 11/7/2023 4:38:56 P
e .
Stilson Ranch Rd:zone.MP—SW Roadside Native (Zone 2 Mins) (6630)

Figure 200 Hunter Hydrawise Default HS Devices and Features

User setup is on the Cloud Page, Irrigation Tab, Hunter Hydrawise Section as shown in Figure 201.
Required is the username (email address) and password that was setup when registering the Hydrawise
device. One or more Hydrawise accounts are supported.

Data is obtained from the Hydrawise server on a periodic interval. Provisions exists for finer resolution
when the irrigation is active. There are account access constraints so the default values of 60 seconds
when inactive and 20 seconds when active may need to be increased depending upon how often
irrigation is active.
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Hunter Hydrawise Connect Parameters
Account 1 Email _IG.COFI‘I

Account T Password . sessess

Account 2 Email -mail.com
Account 2 Password srrsssas

Account 3 Email

Account 3 Password

Additional Properties Exclude from Association Table (@)
Include in Association Table Q)

When Inactive

60
Pelling Interval
(seconds) )
When Running
20
Sarver Disconnect Connect To Hydrawise Server ()

Disconnect from Hydrawise Server (@)

1 Week Flow 2 Week Flow 4 Week Flow B Week Flow
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ch Rd Zone Flow History

1 MP—Hlai Hative
1:MP-N hiarve

1:MP-5 Bluegrass

L < Zone Flow History

et Pool
B 7 So0uth Front

W 7 Porth Fron

Figure 201 Hunter Hydrawise Setup

There is considerable information available from the Hunter Hydrawise server. By default, it is not
exposed. If a user wants to associate additional information into HS Device Features, then it can be
exposed with the setup selection. Creation of additional HS Device Features is done from the MQTT
Page, Association Tab with the suggested filter of “Hydrawise” as the T1 filter. Figure 201 is an example

of the additional information in the table. Note that for this one controller there are 633 items in the
table.

Hydrawise provides a flow sensor with the running count of the volume of water that has been used.
The plugin computes each zone flow from this sensor when a zone is active. A reset button is provided
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that can also be controlled by event to reset the virtual flow sensor value back to zero. Itis
automatically set to zero at the start of a run and at midnight.

The historical flow data will be stored in the SQLite short term database. The data can be viewed
graphically with a stacked column chart in one for four time periods. The period is selected by a button
push and the chart will appear above the buttons. These charts can also be requested via a http request
to the HS IP such as http://192.168.0.100/mcsMQTT/Popup.html?Payload=2681&Days=2 for HS3 and
http://192.168.0.100/mcsMQTT/Popup.html?Payload=2681?Days=2 forHS4 where 2681 is the Ref of the
Hydrawise controller Virtual Flow Feature and Days=2 is the number of days of stacked columns. If Days
parameter is omitted then it will default to the prior chart request number of days.

There is also user selection to disconnect from the Hunter Hydrawise server. This applies to all
accounts. When disconnected there will be no communication for control or status updates.

Filter by Mgtt Topic and JSON Payload Key

(Clear Filters Rebuild Filters

Show Selected Associations

Association Table for Auto Association of MQTT Topic and HS Device

e a ref payload S lasidate

] D D D 5580  Hydrawise/Stilson Ranch Rd
1 D D D Hydrawise/Stilson Ranch Rd Sensor Flow
20231102
2 O O O O Subx Hydrawise/Stilson Ranch Rd.Sensor. Flow:Modelactive true O 210054
: : ) . 20231102
|:| |:| |:| |:| Sub: Hydrawise/Stilson Ranch Rd.Sensor Flow:Modeldelay 0 |:| 91-00:54
n Suby: Hydrawise/Stilson Ranch am 20231102
O O O ] Rd Sensor Flow-Modeldiviser . ] 21:00:54
: Sub: Hydrawise/Stilson Ranch 2023-11-02
O O O ] Rd Sensor FlowMedetflowRate ] 21:00:54

Figure 202 Hydrawise Additional Information
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12.15 Solar Panel Integration
Solar integration collects data from locally installed panels using Solar_Assistant and pulls data for
forecast energy generation from Solcast for the next 24 hours with eight grouping for the day. The
forecast is nominally updated each hour. Local panel generation data is pushed over a MQTT channel.

This integration is in cooperation with HS user Daveyboy who initiated the discussion and provided most
of the ideas and data for this integration.

Setup is from the Cloud Page, Solar Tab. The forecast from Solcast requires the user’s resource Id to be
entered. Solar Assistant MQTT server IP is needed for the local data. A radio control is also provided to
connect/disconnect from both servers.

HomeSeer $4 Web Control

Devices Events Cameras~ Setup Tools ~ Plugins =

URL YolLink Voice Monkey GeoFence Sense Hubspace Switchbot

Tank Utility EcoMet Abode Orbit Solar Thermostats

Solar Setup Parameters

Solcast Resource Id 286f-a?9f-29h3-87a3

Solcast APl Key

Solcast Daily Download Quota 30

Solar Assistant MQTT Server IP. 192.16B.0.16

ST [ F e Connect to Solcast and Sclar_Assistant Servers

Disconnect from Solcast and Solar_Assistant Servers

®0

Figure 203 Solar Panel Integration Setup

Page 338



12.15.1 Solcast

HS Device and Features are created at startup when the Solcast resource id has been entered. Updates
occur each hour. The data from Solcast is assumed to be in UTC time so it converted to local time for
grouping ins HS Features. This grouping is defined as:

Early morning 6 am through 9 am
Late morning 9 am through 12 pm
Early afternoon 12 pm through 3 pm
Late afternoon 3 pm through 6 pm
Early evening 6 pm through 9 pm
Late evening 9 pm through 0 am
Early night 0 am through 3 am
Late night 3 am through 6 am

The forecast data is delivered in 30-minute intervals. Each 30-minute interval within the
defined timer periods is summed to produce the value recorded in the HS Feature.

Solcast is a subscription service with different rate plans available. The plan will determine
the number of daily downloads that will be available. The quota is a user setup parameter
as shown in Figure 203.

Since data is being quantized into eight time-slots per day there is not a need for frequent
downloads. Downloads more frequent than every 30 minutes will result in little new
information since that is the interval quantized by Solcast. Download every hour (24/day)
seems to be a good balance.

Each forecast provides 48 hours of data. mcsMQTT uses only data for the next 24 hours.
The three-hour bucket it selects is based upon the local time of day for the forecast. This
means that if the download occurs at 10 AM, the data in the 6 AM to 9 AM bucket will be
tomorrow’s forecast while data in the 12 PM to 3 PM bucket will be today’s forecast.
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HS4 Web Control

HomeSeer

Devices BEvents Cameras~= Setup Toolks = Plugins -

I:l Solcast 3
 roon J§f roou | e
Solcast | Solcast
[0 Solcast (7990)
J o Solcast:Early moming (7991) 6.5298 kW Today 10:31:43 AM
| o Solcast:Late morning (7992) 2 18RS KW Today 10:31:43 AM
J o Solcast:Early afternoon (7993) 07347 KW Today 10:31:43 AM
| o Solcast:Late afternoon (7994) 0.0000 kW Today 10:31:23 AM
J o Solcast:Early evening (7995) 0.0000 kKW Today 10:31:23 AM
| o Solcast:Late evening (7996) 0.0679 kKW Today 10:31:43 AM
J o Solcast:Early night (7997) 247154 kW Today 10:31:43 AM
O o Solcast:Last night (7998) SB2TE KW Today 10:31:43 AM
Figure 204 Solcast HS Device and Features
12.15.2 Solar Assistant

SolarAssistant is software used to locally monitor and control your solar PV install. It is
designed to run on a Raspberry Pi that is plugged into the solar inverter and optionally a
battery BMS. The application can be accessed from a web browser or the Android/iPhone
app via local network or the internet. It is available at Online Shop | SolarAssistant (solar-
assistant.io) as a RPI image for around $55. Also needed are a Pi, a SD card and a special
cable to link from the Pi to your Inverter.

The table below provides the status of the SolarAssistant support of various inverters at the
time of this writing (May, 2023).

Supported Inverters Not-yet Supported Inverters
Axpert ABB

Growatt APEX/MLT

EG4 Atess

Deye Fronius

Kodak Epever (Expected late 2023)
SunSynk Renology

MPP Solar Schneider

Sol-Ark Sofar

Mecer Solar edge

RCT Solax

Must Power Solis (Expected mid 2023)
SRNE Victron

InfiniSolar
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Easun Power
Megarevo
Luxpower

The killer app with SolarAssistant is that it's all local, manufacturer independent and you get
some really cool charts too - no need to rely on a cloud connection, the manufacturer's
website, data being bounced through China etc.

mcsMQTT provides the mechanism to leverage this capability with integration of the data
into HS. You can view and make actions within Homeseer on live data direct from your PV
install. Battery charge levels, PV levels, house load, grid load. You can even change
configuration parameters on the Inverter to preemptively take advantage of tomorrow's
weather conditions. Turn the hot tub on/off if there is excess PV, turn the water heater on/off
if the batteries are getting low, kill the power to the tumble dryer etc - there are so many use
cases that this integration enables.

12.15.2.1 SolarAssistant Installation

Full SolarAssistant configuration is available at https://solar-assistant.io/help/gett...prepare-
device. After you've got your SolarAssistant up and running you'll need the local
IP address from their Configuration Page:

Metwork status

Internet B4.66.213.15
ethO 10.0.0.5 Do
wlanO 192.168.1.106

And then enter this into the Solar Tab, under the mcsMQTT, Cloud page in HomeSeer:

Solar Assistant MOTT Server IP | 192.168.1.106

Solar Connections Connect to Solcast and Solar_Assistant Servers

Disconnect from Solcast and Solar_Assistant Servers

@
o

Back in SolarAssistant make these changes from the Configuration Screen:
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MQTT Broker

Port 1883

Status:

Advanced Stop

Configuration

Topic prefix solar_assistant

i
£

HomeAssistant discovery = Enabled

[§5]

Allow setting changes Enab

Authentication

Username

Password

Note: No authentication is required for this local network connection.

With the SolarAssistant setup to Enable HomeAssistant Discovery, within a few minutes
there will be new devices automatically created in Homeseer. Is HomeAssistant Discovery
is not enabled then the data from SolarAssistant will only appear in the Association Table of
the MQTT Page of mcsMQTT. From this table, the “a” column checkbox is used to mark
those pieces of data for which HS Device and Features will be created.

The created devices will be placed in a HS Room based upon the MQTT being used by
SolarAssistant. If HomeAssistant Discovery is Enabled then the following is the expected
view from HS.

HS totals room:
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HS inverter_1 room:

There will also be a bunch of new devices created in the HS inverter_1 room (around 80) -
these are unique to each install and to each inverter. You will probably discover that this
information mostly will not be useful to you but a few certainly will be (e.g. battery
temperature, PV load etc.), however, we cannot give guidance here which ones you may
wish to remove. Removing Features is done from the MQTT Page, Association Table by
removing the “a” column checkbox from the table’s row. This tells mcsMQTT to not
associate the SolarAssistant specific piece of data to a HS Feature. Note, if the Feature is
removed using the HS Devices Page, then a new Feature will be created if HomeAssistant
Discovery has been enabled.

Communicating to the Inverter is possible from HS if the Association Table or Edit Tab of
the mcsMQTT MQTT Page is provided a Pub(lish) Topic. This will be the same as the
Sub(scribe) Topic, but end with /set rather than /status.

Our Disclaimer: You must be extremely careful in sending data to control your inverter from
HS as this could render your Inverter inoperative. Only change what you would normally
change via the main Inverter console. You will have received warnings and disclaimers from
SolarAssistant when you signed up to their service so you will be aware of the risks.
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12.16 Pool
12.16.1 Hayward Omnilogic Pool

Hayward provides a Omnilogic control for pool heating, chlorination, lighting and other features.

The integration with Homeseer is based upon the Github Python APl implementation at
https://github.com/djtimca/omnilogic-api. A Python, version 3, install on the same computer as
mcsMQTT is needed to run this code. The Pyton install varies based upon the OS. This download is
installed with

pip install omnilogic

The Python MQTT and HTTP library is also needed. They are most easily installed from the command
line / terminal window using PIP with the command

pip install paho-mqgtt
pip install aiohttp
When both Python2 and Python3 are in the environment then
python3 -m pip install paho-mqgtt
python3 -m pip install aiohttp

If Python3 and PIP are not yet installed on the Homeseer computer they first need to be installed. Use
Google for guidance on installing them on the OS that is hosting Homeseer. After installation, the folder
where python.exe needs to be identified as it varies. There will also be a \Scripts subfolder that
normally is a subfolder of where python.exe is located for Windows installs.

The integration of this library with Homeseer is done with the Python script OmnilogicRequest.py that is
available in the mcsMQTT download package and originally installed at subfolder \bin\mcsMQTT. It will
not be run from this location, but is moved to the \Scripts (or alternate) subfolder of the python install.

During installation of Python, the PATH environment variable is normally updated with path to python
and the scripts subfolder. It may be necessary to have these definitions in PATH.

The mcsMQTT setup for Omnilogic integration is on the Cloud Page, Pool Tab. See Figure 205.
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Hubbapace Switchbot Tanik Litility Ecohet Abnde

Irrigation Solar Thermostats Pl

Hayward Ominilogic Connect Parameters
Acccunt Emad [ Jeom

Account Pasaword 0000 eeseesaes

Pythan Path C:APython311\python.exe
Python Script Path CAPython3d 11\ Scripts\OmnilogicRequest. py
Server Polling Rate (miliseconds) | &0000

Server Disconnact Connect to Omndome/Bryant/lon Server

Disconnect from Omndlogic/Bryant/lon Server i

Figure 205 Hayward Omnilogic Pool Integration Setup

Note the full path to python.exe and the Scripts folder in the setup. Also needed are the email and
password to the account that was setup with Hayward Omnilogic.

For Linux users, see the setup for Carrier Integration Section 12.11.3 for the approach to deal with the
environment variable PYTHONPATH that is not defined when running Python from the shell account.

Data is polled for status updates to handle the local control being synced with HS. Provision is also
provided to disconnect the connection with the cloud server. This disconnection will also result in the
Python script OmnilogicRequest.py being terminated. OmnilogicRequest.py is managed by mcsMQTT
and run when the setup is complete and not disconnected.

mcsMQTT will automatically create an HS Device for each pool and set of features such as in shown in
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Omnilogic | Crane_Residence

Omnilogic-([ Jol (4495)

° Pook:Alarms (4496) Today 271135 PM
0 Pool:AirTemperature (4497) 53F Today 267:42 PM
0 Pook:WaterTemperature (4498) 52°F Today 2:57:42 PM
@ Pool:HeaterState-Heater (4499) aif Today 21135 PM “
0 Pool:HeaterTemperature-Heater (4500) T0°F Today 2:11:36 PM TO°F *
o —— . .
D) pootFinterpumpspeed (4502) 9100% Today 257:42 PM (]
@ Pool:FlowMeter (4503) on Today 2:66:43 PM
PookRelay-Waterfalls (4504) on Today 257-42 PM oOn B

() Pook:ChiorinationEnable (4505) Disable Today 2:56:43 PM m
() PookChiorinationAvgSaltevel (4506) 2800 ppm Today 2:56:43 PM
() PookChlorinationinstantsaltLevel (4507) 0ppm Today 2:56:43 PA
() PootcholorinationOperatingMode (4508) 1 Today 2:56:43 PM
. Pook:ph (4509) 0.00 pH Today 2:56:43 PM
@ pootorp 4510) omv Today 2:56:43 PM
(@) pootLightsstate-pool Lights (4511) off Today 2:56:43 PM [ ]
. Pool:LightsLightShow-Pool Lights (4512) Show-Veodoo Lounge Today 2:57:42 PM ‘Show-Voodoo Lounge ¢

_.
@ PootLightsrightness-Pool Lights (4513) 200 Today 257-42 PM

— ]
(©) PookLightsSpeed-Pool Lights (4514) 116x Today 2:57-42 PA 1H6x B
@ Pook:Theme (4515) None Today 2:56:43 PM

LIGHTS

Figure 206 Hayward Pool Omniologic HS Device and Features
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12.17 Govee Lighting +

Govee produces a wide variety of products that are focused on lighting. Typical are LED strips. Primary
automation access is via the Cloud per the published APl Version 1
https://developer.govee.com/reference/control-you-devices . Secondary access is local using UDP. UDP
control is limited to Power, Color, Brightness, and Color Temperature. Secondary (LAN) control also
needs to enabled from the Govee smartphone App. Refer to https://app-h5.govee.com/user-
manual/wlan-guide to assess if your product has LAN control capability and the process to enable it.

mcsMQTT will evaluate if LAN control is possible, issue the command via the LAN, monitor for returned
status, and if a failure will revert to control via the cloud for the specific command attempted.

The Govee cloud server provides setup information and that is what is used by mcsMQTT to create the
HS Device and Features.

Setup is from the mcsMQTT Cloud Page, Govee Tab as shown in Figure 207. The required Govee API
Token is obtained from the Govee Smartphone App as described at the start of the above Govee API
link.

Govee places a limit of 10,000 calls to their server per day. Each device in the account needs to be
separately polled for status so if there are two devices then the polling rate is reduced by 50%. Polling
values of 10000 milliseconds for one device, 5000 milliseconds if two, etc. There is no limit on LAN
polling and 5 second interval has been implemented in mcsMQTT.

When polled only some of the properties are updated, but when controlled the status update for the
controlled property is updated. This implies that if external control, such as with App, is done then HS
may not be aware of this action. It appears that only those properties that have LAN control will have
status updates when polled. Effects/Scenes, for example, are not updated in status polling for the light
strip being used for testing.
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H G-FI_‘_I ESEE[‘ H54 Web Control

Devices Events Cameras~ Setup Tools~ Plugins -

UIRL Yaolink Vioice Maonkey GeoFence Sense Hubspace Switchbat Tank Litility

Poal Govee

Govee

Govee AP1 Token ab159bd9-49da-4015-b559-7e24171d96b9

Govee Devices Request Govee devices from account

Govee Polling Rate (millizeconds) &O000

Connect to Govee Server )

Govee Disconnect
Disconnect from Govee Server ()

Figure 207 Govee Setup

HS Devices are created on plugin start and can also be done via the Request Govee Devices button. The
Features and properties are disclosed in the data received from the server so each model of product will
have a specific definition and the appropriate Features will be created. Those for the basic light strip
model H615C are shown in Figure 208. Once created, they will not be recreated. Use of the Obsolete
mechanism for all or selective properties can be used to remove existing Features and have them
recreated.

The polling can be stopped and restarted with the Disconnect radio.

When testing the H615C the only anomaly observed is that the Brightness is specified as percentage in
the range of 1 to 100. When controlling Brightness, it appears the control range is 1 to 25 while status
reported is 1 to 100. The plugin will be updated if other models also exhibit the same behavior.
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H O‘Fﬁ €Seer HS4 Web Control & default -

Devices Events Cameras~ Setup Tools~ Plugins~ _ SEARCH
o | oo oo X o w——Y-1-1-1"

Govee | HB15C
Govee-H615C-BB.39.60.74.F4.A0.1C... (1267)
@BB.39.6U.74‘F4‘A0.1C.AE:onI‘\ne-onIine (1268) Online Today 2:43:56 AM
BB.39.60.74.F4.A0.1C.AE-powerSwitch (1269) on Today 8:19:28 AM “ OFF
o BB.39.60.74.F4.A0.1C.AE-brightness (1270) 84% Today 2:30:06 AM [ ]
°BB.39.60.74‘F4‘A0.1C.AE-culnngb (1271) 7827989 Today 81927 AM
oBB.39.6U.74‘F4‘A0.1C.AE-coIanemperatureK (1272) 6839°K Today 2:46:53 AM [ ]
@BB.39.60.74‘F4‘A0.1C.AE-musicMode-musicMode(12?3) Sprouting Todsy 8:06:08 AN
° BB.39.60.74.F4.AD.1C.AE-musicMode-sensitivity (1274) 3% Today 7:54:09 AM L]
BB.39.60.74.F4.A0.1C.AE-musicMode-auteColor (12758)  on Today /:50:38 AM “
oBB.BQ.GU.?‘I,F‘I,ADJC.AE-musil:Mnde-rgb (1276) 1639542 Today 8:04:52 AM
@BB.39.60.74‘F4‘A0.1C.AE-Iigh\Scene 1277) Sleep Today 8:19:43 AM Sleep :
@ BB.39.60.74.F4.AD.1C.AE-diyScene (1278) off Today 2:29:38 AM

Figure 208 Govee HS Device and Features

The API provides for event-based updating for what looks to be oriented to appliance-like products with
events such as ice maker out of ice. There were no events reported for control of the light strip. If one
desires to obtain these event notifications then a connection to the Govee MQTT Broker is needed. The
parameters to be setup on the MQTT Page, Broker Tab are:

Broker IP ... mqtt.openapi.govee.com

Broker Port ... 8883

Security ... TLS1.2

Username ... the same APl Token used on the Cloud Page setup
Password ... the same API Token used on the Cloud Page setup

Note that these will be enter as an additional Broker where semicolon is used to separate the values for
each Broker.

Event data will be visible in the MQTT Page, Association Tab table and should be on Sub Topic of GA/#.
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13 Interactive

The Interactive page provides a means to interrogate variables, execute expressions and send messages
similar to the MQTT Send Message event action.

Any expression that is supported by mcsMQTT can be used. This includes all the HS replacement
variables using syntax SSX: or $SX:(Y):. The first are replacements without parameters such as TIME. e.g.
SSTIME:. The second is for those that have a parameter such as DTR. e.g. SSDVR: (123): [ no space
before (]. If the result is a string rather than a number then encase in quotes. This will be the case for
TIME so the first example should be "SSTIME:". Another example is "SSDTR: (123):".

Expression and functions can be used such as SIN(SSDVR: (123): + MOD(5,2) to use it as a HS-oriented
calculator.

When sending messages and an expression is desired the use the << and >> symbols to encase the
expression. This is shown in Figure 209.

Two forms of interactively working with the HS object are provided. One is a command line format that
can be an expression. It will be much like the immediate script command event action provided by HS.
The other is to run an existing script command located in the \scripts subfolder of HS and interactively
include input parameters to the script. The full syntax in the textbox is script filename, functionname,
parameter. If the script has functionname of “Main” and no parameters being used then simply enter
the name of the script file. Examples are:

Test.vb,Main,1 pass a number

Test.vb,ArrayMain,{1,2,3} pass array of integers as the parameter
Test.vb,StringMain,”1,2,3” pass a string

Test.vb no parameters passed and function name is Main

Function Main (Parm As Object) as Object
hs.Writelog("Script", "FunctionTest")
If isNumeric (Parm) Then
Return "Number " & (11 + Parm) .ToString
Elseif isArray(Parm) Then
Return "Array " & Parm.Length.ToString
Else
Return "String " & Parm
End if
End Function

Figure 209 shows use of replacement variable DVR to get access to the DeviceValue as well as using the
hs.DeviceValue method for the same purpose. Both use the same expression of summing the two
devices values. Result & Feedback boxes show the result of both interactive methods. If a script does
not return a result or an error occurs running the script, the feedback will be “null”.
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Figure 209 Interactive Page
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14 StreetMap (HS4 Only)

Two capabilities are provided by mcsMQTT that utilize the data feed from OwnTracks or NextTracks that
provides location information for smartphones. The first is to augment the data feed with Distance and
Here-Away indication. The HS location is always available so the Here-Away normally can be used for
Home vs. Away indication. Additional locations that identify the center of another geofence can be
added on the Cloud Page, Geofence tab.

The second feature is available on HS4 only. It provides a browser page with a street map view that
identifies the smartphone locations on the map.

14.1 OwnTracks Setup
The OwnTracks page provides a street map view of Android phone OwnTracks tracking App. OwnTracks
is available from the Android Play Store. Once installed it is setup in preferences to point to MQTT WAN
address of the MQTT broker being used by mecsMQTT. mcsMQTT supports multiple brokers so it is
possible to setup a WAN broker and LAN broker.

The OwnTracks App in your smartphone will send position updates to a MQTT broker. You setup the
IP/URL of the MQTT broker, a username and a password in the smartphone App. When using mcsMQTT
the easiest MQTT broker setup is the internal broker that shares the same IP/URL as Homeseer.
Anything can be entered for the username and password. There is no setup to be done on the mcsMQTT
side other than was exists as the defaults. If you want you can enter the same username and password
on the MQTT page, Broker Tab, Broker Username and Broker Password text boxes to improve security,
but it is not required to achieve functionality.

The smartphone needs a way to get through your firewall on port 1883 so you need to make this
happen with your router. The IP/URL that you use for the MQTT Broker needs to be visible on the WAN.
This means you cannot enter something like 192.168.1.100, but use a DNS name such as myHome.com.
If you do not have your own domain then you need to use a service such as no-ip.com or if you have a
web camera, they often provide the DNS service. ASUS routers also provide this service.

The smartphone will push position changes to the MQTT broker, which in this example is mcsMQTT.
mcsMQTT will show what the smartphone has provided on the mesMQTT MQTT Page, Association tab.
Anything on that page can be mapped into HS devices with the "A"ssociate checkbox. Lat and Lon are
typically what is of interest.

In summary

1. Setup a DNS service and firewall so your Homeseer computer can be accessed from the WAN on port
1883. As an alternate use a public WAN MQTT Broker. | think HiveMQ is one, but | have no particular
experience with this one or other MQTT Broker in the cloud.

2. Install mesMQTT plugin for HS4

3. Install OwnTracks on smarthone and configure it to use the DNS name of Homeseer computer and
any username and password

4. Repeat step 3 for your second smartphone

5. Navigate from HS Menu to mcsMQTT MQTT Page, Association tab and observe table Lat and Lon rows
and click "A" column checkbox on each to create HS device and features.
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6. If you want to observe a street view map of the location of your smartphones then navigate to
mcsMQTT plugin, StreetMap page.

OwnTracks has multiple modes of reporting so that battery drain is minimized. The highest resolution is
for movement. The lowest resolution is for major changes. When the movement threshold has been
reached (based upon mode being used) a MQTT message is delivered with new Lat and Lon coordinates.
These will be visible on the Association Tab of the MQTT page such as shown in Figure 210.

Association Table for Auto Association of MQTT Topic and HS Device

] [ a ref payload i lastdate

0 | 0 | 7693 owntracks/mesSolutions/M1
| 0 | | Sub: owntracks/mesSolutions/M1:_type ocation |
. Sub Ks/mesSol M 20210527
2 D D D D Sub: owntracks/mesSolutions/M D 11-16:49
20210527
a D D D D Sub: owntracks/mesSolutions/M1:alt 117 D 1116:49
i
20210527
4 |:| D |:| |:| Sub: owntracks/mesSolutions/M1:batt |:| 11-16:49
-16:4
2021-05-27
5 0 0 0 0 Sub: owntracks/mesSolutions/M1:bs 0 11-16:49
i
20210527
&1 D D D D Sub: owntracks/mesSolutions/M1:conn D 1116:49
i
20210527
7 |:| D |:| |:| Sub: owntracks/mesSolutions/M1 :created_at 66 |:| 111649
64
Dev: owntracks|mesSolutions|h1:lat
Sub: owntracks/mesSolutions/M1:at
7605 Pub: the following Topic on Device cormmand 2021-05-27
0 0 0 695 J O O 11:16:49
Dev: owntracks/mesSolutions|Mi-lon
Sub: owntracks/mesSolutions/M1:don
g - Pub: the following Topic on Device cormmand e T T 2021-05-27
0 O O AaEERO O O nase
20210527
10 D D D D Sub: owntracks/mesSolutions/M1:1 p D 1116:49
L
20210527
1 |:| D |:| |:| Sub: owntracks/mesSolutions/M1:tid M1 |:| 1116:49
M L
20210527
12 0 0 0 0 Sub: owntracks/mesSolutions/M1:tst 622001353 0 11-16:49
L
20210527
a D D D D Sub: owntracks/mesSolutions/M1vac D 1116:49
L
4 | 0 | | Sub: owntracks/mesSolutions/M1:vel |

Figure 210 Owntracks MQTT Report for Android Phone

14.2 Street Map Browser Page (HS4 Only)
mcsMQTT knows that a street map visibility is desired when the “:lat” JSON item is associated wth a HS
device. Normally one also Associates the “:lon” item so the postion coordinates are available in HS
Devices.
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To view the street map, use the StreetMap page from the mcsMQTT plugin menu. When this page is

viewed and a new MQTT message is received with a change in Lat or Lon then the page will be refreshed

to show the new position.

HomeSeer

Devices Events Cameras = Setup Tools~ Plugins =

Add
Assocations | Edit/Add )

Installed

Filter T4
mcsMOTT MOTT
Displayed Checkbox Columns Local
Cloud
Rejected Selections
Stresthap
Accepted Associations
DoC

Outbound Selections

Figure 211 mecsMQTT Plugin Browser Page Options

Figure 212 shows an example of display for two Android phones. The “@” symbol starts at the reported

position. The Id setup in OwnTracks App (and is used as the last element of the MQTT Topic) is also
drawn to identify the specific phone.

The Map is scaled so that all phones are visible. If they are close then the map will span a few hundred
feet. Itisrescaled as the separation between phones changes.
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Figure 212 OwnTracks Display Page

14.3 Geofence Here-Away Tracking
mcsMQTT will calculate the distance from a smartphone to the center of a geofence locations and then
use these to assess if the smartphone is inside or outside the geofence boundary. The information will
be included in the owntracks topic such as shown in Figure 213. In this example there are two geofence
locations, named HS and Home, setup on the Cloud Page, Geofence tab. Each will have a JSON key of
Distance and HereAway.
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T3 T4
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Association Table for Auto Association of MQTT Topic and HS Device

O NN N T A N I I T

o000 174 owntracks/mecsSolutions/M2
N w| wl | 0 Sub: owntracks/mesSolutions/M2:Home:Distance 159339 - 2021-08-23 15:18:11

Dev: owntracks|mesSolutions|M2:Home:HeraAway
Sub: owntracks/mesSolutions/M2:Home:HereAway

<!
3
i

I

20 0 ™ 175 Pub: the following Topic on Device command BT o H O 2021-08-23 15:18:11
300 00 0 [ ] sub: owntracks/mesSolutions/M2:HS:Distance 246 O 2021-08-23 15:18:11
Dev: owntracks|mesSolutions|M2:HS:Herefway
- p— Sub: owntracks/mesSolutions/M2:HS:HereAway . - .

4 L [ Pub: the following Topic on Device command FE= = = & |
O o 0 [ ] Sub: owntracks/mesSolutions/M2:lat 4749323 [ 2021-08-23 15:18:11
oo o0 [ ] sub: owntracks/mesSolutions/M2:lon a7z [0 2021-08-23 15:18:11

A0P0 1 [ ] sub: owntracks/mesSalutions/Mz:vel 1 D 2021-08-23 15:18:11

Figure 213 Geofence Topics

Any or all of these can be associated with HS Devices. In this example the two HereAway devices are
created with HS status reflected as shown in Figure 214.

owntracks | mesSolutions

ﬂ owntracks-mcsSolutions-M2 (174) Today 318:54 FM
M2:Home:HereAway (175) Away Today 3:18:54 PM
@ M2:HS:HereAway (176) Here Today 3:18:56 FM

r B -

Figure 214 Geofence Presence Devices
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15 Bluetooth Low Energy (BLE) Page (HS3 Only)

HS3 supports two modes of BLE operation. One is for purpose of determining Home vs. Away for a
beacon. This is the same capability provided in HS4 on the Local Page, Bluetooth tab. HS3 plugin also
supports a more extensive implementation that uses multiple BLE receivers for purpose of placing a
beacon on a X/Y grid. Onley one of the two modes can be used at the same time. The following
paragraphs describe the location identification mode of operation. See the Local Page, Bluetooth tab for
Home-Away mode of operation.

The mcsMQTT support for BLE is intended to provide location information of devices that contain BLE
capability. It can be used for presence detection of location identification. The BLE scanner(s) being
supported is described in Section 20.16.

BLE is often used in smartphones, fitness bands, smartwatches, audio equipment and tracking beacons.
The BLE protocol provides a means for one BLE device to request that other BLE devices advertise their
MAC address. In the Section 20.16 implementation ESP32 devices will periodically make this request
and the ESP32 will then listen for the MAC addresses that are advertised. After signal processing by the
ESP32, information on changes in advertised locations are published via MQTT. mcsMQTT will provide
the visualization and HS interface for this information.

The BLE MAC address is a crucial element for the tracking beacon and the ability of devices such as
fitness bands to recognize what or who is reporting. For smartphones the MAC address presents a
security concern so the MAC address being advertised is usually randomized to protect the identification
of the smartphone at any given location.

While discrimination of specific smartphones is not possible, it is possible to determine if the MAC
address provided is from a valid supplier and if not then assume it is a randomly generated one and is
associated with some smartphone. The ESP32 can be configured to group all MAC addresses without a
recognized supplier into a single MAC so that presence can be reported. Location information, however,
will not be valid for the case of multiple smartphones being present.

15.1 BLE Page Description
The BLE page is selected from the HS menu under Plugins\mcsMQTT. It provides three tabs. One for
the setup and viewing of data from ESP32 microcontrollers that report beacon position information.
See Section 20.16 for the ESP32 side of the project which describes the algorithms employed and the
MQTT interface specification. The remaining two tabs are used for viewing bubble charts that show
beacon locations. One is for current location of all beacons and the movement of a beacon over the last
24 hours. These charts can also be viewed as popups or created on-demand via HTTP requests.

The architecture of the system consists of multiple ESP32 each running the BLE scanning function. The
ESP32 will exchange information about the beacon measurements each is making. They will each
calculate the distance a beacon is from itself based upon the RSSI measurement. It will communicate
this distance to all scanners. Each scanner will calculate the beacon location based upon the distance
radius from each scanner. Since all scanners have the same information the location calculation done by
each scanner will have the same X,Y result. There are timing differences that will cause slight variance in
each calculation. For final location reporting a master scanner is selected. All scanners will report the
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same beacon location as computed by the master scanner. Should the master scanner go offline then a
new master will be determined.

In addition to (X,Y) coordinates on a 100 ft by 100 ft grid, the scanners also report a Figure Of Merit
(FOM) and a Zone. The FOM is an assessment of the quality of the location determination and will range
from O up to 49.

A FOM of 0 will indicate that the beacon is no longer in range of any scanner.

A FOM of 11 indicates that a beacon is in view of exactly one scanner. The beacon (X,Y) will be
the location of the detecting scanner.

A FOM of 22 to 39 indicates that at least two scanners view the beacon, but the range radius is
too small to have overlapping radius of three scanners. The last digit of the range is the FOM is
the number of scanners that view the beacon. In these cases, a weighted average algorithm is

used to assess a position somewhere in the middle of the beacons that detected the beacon.

A FOM above 33 indicates that trilateration can be done to compute the (X,Y) location of the
beacon. Again, the last digit is the number of scanners that can detect the beacon. The location
will be determined by a set of three scanners that have overlapping distance radius from the
beacon.

The Zone is a single number computed as 100 * X + Y coordinate of the beacon. Itis intended to be
available for use in detecting a beacon that has moved. Hysteresis is applied to the Zone value so that it
will not change with small changes in X or Y. This makes it a good event trigger.

15.2 Getting Started with BLE
There are two major components to the BLE scanning system. One is the MQTT infrastructure that
supports the mcsMQTT Plug-in. Sections 2 and 3.1 contain information to setup this piece.

The second is the ESP32 that will need to have the firmware installed that was developed to perform the
BLE scan function. Source that was developed based upon a branch of Tasmota using Platform 10 and
VS Code. This environment provides for compilation and downloading over USB serial. The files of
interest are at http://mcsSprinklers.com/ESP32_BLE_BinaryAndLoader.zip (1 MB) binary application,
bootloader and partition table http://mcsSprinklers.com/BLEScanner.zip (75 MB) ESP32 source from
PlatformlO folders. Updates to the original uploads are at
http://mcsSprinklers.com/ESP32BLEScanner.zip for binary and
http://mcsSprinklers.com/BLEScannerSource.zip for source.

The firmware can also be installed from a precompiled binary using the tools provided by Espressif at
https://www.espressif.com/en/products/hardware/esp32/resources . Select Tools and “Flash
Download Tools”. Unzip to a folder, run the .exe and select ESP32 button. A panel shown in Figure 215
will appear. On the top row navigate to the binary to be downloaded. The partition used for the
firmware is 0x10000 so enter that at the end of the first row. The same zip file contains two additional
.bin files. One is the bootloader and the other is the partition table. Add these in subsequent rows with
addresses 0x1000 and 0x8000 respectively. Use checkbox on the three rows. Select the COM port at
the bottom of the panel. Click first the ERASE button to clean any prior data from the flash. Click START
button. Download will occur with progress bar at the bottom and info about the chip populated in the
text boxes on the panel. It takes a few minutes. The button shown as IDLE in green will change to
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FINISH when done. Only the first file is needed so uncheck the row 2 and row 3 checkboxes if firmware
is loaded later. If the ERASE button is used again then all three are needed to be downloaded.

SPIDownload | HSPIDownload | RFConfig = GPIOConfig | MultiDownload |

SpiFlashConfig
— FLASH SIZE
CrystalFreq : [C] SpifutoSet
() BMbit "
[7] DoMotChgBin
) 16Mbit
SPISPEED SPIMODE LOCK SETTINGS
@ 32Mbit
@ 40MH ®
©) 40MHz © Qo P DETECTED INFO
) 26IMHz © QOUT flash vendor;
= . C8h: GD
2 20MHz @ D10 flash deviD:
) 80MHz ) DOUT 4016h
@ FASTRD QUAD:32Mbit
crystal:
40 Mhz

Download Panel 1

FINISH AP: 30AEA42345E5 STA: 30AEA42345E4
- BT: 30AEA42345E6 ETHERNET: 30AEA42345E7
3

COM:
START || STOP H ERASE ‘ coMe M

BAUD: (135200 -

Figure 215 Espressif Flash Download Tool

Start up a terminal program such as Termite and connect to the same COM port as used for the flashing.
Termite is at https://www.compuphase.com/software termite.htm.

Cycle power on ESP32 or use its reset button on the circuit card. A startup sequence will show such as
Figure 216. There are three items of particular interest. The first is the group topic BLEScanners shown

at the end of the Project line. The second is the MQTT topic that shown as BLEScan/0. The IP will be
needed to access ESP32/Tasmota via browser.

If the IP is not shown then the SSID and password are needed. At the bottom of Termite page is a text
box to enter data to be sent over the serial connection. The commands that can be used are at
https://github.com/arendst/Sonoff-Tasmota/wiki/Commands. In particular the SSID and PASSWORD
commands. | use the backlog command to consolidate these two into a single line. This is shown below
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“w.n

where ???? will be replaced by your specific WiFi network credentials. The “;” in backlog command is
used as a command separator.

backlog SSID ????; PASSWORD ????

The ESP32 will restart and the startup will be displayed on the serial terminal again. Note the IP address
assigned by DHCP server. One can also go to their router or other mechanism to identify the IP address.
Use a browser with URL at this IP to complete the setup.

ets Jun 82016 00:22:57

rst0x (POWERON_RESET). hoot:01 3 (SPI_FAST_FLASH_BOCOT)
configsip: 0, SPIWEP:Dxee

clk_drv: 000, g_drO0x00,0_drw: 000,250 _drv:0x00.hdd_drv:0x00wp_dre: 000
modeDI0, clock divi2

load:0x3fff0018.len:d

load: 0001 clen1 100

load:0x40078000.len:9232

load:0x40080400,len:E412

entry 40080628

00:00:00 APF: Set Baudrate to 115200

00:00:00 Project BLEScan BLE Scan (Topic BLES can/0, Fallback DWES_00000000/0, GroupTopic BLEScanners) Yersion 5.12.0c-5TAGED

00:00:00%WIF: Connecting to AP1 U in mode 11

00:00:06 WIF: Connected

00:00:06 DN Initialized

00:00:06 HTF: YWeb server active on BLEScan/0-3632 local with IP address 192.168.0.253

00:00:06 MQT: Attempting connection...

00:00:06 MOT: Connected

00:00:06 MOT: BLEScan/0/LWT = Online (retained)

00:00:06 MOT: BLEScan/0jcmnd/POWER. =

00:00:06 MQT: BLEScan/0INFOT = ["Module""WEMOS" "ersion""5.12.0c" "Fallback Topic":"DVES_00000000/0" " GroupTopic":"BLE Scanners", "UTimers""8"}

00:00:06 MOT: BLEScan/0/INFO2 = "WebSersertode""Admin","Hostname""BLEScan/0-3632" "IPAddress""192.168.0.263"

00:00:06 MOT: BLEScan/0/INFO3 = {"RestatReason""1"}

00:00:06 MOT: BLEScan/0/CONFIG = {"Location":{""0,"":0L"Filter" {"RIZ""0"."~"0,"Zone":0,"Dropout”: 4}, "Management" {"ReceiverGain"100,"Scanlnteryal":60." Scanl
00:00:06 MQAT: BLEScan/0fSTATE = {"Time""1970-01-01T00:00:06","Uptirme":"0T00:00:18", "Wifi":{"AP"1,"SS1d" "U" "R S 62, "APKac" "78:84:20:84:458:10", "UTimers":8}

Figure 216 ESP32 Startup Log

It may also be possible to establish the connection using WPS, but | have no experience with this
approach.

Select the Tasmota Console button which will provide an interface similar to the serial one. The scanner
ID is a number between 1 and 10 needs to be specified. This is done with command like:

ScannerlLocation 1,10,20
Where 1 is the ID and 10,20 are the X,Y coordinates on the 100x100 grid that the ESP32 will be placed.

The ScannerLocation command can be entered on the terminal program (e.g. Termite) rather than at
the Tasmota Console. No particular advantage of using one vs. the other, but the next step is to
configure Tasmota so a browser connection is needed.

15.2.1 Tasmota Configuration
The BLE Scanning operation is affected by the setup of the following Tasmota pages:

Configuration : ConfigureModule - No Effect on BLE scanning. Other modules functions should be able
to be selected to extend the capability of the ESP32 to more than BLE scanning.

Page 360



Configuration : ConfigureTimers — No Effect.
Configuration : ConfigureWifi — Needs to be setup but no direct implications to BLE scanning.
Configuration : Configure MQTT — Needs to be setup but no direct implications to BLE scanning.

Configuration : Configure Logging — When Serial or Web log level is set to “3 Debug” then the scanning
report of which beacons were found in the last scan will be shown on the Console. Telemetry period
defines the interval when the scanner CONFIG and beacon Characteristics messages will be published.
They will also be published on a change.

Configuration: ConfigureOther : The friendly name does not affect the BLE scanning operation, but it is
useful to set it so access to a scanner can easily identify which scanner is being accessed. In my case |
use the scanner ID so a friendly name may be something like “BLE Scan 3”.

Information — No Effect.

FirmwareUpgrade — Convient way to update the firmware vs. using the serial connection. | have had
mixed results with sometimes it works, sometimes | get a timeout and sometimes it tells me that the
image is too big.

Console — Used to interact with a single scanner. The additional commands described in Table 7 can be
used via the Console.

Restart — No Effect.

15.3 Tips
MQTT topics are formed from the friendly name of the beacons. This means that all scanners need to
have the friendly names set for a proper exchange of information and collection of data by mcsMQTT.

It is easier to collect beacon names and then remove the ones that are not of interest rather than trying
to catch a particular beacon. The general sequence is to have the BeaconDisable set false (0), collect
beacons for several minutes until you are certain that all have been seen and the beacon info exchanged
among scanners. Set BeaconDiable true (1) to prevent other beacons from being recognized. Look at
the beacons that have been observed by each scanner on the Beacon Location table. Click the R(emove)
checkbox followed by the column header button to send the BeaconRemove command to the scanners.
What will remain is just the beacons of interest.

RSSI measurements have fluctuation so cannot be considered to be very accurate for distance
measurement. Use of the Kalman filter will tend to improve the accuracy, but still movement of the
beacon to a different distance may not always result in much of a RSSI difference.

If all scanners and beacons are placed at the same location the variance in RSSI measurements can be
observed. If one scanner appears to be out of whack vs. the others then the ScannerGain can be
adjusted for it. Use the Distance measurement on the Beacon Locations table to observe the effect of
changing the gain.

Location identification is done by different algorithms depending upon the quality of the measurements
being received. A good location will be identified when three scanners have intersecting distances from
the beacon. If, for example, all beacons distances make it appear the beacon is close to each scanner
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then the distance radius will not overlap. This means that when tuning the beacon distances, one
should error in making the beacons appear further rather than being closer. For example, if the RSSI at
1 meter fluctuates around 60 and 70 then select a calibration reading closer to 60.

Don't worry too much about maximizing the availability of the trilateration algorithm. The Figure of
Merit in the 20’s uses the weighted average or sometimes called triangulation algorithm. It will produce
reasonable results.

All BLE data should be tagged for Express mode processing unless there are special other needs for the
data. There can be considerable MQTT traffic and Express mode minimizes the processing time to
handle each received message.

15.4 Setup Tab
The setup tab contains tables for configuration of the ESP32, their status and the viewing of the beacon
data. A table also exists to manage the viewing within the setup tab and a pair of buttons for facilitate
actions.

When setting beacon parameters from the mcsMQTT BLE Setup tab the entered values will be sent to all
ESP32 scanners. If updates are desired to only one scanner, then the commands should be entered on
the Tasmota Console page per the new command definitions in Table 7.

15.4.1 Page Viewing Options

The page viewing options are shown in Figure 217.

The beacon current location chart is shown on the second tab on the BLE page. It can be generated on
demand using the button provided on that tab. It can also be generated and updated automatically as
long as the BLE page is open. The “Auto Update of Beacon Location Graphic” checkbox enables the auto
update. The negative side to auto update is the CPU resources used, but this should be minor unless
considerable beacon motion is occurring or filter parameters are setup such that noisy behavior exists in
the location determination.

Page Viewing Options
Auto Update of Beacon Location Graphic [Update Beacon Chart when Beacon Zone Changes

Show Only Status
Beacon Locations Table Verbosity Show Status and Beacon Parameters
* Show All Information
Beacon Locations Table Display Reject Override  []Show beacons checked in H column of Beacon Location table

View Beacon Info from Scanner Selected Stop Updates @1 4 5

Figure 217 BLE Setup Tab Viewing Options

The beacon table is organized with one row for each beacon and a number of columns that contain
information about the beacon. In its most austere format, the columns will show location information.
Additional columns can be shown to include the text boxes to setup the transmit power calibration of
each beacon. The most verbose format includes the RSSI information to assist with setting up the
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Kalman filter parameters. Once created, the Beacon Location table, will generally not be updated as
new data is received from the scanners. The “Refresh Beacon Locations Table” can be used to refresh
the table with the most current reporting from the scanners.

The first column of the Beacon Location table is a (H)ide checkbox. Using this checkbox will exclude the
beacon from the display. This is a declutter function. All hidden beacons can be restored for display by
using the “Override” checkbox. Unless there are many beacons this function likely will not be used.

The Beacon table and the Parameters table is populated with data from one scanner. The scanner’s
data that is to be used is selected with the “Selected Scanner” radio. As the radio selection is changed
the Beacon Location and Parameters tables are automatically updated. The Parameters table is updated
in real time. Selecting the “Stop Updates” option will prevent the table entries from being updated as
one is trying to make changes to the parameters for subsequent publishing. After the desired changes
are made then a specific scanner should be selected so the data in the tables is a reflection of what is
being provided by the ESP32.

15.4.2 Configuration Parameters Table

The Configuration Parameters table is shown in Figure 218. Its primary function is to view the settings
that exists within the ESP32 and provide a mechanism to change them. The data values in this table are
updated based upon the MQTT CONFIG topic that is published periodically or upon a change of a
parameter. The specific ESP32 scanner being viewed is selected from the Viewing Options table as
described in Section 15.4.1.

It should always be the case that all ESP32 scanners are using the same configuration parameters. All
the configuration parameters, including those in the Beacon Location table, can be publish to all online
ESP32 scanners using the “Publish all Scanner and Beacon Parameters” button on the Setup tab.

Normally this button is not needed unless a new ESP32 is being brought online and you want to set it to
have the same configuration as the others. For ESP32 that have already been setup then and just
individual parameter is to be changed then when the change is made in the Configuration Parameters
table then it will be published to all ESP32 scanners.
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Configuration Parameters

BLE Scanner Group Topic (e.g9. BLEScanners) |[BLEScanners Change only used within mcsMQTT
BLE Scanner Root Topic (e.g9. BLEScan) BLEScan Change only used within mcsMQTT
BLE Scanner Scan Interval (seconds) 60 Change will be published to ALL scanners
BLE Scanner Scan Duration (seconds) 30 Change will be published to ALL scanners

® ' Publish on every scan
Publish on change in beacon X or ¥

BLE Scanner Reporting Frequency Publish on change in zone

Change will be published to ALL scanners

Beacon RSSI Measurement Error T Change will be published to ALL scanners
Beacon XY Measurement Error 0 Change will be published to ALL scanners
Beacon Zone Hysteresis 5 Change will be published to ALL scanners
Beacon Dropout Count 4 Change will be published to ALL scanners

Retain new beacons found in scan
Beacon New Discovery Disable ® Ignore new beacons found in scan
Change will be published to ALL scanners
REMOVEALL REMOVE UNNAMED
Change will be published to ALL scanners

®! Auto-Select 1 4 5
Change will be published to ALL scanners

Multiple Beacon Removal

Master Scanner Selection

* Do not use retain flag when publishing configuration parameters

MQTT Retain Usage Use retain flag so MQTT broker will retransmit each time a subscribed client reconnects
Change will be published to ALL scanners

Figure 218 BLE Configuration Parameters Table

The top two rows of the Configuration Parameters table are not transmitted to the ESP32 scanners.
They are used to tell mcsMQTT the Group and Individual topics recognized by the ESP32 scanners.
While these can be changed from the defaults of BLEScanners and BLEScan, there is no need. ltis
necessary that what is reported by the ESP32 is the same as what is setup in mcsMQTT so it there is a
change then make the change in both places. The ESP32 will suffix the base topic with the scanner ID
for the individual scanner topics. Tasmota is configured with the same topics used here. The ESP32 will
suffix the individual topic with the ID of scanner. When one looks at the topic published by the ESP32
they will see something like BLEScan/1 where 1 is the ID of this scanner.

The Tasmota console or a serial terminal such as Termite is used to define the ID of each scanner
individually. The command is “ScannerLocation ID,X,Y” where ID is a number between 1 and 10, X is the
grid X coordinate and Y the Y coordinate where this ESP32 scanner is located. These coordinates are on
a 100 ft by 100 ft grid.

Most of the remaining parameters are just a user interface to setup the ESP32 parameters per the
protocol defined in Section 20.16.5.

The Scan Interval and Scan Duration parameter define how often a scan is performed. 60 second
interval and 30 second duration are the values used in the prototype written to evaluate the function.
Longer durations allow infrequently reporting beacons to be more easily detected. Shorter durations
improve the responsiveness of the location determination.
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Reporting frequency is to manage the MQTT traffic based upon what is useful. Every scan will resultin a
new calculation iteration. Any change in distance between the scanner and beacon will be sent
following the scan. This is used by the other scanners to maintain coordination of all distance
information being collected. Other information about the beacons and the calculations will be sent
periodically at the log rate which is typically every five minutes. They can also be sent more often based
upon a change in (X,Y) or change in Zone. This extended information is intended for other clients such
as mcsMQTT when one is trying to view more deeply into the execution of the ESP32 scanner.

When assessing the location algorithms within each ESP32 scanner it may be helpful to select a specific
scanner to be a master. Only the master’s (X,Y) and Zone are reported via MQTT. After the
investigation is complete the master should be restored to auto-select to allow the ESP32 to determine
the healthiest scanner to be master.

The next four rows of the Configuration Parameters table set the filtering parameters to reduce noise in
the location determination. See Section 20.16 for a better understanding of the contribution of each
parameter.

Beacon New Discovery as well as the Blacklist the Remove provisions in the Beacon Locations table are
used to manage spurious or obsolete beacons. Beacons that are not of interest should be removed to
avoid the MQTT traffic that is of no interest. Once all beacons of interest have been identified then the
New Discovery should be disabled.

The removal of individual beacons can be done from the Beacon Locations table using the (R)emove
column checkboxes. They can also be done in group using the one of the two Multiple Button Removal
buttons in the Configuration Parameters table. The REMOVEALL button clears out all the beacons info
from all scanners. The REMOVE UNNAMED removes all that have not yet been given a friendly name
and continue to use their address for topic identification. This second button will likely be the easiest
was to remove beacons that are not of interest. The process would be to first disable new discovery,
then to remove all the unnamed ones. What should remain are those that have been named so should
be just the ones of interest remaining.

The last parameter in this table is the MQTT retain flag. When mcsMQTT starts it will use the last
parameters that existed at the time of its prior shutdown. These may or may not be correct and will not
be updated until the periodic message is published from each ESP32. This is typically every five minutes.
When retain is enabled then the MQTT broker will hold the parameters published by each ESP32. When
mcsMQTT or any other subscribed client goes online the broker will provide the messages immediately.
Since each ESP32 also subscribes to data published by the other ESP32 scanners the broker will be
resending every time the ESP32 temporarily goes offline and then back online. One a message has been
retained by the broker it is a manual process to remove it.

15.4.3 Beacons Locations Table

The Beacons Locations Table serves the purpose of viewing and changing individual beacon parameters.
The table is shown in one of three formats depending upon the viewing option selected as described in
Section 15.4.1. Figure 219 shows the most verbose version.
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Hide | Remove | Blacklist | UnBlacklist Beacon Locations with Last 24 Hour Data Distance (ft)

TxPower TxPower RSSI Filt

HRBU Address Vendor Name Zone FOM 1 2 3 4 5 (X))

@1m @10m RSSI
LI 54:43:9f:d0:3f:23  Unknown 54-43-9f-d0-3f-23 | 60 100 -85  -85.00 3709 11 14 (37,9)
o] | Sci4e:ba:c9:9a:02 Unknown Sc-de-ba-c9-9a-02 | 60 100 -71  -71.00 3709 11 8 (37,9)
LI 5e:36:37:04:4b:bb Unknown Se-a6-37-04-4b-bb | |60 100 -1 -1.00  -101 0 -1 -1-1}-1-1 (-1,-1)
W] | ] | [ 60:14:1f:07:0e:b5 Unknown 60-14-1f-07-0e-b5 | 60 100 =i -1.00 -101 0 |11 -1-1|1[(1-1)
|- b0:91:22:F7:62:bF 1435 BlueCharm 50 100 78 = -78.00 3918 24 9 37 -1 35 37 (39,18)
Instruments
O O O [ dc:0d:30:47:02:09 i:;g::;: Feasycom 50 100 70 -70.00 3717 24 6 26 -1 41 13 (37,17)

Note that any change in Beacon Locations table except H column will be published to ALL BLE scanners
Figure 219 Beacon Location Table

Checkbox and textbox entries will result in the MQTT message being published to all scanners for the
updated (or refresh of existing) value. The leftmost H(ide) column checkbox only affects the displayed
page and does not affect the ESP32 scanners.

The R(emove) column will remove the beacon on the selected row to be removed from its flash
memory. The B(lacklist) column will mark the beacon as being inhibited from publishing status. The
(U)nblacklist column will undo the B(lacklist) column.

The Address column is the unique identifier for each beacon that is produced by the beacon during a
scan. The address is hyperlinked to a popup chart of this beacon’s location history over the past 24
hours.

The Vendor column will contain the results of a MAC database lookup. The database is in the cloud.
Three situations can occur with this. The vendor allocated the MAC address will be identified. The
second is that it is not found. In this case “Unknown” will be displayed. The third is too many accesses
have been made to the database in the allocated period. “Try Later” will be shown in this case. It will
be attempted again the next time the table is generated.

The Name column is used to give the beacon a friendly name. This name will become part of the Topic
that is publish for this beacon. An unchanged name will show as the MAC address with the colons
replaced by dashes.

The TxPower@1m and TxPower@10m entries serve as the calibration of the beacons transmit power
levels. The first is the RSSI when the beacon is 1 meter from the scanner. The second is the RSSI when
the beacon is 10 meters from the scanner. Some beacons will not have sufficient power to reach 10
meters so an estimate such as 100 (or -100) can be used. These can be adjusted as one learns the
behavior of the scanner/beacon relationship. The objective is to get reasonable distance measurements
from the RSSI reading. When making the measurements the RSSI filter should be turned off or set to a
small value as described in Section 15.4.2 so the distance reading will be sufficiently responsive to the
beacon position.

The next two columns show the RSSI reading and its value as it is filtered through the Kalman filter. In
the sample shown it can be seen that the RSSI and filtered RSSI are the same which is an indication that
the RSSI filter is turned off.

The Zone is a single number that can be used as a trigger. Small variances in the (X,Y) location will not
result in the Zone value change, but larger ones that exceed the zone hysteresis threshold (described in
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Section 15.4.2) will result in a change of the Zone. Note that the Zone is the value determined by the
master scanner. The other scanners just relay the master’s value.

The Figure Of Merit was previously described in the introductory Section 15. It provides a feedback as
the algorithm used and the number of scanners that are able to hear the beacon. Higher values
generally are better figures of merit.

X and Y are the calculated coordinates of the beacon. Like the Zone it is the value determined by the
master. Other scanners serve as a relay. This allows HS to see the same value no matter which scanner
happens to be the master at any given time.

The last set of columns are the distance measurements from all scanners for a given beacon. In the
example scanners 2 and 3 had not reported data in the last 24 hours so no information was available for
them. Distances are reported as -1 if no scanner has the beacon in range. In this example only scanner
5 had seen the first beacon in the last 24 hours and it no longer has it in range.

The address is a hyperlink that when clicked will pop-up the graphic that shows the 24 hour history of
the beacon. This is the same graphic that can be view on the 24 hour tab.

15.4.4 Scanner Location Table

The Scanner Locations table provides visibility into the scanners online status and the provisions to
setup its X,Y location as well as a factor to represent the receiver’s antenna gain. Figure 220 provides an
example showing three scanners.

The red highlight is an indication that the scanner is offline. In this case it is scanner 1. Because of this
offline status the other ESP32 have agreed to use Scanner 4 as the master for reporting the X,Y and
Zone.

The scanner location can be setup when the scanner Id is defined via serial or the Tasmota Console.
Alternately is can setup on the Scanner Locations table by entering the X comma and Y coordinates for
the desired scanner.

The receiver gain is nominally 100 percent. The gain can be reduced to make beacons appear closer.
This may be necessary if the scanner is partially blocked for RF. To make them appear at a greater
distance then the gain is increased. Greater distance has advantages in assuring that multiple beacons
will have overlapping radius thus improving the quality of location identification.

The scanner ID is a hyperlink that when clicked will popup the graphic that shows the current locations
of all the beacons that are currently in range of at least one scanner. This is the same graphic that can
be view on the Current tab.
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Scanner Locations

Scanner ID LWT XY Location Receiver Gain Selected for Master Scanner

1 Offline 37,9 100 Scanner 1
4 Online 58,5 100 Scanner 4
5 Online 20,30 120 Scanner 4

Mote that any X.Y change in Scanner Locations table will publish the change to the ONE changed scanner

Figure 220 Scanners Locations Table

15.5 Location Tab
The Location Tab contains the graphic of the beacon locations at the time the BLE page was produced. A
button exists at the top to manually regenerate the graphic. It is also possible to regenerate it
automatically when the Zone value changes. This is setup as shown in 15.4.1.

Figure 221 provides an example of the location of two beacons with respect to five scanners. The
beacons are circles and the scanners are squares. The diameter of the beacon reflects the number of
scanners that are able to hear the beacon. Larger size implies more scanners. In this example there
were two scanners that were hearing BlueCharm beacon and four were able to hear Fessycom beacon.
Beacons with a Figure Of Merit of zero are excluded from the graphic.

The scanners are labeled with their Id number. The beacon is labeled with its friendly name. There are
two other ways to produce this chart. One is to produce a popup by clicking on one of the scanner Id
number hyperlinks in the Scanner table of the Setup tab. A second is to create the chart on demand via
HTTP request such as:

http://192.168.0.14/BLE?Beacon=current

In this case the filename in the HS \HTML\mcsMQTT folder that contains the graphic will be returned
from the http request.
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Scanner & Beacon Locations

Feasycom

BlueCharm

Figure 221 Beacon Current Locations Graphic

15.1 Distance Tab

The Distance Tab contains the graphic of the beacon distance from each of the scanners at the time the
BLE page was produced. A button exists at the top to manually regenerate the graphic. Itis also
possible to regenerate it automatically when the Zone value changes. This is setup as shown in 15.4.1.

Figure 222 provides an example of the location of two beacons with respect to three scanners. The
beacons are circles and the scanners are squares. The diameter of the beacon reflects the distance from
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the scanner for the scanners that are able to hear the beacon. In this example there were two scanners
that were hearing BlueCharm (green) beacon and three were able to hear Fessycom (bisque) beacon.
While not shown on the graphic, the Figure Of Merit (FOM) was 22 and 23 for BlueCharm and Fessycom
respectively. The first “2” indicates that triangulation algorithm was used to identify location. The
second digit reflects the number of scanners able to hear the beacon. In the Fessycom case there were
three, but as the graphic shows that the distance circles do not intersect so triangulation rather than
trilateration was used to determine location.

The scanners are labeled with their Id number. The beacon is labeled with its friendly name and color
used to distinguish the beacons. There is one other way to produce this chart is with a chart on demand
via HTTP such as:

http://192.168.0.14/BLE?Beacon=distance

In this case the filename in the HS \HTML\mcsMQTT folder that contains the graphic will be returned
from the http request.
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Beacon Distance from Scanner

Feasycom

Figure 222 Beacon Distance from Scanner Graphic
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15.2 24 Hour Tab
The 24 Hour Tab contains a selector to choose among the beacon to show their location history over the
past 24 hours. To collect history data to support this graphic the History tab on the MQTT Setup page
needs to enable history data collection for at least one day.

No graphic is shown at time of BLE page generation. Once a selection is mode the graphic will appear
below the selector.

Figure 223 provides an example of the BlueCharm beacon with respect to five scanners. The beacon
positions are circles and the scanners are squares. The cases where the beacon overlays the scanner
position, such as the upper left scanner in this figure, is an indication that this scanner was the only one
that was hearing the beacon at that time.

The scanners are labeled with their Id number. The beacon is identified in the chart title. There are two
other ways to produce this chart. One is to produce a popup by clicking on one of the beacon address
hyperlinks in the Beacon Locations table of the Setup tab. A second is to create the chart on demand via
HTTP request such as:

http://192.168.0.14/BLE?Chart=BlueCharm

In this case the filename in the HS \HTML\mcsMQTT folder that contains the graphic will be returned
from the http request.
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BlueCharm (BlueCharm) Locations Last 24hrs

Figure 223 Beacon 24 Hours History Graphic
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16 Performance Considerations

mcsMQTT has the potential to manage a large set of data or it can be used in a very modest
environment. In the later situation it is likely that maximum user conveniences are made available. In
the former compromise may be needed to have a sufficiently responsive and CPU-considerate
operation.

16.1 HS Event Callbacks
mcsMQTT subscribes to HS callbacks for Device Value change or Device String change. If there are many
active HS devices then many callbacks could be generated and each evaluated to determine if a MQTT
Topic needs to be sent. mcsMQTT determines if a user has selected any Publish Value/Status and if so,
registers for the Value callback. It does the same for String. If at least one Device is mapped to Value
and String Topic publication then all changes in HS devices will be routed through mcsMQTT.

The callbacks are used to trigger publication of MQTT messages and to collect data for charting. If all HS
devices are selected the database will tend to grow large more quickly. The History tab selection for all
vs. only specific devices selected with Association tab D column checkbox will affect the database size
and CPU supporting this capability.

mcsMQTT maintains a queue of HS Event callbacks. In the callback it first assesses if the Device has a
publish Topic associated with it. If it does then it puts it in the Queue for later processing in an
independent thread. The Queue is processed until empty and then the thread is blocked until another
item is put in the Queue.

16.2 Express Mode
Express mode, selected on a Topic-by-Topic basis on the Association tab provides a means to update HS
devices based upon MQTT payload with a minimum of processing overhead. A CPU reduction of better
than 80% can be achieved for Topics identified for Express mode.

Express mode excludes the following:
e ability to store history of received messages with implications that charts cannot be made
e ability to use low pass filter on Device values, make rate devices or accumulate devices
e ability to store JSON content with parent and children devices grouped
e ability to map color x/y to RGB
e ability to collect VSP relationships after Topic selected as Express
e ability to refresh Association tab GUI payload and last change columns as Topics received

Express mode can be customized on the Client tab to include or exclude the following. There is little
CPU penalty for supporting these features, but if a feature is not used then some CPU savings can be
achieved by deselecting them on the Client Tab.

e decode JSON into separate HS devices

e use VSP text and color picker RGB to DeviceValue mapping
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e use regular and arithmetic expressions
e trigger HS events and script callbacks based upon received Topic

Table 4 shows a benchmark that compares Express mode vs. Full mode CPU utilization to process a
message with content shown for the Test Case. A RPi model 3 was used for the test. A test program
generated a MQTT message at 500 millisecond intervals. The time to process the message was
observed in the Statistics window and recorded. In general, the inclusion of additional features
supported in Express mode has a small effect on the CPU burden, but in situations of high MQTT traffic
these may become material.

During the analysis the most illuminating discovery is that almost all of the time for processing messages
was within HS following the calls to SetDeviceValue or SetDeviceString. When removing these calls, the
Express mode times were under 1 millisecond.

During Full support mode calls are made to get the HS device object (dv = hs.GetDeviceByRef) which
consumed 12 milliseconds and then each call that used the hs object as a parameter (e.g.
dv.Interface(hs)) used a similar time so working with the HS device object became expensive . In version
3.5.5.0 the use of the hs parameter was eliminated in favor of Nothing for the real time processing. The
assurance that DeviceString was empty for non-text devices was removed from the real time processing
and done during initialization. These steps resulted in a significant reduction in the CPU utilization for
Full support mode.

Table 4 Receive Message Benchmark for Full vs. Express Modes

Test Case V351 | V355 V3.5.5
Full Full Express
Support | Support | Mode

Incrementing Number 200 ms | 32ms 6 ms
VSP Toggle On / Off 200ms | 32ms 6 ms
JSON with 5 keys and 1 associated with HS Device 310 ms | 33 ms 6 ms

JSON with all 5 keys associated with HS Device (Number, Text, VSP) 510ms [ 142ms | 32 ms

Express Mode does not support Parent/Child grouping. If any item of a JSON group is selected for
Express Mode then all items of that group will be forced to Express Mode as well. The opposite occurs
for deselection of any item that was previously selected for Express Mode.

16.3 Subscription Topics
By default, mcsMQTT subscribes to all Topics serviced by the connected Broker. This is done by
providing the wildcard # as the template for subscription along with any special Topics that have been
manually entered which contain Broker statistics. When mcsMQTT starts, it will connect to the Broker
and the Broker will respond with a burst of messages that it is responsible to deliver to newly subscribed
clients. The Retain=true flag per MQTT protocol used by the various clients will increase the size of the
initial connection message quantity. As a minimum the Broker will deliver the LWT status of all clients.
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mcsMQTT maintains a receive Queue to deal with the flooding at initial connection and in general
control the peak CPU utilization during message bursts. Three user settings are available on the Client
Tab Inbound (Subscription) Section to tune operation of the receive Queue. It is likely that no tuning is
needed, but it is available. mcsMQTT will process a set of messages as a group and then yield the CPU
for a user-specified period and then resume the process until the Queue is empty. When the number of
messages received exceed the size of the queue then they are discarded and not included in the
statistics.

Visibility to help tune the parameters is provided at the bottom of the MQTT/Statistics Topics shown in
Figure 224. A current Queue depth near 0 will provide the lowest latency between message receipt and
update of HS Device. The max size will usually occur upon initial connection. The average processing
time measures the time it takes to update HS devices and evaluate trigger conditions for each received
message. The average receive milliseconds is the interval between each incoming MQTT message on
the average. These averages will be dynamic at startup and become stable as a large number of
messages are processed.

Page 376



Filter Association Table by Mqtt Topic and JSON Payload Key ‘Clear Filters Rebuild Fitters.
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Figure 224 MQTT Statistics

It is also possible to have the statistics reflect in HS Devices for other uses. This option is selected with
the “A”ssociate checkbox on the desired statistic. These devices will be grouped in a parent/child
association with the parent being “MQTT Statistics”. See Figure 225 as an example of selected statistics
mapped into HS.

Events triggered by a change in connection status can be done either using the mcsMQTT connection
trigger (See Figure 39) or DeviceValue change of the statistics online/offline Device.

The last statistic is the CPU utilization over the past 60 second interval and represented as a percentage.
It is possible to setup an event that monitors the CPU use of the plugin. It is the same as the statistic
reported as part of the HS pseudo-topic.
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MQTT | Statistics
B MQTT-Statistics (5597) Today 10:44:34 AM

) 192.168.0.30:0nline @ 2021-04-04 10:28:58 for  _ N
@) 12-Broker Connection Status(2) (5598) e oday 10:44:34 AM
0 Days 0 Hours 17 Mins 38 Secs
@ 2A-Publish Count (5599) 0
@ 2C-Receive Associated Count (5600) 0
@ 3A-Receive Associated Count Today (5601) 0
®4A—Last Published Topic (5602) Device Created

@ 4E-Last Received Topic (5603) IrrigationWater/SENSOR

@ 5A-Receive Queue Depth (5604) 0
@ 5B-Max Receive Queue Depth (5605) 0 Today 10:46:04 AM

@ 5C-AverageReceiveTime (5606) 40 Today 10:46:27 AM

Oo0ooooodoooono

@ 5D-AverageReceivelnterval (5607) 75571 Today 10:46:37 AM

Figure 225 MQTT Statistics in HS Devices

16.4 Plug-in Startup
During startup the Plug-in performs a two-pass initialization. The first pass covers those things that
need to be setup to continue communication with HS. When this is complete a new thread is spawned
to cover those things that are needed to completely restore the plug-in to its state at time of last
shutdown.

For setups that have a large number of HS devices it takes some time to enumerate all of them to make
them available for viewing on the Association Tab. In most setups the HS device does not change that
often and then even when they do it may not be of interest to being a Topic that will be published via
MQTT. The Client Tab (Figure 40) Outbound (Publish) Section contains a radio to enumerate devices at
startup or only manually by button press.

The received topics and those setup for association are maintained in the \data\mcsMQTT.db database.
During startup the database contents are validated and transferred to RAM cache for better real time
performance. This process was benchmarked at approximately 30 milliseconds per topic. If there are a
significant number of topics being managed then this can take a significant amount of time before
mcsMQTT is totally ready to interact with HS. Two approaches are available to deal with environments
that produce a large number of topics.

The Client tab, Inbound Management section, Topic Discovery row allows the user to subscribed to all
topics being managed by the broker (the default) or to only receive a subset. If the subscription is
limited then there will be less for mcsMQTT to manage and performance will improve.

The General Tab, Obsolete Unassociated row has a checkbox that will remove all topics at shutdown
that had not yet been associated with HS device or used for history data retention. This allows new
topics to be recognized during a session, but if they have not been associated with HS device they will be
removed from the database as shutdown. This means that the next startup will not have the records in
the database and the startup will be faster.
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The plugin will monitor for excessive accumulation of records from received MQTT Topics. The user has
the ability to set this threshold on the General Tab, Receive Topic Warning Threshold textbox. The
default value is 10000 records which was selected based upon a benchmark of initialization times of 15
records per second on a 10-year-old Windows laptop (i.e. 12 minutes) and the size of the Device table
being used by HS. Each day the plugin will evaluate the size of the Association Table and provide a
warning in HS Log if it exceeds this threshold. It will also automatically remove the oldest unassociated
records to bring the record count to 75% of the warning setting when the warning setting is exceeded or
remove all unassociated records if there are more that 1000 unassociated.

During normal operation and much larger record count can be managed without a noticeable
performance penalty. This is a reflection of the general design philosophy of cacheing in RAM those
things that are part of repetitive operation. This tradeoff comes at the expense of startup time to build
the cache and validate the integrity of the data. The use of the General Tab, Obsolete Unassociated row
checkbox is the recommended means to keep the Association Table size in check, but it is only activated
following shutdown/restart of the plugin.

The timing for startup and page rendering can be viewed in the debug file
\data\mcsMQTT\mcsMQTT_Debug.txt. This will allow for assessing the benefit/cost of various settings
for any given environment.

16.5 Browser Page Rendering
When the mcsMQTT page is requested by either direct URL or from the Plug-in button on HS Browser
page, the is generated with multiple tabs. In general, the Association and History Tab content will only
be the selection filters with tables of data for each only produced when manually requested by button
push. The exception is for the Associations table that will be initially built if it is small. Small is defined
by the user setting in the mcsMQTT Management Section of the Client Tab.

All updatable and user-entry fields on the Browser page are encoded for update via AJAX protocol. On
user action or otherwise two second intervals changes will be updated on the page. The two-second
update is initiated by a timer in the Browser that does a post back to HS Server which forwards it to
mcsMQTT to send any updates needed via AJAX.

Independent Browser pages are managed by mcsMQTT. Within a Browser page the fields between the
Association Tab and Edit tab are synchronized as changes are made on either. This synchronization does
not occur across Browser pages. A Browser page that remained open when the plug-in started or
otherwise has expired will no longer be updated by mcsMQTT, nor will user entry on the expired page
be recognized.
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17 Reference Tool Tips

17.1 MQTT Page Association Tab
The Association tab is where most HS-MQTT activity is initiated. This tab contains a table that can be
quite large that will show all received MQTT topics and all HS devices. A user then needs to only click
the “A”ssociate column checkbox to map the topic to the HS device. If the communication is to be
bidirectional then a publish topic is also entered by the user in the textbox provided. Note that the user
may want to user the Edit popup or tab to specify the format of the MQTT payload that is being
published if it is not a simple numeric value.

Because the table can be quite large there are filtering provisions provided in the form of checkboxes,
textbox, and pull-down selectors. Use of these limits the size of the table. Once the filters are setup the
show button is used to display the selected topics and devices.

Three filter tables are provided. The first is a textbox into which the user can specify text that must exist
in the MQTT record. The record has multiple fields such as the subscribe Topic, the publish Topic, the
Payload, the VSP entries when mapped to HS devices and others. The text of interest is specified as
either simple text or as a regular expression. Regular expressions use the syntax REGEX(expression),
<<REGEX(expression)>>, or <<expression>>. Simple text is the pattern that must exit in one of the
MQTT record fields.

The second is oriented to HS devices and allow selection of one or more of the Device properties. The
second is oriented to subscription topics. Each segment of the topic (e.g Home/Printer/Status) is listed
in the pull-down corresponding to its position in the hierarchy. In addition if JSON keys are in the
payload then these can be selected as well (e.g. Wifi:{MAC:1234565789012,...} will include Wifi and MAC
in the two JSON selectors.)

Page 380



Filter Association Table by Category

Displayed Checkbox Columns [JExclude O & R Columns [Exclude H&D Columns
Rejected Selections [include Rejected Messages
Accepted Associations [IShow All Associated Only
Outbound Selections [include Non-Flugin HS Devices
Inbound Selections M Include Received MQTT Topics
Filter Association Table by HS Device Categories Clear Filters Rebuild Filters
Room | v] Floor | +| Type | "linterface [ v,
Filter Association Table by Mqtt Topic and JSON Payload Key Clear Filters Rebuild Filters
™ T2 T3 T4 T5 T6
| SpaceHeater || | v | v | 4|
| "z 4 33 -] Ja -] 5 -] =
Show Selected Associations
Prev D of 28 | Next
Association Table for Auto Association of MQTT Topic and HS Device
N o r e a REF topic payload h d lastdate
Dev: Unknown
Sub: SpaceHeater/SENSOR:Time . .
O | (] [ ¥ # 1173 | pyp: the following Topic on Device command 2019-03-17T10:40:52 [ [ 2019-03-17 11:40:54
Dev: |SpaceHeater|STATE:POWER
Sub: SpaceHeater/STATE:POWER .
i O O # p2ag Pub: the following Topic on Device command rF O O AT Al
Dev: |SpaceHeater|STATE:Sleep
Sub: SpaceHeater/STATE:Sleep s
20 0O o # paGa Pub: the following Topic on Device command 0 O [ 2019-03-17 11:40:54
30 O w | || sub: SpaceHeater/STATE:Vce 3.390 O 2019-03-17 11:40:54
40 O O O | ] sub:SpaceHeater/STATE:SleepMode Dynamic O 2019-03-17 11:40:54
50 0O O O || sub: SpaceHeater/STATE:WIfi:AP 1 O 2019-03-17 11:40:54
6 0 0O LI [ | sub: SpaceHeater/STATE:Wifi:SSId u 0O 2019-03-17 11:40:54

Figure 226 Association Tab

17.1.1 Filters to Restrict Number of Displayed Rows in Association Table

17.1.1.1 Accepted Associations
"Exclude 'O'bsolete and 'R'eject columns in Association table display for
selection of obsolete non-Displayed rows. When obsolete row is checked it will be
removed.

"Exclude 'H'istory and 'D'evice columns in Association table display for selection
of History filters for subscribed and published topics”

17.1.1.2 Rejected Selections
"Checked overrides the 'R'ejected checkbox on each topic to allow them to be shown
in Association Table"

17.1.1.3 Accepted Associations
"Checked hides all devices that have not yet been ‘A’ssociated from page"

Page 381



17.1.1.4 Outbound Selections
"Check to include HS Devices in Association Table to select for publication"

17.1.1.5 Inbound Selections
"Check to include received MQTT Topics in Association Table to select for HS

device creation”

17.1.1.6 Filter By Text
"Enter text pattern that must exist in some field of the MQTT records for records
that should be included in the Association Table. Simple text can used or regular
expression can be used with syntax <<xxx>>, <<KREGEX(xxx)>> or REGEX(xxx)."

17.1.1.7 Filter Association Table by HS Device Categories
"Press to clear all device pull-down filters"

"Press to reconstruct all device pull-down filters"

17.1.1.8 Filter Association Table by Mqtt Topic and JSON Payload Key
"Press to clear all Topic/JSON pull-down filters”

"Press to reconstruct all Topic/JSON pull-down filters"

"Select Topic segment for the filter. Multiple items may be selected for 'OR'
condition. Reselect to remove from list. Select blank to remove all. Segment

"Filter on JSON Segment Key # "

17.1.2 Associations Build/Display Control
Up to twenty rows of topics will be shown in the Association table. Previous, Next and Row locator
controls are provided to select the starting row of these twenty.

At the top of each column there are also sort buttons that affect the order of the topics presented.

Show Selected Associations
Prev 18 of 38 = Next

Association Table for Auto Association of MQTT Topic and HS Device

N o r e a ref TOPIC payload h d lastdate

Figure 227 Association Tab Build/Display Control

17.1.2.1 Show Selected Associations
"Press to show MQTT message and HS Device relationships based upon filters that

have been setup"

17.1.2.2 Prev/Next
"Association table is shown 20 rows at a time. Enter the starting row"

"Click to display previous 20 rows in Association Table"

"Click to display next 20 rows in Association Table"

17.1.3 Association Table Header
“Sort on Obsolete”
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“Sort on Reject”

"Sort on Express”

"Sort on Associate"

"Sort on Device Reference"
"Sort on Topic"

"Sort on Payload"

"Sort on History"

“Sort on Chart”

"Sort on Long Term"

"Sort on Last Date"

User entry is allowed in most of the columns of the Association table. Some of the entry options are
hidden until another entry is made on the same row to make these additional inputs options relevant.

The rows are color-coded. If green the topic is a subscription of inbound traffic. If pink it is HS Device
that will publish when it changes. If blue it is an existing HS Device that will be commanded by the
subscribed topic. The most used rows will likely be the green ones that will enable HS to have access to
MQTT topics published elsewhere.

The leftmost columns of the table contain three checkboxes. The most-often used with be the
“A”ssociate checkbox to establish an association between a MQTT topic and a HS Device. For the green
rows the “A”ssociate will create a HS Device and place the payload in the Device. Each update to the
payload will be reflected in the Device. It will also open publish text box that can be used to specify a
topic to be published when the HS Device has been commanded. Note that the Ul for the command will
be based upon the payload received. If it is a number then a text box will be presented for number
entry. If it is something like On or Off then a two-state button will be presented. Other options are
available and these can be edited later from the Edit tab.

Following “A”ssociate on the pink rows the user needs to specify the publish topic. The Client Tab
default topic will be initially populated, but it can be changed. Since pink rows are existing HS Devices
there will be no new HS Device created.

The other two checkboxes “H”istory and “R”eject are used for filtering specification on a topic-by-topic
basis. Those tagged for “H”istory will be included in the History database. Those tagged for “R”eject will
not normally be shown later in the Association Table unless overwritten by a Show Reject checkbox
above the Association table.

The Ref column is the HS Device Reference number. It is a unique number of each HS Device. If the
topic/Device has been “A”ssociated then the Ref is shown as a button. When clicked the Edit tab will be
populated with the properties of this Ref Device. If a text box is shown then an existing HS Device Ref
number can be entered to be associated with the green row topic and this topic will then be used to
command the existing HS Device.
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Inbound payloads may not be in the desired format when used within HS. Regular expressions can be
used on the payloads before being stored in the Device Value or Device String. The first part of the
regular expression is the match pattern. The second part is a replacement pattern. A checkbox is used
to specify if the match is to be extracted or if it is to be replaced by the replacement pattern. Simple
manipulations are date format or command vs. period for decimal.

Association Table for Auto Association of MQTT Topic and HS Device

N o r e a ref TOPIC payload h d lastdate

Dev: Unknown
Command HS Device on subscribed Topic:
test/Dav27
18 [ m m ) 71 Publish message on Device change using Topic: m m 0001-01-01 00:00:00
Dell-PC/mesMQTT/Unknown/Unknown/NonPluginBy
Encode Payload per template:

Dev: Unknown
Sub: test/JSON:color:x
Pub: the following Topic on Device command

1901 0O o # 80 5040 O [  2019-02-15 09:06:12

Dev: Test|Unknown|RefTest
Command HS Device on subscribed Topic:
Test/RefTest
200 OO o # 1095  Publish message on Device change using Topic: Test Payload O []  2018-11-27 11:16:36
MCS7/mesMQTT/Test/Unknown/RefTest
Encode Payload per template:

Dev: |Test|Timon2

Sub: Test/Timon2

Pub: the following Topic on Device command
MCST7/mesMQTT/HSprinklers/Area_3_Status
Dev: Unknown

Sub: Test/Timon3:D518B20:Humidity
Pub: the following Topic on Device command

210 O o & 1167 5071 L] [0 2019-02-21 13:10:10

220 0O 2 & 244 5.0 O [ 2019-02-21 13:03:40

Figure 228 Association Table

17.1.3.1 O(bsolete)
"Check to remove obsolete topic from Association table and database"

"Click to delete all rows marked as obsolete"

17.1.3.2 R(eject)
"Check to remove topic row from page unless overridden by show rejected checkbox"

17.1.3.3 A(ccept)
“Check to associate new HS Device with MQTT Topic. If Topic is to be associated
with existing HS Device then use the Ref box to the right to enter the non-Plug-in
Device Reference."

17.1.3.4 E(xpress)
"Check to assign this Topic to Express mode where only update of HS Device will
occur. No other support such as event actions or history will occur in Express
mode. "

17.1.3.5 H(istory)
"Check to include topic in history recording"

17.1.3.6 S(hort term)
"Check to include device in SQLite recording"
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17.1.3.7 L(ong term)
"Check to include device in InfluxDB, mySQL or MS SQL Server recording"

17.1.3.8 Ref(erence Number)

"Enter an existing HS Feature to associate this subscribed topic. This can be the
Ref of a non-plugin device or it can be the Ref of another mcsMQTT device to
associate multiple MQTT topics to the same HS device. If new HS device is to be
created then check the 'A' box"

"Click to populate Edit tab with this Ref and properties”

17.1.3.9 Pub: the following Topic on Device command
"Enter Topic published when HS commands Device"

17.1.3.10 Command HS Device on subscribed Topic:
"Received message Topic to command HS Device to change. Received Payload will be
the command"

17.1.3.11 Publish message on Device change using Topic:
"Substitutions are
$$NAME : , $$ROOM; $$FLOOR ; $$COMPUTER : , $$INTERFACE : , $$INSTANCE : , $$TYPE: , $$ADDRESS : , $$C
ODE:,$$REF:, $$TASMOTACMND: and those in the payload list"

17.1.3.12 Encode Payload per template:
"Substitutions are
$$VALUE: ,$$VALUE_EUROPE : , $$PREVIOUS: ,$$PUBLISHED: , $$STRING: , $$STATUS: ,$$LABEL : , $$V
SP:,$$PAYLOAD: ,$$TOPIC: ,$$DATE:,$$TIME: and those in status Topic list"
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17.2 MQTT Page Edit Tab
The Edit tab is the place where edits are made to existing MQTT-HS associations or where subscriptions
are manually defined. Manual entry is for case of the broker topics that start with “SSYS” as these are
not normally subscribed by mcsMQTT, if Topic Discovery is turned off on Client Tab, or if a message has
not yet been published but a HS relationship setup when it does get published.

Three tables exist on this tab. Normally one starts with the first one where they identify the Device or
the subscription topic that they desire to observe, edit or delete. Note that use of the Ref button on the
Association tab row will automatically fill the tables on the Edit tab and will bring up a new window that
will contain the Edit table associated with the device.

The second table is used to edit non-mcsMQTT HS Devices that are associated with MQTT topics. The
orientation is for publishing something when the HS Device changes as reflected in the pink coloration.

The third table is used to edit mcsMQTT HS Devices that were previously defined based upon a topic
subscription. The orientation is for changes in subscribed topic payloads as reflected in the green
coloration.

Changes in the tables will be retained in the mcsMQTT.db database. The Delete button will remove the
records from the database.

Start with Either Existing Device Ref or Subscribe Topic

_ elete
Ref: [100 Sk =L
- RadariaotionZ/LWT and

Ref
Change association bebween HES Device
Reference and MOTT Subscribe Topic

Figure 229Edit Tab Device Identification

17.2.1 Start Reference

17.2.1.1 Ref:
"Enter existing HS unique reference number (DeviceRef)"

17.2.1.2 Sub:
"Enter subscription topic. Use : for JSON keys."

17.2.1.3 Delete Sub and Ref
"Press to remove the subscription topic from database and referenced device from
HS"

17.2.1.4 Change association between HS Device Reference and MQTT Subscribe Topic
"Change the association between subscribe topic <..> and <..>. Enter either a new
subscribe Topic or a new non-Plug-in Device Reference."

17.2.2 Publish (Outbound)
The key to non-mcsMQTT Devices is the HS Device Reference number. This number cannot be edited,
but is used to identify the Device being edited. This is the same as the Ref in the first table on this tab.

Page 386



When this Device changes in Value or String content or appears in the Log then mcsMQTT will publish.
By default, the value change event will be used, but string change or log can be selected. When Value
Change is selected then publish will only occur if the DeviceValue changes. If Log is selected, then it will
occur on any update of the Device and the publish will be the DeviceValue. If multiple are selected then
multiple messages will be published. The publish topic can be static text (e.g.,
“MyHS/AtticSensor/Temperature/Centigrade”) that follows MQTT topic protocol. The topic can also be
specified using a combination of static text and replacement variables. An example may be
“SSCOMPUTER:/SSROOM:/SSNAME/Centigrade”. When substitution variables are used then the
substitution occurs before the topic is published so if the computer network name, Device Room
property and Device Name property are MyHS, AtticSensor, and Temperature respectively then the first
example will be published in both cases.

The Quality Of Service (QOS) and Retain flag defaults are setup on the Client Tab, but change changed
for particular messages. Normally a common QOS and Retain policy is employed and no editing is
needed.

It is possible that the existing non-mcsMQTT HS Device will be controlled by a MQTT topic. In this case
the subscription topic used for this control is entered for the subscribe topic. The payload in this topic
will need to comply with the CAPI (Control Application Program Interface) definition that exists when
the non-mcsMQTT Device was created. Normally text such as “On” and “Off” will be payloads for these
cases, but it is totally dependent on the HS Device expectations.

Two HS Device property fields are provided to facilitate editing of properties that are not normally
available via a browser. One is the grouping parent ref which is the parent Device under which Features
are organized. In essence these are the Association and Relationship properties.

If a Parent Device is being edited then the grouping text box can be used to list all the Child Features
that are to be grouped under this Parent Device. If a Child Feature is being edited then the grouping
text box is used to assign this Child Feature to a different Parent Device.

The second is the Interface property. Changing this to the name of the plugin will change the ownership
of the device. This mechanism can be used for mcsMQTT to take ownership of a Virtual Device or a
Device created by another plugin.
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Edit of Non-Plugin HS Device to Subscribe (Inbound) and Publish (Outbound) on Ever

Figure 230 Edit Tab Publish
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17.2.2.1 Existing HS Device Reference
"Enter existing HS unique reference number (DeviceRef) that is not a mcsMQTT
Device"

17.2.2.2 Grouping Parent Ref
""Enter grouping parent or comma-separated child references, negative value To
create New parent device, Or blank to remove from grouping."

17.2.2.3 Owning Interface
"Name of the plugin that has ownership. This is the interface property of the
device.")

17.2.2.4 HS Event Trigger
"Check to publish on DeviceValue change"
"Check to publish on DeviceString change"
"Check to use log event. This is used if Device update without a value change is
needed."

17.2.2.5 MQTT Publish (status) Topic
"Use semicolon to separate CSV topics. Substitutions are
$$NAME :, $$ROOM: , $$FLOOR : , $$COMPUTER: , $$INTERFACE : , $$INSTANCE : , $$TYPE : , $$ADDRESS : , $
$CODE:,$$REF: and those in the payload list"

17.2.2.6 MQTT Publish Payload Template
"Substitutions are
$$VALUE: ,$$VALUE_EUROPE : , $$PREVIOUS: , $$PUBLISHED: , $$STRING: , $$STATUS: , $$PAYLOAD: , $
$PAYLOAD_EUROPE, $$TOPIC:,$$DATE: ,$$TIME: , $$LASTDATE: ,$$DEVICETYPE: , $$DEVICESUBTYPE
: and those in status Topic list™

17.2.2.7 URI Encode Payload
"Use URI encoding convention to encode special characters such as space, colon,
etc.”

17.2.2.8 MQTT Publish to Sign
"Publish to Messaging Sign uses JSON encoding and API specific for sign. The
plug-in will format to this API when this radio is selected."

17.2.2.9 MQTT Publish QOS
"Select among the three levels of Quality Of Service"

17.2.2.10 MQTT Publish Retain
"Flag to send to broker to retain or not retain messages per MQTT protocol”

17.2.2.11 MQTT Publish Broker
"Select the broker to which the message will be published”

17.2.2.12 MQTT Subscribe (control) Topic
"Enter MQTT Topic that when received will command HS Device change"

17.2.3 Subscription (Inbound)

Subscriptions are keyed to the inbound MQTT topic. The first row of the third table and the first Edit tab
table will have the same topic populated. The association with a HS Device is normally done on the
Association tab.

Regular expression editing and publish topic editing is the same as on the Association tab row. The QOS
and Retain policies are the same as with other outbound publication.
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The status and shown in HS Devices is based upon the subscribed topic’s payload. If the payload is a
number, then that number will be shown for status. From HS Device Management a prefix or suffix can
be added if desired. HS normally appends a “Dim” suffix for most numbers.

For textual payload three options exist. For common two-state text of Off/On, Closed/Open, False/True,
Offline/Online, Inactive/Active, and Disarmed/Armed a button and graphic will be setup in Value-Status-
Pairs (VSP) of the HS Device. For other payloads that have been received with a single text string then a
button will also be setup with the second state being “Not xxx” where xxx is the received text. For other
payloads the VSP will not be used and the payload text will be placed in the Device String.

All of these default/automatic decisions can be edited by selecting a different Control/Status Ul radio
button. The List type will create multiple value-status pairs. The Color Picker and ColorXY is used only
for published topics where a color selector is the desired control Ul.

Different Payload states are observed and collected as Value-Status-Pairs until the Topic has been
identified as being a number via the Control/Status Ul selection or until the max VSP text box entry
value has been reached. Up to twelve states are collected by default. This can be changed on the Edit
tab textbox for the Max VSP. When this number of entries has been exhausted then the other checkbox
determines the action to be taken. If unchecked the received payload is ignored. If checked and the
VSP limit has been achieved then an additional entry will be made with the HS Device Value of the max
limit and the status of Other. The payload will still reflect the last received text on this Topic.

The VSPs that have been observed in payloads can be edited by adding additional pairs or the value-
status relationship of the pair can be edited with the VSP box. There are four fields available. The first is
the text received in the MQTT Payload. The second is a number to uniquely associate the Payload text
to a value to be used in HS Device. The third and fourth are optional and if excluded will take on the
Payload text. The third is the text to be put on HS Device/Feature control. The fourth is the text to
show in HS for the status.

Four options exist to edit the VSP.

The first establisheds a Payload text to unique value relationship such as “label=number”. The label is
the payload text received via MQTT. Number is the numeric pair assigned to the label.

The second does the same as the first but also allows user to specify a different control text to be shown
on the control button or selector of the HS Device/Feature. This is done in the format
“label=number;control”. An example is “87WRTX=3;KitchenDoor” where 87WRTX is the MQTT payload
and KitchenDoor is what HS shows for the control. Figure 231 is another example where the received
Payload is upper case, but the Control will have mixed case spelling.

The third is an extension of the second where a different status text is used in HS than the text received
in the Payload. The format is label=number;control;status”. An example is “On=1;0pen;Opened” where
“Open” shows on the control, “Opened” is shown for status when the received MQTT Payload is “On”.

The fourth removes a label where the syntax is to just enter the label. For example, “On” to remove the
VSP for the received Payload of “On”

The last redefines the entire VSP list with assignment of increasing numbers starting at zero. The syntax
in this case is a set of comma-separated labels such as “off, on, unknown” to assign off=0, on=1,
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unknown=2. The typical edit format that maps the Payload text “OFF” to the HS Device VSP of “Off” for
value 0 is shown in Figure 231.

Add Accum []Create
Device No Re:| MQTtxt=VSPval or MQTTxt=VSPval;VsPext £ | . ght

Settings for (OFF=0;0ff]
Plugin Device '

HS Device

Publish Topic

HS Device Unspe: Cancel m [ Text *® List RGB

Control/Status Ul HSB

Payload OFF = VSP 0;0FF
HS Device V5P Payload ON = WSP 1;0N

e Clear existing VSP

Figure 231 Typical VSP Edit Syntax

HS Devices have a MISC property that affects how the control and status of the device operates.
Normally the radio button selections for control/status will set these to provide the desired operation.
If a change is needed then they can be made here.

Normally subscription associations create a mcsMQTT HS Device. This can be modified to associate the
subscription with a non-mcsMQTT HS Device and if it is done then the mcsMQTT device will be deleted.
This relationship between subscription and non-mcsMQTT device is the same as can be done from the
second table on this tab.

HS maintains a database to record energy utilization. It will accept the Watt consumption or production
over sensed periods of time. To utilize this database the HS Energy Database row of the Edit tab is used.
The preferred source is a total energy sensor source. The plug-in will handle a daily energy sensor as
well, but energy consumed between the last sample of prior day and midnight may introduce minor
variance, depending upon the frequency of the sensor’s sampling and reporting.

The Control/Status Ul selection determines how mcsMQTT processes the payload and how information
is made viewable. Text is stored in DeviceString. Button, Toggle and List will create Value Status Pairs
(VSP) where the status is rendered as text while DeviceValue is used to identify each of the text
enumerations. List can grow as new payload text is received. Button text is static once associated with
HS Device Feature.

Various forms of color space processing are provided. These are Color Picker, RGB, RGBW, HSB and
color XY. The general strategy is to convert from the client’s color space to the HS RRGGBB color space
with the numeric value stored in DeviceValue. ColorXY is for a client that uses XY color space. Zigbee
often uses it. JSON is normally used. RGBW is expecting comma-separated decimal values for R, G, B
and W. HSB will typically be JSON values for each parameter. Because of all the different client’s
representation of color space there are many special-case situations.

Numbers are shown as text boxes or as sliders with Number, Number Change, and Slider selections.
Jpg File will store binary data from payload. If base64 encoded, then it will be converted to raw binary

before storage into the jpg file.
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CSV is expecting a comma separated list of numbers and each will be handled as separate HS Features if
associated.

Sign contains the formatting for the LED Matrix Sign described in Section 20.19 .

Ramp is a slider to which a change filter is applied to control the rate at which a DeviceValue will change.

Edit Setup Or Edit Of Subscription (Inbound) To a MOTT Topic

shellies/shelbydimmmer2-DE4082
JEON key(s) 1o be elevated for uiigueness

MOTT Subscribe Topic
Payload RegEx
Malch Patlerm
Payload RegEx
Replace Pallerm
Payload RegEx Replace Match Patlem With Replsce Pattern ()
B Extract Match Pattern ()
Subsarmple 0
Min Secs
Lioww Pass 1
Filter
Expression
Per Second ()
Mane i Per Minute ()
Mew () PerHour i
Add Extra ar Exizting () MolaRale (O
Rale Devire
(Device Rel) (Rate Sensitivity 0.00 1o 1.00)
-1 075
A " MoRessl ()
Device Creale a HS Accurn Deviee] | Aceum Since Midnight ()
Delta Since Midnight
Sl Iri HS Device Value )
Paylaad I HS Device Sting (O

Report Status on noll Payload (O
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Figure 232 Edit Tab Subscribe

17.2.3.1 MQTT Subscribe Topic
"Elevate to treat as part of topic to establish uniqueness of message. The value
contained in the payload will be added as a level to topic and all members of the
JSON group will be children of it."

17.2.3.2 Payload RegEx Match Pattern
"Enter regular expression match pattern to be used on received payload"

17.2.3.3 Payload RegEx Replace Pattern
"Enter regular expression replace pattern to be used on received MQTT Payload"

17.2.3.4 Payload RegEx Operation
"Extract or Replace of Regular Expression on received MQTT Payload before storing
in HS device"

17.2.3.5 Subsample Min Seconds
"Subsample to reduce the processing burden of high-rate data. Number specified is
the minimum number of seconds since last message before accepting a new one from
the same topic"

17.2.3.6 Low Pass Filter
"Smooth payload value using low pass filter with sensitivity ranging from ©.00 for
payload ignored to 1.00 for no smoothing"

17.2.3.7 Expression
"Numerically transform payload (e.g. $$PAYLOAD: * 2.54 to convert centimeter to
inches). Use replacement variables, math operators and functions."

17.2.3.8 Add Rate or Extra Device
"Select between no rate/extra device, creation of a new device, or use an existing
device."

“Use and existing HS device to allow a different expression to be used when
updating this additioinal HS device.”

"Set rate sensitivity with value between 0.00 for no rate change to 1.00 for
change based only on last two samples”

“Select units for rate of change”

17.2.3.9 Add Accum Device
"A device that sums the payload can be created independent of the payload device"

"Select between no reset, accumulate totals since midnight, or accumulate change
since midnight"

17.2.3.10 Payload Store
"Normally only Control/Status of Text will store payload in DeviceString. Others
in DeviceValue. This can be overridden for non-Text types with this setting so
DeviceValue is not updated, but DeviceString will contain the Payload. For the
case of null payloads, the null value can be stored in the DeviceString or it can
be used to trigger sending current Device Status."
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17.2.3.11 HS Device Publish Topic
"Substitutions are
$SNAME : , $$ROOM: , $$FLOOR: , $$COMPUTER: , $$INTERFACE: , $$INSTANCE: ,$$TYPE: , $$ADDRESS: , $
$CODE: ,$$REF: and those in the pub payload list"

17.2.3.12 HS Device Control/Status Ul
"Identify how UI control will be shown on HS Device. Button and List are for VSP
mappings that update DeviceValue and show DeviceStatus text. Number, NumberChange
and CSV are for DeviceValue updates. RGB, HSB and ColorXY are for color wheel
that use DeviceValue. Text is for DeviceString updates. Sign is for data send to
messaging sign. Jpg File is to store binary data from Payload into file of type
-jpg.”

17.2.3.13 Device Type API
"Select the Device API type for the Device or Feature"

"Select the Device API subtype for the Device or Feature"

17.2.3.14 HS Device Location
"Loc2 (Floor) where this HS Device placed.”

"Loc (Room) where this HS Device placed.”

“Name to be used for the HS device."

17.2.3.15 HS Device VSP List
"VSP are collected based upon Payload data. This can be a large number if the
payload does not represent state data. This setting determines the max number to
be remembered"

"Check if all undefined VSP, that occur after max limit is reached, are assigned
to Max Value with HS status of 'Other'.

"Value status pairs (VSPs) are the values, controls and statuses visible on the
device's Status Graphics tab in the Device Management page of HS. The syntax for
entry is PayloadText=Number;Control;Status where PayloadText comes from MQTT
Message and Number, Control and Status are what is used in HS. PayloadText will
be used for HS Control and Status unless other text is provided.

Five edit formats are supported.

1: text=number (e.g. On=1) syntax to specify or overwrite a specific entry.

2. text=number;control (e.g. Closed=0;Close).

3. text=number;control;status (e.g. off=0;Close;Closed)

4: text alone (On) to delete it.

5: comma-separated list (e.g. Off,0On) to define full VSP list numbered starting at
0

"Click to clear previously defined VSP definitions"

17.2.3.16 HS Device MISC Properties
"Check to set MISC property"
17.2.3.17 Grouping Parent Ref

"Enter grouping parent reference, negative value to create new parent device, or
blank to remove from grouping"
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"Click to create a new mcsMQTT device that will serve as a parent for this and
possibly other devices in group"

17.2.3.18 Publish Payload Template
"$$label:, $$status:, $$vsp: (default if blank) for text and $$value: for number
are typical for CAPI, view Publish Topic & Payload for other substitutions"”

17.2.3.19 Publish QOS
"Select among the three levels of Quality Of Service"

17.2.3.20 Publish Retain Flag
"Flag to send to broker to retain or not retain messages per MQTT protocol”

17.2.3.21 HS Energy Database
"Enter energy sensor that provides readings in Watts. Plug-in will compute the
delta usage since last sensor report to store in HS Energy database."

17.2.3.22 Database Hysteresis
"Minimum change in value between consecutive entries stored into long term
database. Use negative values to disable the hysteresis filter override."

17.2.3.23 Tag Field
"Free form input field to record notes or othre information that can then be later
retrieved using $$TAG: replacement variable"

17.2.3.24 Control non-Plug-in HS Device

"If associating subscription topic with an existing non-Plug-in device then enter
the existing Device Ref otherwise leave blank"
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17.3 MQTT Page Client Tab

H OﬁESEE r HS4 Web Control o default ~

Assocations Edit/Add Publist/Sign Client Broker General History Chart

Broker Connection(s)

. . . @ 127.0.0.1:0nline @ 21 0-28 14:52:12 for 0 Days 0 Hours 9 Mins 5 Secs
Connection Status : _ . : ; - — .
® 92.168.0.16:Client Disconnected Last Online @ Mever for 0 Days 0 Hours 9 Mins 6 Secs

MQTT Client 1D Test on DELL;Test on DELL

mcsMOTT LWT Topic DELL/mesMQTT/LWT;DELL/mesMQTT/LWT
vall @
V500

MQTT Protocol O
vallt Q
vsoo @

QTT Broker C cti
ey e Er B MR Disconnect from MOTT Brcker[s]D

MQTT Statistics Reset MQTT Client Statistics Counters

Figure 233 MQTT Broker Connection Settings

The dominant MQTT protocol in use is version 3.1.1 while the updated standard 5.0 has been available
for several years. Clients using 5.0 can interact with clients that uses 3.1.1, but legacy clients will not be
able to communicate with clients using 5.0.

The Broker can accept an anonymous connection or it can be with a username/password protection.
Additional security is with encryption with certificates identified used to decode the encryption.
mcsMQTT is a client and provides a default ID of mcsMQTT on <hostname>, but this can be edited if
desired.

17.3.1.1 MQTT Client ID
"mcsMQTT Client ID to uniquely identify mcsMQTT as the source of message. Separate
multple with semicolon."

17.3.1.2 mesMQTT LWT Topic
"Last Will and Testament topic given to broker by mcsMQTT. Broker publishes the
topic when mcsMQTT appears to have disconnected. Payload will be 'Offline’'."

17.3.1.3 MQTT Protocol
“Select MQTT communication protocol version to be used by mcsMQTT for Broker.”

17.3.1.4 MQTT Broker Connection
"Check to disconnect from MQTT Broker and no longer subscribe"

17.3.1.5 Reset MQTT Statistics
"Use button to reinitialize receive statistics to facilitate specific time
measurements"”
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17.3.2 Inbound (Subscription) Management

MQTT has bidirectional communication. Messages published by others can be subscribed by mcsMQTT
and is considered inbound from mcsMQTT’s perspective. Normally mcsMQTT will listen to all messages
delivered by the broker. This makes it easier for user selection of the topics of interest. If this feature is
not desired for performance or simplicity reasons then the discovery of published topic can be turned
off. Similarly, if a stable configuration exists and there is no desire to receive any new topics then new
topic discovery can be turned off.

When only specific topics are desired then the topic discovery template is defined using a comma
between each pattern is used. For example, if subscribing to “HS” or “HS3” topics then the template
would be specified as “HS/#,HS3/#".

Normally mesMQTT will not subscribe to topics that it publishes. If there is a need to receive published
messages then it can be turned on.

mcsMQTT will treat payloads in one of three manners. One is to place it into a HS Device String or
Device Value depending upon it being numeric. If the payload is JSON-encoded then it can expand to
topic to include the JSON keys and the Device Value or Device Sting will be populated with only that one
JSON element value. The third option is to create a parent HS Device and then children devices with the
decoded JSON items in each of the children.

IOT devices many be removed from one’s location or there may be some experimenting that resulted in
Topics being discovered that will never be used again. To remove the clutter of obsolete Topics a
provision exists to remove them from the database. This can be done on individual Topics or on a group
identified with wildcard characters. See Section 4.1.26. Also note the obsolete unassociated on
shutdown on the General Tab that will remove all unassociated topics that accumulated during the
session.

Another approach to excluding topics is with the Reject mechanism. This can be done on a topic-by-
topic basis on the Association tab or can be done based upon the reject Topic template on the Client
tab. The template to prevent discovery is processed at the time of message reception and considers
only the Topic. Its use is not as desirable as changing discovery to only update associated messages, but
will consume fewer resources than the individual reject checkboxes.

In the singular case and reject templates will only hide the Topics from the Association table. the
messages are processed, but just not visible on the Association tab. The Reject done using a Reject
Topic template will firewall the message and no record of the message will be retained.

There are some MQTT clients that send messages with the retained flag set. This means that every time
mcsMQTT starts it will receive these retained messages from the Broker. If these Topics are no longer of
interest, then they can be removed from the MQTT Broker’s database using a wildcard template (i.e.,
with +, * and #) or individually specified. When using this capability, the message will be removed from
the MQTT Broker database andif it has not been associated with a HS Device then also removed from
the mcsMQTT database. If the Topic is again sent through the Broker, then it will be restored to the
databases.
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On lower power processors it may be desirable to manage the processing of inbound MQTT traffic. This
is especially significant following startup when the broker may have a large number of topics that it will
burst to mcsMQTT. Received messages are placed in a queue and the queue is worked-off based upon
the depth and delay parameters. Normally no special provisions are needed to manage the queue.

17.3.2.1 Topic Discovery
"Discover listens for all (#) topics otherwise subscribe to only Associated
topics. Separate each topic by comma. + and # wildcard symbols are honored.

17.3.2.2 Inhibit Topic Discovery
"Prevent new topics from being discovered"

17.3.2.3 Subsample Topic Templates
"Enter set of semicolon-separated topic templates to be subsampled with interval
specified below. MQTT wildcard symbols +, * and # can be used to identify Topic
range. For example, 'test/topic/#' will reject all Topics that start with
'test/topic'. Reject template applies only to Topic and does not consider
anything in the Payload.”

17.3.2.4 Subsample Min Seconds
"Subsample to reduce the processing burden of high-rate data. Applies only to
topics that match the subsample template above. Number specified is the minimum
number of seconds since last message before accepting a new one from the same
topic."

17.3.2.5 Enable Auto Device Creation
"Specific topics including shellies/#, wled/#, and other devices will
automatically create HS devices when received."

"Specific topics advertised by Tasmota.Discovery or Homeassistant/../config topic
will automatically create HS devices when received."

17.3.2.6 Wildcard Plugin Auto Associate Template
"Enter topic template for auto-association of plugin devices. When not blank and
a topic that matches template is received then HS device(s) will be automatically
created with publish topic set to the Default Topic Template and Default Payload
Template (e.g. +/Tasmota/# for any topic that is Tasmota in the second position)."

17.3.2.7 Wildcard Non-Plug-in Control Template
"Enter template for auto-association of non-plug-in devices with topics using
$$REF: for device reference (e.g. HS/$$REF:/cmnd)"

"Must define an subscribe wildcard template and publish topic template before auto
association can be done"

17.3.2.8 Default HS Device Location
" If default is selected then all new associations will be placed in the same HS
Loc2 (Floor) and Loc (Room), otherwise the location will be based upon the MQTT
Topic."

"Loc2 (Floor) name where all new Associations will be placed"

"Loc (Room) name where all new Associations will be placed"
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17.3.2.9 Default Name Property
"Selection affects the update of the Last Change property. Options are to always
change it when any value Is written to a device or to only change it if the
written value changes."

17.3.2.10 Default Misc Property
"Selection affects the update of the Last Change property. Options are to always
change it when any value is written to a device or to only change it if the
written value changes."

17.3.2.11 Default HS Parent Device
"If default is selected then parent HS device will be based upon the MQTT topic
hiearchy, otherwise the newly created feature will be the child of the specified
device reference number."

"Device reference number that will be parent device of newly created feature"

17.3.2.12 Echo
"Identify if need to have transmitted topics to be wrapped around and seen as
potential subscription topics"”

17.3.2.13 Express Mode
"This setting defines the default setting for the Association tab 'E'xpress column
checkbox. Full support or Express. When a Topic is associated then the 'E’
checkbox will be set to this default option."

17.3.2.14 Express Mode Features
"If Payload is JSON-encoded then decode into separate HS devices rather than
storing payload in DeviceString"

"If Edit tab has been definded payload to be color picker, button, or list then
convert payload to DevcieValue rather than storing in DeviceString"

"Regular and arithmetic expressions will be included to transform received
payloads before storing in HS Device"

"Ability to trigger an event or generate a script callback based upon a received
Topic"

17.3.2.15 Reject Topics
"Enter set of semicolon-separated topic templates to be rejected from
subscription. MQTT wildcard symbols + and # can be used to identify Topic range.
For example, 'test/topic/#' will reject all Topics that start with 'test/topic'.
Reject template applies only to Topic and does not consider anything in the
Payload."

17.3.2.16 Receive Queue Depth
"Enter maximum number of received messages to be processed immediately"

"Enter maximum depth of the receive queue"

17.3.2.17 Receive Queue Interval
"Enter number of milliseconds to wait to process received messages when queue is
above 'queue depth' threshold"
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17.3.3 Outbound (Publish) Management

mcsMQTT will publish topics when HS Device(s) change, as a result of an Event action or from a script.
The topic to be sent is user-specified on a case-by-case basis, but if there is a standard format that is
being used for publish topics then this format can be specified in a template with substitution variables.
These variables will then be filled out at the time the topic is published. The substitution variables
available are $SNAME:, $SROOM, $SFLOOR, $SCOMPUTER:, SSINTERFACE:, SSINSTANCE:, $STYPE:,
SSADDRESS:, SSCODE:, SSREF:, SSVALUE:, SSVALUE_EUROPE:, SSSTRING:, SSSTATUS:,SSLABEL:,
SSVSP:,SSPAYLOAD:,SSTOPIC:, SSDATE:, and SSTIME:.

The same substitution variables are available for published payloads. If not specified then the payload
will be Device Value if numeric, Device String if non-numeric or a CAPI value or label if commanding a
mcsMQTT Device.

Expressions can be used in the template by encasing the expression in “<<” and “>>". Nesting
expressions to two levels is supported. A typical JSON template with an expression is
‘{“Brightness”:<<ROUND(SSVALUE*255/100,0)>>} where the expression produces an integer in range of
0 to 255 based upon an input in the range 0 to 100.

The templates here are setup as the defaults. Individual topics can later be specified that vary from the
templates. Templates do not need to be defined, but only exists for those who have a large number of
topics to publish and desire to standardize on the structure.

MQTT protocol provides for Quality Of Service and message retention on a topic by topic basis. Just as
payloads can have a default template, the same is true for these attributes. They can later be changed
on a topic-by-topic basis.

Normally MQTT messages are published only when something changes. They can be setup to
periodically publish to assure that subscribed clients contain current information. Note thereis a
redundancy between QOS/Retain and the periodic status reporting.

For users that have a large number of Devices and infrequent addition to the set then it may be
desirable to reduce CPU burden and not enumerate all the devices each time mcsMQTT starts. A button
is provided for this alternate mode of enumeration.

Provisions exist to support LED Messaging Sign described in Section 20.19. If information from the HS
Log is to shown on the screen, then the Sign Log radio is set to enable it. Itis likely that a subset of
everything going to the sign is all that is desired. The Regular Expression that is applied to the Log type
field is used to select the desired subset.

17.3.3.1 Default Topic Template
"Blank for computer/plug-in/location/name or formatted text including substitution
variables"

17.3.3.2 Default Payload Template
"Blank for Device Value/String or formatted text including substitution variables"

17.3.3.3 Default QOS
"Select among the three levels of Quality Of Service"
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17.3.3.4 Default Message Retain
"Flag to send to broker to retain or not retain messages per MQTT protocol”

17.3.3.5 Publish Periodic Status
"Enter number of minutes between periodic status reporting. © to publish only on
status change."

17.3.3.6 URI Encode Topic
"Spaces are not recommended in topics, but are legal. This option will send the
space as ' ' or '%20'. URI encoding applies to all special characters and not
just space."

17.3.3.7 Publish HS Device Changes
"Normally MQTT messages are published based upon explicit associations between a
HS Device and a MQTT publish topic as shown in Association tab. This option
removes the need for explicit associations. It allows all Device changes to be
published or only non-plugin Device changes. The default topic and payload
templates are used to form the Topic and Payload in this case."

17.3.3.8 Publish non-MQTT Sources
‘Interfaces that get their data by means other than MQTT such as serial or HTTP
responses will typically be have a pseudo MQTT Topic assigned and processed as if
it was received via MQTT. These messages can be internally processed or can be
published through the first MQTT Broker. The later case is used when non-HS
clients also desire access to these messages.”
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17.4 MQTT Page Broker Tab
Each MQTT environment needs a MQTT Broker and this is normally the internal Broker built into
mcsMQTT or an external one such as Mosquitto. The Broker can be identified by network name or IP
address. The internal Broker is always 127.0.0.1. It normally uses port 1883 or 8883 if secure
connection is established.

If the internal Broker is used, then two options are available as to how it should handle the retained
messages. At shutdown it can save the retained message information and then restore it at startup.
This is the standard method such as is used by Mosquitto Broker. It can also discard them and start
fresh to accumulate retained message information on next start. This is the implementation used by
Home Assistant.

Note that the MQTT Page, Client Tab, Inbound Management Section provides a means to remove
retained messages from any Broker on a wildcard or topic-by-topic basis.

Statistics maintained by the internal Broker are visible for all MQTT clients that are using this Broker
such as shown in Figure 234. The client is the reference so the “Send” columns reflect the MQTT
messages published by the client. The “Time” column reflects the last time the message transaction
occurred. The current day is assumed unless an explicit date is shown in the table. Clients that are no
longer connected to this Broker drop off of the table
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Figure 234 MQTT Broker Tab
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17.4.1.1 MQTT Internal Broker Operation
"When using the internal MQTT Broker the option exists to save retained messages
on shutdown and then restore them on restart. This is standard operation for MQTT
Broker. The other option is to only persist retain messages for those that are
received since a restart.”

"Use button to get current Internal Broker client list and statistics.”

17.4.1.2 MQTT External Broker Name or IP Address
"MQTT Broker (e.g. Mosquitto) network name or IP address. Separate multiple
brokers IP address with semicolon. If left blank then mcsMQTT will spawn its own
internal MQTT Broker unless “No Internal Broker” is selected.”

17.4.1.3 External MQTT Broker Port
"Optional if port other than 1883 is being used by Broker. Separate multple ports
with semicolon.”

17.4.1.4 External MQTT Broker Security
"Select the communication security used by the Broker"

17.4.1.5 External MQTT Broker caCert File
"Enter full filename path for caCert used by each Broker. Use semicolon to
separate broker’s file paths"

17.4.1.6 External MQTT Client Cert File
"Enter full filename path for Client Certificate. Use semicolon to separate
broker’s file paths"

17.4.1.7 External MQTT Client Key Password
“Enter password for Client Key Certificate"

17.4.1.8 External MQTT Broker Username
"Optional username expected by MQTT broker is this security implemented by broker.
Use semicolon to separate brokers usernames."

17.4.1.9 External MQTT Broker Password

"Optional password expected by MQTT broker is this security implemented by broker.
Use semicolon to separate brokers passwords."
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17.5 MQTT Page General Tab
The General tab contains settings that are generally one-time edits to configure mcsMQTT to a user’s
environment. General configuration information is retained in \Config\mcsMQTT.ini. In the mcsMQTT
Management header the version of the plug-in that is running is visible.
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Figure 235 mcsMQTT General Settings

17.5.1 Beta Updates

mcsMQTT is released through the HS Updater and often has updates available as new features are
added and fixes are incorporated. These delta or beta updates can be installed using the “Install Beta
Update” button at the top of the General Tab. In the same area, the currently installed version and the
available beta version are visible. An update by this mechanism requires that the plugin has access to
the local HS web server. This access can be restricted if the user’s HS Setup/Network checkbox has PW
required setting. In this case the user needs to provide the username:password or disable the HS Setup
setting to require login on the LAN.

A second method where mcsMQTT is not allowed to access HS web server is to start the update using
the button on the General Tab and then manually use the HS Plugins page to stop mcsMQTT. Within a
minute-or-so the update should be complete and mcsMQTT can be restarted again from the Plugin meu.

A third method to install these updates manually with the links to the updates at
https://forums.homeseer.com/forum/hs4-products/hs4-plugins/lighting-primary-technology-plug-ins-
aa/mcsmatt-michael-mcsharry-aa/1498637-mcsmatt-change-log-hs4-hs3 .

The update is performed by launching the executable UPDATEPLUGIN.exe. This helper looks finds the
process ID of HSPI_ MCSMQTT.exe, sends a request to HS to shutdown mcsMQTT, waits for the process
ID to disappear, copies the beta files from site mcsSprinklers.com, copies them into the desired
locations, sends request to HS to start mcsMQTT.

It produces a trace file in subfolder \Data\mcsMQTT\UpdatePlugin.Trace. A normal update will have
something like below in this file

6/2/2024 1:39:05 PM UpdatePlugin Found HSPI MCSMQTT in process 52260
6/2/2024 1:39:07 PM UpdatePlugin GetHSPluginList PluginIndex.Count=12
6/2/2024 1:39:07 PM UpdatePlugin Plugin Command ?enabled 5=unchecked

6/2/2024 1:39:16 PM UpdatePlugin SubPost Return:
["installed interfaces","\u003cform

n\r\n\r\n\u003c/form\u003e\r\n\r\n", "PAGE refresh","true"]
6/2/2024 1:39:53 PM UpdatePlugin CPUuse 46692
6/2/2024 1:39:53 PM UpdatePlugin Successful Update

The second approach to update will work because UPDATEPLUGIN.exe is just waiting for the
HSPI_MCSMAQTT.exe to disappear to allow it to continue to update the files. There is a timeout so if
mcsMQTT is not stopped within 30 seconds then the update will not occur.

17.5.2 Debug

There are three locations where mcsMQTT provides user feedback. One is on the browser with alert
boxes when a user entry is not valid. The second is the HS Log when significant errors are detected. The
third is in file \Data\mcsMQTT\mcsMQTT_Debug.txt. This third location will always contain some
information related to the startup and timing. Additional debug information is included when the
General Debug checkbox is used. Some of the debug data is voluminous or chatty so could result in a
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large debug file. This data can be selectively excluded with checkboxes. In general, they should be
checked unless debugging topics specific to their content.

Access to the debug file can be achieved by navigating to the folder where it is stored or it can be
uploaded to the Browser’s standard upload folder (typically ...\Downloads on Windows) in a compressed
zip format. When uploaded, the zip file will also contain the last two days of the HS log that was
reported by mecsMQTT in a csv file format.

17.5.3 Topic Volume Management

In some systems much MQTT traffic exists and mcsMQTT default behavior is to collect and make visible
everything that it sees. This can result in large and unwieldy operation. Various facilities are provided
to manage the large amount of data.

17.5.4 Backup

The configuration information that relates to specific MQTT topics is maintained in an SQLite database
at \Data\mcsMQTT\mcsMQTT.db. The database is backed up every time the mcsMQTT starts which will
normally be each time HomeSeer starts or when an update is installed.

mcsMQTT provides a backup facility to protect its integrity and has extended it to allow a user to do a
daily backup of any folder they desire. A backup can be done with a full backup every day or it can be
done as a delta backup from the prior day. In either case a full backup is done on the number of days
interval specified by the use.

If no backup folder is specified then no backup is one with the assumption that the user has other
means to create a backup of the user data. If a backup folder is specified the mcsMQTT will backup in a
compressed zip format all files that are necessary to restore user data so mcsMQTT can function from
the backup. This includes all the \config, \data for HS and mcsMQTT, and \script subfolders of HS. It
does not include other paths such as those used by external databases.

It is also possible to backup other folders using this mcsMQTT feature if the path to the folder is
specified. Semicolons are used if multiple additional backup paths are desired. Note that if an external
database is to be backed up then the facility provided by MySQL, MS SQL Server, or InfluxDB should be
used to assure the integrity of backup is maintained.

Backups can be in either of two formats. In both cases a “.zip” file is created for the top-level folder that
is being backed-up. In one case all the files are included. In the other case only the files that have
changed are backed up. It is a tradeoff between ease of restoration vs. space required to perform a
backup. A full backup is done on the interval specified by the user. The incremental backup is done
otherwise. To restore an incremental backup, one needs to copy all files changes from the backup since
the last full backup. If backup storage space and CPU utilization to perform a backup are not limiting
factors then a daily full backup can be done and restoration is simply to restore from the day of last
known desired operation.

mcsMQTT collects CPU utilization information for HS and pluigns and these can be associated with HS
devices. These devices will also have controls to stop, start and restart HS or plugin. To perform the
plugin control, it is necessary to get access to the HS web server. The default setup for HS is to not
require login on access to HS from LAN. If a user changes this to require a login, then mcsMQTT will also
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need to know the login credentials for stop, start, restart control of the plugins. This is provided in as
the password for the user ‘default’ or in fomat ‘username:password’ for other users.

17.5.4.1LAN user:pw PW for Plugin Control
"This setting is only needed if LAN access to HS has been modified on HS Setup
page to require password on Local login. Access to HS server is needed to perform
individual plugin start, stop, restart control. If only password is entered then
assumed user account is 'default', otherwise enter both username and password with
colon separator (e.g. name:pw). Enter the password for this user login."

17.5.4.2 HS Device Discovery
"Enumeration makes HS Devices visible on Association table for ease of associating
HS Devices with MQTT Topics for publishing"

17.5.4.3 HS Device Enumeration
"Use button to refresh HS devices listed in Association table"

17.5.4.4 Publish HomeAssistant Discovery
"Use button to publish associated non-plugin devices discovery information using
HomeAssistant discovery protocol™

17.5.4.5 Obsolete Topics
"Enter a topic to be removed from mcsMQTT database. If Topic is again received it
will be restored to database. MQTT wildcard symbols + and # can be used to
identify Topic range, but be careful. For example, 'test/topic/#' will remove all
Topics that start with 'test/topic'. To remove a Topic with JSON payload then use
# at end of Topic."

17.5.4.6 Remove Retained at Broker
"Remove a set of topics from MQTT Broker database that may be retained and if not
associated also remove from the mcsMQTT database. If Topic is again received by
the broker with the retain flag it will be restored to its database. MQTT
wildcard symbols + and # can be used to identify Topic range, but be careful. For
example, 'test/topic/#' will remove all Topics that start with 'test/topic'.
Individual JSON payload keys cannot be removed. All payload keys in the Topic
will be removed."

17.5.4.7 Obsolete Unassociated Topics On Shutdown
"Remove topics that have not been associated to improve startup performance.
Where there are a large number of records collected during a session that are of
no interest then statup performance will suffer.”

17.5.4.8 Receive Topic Warning Threshold
"Enter the max number of Association Table records that will be accumulated before
warning received. Oldest unassociated records will be removed to reduce size to
150% of max value.

17.5.4.9 Debug File at \Data\mcsMQTT\mcsMQTT.txt
"Check to generate debug output in \data\mcsMQTT_debug.txt"

"Check to inhibit the data download from Cloud servers being included in the
debug"

"Check to inhibit the data showing event callbacks (e.g. device value changes)
being included in the debug"
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"Check to inhibit expression evaluation data in the debug"

"Check to inhibit notification of a HS device being blacklisted from MQTT event
evaluation”

"Use button to upload the debug file in zip format. It will go into standard
downloads folder.

17.5.4.10 Configuration Backup
"Config, Data (HomeSeer and mcsMQTT), and script HS subfolders will be copied at
midnight to a newly created folder in the specified path. Backup can be used to
restore to a prior setup.

17.5.4.11 Path(s) to Additional Source Folder(s)
"Full path of other folders that should be included in backup. If multiple then
separate each with semicolon.™

17.5.4.12 Days Between Full Backup
“Backup will occcur daily and save files that have changed since the prior day.
An unconditional backup will occur on the interval of days specified. If one
desires a full backup every week then enter 7. If a full backup every day, then
enter 1"
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17.6 MQTT Page Sign Popup

The Messaging Sign popup illustrated in Figure 236 is shown when the “Configure Sign Parameters”
hyperlink is clicked. This hyperlink is located on the Edit Tab/Popup when the Sign has been selected for

use.

The Message Sign is a LED Pixel matrix described in Section 20.19.

17.6.1

17.6.2

17.6.3

17.6.4

17.6.5

Messaging Sign Text Properties

Sign Display Row 1

Massage Duration 55535

(minutes)

Text Color RRGGEE NI

Default Text C\HomeSeer\Data\MyPlugin\Chart jpg

Image Processing for Sign
JPEG Image Scaling % 200

Figure 236 Sign Properties Configuration Popup

Sign Display Row
"Enter row (top=1) of sign where the message will be shown™

Message Duration (minutes)
"Duration of @ is to remove from sign. Duration of 65535 is until manually
removed. Others are number of minutes to show message."

Text Color RRGGBB
"Select color that is default for message. Color can be changed on a character-
by-character basis using [RRGGBB] encoding in the message text."

Default Text Payload
"If DeviceString is null then the text entered here will be used for payload when
topic is published. This included both Text and Image."

JPEG Image Scaling %

"The JPEG image will be scaled to the percentage of screen size entered. Values
between 100 and 200 are reasonable. If the image is too large to fit the sign
then automatic reduction will be done."
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17.7 MQTT Page Edit Popup
The Edit popup is an alternate means to edit the properties of associations. The popup window is
displayed when the Ref button or row sequence number on an Association Tab row is clicked. One table
will be shown depending upon if the row is associated with a Plug-in Device or a Non-Plug-in Device.
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Start with Either Existing Device Ref or Subscribe Topic

Ref: 212 Sub: GarageDoor/Door Delete Sub and Ref

Edit Setup or Edit of Subscription {Inbound) to a MQTT Topic
MQTT Subscribe
Topic

Payload RegEx
Match Pattern

Payload RegEx
Replace Pattern

Payload RegEx

GarageDoor/Door

® Replace Match Pattern with Replace Pattern Extract Match Pattern

Operation
Low Pass Filter Filter sensitivity of 1 (range is 0.00 to 1.00 {most sensitive))
Expression
[ |Create a HS Rate Device with rate sensitivity of 0.75 Range 0.00 to 1.00
Add Rate Device . vy (Rang )
Per Second Per Minute '®*' Per Hour

[|Create a HS Accum Device
MNo Reset Accumulation Since Midnight '®'  Delta Since Midnight

Add Accum Device

Settings for
Plugin Device
HS Device Publish
Topic

HS Device
Control/Status UT

GarageDoorlemnd/Doaor

Unspecified ®' Button Number Text List ColorPicker

0 CLOSED

A ) 1 INDETERMIMNATE
HS Device VSP List 3 OPEN

HS Device MISC [ INO_STATUS_DISPLAY [ |NC_GRAPHICS _DISPLAY [ |AUTO_VOICE _COMMAND
Properties [1SET_DOES_NOT_CHANGE_LAST_CHANGE RASHOW_VALUES [ |STATUS_OMLY
Publish Payload
Template
At Most

Publish QOS At Least

® Exactly
Publish Retain Flag ® Do not retain Retain at broker
Settings for
Non-Plugin
Device
Control non-Plugin
HS Device

Mote additional customization of buttton text, display graphics, button/number relationships etc. is done via HS
Device Management Page by clicking on the Device Name link and using the Status Graphic and Configuration tabs

Figure 237 Edit Popup Window
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17.8 MQTT Page PublList/Sign Tab
The publication lists are a set of Topics and Payloads that are contained in text files of type “.pub”
located in folder \Data\mcsMQTT. These files can be manually created and edited outside of mcsMQTT
or interactively with the browser on this tab. When using the MQTT Page, Publish/Sign Tab editor, the
first four rows are the substitution variables $51:, $52:, $$3: and $54:; and the remaining rows are the
Topic=Payload assignments.

“u_n

If the contents of publist entry contains a then it needs to be escaped with “\=" because mecsMQTT
uses the “=" to separate the URL querystring from the data that is sent with POST and PUT methods. An

example is shown in Section 12.5.2.

17.8.1 Publication List

The set of “.pub” files that exist can be selected from the pull-down, lines edited if desired, and then the
group published via the Execute Publication List button. Prior to publication substitution variables are
applied if they are setup.

Publication List Selections

Select Existing Publication List publisti »
Create New Publication List

Substitution for $$1. Sub1

o

Substitution for $52:
Substitution for £$3:

’

Substitution for 54

Execute Publication List

Pub/Test/1=0n
Pub/Test/2=551:

Figure 238 Publication List and Sign Setup Tab (Publist)

17.8.1.1 Select Existing Publication List
"Select file that contains the list of messages to be published"

17.8.1.2 Create New Publication List
"Publication 1list file contains a list of topics and payloads that can be
published on command"

17.8.1.3 Substitution for S51:, 5S2:, S53:, 554:
"Topics and payloads can have substitution variables that are replaced prio